Index

Installing Banana ........................................................................................................ 10
  System requirements ......................................................................................... 10
  License key .......................................................................................................... 11
  Installing under Windows .................................................................................... 13
  Installing under Mac ............................................................................................. 16
  Installing under Linux .......................................................................................... 18
  Advanced installing .............................................................................................. 19
  Message: a more recent version has already been installed .............................. 20
  Uninstalling Banana ............................................................................................. 20

Technical data ......................................................................................................... 23
  Technical information for updates .................................................................... 28
  User-focused Design ............................................................................................ 30

Interface .................................................................................................................. 37
  Cells ....................................................................................................................... 41
  File Menu ............................................................................................................... 43
    Create a new file ............................................................................................... 43
    Convert to new file ............................................................................................. 47
    Transfer to a new accounting plan ..................................................................... 49
    Outline to create new file ................................................................................... 52
    Open, save, copy and backup .......................................................................... 53
    Recover autosave file ......................................................................................... 58
  File properties ....................................................................................................... 59
    Accounting Tab .................................................................................................. 59
    Options Tab ......................................................................................................... 61
    Address Tab ......................................................................................................... 62
    Foreign currency ................................................................................................. 62
    VAT/Sales tax ....................................................................................................... 63
    Other Tab ............................................................................................................. 63
    Password Tab ....................................................................................................... 64
    Text Tab .............................................................................................................. 65
    Create Pdf dossier ............................................................................................. 66
    Recent / Favorite files ....................................................................................... 67
    Associate .ac2 files with the most recent Banana version .............................. 67
    Setup a Logo ....................................................................................................... 68
  Edit Menu .............................................................................................................. 69
  Data Menu ............................................................................................................. 70
    Find and Replace ............................................................................................... 70
    Find ..................................................................................................................... 71
    Rename .............................................................................................................. 72
    Go to ................................................................................................................... 72
    Extract and sort rows (Extract) ........................................................................ 73
    Extract and sort rows (Sort) .............................................................................. 74
    Sort rows ............................................................................................................ 75
    Tables setup ....................................................................................................... 76
    Columns setup ................................................................................................... 78
New column ................................................................. 81
New view ........................................................................ 82
**Format Menu** ........................................................... 82
  Highlight rows with colors ............................................ 83
**Tools Menu** .................................................................. 84
  Add new functionalities ............................................... 84
  File info ........................................................................ 84
  Program options .......................................................... 85
    Interface ..................................................................... 85
    Editor ......................................................................... 86
    Advanced .................................................................... 87
    Developer .................................................................... 89
    System Info ................................................................. 89
**Apps Menu** .................................................................. 90
  Manage Apps ................................................................. 92
  Print label ..................................................................... 94
  Options ......................................................................... 95
  Label ............................................................................. 96
  Extract ......................................................................... 97
  Sort .............................................................................. 98
  Composition ................................................................... 98
  Labels format ................................................................. 99
    Page settings - Options .............................................. 99
    Page settings - Composition ..................................... 101
  Installing an App offline ............................................. 101
**Help Menu** .................................................................. 102
  Keyboard shortcuts .................................................... 102
  Error messages ............................................................ 104
**Favorites menu** ........................................................ 105
  Composition ................................................................. 105
**Export** ........................................................................ 108
  Include Tab .................................................................. 109
  Export in Excel .............................................................. 110
  Export in Html ............................................................... 112
    Html Options Tab ..................................................... 113
  Export in Xml ............................................................... 114
  Export rows in txt ....................................................... 115
  Save ............................................................................ 116
**Import** ........................................................................ 116
  Import into accounting ............................................... 116
    Import transactions .................................................. 118
      Import ISO 20022 file .............................................. 122
    Import data from a Cash book file ............................ 123
    Import accounts ......................................................... 126
    Import VAT codes ..................................................... 127
    Import exchange rates ............................................. 129
    Import file .................................................................. 129
    Manage Apps ............................................................ 132
  Import transactions from Paypal ............................... 133
  Merge file .................................................................... 133
  Import rows .................................................................. 134
Installing Banana

When downloading the program, it is automatically saved in your Download folder.

After you execute, if you don't indicate any other destination folder, the program will be installed by default into the Programs folder (Windows: C:\Programs; MAC OSX: /Applications; Linux: /bin).

The following pages explain how to install Banana Accounting in all operating systems.

For more information about the Banana files please visit the Save, copy and backup page.

System requirements

Banana Accounting 9 is available for Windows, Mac and Linux. For optimal performance, we recommend the following system requirements:

Banana 9 for Windows

- Windows 7, 8, 8.1, 10 "Fall Creators Update"  
  (Windows Phone and RT are not supported)  
- 200 MB of disk space*  
- Internet connection to access the Templates and the Help function of the program

Banana 9 for Mac OS X

- Mac OSX 64bits 10.10, 10.11, 10.12, and macOS 10.13 "High Sierra"  
  (iOS, IPad and 32 Bit are not supported)  
- Intel processor  
  (PowerPC processors are not supported)  
- 200 MB of disk space  
- Internet connection to access the Templates and the Help function of the program

Compatibility with MacOS 10.14 "mojave ": Banana Accounting 9 can be used under MacOS 10.14 Mojave but it has in the current version some imperfections regarding the graphical interface and the print preview, in particular all the texts are displayed in bold. The accounting calculations are working correctly. Please check this page regularly to see when a version fully compatible with Mac 10.14 Mojave will be available.

Banana 9 for Linux

- Ubuntu 14.04 or more recent,  
  other distributions partially supported  
- Dependency: libc6 (>= 2.19), libstdc++6 (>= 4.8.2), libfontconfig1, libfreetype6, libglib2.0,  
  libgtk2.0, libz.1, libpng12-0  
- 200 MB of disk space  
- Internet connection to access the Templates and the Help function of the program
Other information

- The indicated disk space requirement depends on the amount of transactions and accounts used in the accounting file. 3 MB is an average space for an accounting file with 200 accounts and 2000 transactions.
- There is no limitation to the number of files.
- The software is a single user program, just like Excel. Only one person at a time can edit a file.
- The Windows version can be installed on a server, and then be run on client computers.
- The program can be used with Terminal Server or similar remote desktop technologies.
- Also see the Installing on a server page.

License key

What is the license key?

It's a code that is being furnished when the program is purchased and that makes the program fully operational.

The license key is furnished in the following ways:

- in the box, printed on a yellow flyer
- sent by email when bought online with a credit card
- printed on the invoice (for those buying directly from us).

IMPORTANT: Keep the license key in a safe place. In case the license key gets lost, read our page Lost license key.

A single license key for Windows, Mac and Linux

With Banana Accounting 9 the license key can be used on all operating systems.

Starter Edition mode at no cost

If you install the program without entering the license key, the program runs in Starter Edition mode.

With the Starter Edition mode, you can:

- Use the program in complete mode, entering up to 70 rows into the Transactions table.
  If you have more than 70 rows in the Transaction table you won't be able to save or export the file, and in the print-outs the words "Starter Edition" will appear.

When the license key is being entered, Banana Accounting switches from the Starter Edition mode into the complete mode.

Entering the license key

- Open Banana Accounting
- Select the command Manage license keys from the Help menu
- Enter the license key number into the appropriate field
• Click on the **Save license key** button
• Confirm the operation if asked

**Important:** The license key is saved only for the current user of the computer.

Registration code

Once the license key has been entered and saved, the program displays the registration code and the following dialog appears in the **Manage license keys (Help menu)** window:

For security reasons the license key is partially hidden.
In case the user loses his license key, the registration code can be used to find the license key that he has entered.
It is important to copy this registration code and keep it in a safe place.

**Modifying the license key**

Before modifying an already entered license key, please save your open accounting files and close them; only the program remains open.

In order to modify a license key, you have to **first remove the existing license key** and then enter the new (different) license key.
Remove License Key

Click on the Remove license key button to remove the key. By removing the license key, the program switches back to the Starter Edition mode.

Enter a new (different) license key

- Enter the new license key number into the appropriate field
- Click on the Save license key button
- Confirm the operation if asked

At the end of this operation, close the program and restart.

Lost license Key

If you have registered your product, you can recover your license key through the License key recovery form without fees.

You can also ask us - by email - to resend you your own license key (service fee). For us to be able to find it, please send us the registration code displayed in the Manage license keys window (Help menu). You may also send us a screenshot of that same window.

Please note:

- Resending you your license key has a cost of 20.- CHF.
- If the registration code cannot be provided, but only a proof of purchase, the costs will be 30.- CHF.
- If it is impossible to provide either the registration code or a proof of purchase, a new license needs to be purchased
- As an alternative to the recovery of the lost license key of the previous version (e.g., Banana Accounting 5, 6, 7 and 8), we recommend the purchase of Banana Accounting 9, valid for all operating systems at the upgrade price of CHF 89.- (instead of 129.-). For more information please see the Updates page.

Installing under Windows

The program installation is a matter of minutes and it is all automatic. By downloading the program, you accept the user license conditions.

Once the download is finished, just double-click on the file you downloaded.
The software will be saved by default in the C:\Programmi Files\Banana90 folder. If you wish to save it in a different folder click on the **Browse** button and choose the desired path.

The program activates by default the **Create a desktop icon** and **Associate Banana Accounting 9.0 with the AC2 file extension** options; if you do not wish to have these options, simply uncheck them.
Click on the **Install** button to start the installation process. The program will be automatically installed in your operating system language; you will be able to change the program language anytime by choosing the **Program options** command from the **Tools** menu.

**Entering the license key**
After opening the program for the first time enter the license key and confirm with **OK**

By entering the license key into Banana Accounting, you go from the **Starter Edition** demo mode to the complete mode. If the license key is not entered, a message appears at the opening of the accounting file, warning the user that he is working in the **Starter Edition** mode.

**Open the software**
As soon as you open the software, choose the **New** command from the **File** menu. From the pop-up window you will be able to choose your accounting type, the option with or without VAT, the file language, and an example or template (or you can also open a blank file - not recommended)
Note: in order to uninstall the software, please select the Install/Uninstall applications from the Control Panel and then chose to remove Banana Accounting from the list.

Installing under Mac

Installing the software is very easy, thanks to the autoinstall function. By downloading the program, you accept the user license conditions.

Follow these steps:

Download the .dmg file by clicking on the Save file button.
After saving the file in your Download folder, double click on it.

Drag the Banana9 icon in the Applications folder
Banana Accounting 9 is now ready to be used. Double click on the Banana 9 icon from your Applications folder. The program is installed in your operating system language, but is always possible to change it from the Tools menu, using the Program options command.

**Entering the license key**

After opening the program for the first time, enter the license key and confirm by pressing the button Save license key.

Then launch the New command from the File menu. From the pop up window it is possible to choose the accounting type, the with or without VAT management option, the language and a template or example (or you can choose to open a blank file - not recommended).
In case of problems while installing the program: verify in Apple -> System Preferences, Security & Privacy, to have chosen the option "Anywhere" instead of "Mac App Store and identified developers". See also Apple’s internet page.

NOTE: in order to uninstall the software, simply drag the Banana9 icon from the Applications folder to the Trash.

Installing under Linux

The program installation is very easy thanks to the AppImage package. When downloading the program, the user license conditions are automatically being accepted.

Complete installation

With this procedure, Banana Accounting 9 will be copied to the /opt/banana9 folder, registered in the system and associated with the .ac2 files.

Open a Terminal window (Shell, Konsole) and execute the following commands:

mkdir ban9 && tar -xzf banana9.tgz -C ban9
ban9/install-banana.sh

Need more help installing Banana for Linux? Watch this Video tutorial

Packages .AppImage

- Download the package
- We recommend to save the package under $HOME/.local/bin or $HOME/bin
- Make the package executable
  - Right click the package and select Properties
  - Under the tab Permission activate the option "Allow execution ..."
  - Confirm the change with Ok
Start the application with a double click on the package
Insert and save the license key in order to enable the complete mode

To uninstall the program, simply delete the package.

Packages .tgz

- Download the .tgz package
- Extract the .tgz package
- Run the file start_Banana.sh
- In order to enable the complete mode, insert and save the license key.

To uninstall the program remove the folder containing Banana9. Be careful not to delete user data!

Advanced installing

Installing on a computer that is not connected to internet

- Use a computer that has an internet connection and [download the installer](#) that is suitable for the operating system of the computer on which the program will be installed.
- Copy the file to a USB key or a CD
- Enter the USB key into the computer where the program should be installed
- Launch the installer
- Start Banana Accounting and [enter the license key](#).

Windows installation on a server or a USB key

Legal considerations

Remember that in order to execute Banana Accounting from multiple computers, you need to buy as many licenses as there are computers that use the program.

Banana with terminal server and package management systems

Banana accounting can, without any problem, be installed on a server, a terminal server, external disks or can be packaged for distribution, because:

- Everything necessary to execute Banana Accounting is installed in the installation directory (exe, dll, examples)
- Banana does not write in the system directories and the system registry
- The user settings are stored in the registry of each user
- For each accountin, there is a single file that (as in Excel) can reside on a local disk, network, USB flash drive or a directory in DropBox, Google drive, or other similar systems
- Banana is compatible with Remote Desktop systems or systems of software packaging for the installation

For more information on the files, see also File - Save.

Installation on a shared folder or USB key
• Follow the normal installation procedure, usually the program will be installed under C\Program Files \ BananaXX \ (XX stands for the version number).
• Start the program BananaXX.exe “as Administrator”
• Enter and save the license key
• Copy the entire installation directory on the USB key, shared folder or package management system.

For more information on this subject, contact our technical support.

Apple/Mac server installation

It is not possible to install Banana Accounting on Mac servers.
The program must be installed and the license key must be entered on each computer.
Of course, you can save the accounting files on a network disk.

Message: a more recent version has already been installed

If, during the installation, a message is being displayed saying that a more recent version has already been installed on your computer, you should interrupt this installation.

If you have not yet inserted the license key, launch Banana Accounting as usual and insert the license key to activate all its functions.

Uninstalling Banana

Uninstalling Banana Accounting on Windows

• From the Start menu choose -> Control Panel
• Select -> Programs -> Uninstall a program
• Choose the program you wish to uninstall, for example a Banana Accounting old version
• Press the Uninstall button

By uninstalling Banana Accounting you will only deleting the program; your personal .ac2 files will not be modified.

Uninstalling Banana Accounting on Mac

• Go to the Finder
• Choose the Applications folder
• Choose the program you wish to uninstall, for example a Banana Accounting old version
• Drag the selected program into the Trash

By uninstalling Banana Accounting you will only deleting the program; your personal .ac2 files will not be modified.

Uninstalling Banana Accounting on Linux

For the details, we refer to our 'Installation under Linux' page: Packages .AppImage and Packages
Technical data

Applications and accounting types

Banana is a native application for Windows, Linux and Mac and includes functions that allows the user to manage different types of accounting files:

Income & Expense accounting

- Income & Expense accounting (income and expenses of several accounts)
- Cash book (income and expenses of one single account)

Double-entry accounting

- Double-entry accounting
- Multi-currency accounting

Labels

Every application can be set up with or without VAT/Sales tax and includes:

- Accounting plans divided by language
- Accounting plans with VAT
- Specific accounting plans for different countries
- Accounting plans for small companies (for the family, non-profit organizations, professional studios, shopkeepers, churches, etc.)

All the different types show a resemblance with the Microsoft Office software and operate in a similar way: windows, tables, data selection, copy and paste, find and replace data, undo and redo operation, printouts with various options, data protection, password, etc.

Main interface/Accounting/ Files

- Multilingual: English, Italian, German, French, Spanish, Portugese and Dutch NEW
- Main graphic interface easier and more user friendly - computers with small screens such as notebooks will benefit the most NEW
- Management of multiple accountings: there are no limits with regard to the amount of accounting files that can be managed
- Every file contains an accounting. There is no limit to the amount of files
- Every file can be saved, moved or copied on whichever type of support (local files, network, CD, USB sticks)
- Favorite files list - it allows to access your most used files with a single click NEW
- Possibility of protecting the Composition settings NEW
- Autosave of the work in a temporary file (Auto backup + file name)
- Possibility of creating a copy of a file, with or without the transactions
- Every file of a specific type can be converted into another type
- For each accounting type, the set up of the currency can be selected by the user
- With the Open command from the File menu, the folder, in which the current accounting has been saved, will be opened. NEW
Accounts/Categories

- All the Charts of accounts for Switzerland have been updated according to the new legal regulations
- Unlimited number of accounts/categories
- Numeric or alphanumeric accounts up to 256 characters
- Free setup of groupings and totaling (up to a 100 levels of totaling)
- Automatic totals recalculation (possibility of switching it to manual)
- Account/category numbers can be adapted to any kind of national requirement
- Accounts can be added or cancelled at any moment
- Double clicking on an account/category number doesn't open the account card anymore (it goes into editing mode instead). In order to open the account card you need to click on the little blue arrow in the top right corner of the cell
- From the account/category card, by double clicking in the row number (underlined as a link), you can open the Transactions table at the corresponding row, so it can be edited
- Opening balance, actual balance
- Budget and difference between budget and balance (for the entire accounting period)
- Transactions and balance by period
- Balance of the previous year and difference with the previous year
- Account cards, complete or by period, with indication of the balancing entry
- Multi-currency: accounts in more than one currency
- Display of the amounts in the account currency as well as in basic currency

Transactions

- Unlimited number of transactions
- Corrections are also possible with no need to make a reverse transaction
- Possibility of editing texts directly in the cell
- Smart fill (automatic completion of already used texts) directly from the cell, with possibility of filtering the texts
- In the Date field, by entering the "." key the current date is entered
- Automatic completion of the account number directly in the debit or credit cell (a drop down menu will appear with the list of all accounts)
- In the Status bar, the information on the number of selected amounts, apart from their total, has been added.
- In the Multi-currency accounting, also the changes with a date are being used for the completion of the transactions
- The position of the current cell is highlighted in the row number and in the column heather
- Possibility to add and cancel transactions at any moment
- Recurring transactions can also be retrieved from the smartlist by pressing Enter or by selecting them with the mouse
- Automatic totalisation also possible with the selection of individual, non contiguous cells (key Ctrl + mouse)
- Simple transactions or on several accounts
- Possibility to insert links to digital documents (PDF, JPEG...)
- "Rename" command, which allows the user to modify an account or VAT code with automatic replacement in the transactions
- Automatic completion of dates and account numbers
- Search of the account number from the description
- Automatic completion of the transactions (even based on previous year's transactions)
• Possibility of memorizing repetitive transactions
• Sorting of transactions by date, document date, value date, payment date, expiration date
• For multiple transactions, the still missing amount is displayed
• Command for searching transaction differences
• Journal: complete or by period

VAT Management

• Table to define VAT codes
• Possibility to add or edit VAT codes at any moment
• For each VAT code, the number of the Swiss VAT Declaration form is present, in order to facilitate the periodical VAT Declaration.
• Account Automatic VAT already defined in the File and Accounting Properties (Basic Data)
• Automatic calculation and splitting of VAT
• Splitting and VAT report also on foreign currency amounts
• Uniformity of calculation and splitting of VAT
• Swiss VAT report, both for the effective method and the flat tax rate method, already integrated in the program. Data should be manually copied on the official VAT form NEW
• VAT form with flat tax rate method: the form also works with the automatic VAT splitting (with the percentage defined in the VAT table) NEW
• Possibility to define the VAT percentages based on the gross or the net amount
• The accounts on which the VAT should be registered can be freely defined
• The groupings for the totaling are defined directly in the VAT table
• Supplementary column for external groupings
• Possibility to freely define rounding with multiples (for instance 0.05)
• Rounding system defined for all or for a single code
• Possibility to split the VAT from the gross, the net, or only the VAT amount itself
• VAT deductible also if only partial
• Possibility to connect a VAT code to an account
• VAT/Sales tax reports, global or by period
• VAT Reports with protected personal settings (Compositions) NEW
• The VAT report can be obtained with transactions and totals by code, account, percentage, or using the user’s own grouping scheme
• VAT Code for importing
• VAT reports can be exported in Excel / HTML / XML

Reports and Balance Sheets

• In the Income & Expense accounting, the Enhanced statement with groups has been added NEW
• Balance sheets and reports with previous years and budget data NEW
• Possibility of creating budgets also by period and comparison with final balances NEW
• Reports with income and expenses being displayed and definition of capital (Cash book and Income & Expense accounting) NEW
• In the Enhanced balance sheet by groups, the columns "Diff. Budget" and "Currency 2" can be included NEW
• In the Balance sheet by groups of the Multi-currency accounting the Currency symbol is being displayed NEW
• In the Enhanced balance sheet and in the Enhanced balance sheet by groups, a zoom (font size) greater than 100% can be applied NEW
• In "Create PDF file" of the Income & Expense accounting, it is possible to include the Enhanced balance sheet and the Enhanced Balance sheet by groups NEW
• In the External accounting reports, also the columns of the "Amount" type, defined by the user, are being totalized NEW
• In the Enhanced balance sheet by groups, the Budget amounts are adapted to the selected period and subdivision NEW
• Detailed balance sheets, also with subgroups (Double-entry accounting and Income & Expense accounting) NEW
• Possibility of creating reports and balance sheets using Compositions (protected personal settings) NEW
• Possibility of editing and updating accounting reports with account card directly in the table NEW
• Possibility of editing accounting reports and select favorite settings directly in the print preview NEW
• Different styles available (default balance sheet models)
• Possibility to modify the headers of the Balance sheet and the Profit & loss Statement
• Possibility to customize Balance sheets and reports by selecting different colors
• Possibility to exclude groups, subgroups and accounts from Balance sheets and reports
• Balance sheets and reports by period
• The data requested for a specific period can at their turn be presented by period

Segments

• Balance sheets and reports saved in Excel, Html, Xml, Pdf or copied to clipboard
• Segments are a kind of cost center without limits as to classification or levels. They are very useful to obtain reports pertaining to projects or other reports related to main expenses and revenue
• The segments are being inserted simultaneously with the debit and credit account.
• Reports by segment

Cost and Profit centers

• Directly defined in the chart of accounts
• Have the same characteristics as the accounts
• Possibility to also manage cost centers in foreign currency
• Up to three types of cost centers for every transaction
• Possibility to make entries with or without the VAT amount included
• Periodical cost center reports available

Transfer to the New Year

• Automatic allocation of profit/loss for the accounting period (Double-entry accounting)
• Creation of the "Profit or loss of the current year" group in the Liabilities to obtain the balance between assets and liabilities
• Guided opening of the new year with the creation of a new file
• Transfer of the Chart of accounts, of the VAT table and the opening balances
• Possibility to open a new year even if the previous one has not yet been closed
• Possibility to carry forward the final closing balances of the previous year

Protection and storage of data

Data protection
- The rows can be locked in order to avoid manipulations
- Possibility of setting up a password
- Protection of the rows can also be done by selection
- System based on the electronic signature technique
- Patented method US Patent No 7,020,640
- Transactions lock up to a defined date
- Calculates the control numbers to verify the authenticity of the data
- Verifies whether the locked data have been manipulated
- Indications possible manipulations in detail
- Lock information reports
- Possibility of removing the lock

Storage
All data can be stored in archives, and saved in a PDF format.

Data export

- Export in HTML
- Export in Excel
- Export in XML
- Export in PDF - the number of pages is limited to 65,000
- Global or periodical exportation
- Possibility of creating Compositions for each data export, with specific settings that can also be protected
- Exportation of text files with fields separated by tabs, in Ascii or Utf8 (Unicode) characters, with the entire table or only selected rows

Data import

- Import ISO 20022: added to the importation the camt.052, camt.053 and camt.054 formats
- Bank statements in ISO 20022 (*.xml) and MT940 (*.txt) format can be opened and displayed directly in Banana
- Import bank statement in ISO 20022 format - the standard format adopted by all banks and institutes
- Import bank statements from different banks (UBS, Credit Suisse, Raiffeisen Bank, ...) directly from Banana - no need to import and update import filters for each bank anymore
- In the import scripts, it is possible to define the format of the dates and the amounts to be converted in the internal format
- Text files: importation of all text files that have fields separated by tabs
- Possibility of exporting the entire table or only certain rows
- Automatic completion of missing fields (VAT codes, exchange rates)
- Possibility of importing in Ascii or Utf8 (Unicode) characters
- Possibility of importing directly from the clipboard
- AC2: import from Banana Accounting .ac2 files
- Possibility of indicating the accounting period from which to import data
- The accounts and the categories are imported following in the correct sequence
- Importing VAT Codes: allows the user to import VAT Codes from another file (also from a .txt format)

Functions no longer supported
- DDE interface - in version 7 a new interface will be presented, based on http protocol

**System requirements**

- Windows XP or more recent version, 32 or 64 bit
- Mac OS X 10.5 "Leopard" or more recent version, 10.9 "Mavericks" (only 64-bit) NEW (iOS e iPad not supported)
- Ubuntu 12.04 LTS or more recent version LTS NEW
- Intel or AMD Processor (Mac with PowerPC not supported)
- 150 MB Ram memory - The RAM requirements depend on the amount of transactions and the amount of accounts inserted in the accounting. The value indicated here is valid for an accounting with 200 accounts and 2000 transactions. The amount of different accountings, accounts and transactions are not limited.
- Internet connection for accessing the Help function of the program.

**Documentation**

- Online help - directly accessible from the program with direct link to our website / detailed explanation of all dialog windows
- Index directly linked to the subjects
- Error messages windows and warnings window directly accessible
- Help center and online manuals downloadable from our website: [https://www.banana.ch/doc9/en](https://www.banana.ch/doc9/en)

**Technical information for updates**

**Important information when updating to Banana Accounting 9**

for those who have an accounting file created with a previous version (4.5.6.7.and 8) and want to update to version 9.

In order to see what's new, visit the page [What's new in version 9](#).

**File management and -exchange**

Once Banana Accounting 9 has been installed (on Windows or Mac), you can launch the program and open the accounting files that have been created with Banana Accounting:

- Banana 9 opens the files of all previous versions: 2.02, 3, 4, 5, 6, 7 or 8.
- Files saved with Banana 9 can be opened and edited with the versions 5, 6, 7 and 8 of Banana Accounting.
  - If you are using features only available in Banana 9, these do not work with earlier versions.
  - Files saved with Banana 5, 6, 7, 8 and 9 cannot be opened anymore with Banana 2, 3 or 4.
- Files can be transferred easily from one operating system to another.

If the files are not listed in the recent files (Initial page), you can look for them following these instructions.
If after installing the new version of Banana, files are opened with the old version, you need to activate the option "Associate .ac2 files".

**Starter Edition version / License key**

If the program is installed without license key, Banana 9 operates in the Starter Edition mode. This allows the user to use all features and to save a file with no more than 70 transactions.

- In order to use version 9 in the complete mode, you need to purchase the update license key and enter it in the software (update) that you can download from our download page.
- An [Update Version](#) is the normal version sold at a preferential price. It can therefore as be installed on a computer that doesn't have a previous Banana version installed.
- The license keys are valid for Windows, Mac and Linux, for installing Banana 9 on a maximum of 2 computers (belonging to the same owner).
- In the [Starter Edition mode](#), the Cash book is also limited to 70 transactions.

**Version for Mac**

In order to avoid conflicts with the keys used by the Apple operating system, the function keys F4, F5, F6 of Windows have become CMd+4, Cmd+5, Cmd+6 under Mac.

**Importing bank statements**

Banana 9 provides various import filters that can be downloaded from our website. To import the bank statements / update the filters, you need to:

- select the Import to accounting command from the Account1 menu -> Import transactions
- click on the Manage filters button to see all the available filters
- click on the Update filters button
- enable the desired filters by selecting them and clicking on the Enable filters button

**Importing Postfinance Xml file**

Banana 9 imports bank statements using the new XML ISO 20022 standard. Postfinance supplies this format only when requested by the customer.

It is therefore necessary to ask your Postfinance consultant to change the format and switch to the ISO 20022.

Postfinance Business clients can ask to have the Pfd as well as the ISO 20022 format.

**Swiss VAT Report**

In order to obtain the quarterly Swiss VAT report, ready for the official form, proceed as follows:

- Apps Menu -> Manage Apps -> select Swiss VAT Report (effective method or flat rate method) -> press Install
- Once you have installed the Swiss VAT report App, when needed you just need to go to the Apps Menu and select it.
- In Banana Accounting 9, the VAT report will also be available for those who are submitted to the flat rate method.

**Enhanced Balance Sheet with Groups**
In the Enhanced Balance sheet with Groups (from the Account1 menu), in the Previous Year column, the balances that have been carried forward from the previous year's file are being displayed. If, in the Options tab of the File and Accounting Properties dialog window, no previous year's file has been indicated, then the balances will be carried forward from the Prior column of the Accounts table.

Changes from Banana 6 or previous versions

From Banana 6 to Banana 9 some functions changed their names:

- Data can be edited directly in the table cell (just like in Excel)
- With a double-click you go in the cell editing mode.
  In order to open an account card or to access the Extract rows command, instead of the double-click you can use:
  - Alt + mouse click
  - Right mouse click (opens the menu)
  - A mouse click on the little blue arrow next to the account number (cell top left corner)

- The Messages window has been moved in the lower corner of the screen, next to the Info window.
- The Messages window can be reached by clicking on the correspondent table.
- The Views list has been moved to the top of the screen, just below the tables list.
- When scrolling the vertical bar, the table content now immediately scrolls too.
- In the transactions, the indication of the date and the document are not shown any more.
- From the Banana 7 version it is possible to update the account card (see refresh button on the top right corner); in Banana Accounting 6 it was necessary to give the command again.
- When printing or when viewing the print preview, it is now possible to only print a selection of rows.
  In the print dialog window, it is possible to choose if you want to print everything or just a selection (only in Banana for Windows).
- In the Date column, by entering the “.” symbol, the program automatically enters the date of the day.
- Simple Accounting -> has been changed into -> Income & Expense accounting
- The Cash1, Simple1, Cash2 and Simple2 menus have been replaced by the Account1 and Account2 menus
- Accounts by period -> has been changed into -> Accounting Report
- Export file in pdf -> has been changed into -> Create Pdf dossier
- In some functions, such as the Enhanced Balance sheet, ... a new submenu called "Compositions" has been created in order to recall saved personal settings (in Banana 6 they were called Favorites).
- In the Help menu "Keyboard Shortcuts", you find the list of key-combinations and the commands that are associated with them.
- In the Info and Messages windows, next to the error message, there is now the symbol: if you click on it, you will be directly connected to the online page explaining the error message and suggesting possible causes and solutions.
- DDE connections are no longer supported

User-focused Design

Banana Accounting was - and is - being developed taking into account and focusing on the needs and
expectations of its users.
We aim to create a professional, intelligible, easy to use and fast accounting tool.
To achieve this goal, 10 heuristic interface design rules, developed in 1990 by Jackob Nielsen, have been used as a reference. These principles continue to be valid, even in the current Internet environment, and serve as a reference for developers of programs, apps and websites.

Banana Accounting implements all of the 10 rules as plainly as possible.
Over the years, there has been a continuous attention to adhere to these rules, (refer to the Interface page), and to integrate new technologies going forward, obviously, whilst building on the same foundations.

You will find the different rules below, with notes relating to how they are interpreted and implemented in Banana Accounting.

1. Visibility of system status

“The system should always keep users informed about what is going on, through appropriate feedback within reasonable time.”

This most important point, is achieved thanks to the table interface, typical of spreadsheets, where the user will always be able to determine what stage he is at and what data have been entered.

- If you add or delete a line, change the format, the colour, you will instantly see the result of the operation.
- When you resume accounting, or you are interrupted by the phone, you immediately see what the last recorded entry was.
- The calculations (account balances and others) are updated and visible immediately.
- Multiple windows can be displayed simultaneously.
- The preview window does not block the use of the program, it can be kept open in parallel.
- In the Info window below, you will find additional information about the transaction, account or other on which you are positioned.
- In the Graphs window, you can see the evolution of the account balance on which you are positioned. If the cash drops below zero, you will be able to notice it immediately.

2. Match between system and the real world

“The system should speak the users' language, with words, phrases and concepts familiar to the user, rather than system-oriented terms. Follow real-world conventions, making information appear in a natural and logical order.”
The spreadsheet was created from the world of accounting. The table is the native mode of accounting (cash book, account list).

- Entering data in the table leads to an immediate change in status. Everything is updated immediately accordingly.
- The Transactions table contains all movements, exactly as expressed in the accounting.
- The Accounts table contains and displays the Balance Sheet and the Profit/Loss Statement, with accounts and groups, and the related updated amounts, complete with balances, movements, budgets or discrepancies.

3. User control and freedom

“Users often choose system functions by mistake and will need a clearly marked "emergency exit" to leave the unwanted state without having to go through an extended dialogue. Support undo and redo.”

Within Banana Accounting, the user has full control and freedom:

- You choose the sequence in which you wish to work freely.
  - You will never be blocked by the system and can change or interrupt whenever you need to.
  - You can navigate freely within the table and add or change any information.
  - You can move from one table to another.
  - You can switch from one file to another.
- Operations can be cancelled or restored; you can also decide to not save the file you notice that the work done does not satisfy you.
- Any dialog and procedure can be interrupted with the Esc key.
- You can protect your data:
  - Protect any row from being modified.
  - Lock the rows of the Transactions table with blockchain.
  - It complies with requirements for the accounting data conservation and will prevent ill-intentioned persons from interfering with your accounts, without your knowledge.
- Decide where to save your files.
  - All accounting data is saved in a file, with a user defined name and can be copied, moved, sent by email, saved to a network or cloud drive, such as is most useful to you.

4. Consistency and standards

“Users should not have to wonder whether different words, situations, or actions mean the same thing. Follow platform conventions.”

Banana Accounting aims to be consistent throughout.

- The mode of use of spreadsheets is kept consistent.
- The interface and the commands conform to Microsoft Excel and Office, reference programs in the administrative field.
  - Being familiar with that software will put you at ease immediately, the main commands and operating methods are as similar as possible.
- In dialogues and other interactions, graphics and logic specific to the operating system in place are used.
- "Compositions" will allow you to save and use setups in a standardised form.
- We aim to maintain continuity from one version to the next. New designs are only put in place if
they are considered effective and bringing benefits.

5. Error prevention

“Even better than good error messages is a careful design which prevents a problem from occurring in the first place.”

Banana Accounting connects the data structure and the display functions and there is help while inputting rows.

• Columns and Rows will make it clear, which information is to be inserted.
• When in editing mode, the program will propose a list of suggestions, so as to avoid input mistakes.
  ◦ In the date column, entering only the day, the program will suggest the complete date of month and year based on the previous registration.
  ◦ In the document column, the program indicates the following number, regardless of the numbering convention used.
  ◦ In the account or code column, existing ones will be displayed and will also allow you to search via entering the description.
  ◦ The description column will display texts already used, which can be reused, along with the rest of the transaction.

6. Recognition rather than recall

“Minimize the user's memory load by making objects, actions, and options visible. The user should not have to remember information from one part of the dialogue to another. Instructions for use of the system should be visible or easily retrievable whenever appropriate.”

With Banana Accounting, as with spreadsheets, it is quite clear what should be done by you and how to proceed.

• To add a transaction, an account or a group, a row is added.
• To delete a transaction, an account or a group, the row is deleted.
• To format, change colour, copy and paste data, select the zone first and then click the command.
• All commands are visible in the context menu, the top menu or the toolbar.
• Account numbers or other values to be entered are suggested when in modification mode (see previous post).

7. Flexibility and efficiency of use

“Accelerators – unseen by the novice user – may often speed up the interaction for the expert user such that the system can cater to both inexperienced and experienced users. Allow users to tailor frequent actions.”

There are several options for advanced users to work faster:

• You may use Key shortcuts.
• There are contextual commands that automate a certain number of operations (such as reversing debit and credit account allocation).
• You may apply the commands (copy, paste, delete, format) to a whole selected area. Other
accounting programs generally allow you to work on one line at a time only.
- Pick up rows of recurring transactions.
- Row settings for recurring transactions.
- "Compositions" to set and save report settings and other commands.

8. Aesthetic and minimalist design

“Dialogues should not contain information which is irrelevant or rarely needed. Every extra unit of information in a dialogue competes with the relevant units of information and diminishes their relative visibility.”

Banana Accounting was and is conceived to generate accounting files that adhere to regulatory requirements and will contain only related necessary data.

- Your accounting can be created with only the required options. Functions such as VAT, multi-currency, cost and profit centers, segments, are not present if not necessary, but can be activated selectively when needed.
- Your spreadsheet can be customised. You may hide columns that you do not need.
- You can create different views of the columns, in order to access them when and how it is most suitable to you.

9. Help users recognize, diagnose, and recover from errors

“Error messages should be expressed in plain language (no codes), precisely indicate the problem, and constructively suggest a solution.”

Banana Accounting has several ways to allow the user to notice any errors or problems:

- Error messages, well described, when you enter or effectuate an incorrect operation.
- Errors or warnings are highlighted in colour of the row concerned.
- Explanation of the error in the Info window.
- "Check Accounting" command, to recalculate and check all data entered and signal any errors or problems.
- Window displaying the list of all messages, allowing you to locate the row in which the error occurred.

10. Help and documentation

“Even though it is better if the system can be used without documentation, it may be necessary to provide help and documentation. Any such information should be easy to search, focused on the user's task, list concrete steps to be carried out, and not be too large.”

Banana Accounting provides a contextual and comprehensive documentation:

- Each error message has its dedicated documentation page, reachable at a click, complete with causes, solutions and links to information pages, which will help you solve your problem.
- When you are using the table, the help command will lead you directly to the relative Help page of the application and the data table.
- Each dialogue has a help button that leads to the specific help page.
- There is a complete and very comprehensive documentation, structured according to the logic of the program and with links to all the related topics.
- Beside this documentation, there is an index that will allow you to understand it's structure and
to move around it easily.
• Dialogues created through program extensions written in Javascript, also link to specific help pages.
Interface

When a new file is being created or an existing one is opened, the software presents a structure that is characterized by the following elements:

**The menubar**

The menubar contains all commands grouped by menus. The menubar changes depending on the chosen accounting type.

Attention: in the Mac operating system, the Banana menu bar is located on the top of the screen, at the rightside of the apple logo:
The toolbar

The toolbar contains icons that allow you to access the most used commands and dialogs. If you go over the icon with your mouse a command description will be displayed.

Text input area

Text are entered directly in the cell. The entered text is also shown in the text input area, right below the toolbar. The text can be edited in the text input area, or directly in the cell, by double clicking on it or by pressing the F2 key.

If the Smart fill option is activated (Program Options command from the Tools menu), a drop-down menu will be shown with all the possible text choices; just select the chosen text and press the Enter or the F6 key.

Smart fill (autocomplete)

When you enter a text, the program suggests different choices:

- Texts of similar transactions
- Accounts list. By entering a text the program will list all the accounts containing that text.

Execute command

Some columns are associated with certain actions that can be executed with the Execute command (from the Edit menu) or relative touch key, as indicated in the information window.
Some examples:

- Doc column: recovery of recurring rows or progressive number
- Description column: recovery of similar row data

The tables

Each accounting file has various tables. Some of them are main tables and others are optional. Tables vary depending on the chosen accounting type.

The views

The views are ways of showing the accounting data with specific columns. For each table there are different views and they are very useful when you want to show your data in different ways, without altering your basic settings.
Views are located right below the tables and can be personalized using the Tables setup command from the Data menu.

Related document: Tables setup; New view

The columns

Columns are the table vertical elements. Each table has specific columns with specific heathers. The display, size, description, format, width, style, alignment can be edited through the Columns Setup command from the Data menu.
Some columns contain data entered by the user, and some others can only be used by the program and cannot be edited by the user (for example the account cards columns).

Users can add new columns in order to include additional information (always with the Columns Setup command from the Data menu), but the data entered will not be processed by the program.

A group of specific columns composes a view that displays only specific data.

**Related document:** Columns setup

---

The information window

This is a window located in the lower part of the screen, where the program displays useful information related to the active table and cell. Error messages are shown in red.

---

The error messages window

The Messages windows contains a list of the errors found by the program.

In order to read the messages click on the Messages tab.

From the Messages window, by double clicking on the error message, you will be taken to the row that generated the error.
Date and numbers format by per default

Once the program is installed, it automatically uses as default your operating system settings.

If you wish to change your operating system settings, you should go in your Control Panel (Windows) or your System Preferences (Mac).

Here is the step by step process on Windows 8 and Windows 10:

- from the Start menu, go to the Control Panel
- click on International options and then on Change date, time or numbers format
- a dialog window will appear where you can change your data format (in the Format tab)
- in order to change your numbers or currency format, from the same window you can click on the Additional settings button and then on the Numbers or currency tab.

Here is the step by step process on Mac OS X 10.9.5:

- from the Apple logo (on the top left of your screen) click on System Preferences
- from the dialog window that appears choose the Date and time icon
- a new window will appear where you can choose Open language and zone...
- a new window will appear where you can click on the Advanced button
- finally a new window will appear where you can change the numbers format (General tab), date or time format (Date and Time tabs)

Format and numbers in Banana Accounting

Cells

Copy, Cut and Paste

It is possible to copy/paste cells, rows or selected text just as it is possible to do with any normal Windows program:

- Select the line or the area of data to be copied
- In the Edit menu, select the Copy or Cut command
- Move to the row or the area where the information should be copied
From the Edit menu, select Paste.

The user can also copy/paste by using the following icons:

- or press **Ctrl+C** to copy, **Ctrl+X** to cut and **Ctrl+V** to paste.

There are also commands such as **Copy rows**, **Delete rows** and **Paste rows**: in this case they refer to a full row or rows and not to a cell selection. For this purpose the commands Copy, Cut and Paste should not be used.

**Entering a text**

In order to enter a text position yourself in the cell you wish to write in. With a double click on the cell a drop down menu will appear with all the text previously entered; as you start writing the program automatically suggest similar text previously entered; select the appropriate text and:

- press **Enter** - in order to automatically enter the selected text
- press the **F6** key - in order to automatically enter the selected text + all other row data (debit account, credit account, amount, ...)

**Editing a text**

From the version 7 of Banana Accounting it is possible to edit the text directly in the cell; just double-click in the appropriate cell (or press the **F2** key) and enter the new text. Also when editing the texts, the **Smart fill** and **autocomplete texts** feature suggests earlier entered texts.

It is also possible to edit a text selecting the cell and entering the new text in the text imput area, under the toolbar. On the left side of this area, two icons will appear to undo or accept the entered text.

**Wrap text**

When the text for a row is very long, the **Calculate row height** command from the **Format** menu allows the user to view it completely, adapting the height of the row.
To adapt the height of the row to the text, the user should:

- choose the **Columns setup** command from the **Data** menu;
- select the appropriate field name;
- activate the option **Wrap** text in the **Display** tab;
- recall the **Calculate row height** command from the **Format** menu each time it is necessary.

The **Calculate all row heights** command is equal to the one described above, with the difference that it operates on all rows of the table.

**Entering an account number**

Position yourself in the Debit or Credit account column and start entering the account number or account description; the program will suggest you all the accounts with a similar number or description. Choose the appropriate one with the **Down arrow** key or **Up arrow** and press **Enter**.

**Attention:** to deactivate last year's smart fill, you must deactivate the **Smart fill with transactions from previous year** option from the **File and accounting properties** command (Options tab - File menu).

**File Menu**

Banana files are compatible with versions from all operating systems and with syncronization systems (Dropbox, iCloud, …)

For more information please visit the **File Saving** page.

**Create a new file**

To create a new File, go to the **File menu** and click the **New** command.
The appearing window will allow you the possibility to create a new file in three different ways:

1. **Using an existing Template**
2. **Copy data from an existing File**
3. **Use a New empty File**

**Start with one of our templates adapted to your business**

This will generate a new File based on one of the existing templates.

- **File Menu, New command**
- Select your country
- Select your language
- Select your category
- Select your Accounting template
- From the dropdown list of templates that will display in the dialog box, select the template that most closely matches your needs.
  Clicking on the file will automatically open it and can then be saved with the name you wish.

All the files with the VAT option have the VAT codes table adjusted to the new rates.

The Chart of Accounts can be adapted to your requirements (change of account description, insert or delete groups, sub-groups, etc.)

You can search for a template by entering a keyword in the search box.

**Save the file with a name**

Once you have opened the template with Banana you need to use the **Save as** command from the File menu

- Chose the destination folder
  It might be useful to create a separate folder for each year, so you are able to store documents, other than the accounting file that are related to that year.
- Chose a file name containing the company name and the accounting year, for example smith_company_2018.
  The software will add the .ac2 extension, typical for the Banana files
- Chose a file name containing the company name and the accounting year, for example smith_company_2018.
  The software will add the .ac2 extension that distinguishes the Banana files.

**Adapt the template**
1. Edit the File properties
   - Enter the headings and the accounting period
   - Enter the address
2. You can now adapt your Chart of accounts
   - Enter your bank accounts.
   - Enter or edit the chart of account to fit it to your requirements.
     While going along with your work, you will still be able to add or edit, if new needs arise.

Start with an existing File

Starting from an existing file or template, without modifying the existing file.

There are several possibilities to copy data:

- Open the File that is to be your template via the Browse button and indicate the path to locate your file.
- Create a copy of the open file, using the Save As command from the File menu
- Else, you may create a copy of the open file via the Tools menu, click on the Create File Copy command, the window that will appear allows you to choose which data to keep. If none of the three options are activated, a file is created with the Plan of Accounts only.

Save the file in the folder where you wish to keep the data (normally in the documents folder)

- Enter the company name and the accounting year as file name, for example smith_company_2018.
- If you are taking over an existing accounting file, you will also need to enter the opening balances in the Opening column.
- If you are working in a multi-currency file, you need to update the opening exchange rates.
Starting from a New empty File

You will be starting from scratch, so you will need to set up the basic accounting data and the entire Plan of Accounts (not recommended).

- **File** Menu, **New** command
- Click **New empty**
- Select your language
- Select your category
- Select your Accounting template
- From the dropdown list of templates that will display in the dialog box, select the template that most closely matches your needs.

Clicking on the file will automatically open it and can then be saved with the name you wish.

- Setup the **Outline to create new file**

- **Setup the File and accounting properties**
- Save with File Name.
- **Create the Plan of Accounts structure**

Related documents
• Start a new **Income and expenses accounting and Cashbook** file
• Start a new **Double-entry accounting** file
• Start a new **Double-entry accounting with multicurrency** file
• **Utilities** documents

**Transferring to a new year**

When transferring to a new year, there is a specific procedure to follow, in order to **create a new year's file and automatically carry forward the opening balances**.

**New file settings**

When the program creates a file with new characteristics, you need to setup the **outline of the new file**.

**Convert to new file**

This command converts an existing file (which will not be modified) into another one with different characteristics:

- Change language
- Change the roundings
- Change the file type. For example:
  - Pass from an accounting without VAT to one with VAT
  - Pass from a Double-entry accounting to a Multi-currency accounting

It is as if you have created a **new blank file** and then have manually transferred the data.

The existing file characteristics can be consulted by executing the command **Tools -> File Info**

**Creation and data transfer**

The **Convert to new file** command, from the **Tools** menu:

1. Creates a new file of the specified type with the predefined columns setup
2. Transfers the data into the new file, proceding with the necessary conversions
3. Saves and indicates the name of the new file.

When converting a file with more options into one with fewer options, part of the data will be lost during conversion. If, for example, an accounting file with VAT/Sales tax is converted into an accounting file without VAT/Sales tax, all data in the VAT columns will be lost during conversion.

**Passing from a Double-entry accounting to a Multi-currency accounting file**

- Make sure that in the **File and accounting properties** the currency symbol is being specified (which will become the basic currency)
- Choose the Multi-currency accounting as destination
- The program creates a Multi-currency accounting, recovering the existing data:
  - The Transactions table includes the columns for managing the Multi-currency accounting,
as a currency the basic currency and the exchange rate 1.000
- The existing accounts in the Accounts table are being completed with the basic currency symbol
  - You have to add the predefined accounts for exchange rate profit & loss.
  - In the File and accounting properties, you have to indicate the predefined accounts for exchange rate profit & loss.
- The Exchange rate table will be empty; it is therefore necessary to add the currencies and exchange rates used in the transactions
- In the Accounts table, the accounts in foreign currency have to be added.

In order to change the currency of an accounting file, see the Accounting tab of the File and accounting properties.

**Passing from an accounting without VAT to one with VAT**

- Choose the desired type of accounting with VAT as the destination
- The program creates an accounting with the VAT columns, recovering the existing data:
  - Add the VAT accounts into the Chart of accounts
  - The File properties regarding the VAT need to be completed, and the default account on which the VAT must be recorded needs to be indicated
  - The VAT Codes table has to be completed with the necessary VAT Codes
  - With the Import to accounting command -> VAT codes, the VAT codes table of an existing accounting can be imported (for example it can be imported from a default VAT accounting template).

**Dialog**

- The file type, in which the user is working, is being indicated
- For more information on the language, roundings and decimals, go to the File and accounting properties (from the File menu)
- A list with different options appears

![Create new file (copy data)](image)

**Outline to create new file**
Transfer to a new accounting plan

Hereunder we explain how to proceed when:

- passing to a chart of accounts with a different numbering
- retrieve and convert the data of an existing accounting, including the transactions.

Converting for the new year

The program will convert the file for the choosen year. If you have already entered the year 2014 you can convert the 2014 file. If you wish to start a new year with a new chart of accounts, there are two possibilities (for example considering the year 2015 as the new year):

- converting the previous year (2014) and then creating the new year (2015)
  You will have two different files for the year 2014 (the one with the old chart of accounts, and the new one), and a single file for the year 2015, with the new chart of accounts. This procedure is useful when you need to have both years with the same chart of accounts
- creating the new year's file (2015), and then converting it the new system.
  In this case the year 2014 will remain unchanged. For the year 2015 you will have a transition file, with the old chart of accounts, but with the updated opening balances. The conversion of the 2015 file can be done right at the beginning, but also after some transactions have been entered.

Step 1: Creating a new accounting file

1. Create a new accounting file, choosing the desired type.
2. Adapt the chart of accounting to your own needs

Step 2: Adding the matching accounts

1. Position yourself in the Accounts table and add a new column called Account_1 (Data menu; click on the Add button of the Columns Setup window and then enter the Account_1
2. For each new account, in the Account_1 column, enter the corresponding account in the old chart of accounts; In case the account remains the same, you can also choose to not indicate it.
3. In case several accounts need to be grouped in one, enter the separated accounts with a semi-colon "1000;1001".
4. In case one account needs to be subdivided on several accounts, you need to proceed manually, see herunder.

<table>
<thead>
<tr>
<th>Section Group</th>
<th>Account</th>
<th>Description</th>
<th>BClass</th>
<th>Gr</th>
<th>Opening CHF</th>
<th>Source CHF</th>
</tr>
</thead>
<tbody>
<tr>
<td>5</td>
<td>1002</td>
<td>1000,1001 Cash on hand</td>
<td>1</td>
<td>100</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>1020</td>
<td>1010 Bank account</td>
<td>1</td>
<td>100</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>100</td>
<td>Cash and cash equivalents</td>
<td>10</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>1068</td>
<td>1080 Bonds and stocks</td>
<td>1</td>
<td>106</td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>106</td>
<td>Short-term Assets listed in Stock Ex</td>
<td>10</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>1082</td>
<td>1085 Internal transfers</td>
<td>1</td>
<td>109</td>
<td></td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>1094</td>
<td>1090 Transfer account for salaries</td>
<td>1</td>
<td>109</td>
<td></td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>1095</td>
<td>Accounts to be clarified</td>
<td>1</td>
<td>109</td>
<td></td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>109</td>
<td>Transfer accounts</td>
<td>10</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Step 3: Starting the import operation

For more information, please check the related pages Import to Accounting and Import File.

- From the Account1 menu, choose the Import to accounting and then Import File commands
- Using the Browse button, select the file of your old accounting plan
• Confirm by clicking on the **OK** button and pass on to the next window
• Define the import options
• Activate the Activate account numbers option, indicating that the account matches are in the destination file.
Subdivision of one account into several accounts

When one transfers to a more detailed chart of accounts, it is probably necessary to subdivide one account into several accounts.

After the import operation, proceed manually in the following way:

- In the Chart of accounts, subdivide the opening amounts, budget amounts and previous amounts of one account into several accounts;
- Go over the transactions, one by one, of the account that needs to be subdivided and assign them to the more specific account, or create extra transactions if it is necessary to subdivide one amount into more detailed amounts;
- Proceed in the same way for the transactions of the Budget table.

Results and possible errors

In case the program reports mistakes (absence of accounts or others), the import operation probably needs to be cancelled and the matches need to be completed; then repeat the import operation.

The program, confronted with different charts of accounts, cannot automatically do extensive verifications and guarantee that all the data have been imported and grouped correctly.

It is therefore strongly advised to manually check the result, making sure that the totals of the Balance Sheet and the Profit & Loss Statement are correct.

Outline to create new file

Language
The language used for the columns headers of the various tables.

Decimal points for amounts
In order to avoid accounting differences, the number of decimal points for the amounts is fixed for each file. Two decimal points are normally used, but there are currencies where decimal points are not required so 0 needs to be inserted.

Decimal points for amounts in foreign currency
If using multi-currency accounting, then it is necessary to define the number of decimal points for the amounts in the foreign currency as well.

**Rounding type**
The amounts are rounded up or down to the closest whole number. In the case of exactly half (for example: 100.5 / 101.5 / 102.5 / 103.5) the following systems are being used:

- **Banking (Half at even)** is being rounded up or down towards the nearest even number (100 / 102 / 104).
- **Commercial/Arithmetic (Half up)** is being rounded up to the next whole number (101 / 102 / 103 / 104). In accounting, this is the system most used.
- **Compatible version 4**. A minor precision is being used, which in very special cases, can bring forth a different rounding.

**Address fields in accounts table**
When this option is activated, the Address view is created in the Accounts table. In this view, the user can enter the addresses of clients, suppliers and members.

**Budget Table**
When this option is activated a Budget Table is created, where the user can enter his budget transactions.

The user can thus create different accounting files, in different languages, and with different decimal points. In order to change the language or the decimal points once the accounting file has been created, the accounting type must be converted by selecting Convert to new file from the Tools menu.

**Open, save, copy and backup**

**Opening a file**

- Accounting files can be opened in Banana Accounting if they are on the local computer or if they are accessible through a network.
- If they have been sent by email, before opening them you need to move them in a computer folder.
- Only one user at a time can edit a file.
- If you edit a protected file or a file already in use by other users, you need to save the file with another name in order to save your changes.
- The Banana Accounting program, notifies that you have opened a read-only file in the following cases:
  - the file is located on a non-writable disk (CD-ROM)
  - the file is located on a temporary non-writable folder
  - the file is protected or the user doesn't not have rights to edit it
  - the file has already been opened by another user
  - the file has already been opened from the same user but in another session

**How to look for *.ac2 files**

If you don't remember in which directory your accounting files are located, you can use the search Windows Explorer box or the Mac finder search tool.
Find your accounting file on a Windows computer

Banana Accounting files have an .ac2 or .sba extention. The Windows search tool will vary depending on your Windows version.

- Windows 10: click on the search icon on the Applications bar and enter "ac2" or "sba" or your file name and click on the Documents arrow.
- From the Explorer File Manager enter the "*.ac2" extension, the "*.sba" extension or your file name and let Windows look for it.
- When in Banana you get to the Open file dialog window (File menu -> Open), enter the "*.ac2" or "*.sba" extension in the top right search box and then click on the look in the whole PC icon, or select the directory where you want Windows to look for your file.

Find your accounting file on a Mac computer

- When in Banana you get to the Open file dialog window (File menu -> Open), enter "ac2" or "sba" or a word that is part of the file name in the top right search box. With the icons, select where you want to look for your file (in the entire computer or in selected folders).
- Open the Finder and enter "ac2" or "sba" or a word belonging to the file name in the search box.
- Right click on the Finder icon, then click on Search, and then enter "ac2" or "sba" or a word belonging to the file name.

Saving a file

With the Save or Save as... command, the data are saved onto the hard disk. Pre-existing disk data are replaced with the new ones.

- A single file can be saved by one user at a time
  The file can be saved by the user only if it is not also being used by other users
- Files can be saved anywhere.
  You can enter the file name and destination when saving it for the first time or when using the Save as command from the File menu
  As a first option, Banana Accounting suggest the Documents folder as destination folder for the .ac2 files, but it can be changed with the Browse button.
- If you are managing different accounting files, we suggest you to create a separate folder for each company and for each accounting year.
- Each file can be password protected.

Accounting files (*.ac2)

- Files created with Banana Accounting have an .ac2 extension, regardless the operating system used.
  The .ac2 file format is specific for Banana. When saving, all data are compacted and saved in bulk.
- Ac2 files are compatible between different operating systems (Windows, Mac and Linux)
  You can save a file with Windows, then open it and edit it on a Mac, and then reopen in on a Linux or Windows computer.
- Each file can be sent as an email attachment, edited on different operating system and resent to the sender.
- Accounting files are completely separated from the software Banana itself, that has an .exe
extension for Windows,
- The installation files for Mac have a .dmg extension and a .deb, .rmp .run or .tgz extension for Linux.

**Automatic saving**

Banana Accounting automatically creates and saves your work in a temporary file that ends with ".autosave". When you press the **Save** button or you exit the program, this temporary file is deleted. In case your computer should crash or turn off in the middle of your work, it would be possible to recover your data by opening this file.

In order to have the program automatically create this temporary autosave file, the corresponding option should be active (it usually is by default) in the **Program Options** (you can access them from the **Tools** menu).

When the program is reopened after a crash and finds that the AutoSave file (temporary) was not deleted, a message appears, asking whether you want to retrieve the file. If the user confirms the recovery, the original file is renamed in the following format: `<file_name.ac2>_.date + time..bak`.

**How to copy or move your accounting files**

Banana can save your files on any unit seen by the operating system or on a rewritable disc. From non-rewritable discs (CDs or DVDs) Banana can open the files on a "read only" mode.

All .ac2 files can be moved in different ways:

**from one directory to another:**

- using Windows Explorer or Mac Finder to locate the directory where your files have been saved
- copying and pasting them in the new destination directory (once you pasted them you can delete from the original directory)

**from one computer to another:**

- saving the files on a memory stick and then saving them on the new computer:
  - open the file to be moved
  - from the **File** menu choose the **Save as** command, choosing the memory stick as destination unit
  - this copy can also be made from Explorer by dragging the accounting file into the memory stick unit
- by sending them as email attachments and then saving them on the new computer

**DropBox, Google Drive and other synchronization systems**

Banana is compatible with systems such as DropBox and Google that keep files synchronized with cloud storage services.
Banana overwrites `.ac2` files and deletes the `.ac2.bak` files. In the deleted files list you will find all `.ac2.bak` files previous versions.

**Viewing changes**
Banana Android works directly with Dropbox servers. If you make changes on your PC, usually you have to wait a few seconds before you see the changes on the server, so also on Banana.

To ensure that the file is properly synchronized with the server, the file on your PC must be marked with the green check mark.

If you do not see the sync symbols (green, red, blue), you have to update the Dropbox application installed on your PC.

Another way to check the synchronization status from your PC, is to click on the Dropbox icon in the bottom bar:

In addition, Android synchronization does not occur while you are working with the app. You must close and reopen it.

**Attention:** Banana cannot realize if some files are opened simultaneously on more than one computer. It could thus happen that someone erases some data or that someone else adds some new data. Only the more recent copy of the saved file is kept. For this reason we strongly advise to avoid working at the same time on the same file.

**Security copies (backup)**

We strongly advise you to create external backup copies of your accounting files, in order to prevent a possible data loss, due for example to a computer crash or other causes.

- if you have a Mac computer you can use "Time Machine"
- if you have a Windows computer you can use the "File history" function

You can find other programs on the market that allow you to automatically create a backup of your data.

**Saving and .bak files**

When saving, Banana Accounting replaces the contents of the existing file, with the more recent data, only if the saving process is successfull:

- Data are saved on a temporary file
  Only if the saving process is successfull the data on your disk are replaced to the existing ones.
If the **Create backup copy (.bak)** option is activated (Tools menu -> Program options command -> Advanced tab) the program renames the pre-existing file with the same name, adding the .bak extension. A new file named “filename.ac2.bak” is created, containing the data before the saving process.

If an error occurs during the saving process, if for example the network disk is no longer available, choose another file name for saving your data.

**Recover your data from a .bak file**

When for a number of reasons you cannot find your accounting file, you can recover your data from the backup copy automatically created by the program. Here is how to proceed:

- open the directory where your accounting file was located
- open the file with a .bak extension. If it is not shown in the dialog window, you need to select the "show all files (*.*)" option at the bottom right of the window
- once the file is opened, save it with a name. Usually the same name as the lost file is chosen.

**Damaged .ac2 files**

Sometimes a computer crashes due to technical problems or viruses. Sometimes data received by email are compromised or damaged. For these reasons we strongly suggest you to make copies of your files.

If, for technical reasons you have a damaged file, our support team can verify, for a fee, if there are data that can be recovered.
Recover autosave file

This dialog appears when the program closes unexpectedly, and it was not possible to save changes made to the file. When the program is reopened, it detects that the autosave file (temporary file) has not been canceled, and then asks if you want to retrieve the file.

You can choose from the following options:

- **Recover**
  - The autosave file is copied replacing the original file
  - The original file is renamed as indicated in the dialog window
- **Don’t recover**
  - Both the original file and the autosave file are kept
  - The program will not warn you anymore that the autosave file was kept
- **Cancel**
  - Both the original file and the autosave file are kept
  - Next time you open this file, the program will warn you that an autosave file with unsaved changes was found

The autosave files that were not recovered will be kept, and will have to be deleted manually.

If the program stops working

If the program is closed normally, it asks whether to save the modified data, and the autosave file is deleted.

However that program may be unexpectedly closed for a number of reasons:

- A power outage or another event that caused an immediate arrest of the operating system
- A problem that led to the crash of the program
  - Due to another program or to a situation of the operating system or driver that caused the program to stop.
    - Try to restart your computer and use the program without other programs.
      - A flaw in the operating system or a faulty program can cause an interruption of Banana.
      - Problem with some Dell computers.
      - A computer fault (memory error)
      - A virus or some other problem
- A problem in the Banana Accounting software
  Usually when, repeating the same command always causes the program to crash. If the program stops in completely different situations, it is more likely that the problem is due to a computer or operating system problem (see above)
  - First of all make sure that you have the latest version of the program
  Install the updates if necessary. The problem could have been solved in the meantime

**Contact technical support**

Verify the situation in which the program stops.

- It is important to understand in what situations the program stops, so that technicians can replicate the problem.
- When you contact the technical service:
  - Describe the problem and how it can be reproduced - describe the error.
  - Enter your system details (you can copy them under Tools -> Program Options -> Info System.
  - If the problem occurs in relation to a file, send a copy of the file (removing confidential data).

**File properties**

When a new file is created, the basic data need to be entered in the File menu, using the **File and accounting properties** command.

The file properties can vary depending on the chosen accounting type.

![File and accounting properties](image)

For the explanations of the different tabs please visit the pages hereunder.

**Accounting Tab**
Left and right headers

These are the two empty cells at the top where any desired text can be inserted which will be used as a header for print-outs (left and right).

Opening date

The opening date is the date when the accounting begins. It can also be left blank. If a date prior to the opening date is inserted when entries are made, the program will give an error message.

Closing date

This is the closing date of the accounting. It can also be left blank. If a date greater than the closing date is inserted when entries are made, the program will give an error message.

Basic currency

The code of the currency in which the accounting is being handled. You can enter any currency code, even the one that are not in the list. When the code of the basic currency is being changed, the program changes the column headers for the amounts in basic currency using the new code.

In the multicurrency accounting files it is mandatory to select the basic currency, which will work as the functional currency, the one used for the calculation of the Balance sheet and Profit & Loss statement.

Changing the basic currency symbol

If you change the basic currency symbol the program will not change the existing amounts. We advise you to change your basic currency symbol only if you don't have yet entered any opening balances and any transactions.

Accounting file WITHOUT foreign currencies

You can replace the basic currency symbol with the new symbol.

Accounting file WITH foreign currencies
• Replace the currency symbol in the **File properties** dialog (from the **File** menu)
• in the **Accounts** table
  ◦ Select the whole **Currency** column (click on the column's header)
  ◦ Use the **Find and replace** command from the **Data** menu and enter the old and the new currency symbol - make sure to check the **Selected area only** option. Replace all the symbols found.
• in the **Exchange rates** table
  Enter the new exchange rates for all the currencies.
• Give the **Check accounting** command from the **Account1** menu.
• If there are opening balances or transactions, the amounts and the exchange rates will have to be manually updated.

**Options Tab**

![Options Tab screenshot](image)

**Transaction date required**
If this option is activated and then a transaction is entered without a date, there will be an error message.

**Recalculate totals manually (F9)**
If this option is activated, the program will not automatically recalculate the principal groups of the accounting file, but the user needs to use the F9 key.

**File from previous year**
By using the **Browse** button, the user can select a file from the previous year.

**Smart fill with transactions from previous year**
If this cell is checked, the program keeps the transactions from the previous year in memory, and offers them as Smart Fill while the user inputs new entries.

**Use the minus sign (-) as segments separator**
When this option is activated, the segments have to be entered in the Transactions table with the minus (-) sign preceding the segment code. When this option is deactivated, the segments need to be entered with the colon sign (:), as in the chart of accounts. The colon needs to always preced the segment code.
**Records (+/-) cost centers according to the category**
This function is active only for Simple accounting and Cash book. By activating this box, the amount is entered in the cost center (positive or negative) according to the category.

If, instead, this option is not active, in order to enter a negative value, it is necessary to enter a minus sign before the cost center (-CC).

Related document: [Text input, edit and Smart fill](#)

**Address Tab**

In this tab data about the company or the individual whose accounting is being handled can be entered.

![Address Tab Image](#)

**Foreign currency**

![Foreign currency Image](#)

For the explanations of the different tabs please visit the corresponding page [Starting a multi-currency accounting](#).
**VAT/Sales tax**

For the explanations of the different tabs please visit the corresponding page **File properties (VAT/Sales tax tab)**.

**Other Tab**

**Current language**
There are some file texts that the program generates automatically, (e.g. the lines of the Totals table, the transactions on the account card, and the printout of the Enhanced balance sheet); in this tab, the user can indicate the language for these texts (usually the same as the creation language).

**Creation language**
This is the language chosen and selected when the user creates an accounting file; this language is
used for the column headers. If the user wants to change the creation language, then it is necessary to convert the file to a new one using the **Convert to new file** command in the **Tools** menu.

**Apps properties**
List of the activated properties in the **Manage Apps** dialog. In order to remove an App, delete the corresponding property.

---

**Password Tab**

The files can be protected by using a password.

**Password compatibility with old versions**

Activate this option if you want your password to be compatible with the Banana Accounting 8 versions and earlier.

This option not recommended because the password is saved in a less secure mode.

**Entering a password in a file that doesn't have a password**

- The box **Confirm old password** is shown in gray.
- Indicate your new password twice (**New password** and **Confirm new password**).
- Confirm with **OK**.

**Changing an existing password**

- Enter the existing password.
- Indicate your new password twice.
- Confirm with **OK**.

**How to cancel a password**
- Enter the existing password.
- Leave the boxes for the new password empty.
- Confirm with OK.

**Forgotten password**

For information about a forgotten password, please refer to the Questions and Answers page, [Password unlock](#) paragraph.

**Note**

Using a password does not give a high level of protection. In order to render the data truly inaccessible to third parties, it is necessary to have the appropriate cryptographic software.

**Text Tab**

In this tab it is possible to enter different keys in order to save extra information, such as the accountant name, for example.

**Key**

In this field, input the reference text (e.g.: Address).

**Value**

In this field, it is necessary to input the value related to the key (e.g.: Ocean Avenue, ...).

**Add**

This button saves the new entered data.

**Remove**

This button removes the selected Key.
Create Pdf dossier

In order to create a Pdf file choose the **Create Pdf dossier** from the **File** menu (or click on the corresponding icon on the Toolbar).

**File Name**
In this area you need to enter the name of the new file that the program will create to export the data. If, however, an existing file is selected by using the Browse button, the program will overwrite it with the new data.

**Display file immediately**
As soon as the Pdf file has been created, the software to view it will be launched. In this way, the result of the export can be seen immediately. It is best to remember that browsers like Mozilla and MS Explorer use a cache mechanism for files. When the export is made for a second time, it is possible that the user will see the previous version until the browser Reload button is pressed.

**Table creation options**

**Headers 1, 2 and 3**
These are the table headers.

**Page options**
By activating the page options it is possible to include:

- page numbers
- page progressive numbering
- date

**Page size**
You can select the page format

**Other Tabs**
For the explanations of the other tabs, please visit the following pages:

- **Include**
- **Period**
- **VAT**
- **Composition**

### Recent / Favorite files

These commands display the list of recently used files and the favorite files.

In order to eliminate the list of recently used files, click on the **File** menu, **Recent files**, and on **Clear list recent files**.

In order to remove just one single file from the **Recent Files** list of the **Favorites** (Start page), position the cursor on the file name, proceed with a right mouse click and select **Remove** (Mac users should use the key combination **Ctrl + right mouse button**).

To make a file Favorite:

- Open the desired file
- Click on **Favorite files**
- Click on **Add to list**

To edit the list of favorites, click on:

- **Favorite files**
- **Edit list..**
  - In the window that appears, edit the favorites, by using the buttons: **Add, Remove, Open folder**.

### Associate .ac2 files with the most recent Banana version

When the Banana Accounting program is being installed, the "Associate Banana Accounting 9 with the AC2 file extension" option is activated by default; as a result all the accounting files will be opened with the new version.

If, when clicking directly on the file before opening the program, it should occur that the file gets opened with a previous version of Banana Accounting, this problem can be solved in the following way:

**Windows:**

- right-click on the file icon
- on the menu that appears select "**Open with**" and then "**Choose Default Program...**"
- choose the Banana program, the latest installed version.

**Mac:**

- right-click (or "**ctrl */+ click") on the file icon
• on the menu that appears select "Get Info"
• under "Open with..." choose the latest installed version of Banana, click then on "Change All..." option.

Just run this operation once and on a single file; from then on all files will always be opened with the latest version.

**Setup a Logo**

From the Banana [version 9.0.3](#) it is possible to include a logo and to define its settings (width, height, position) from the File menu > Logo setup command. It is also possible to create and save Compositions with different logo settings. This feature is a simplified alternative to the logo setting with the Documents Table.

In the Logo Formats dialog window -> Options tab, it is possible to include an image with the Add button; you can also define the width, height and alignment of the logo image. If the logo has already been inserted, it my be modified or deleted via the Modify/Delete button.

![Logo Formats dialog window](image)

**Note:**

Thanks to this feature, the logo can now be recalled and applied for all printouts, as follows:

• from the File -> Page setup command
• or directly from the Print preview, by clicking on the Settings icon.

If, however, you only wish to use the logo in a specific printout, you need to directly enter it in the setup of that printout, for example the Account cards, the Enhanced Balance sheet, the Enhanced Balance sheet with groups and the Accounting report.
If this box is ticked, headings of the dialog windows for "Account Cards", "Enhanced Balance Sheet", "Enhanced Balance Sheet with Groups" and "Accounting Report" will be added, relative to the logo (i.e. Below, Center, Top).

**Edit Menu**

**Adding and deleting rows**

To insert blank rows below the selected row, follow these steps:

- Move the cursor above the row where additional rows need to be inserted
- From the **Edit** menu, select the **Add rows** command
- In the window that appears, key in the number of rows to insert
- Confirm by clicking on **OK**

There is still another procedure to add blank rows:

- Move the cursor above the row where additional rows need to be inserted
- Click on the following icon on the Tool bar, one time for each row that you want to add. This procedure is advised when the amount of rows to be added is rather limited. The sequence for the shortcut key is: Ctrl+Enter.

To insert blank rows above the selected row, follow these steps:

- Move the cursor below the row where additional rows need to be inserted
- From the **Edit** menu, select the **Insert rows** command
- In the window that appears, key in the number of rows to insert
- Confirm by clicking on **OK**.

In order to delete one or more rows, select the row or rows that need to be deleted and from the **Edit** menu, click on the **Delete rows** command.

**Protecting the rows**

Using the Protect rows command, from the Edit menu, the user activates row protection to avoid making any changes by mistake.

The protected rows cannot be edited until, by using the Unprotect rows command, the protection is being removed.

To put protection into effect:
- Select the desired row(s) to protect
- From the Edit menu, select the **Protect rows** command
- Confirm the number of rows to be protected by clicking on **OK**.

Protected rows have light grey row numbers. In order to edit them again, first remove the protection by the **Unprotect rows** command in the Edit menu.

**Data Menu**

- **Find and Replace**
- **Find**
- **Rename**
- **Go to**
- **Extract and sort rows (Extract)**
- **Extract and sort rows (Sort)**
- **Sort rows**
- **Tables setup**

**Find and Replace**

The text to be searched and the text to be used as a replacement should be inserted in the same format as the one displayed in the input field. For example, the amounts should be inserted without the separator for the thousands.

**Search text**
Enter the text to be searched.

**Replace with**
Enter the replacement text.

**Options**

**Whole words only**
If this box is activated, the program will find whole words only. For example, if the word being searched is Tot, it will not find Totals.

**Match case**
If this box is activated, the program will make a distinction between capital letters and small letters.

**Selected area only**
If this box is activated, the program will only search the information in the selected area.

**Replace all**
This key will replace the desired data throughout the whole document at once. When you need to change data that are being repeated in the **Accounts**, **Categories**, **Transactions** and **VAT codes** tables (for example, an account number or a VAT code), you can also use the **Rename** function.

**Replace**
This key will replace one data at a time.

**Find all**
Looks for all the information, according to the entered keyword, and displays it in the Information window in the lower part of the screen.

**Find next**
Looks for the following information item.

**Find**

![Find dialog box](image)

**Search text**
Enter the text to be searched. Amounts must be entered without separators.

**Options**

**Whole words only**
If this box is activated, the program will find whole words only. For example, if the word being searched is Tot, it will not find Totals.

**Match case**
If this box is activated, the program will make a distinction between capital letters and small letters.

**Selected area only**
If this box is activated, the program will only search the information in the selected area.
In order to begin the search, click on the **Find** button. The first piece of information corresponding to the request will be selected. To continue the search and find the next piece of information, select the **Search next** command from the **Data** menu, or else use the **F3** key.

**Rename**

This command allows the user to change the account or category number (accounts or categories table) and the VAT code (VAT Codes table), without having to enter the necessary modifications in the transactions.

In order to rename, you need to:

- position yourself with the mouse on the cell that has to be changed (account/category number, VAT code);
- click on the **Rename** command from the **Data** menu;
- enter the new name in the appearing window.

Then, the software operates as follows (for example if you rename an account):

- verifies that there is no other account or group with the same number; if there is it the software will alert and ask if you want to proceed anyway. Please note that it is not possible to have to identical account numbers in the accounting plan;
- verifies where the account to be renamed has been used and makes sure that the rows are not protected or blocked; if they are it will alert that the rename operation cannot be carried forward;
- substitutes the account number wherever it has been used, in the tables and in the File properties, with the new account number.

The software does not recalculate any total, simply renames the account number.

**Go to**
Select the **Go to...** command from the **Data** menu to open a window allowing the user to move to a desired row. When a selection table is active (for example, an account card), by using the **Go to original row** command, the program automatically takes the user to the corresponding row of the Transactions table.

### Extract and sort rows (Extract)

![Extract and sort rows](image)

The **Extract and sort rows** command is available from the **Data** menu. This command is different from the **Sort rows** command, since it creates a new table where the result of the extraction or the sort is shown. The rows of the original table will not be changed.

**Extract**

In the Extract table you can click on the row number (underlined) to return to the row of the original table.

**Column**

You need to select the column you wish to extract the data from.

**Condition**

You need to select the condition for the extraction (ex. Greater, less, contains text, starts with, ends with, ...)

**Value**

In this field you must enter the text you want to use as comparison in relation to the condition (for example, if the condition is = Equal, entering 25.01.2015 as value, the program will extract all transactions with date January 25, 2015). The value is a date if the selected column was Date, a numeric value if the selected field was Amount, a text if the selected columns was Description.

**Add**

This button allows you to add new fields for the extraction.
Clear all
This button allows you to clear all the settings you have entered for the extraction.

Sort selected rows only
This option is only available when rows have been pre-selected. If activated, only the selected rows will be sorted.

Total row
If this option is activated, the program will show the total row for the extracted rows with an amount.

Sort
The sorting columns are being indicated. The options are the same as for the Sort rows command.

Composition
The explanations of this window are available on the following web page: Composition.

Example accounts list
It happens sometimes that you want to have a list with only the accounts.

- Put yourself in the Accounts table.
- Impart the "Extract and Sort" command
- In column, choose "Account"
- Under condition, indicate "Not empty"

In case you wish to have accounts sorted by description

- Put yourself on the "Sort" section
- In the "Sort by" box, indicate the "Description" column

If you want to display only certain columns, you can create a new view with the Tables setup command.

Extract and sort rows (Sort)
The **Extract and sort rows** command is available from the **Data** menu. This command is different from the **Sort rows** command, since it creates a new table where the result of the extraction or the sort is shown. The rows of the original table will not be changed.

**Sort by**
You can choose the desired sorting criteria.

**Then by**
The program allows you to choose two other sorting criteria other than the main one.

**Ascending**
The rows sorting is done in an ascending order, taking into consideration the selected sorting criteria (date, doc, ...)

**Descending**
The rows sorting is done in a descending order, taking into consideration the selected sorting criteria (date, doc, ...)

**Number**
If the column chosen as sorting criteria only contains numbers, you need to check this option.

**Clear all**
This button allows you to clear all the settings you have entered for the extraction.

**Sort rows**
The **Sort rows** command is available from the **Data** menu. Please take note of the fact that the **Sort rows** command is different from the **Extract and sort rows...** command, since it changes the order of the rows in the table you are currently working on, according to the sort keys you entered. We advise you to be very careful before pressing the **OK** button, especially if you are working in the **Accounts Table**, because you might completely change your accounting plan structure.

The rows on the table can be sorted according to the content of the columns. It is possible to enter up to three sorting keys:

**Sort by**  
From the dropdown list choose the desired sorting key

**Then by**  
You can here choose an additional sorting key other than the first one

**Ascending**  
The rows sorting will be in an ascending order, according to the selected sorting key (date, doc, ...)

**Descending**  
The rows sorting will be in a descending order, according to the selected sorting key (date, doc, ...)

**Number**  
You need to activate this option if the sorting key you chose only contains numbers

**Clear all**  
This button allows you to clear all settings previously chosen as sorting criteria

**Selected rows only**  
This option is only available when rows have been pre-selected. If activated, only the selected rows will be sorted.

**Tables setup**

This command allows you to manage
• **The Tables:**
  These are the elements that contain the data in a format or rows and columns.

• **The Views:**
  Indicated under every table.
  These are the elements that define the way in which the columns of the table are displayed. Thanks to the views, one can define which columns need to be visible, the sequence of the displayed columns and the way in which they are displayed.

![View's Settings](image)

**View's Settings**

In order to add tables, please go to the [Add new functionalities](#) command.

For each table, you can define:

- **Name**
  The name of the table in the file language. This field cannot contain spaces or special characters.
  It can only be changed for added tables.
- **Xml name**
  The name this is being used for the programming. This field cannot contain spaces or special characters.
  It can only be changed for added tables.
- **Header**
  The name that appears in the tables list
- **Visible**
  Indicates whether the table is visible or not.

### Manage Views

**Name**
It is possible to enter a new name for the selected View.

**Xml name**
This is the View name for the Xml export. For system Views this name cannot be changed.

**Number**
This is a number automatically given to the View by the program.

**Visible**
When selecting this checkbox the View will be visible.

**System**
If this checkbox is selected the View is a system View and cannot be deleted or edited.

**Columns setup...**
Displays the [Columns setup page](Columns_setup_page) that allows to edit them, both in displaying them as well as in setting them up.

**Page setup...**
This button leads to the [page format settings](page_format_settings).

**Add...**
This button adds a new View to the active table.

**Delete...**
This button deletes a View.

**Set as default**
Defines the View that is being used.

**Columns setup**

The command [Columns setup](Columns_setup) command can be found in the [Data](Data) menu. With this command, columns can be displayed, hidden, renamed or moved left or right in the various tables.

**Display Tab**
Header
This is the column header.

Header 2
This header is used by the program for only a few fields (e.g. Amount column).

Description
This is the description of the field. This description will be shown as a tooltip.

Format
This is the format to show numbers, date and time (see chapter at the end of this page).

Width
This section defines the horizontal size of the column.

Column Style
This is a drop-down menu that indicates the style to be used (Format, menu, see sub chapters). This style has priority over the style of the row.

Alignment
The user can choose whether to align the text right, left or center in this drop-down menu.

Wrap text
This option allows the user to view the input text on more than one line.

Protected
This option allows the user to protect the entire column so that no data can be input or edited.

Exclude from printing
When this option is activated, the field will be excluded from printing.

Visible
This option allows the user to make column visible.

The tables can be altered. Fields can be added, headers can be changed, and column sizes and the order in which they are shown can be altered.
Move up, Move down
The fields are listed in the order in which they appear on the table being used. The visible fields are the ones with a checkmark.
In order to alter the order in which they appear simply select the field you wish to move and drag it up or down.

Add
This button adds new fields (columns) to the current table. Field added by the user are just information fields; the program does not make any calculation on numeric data.

Delete
This function is used to delete a field (column) from the list. A system field, however, cannot be deleted.

Settings Tab

Field name
This is the name of the active field and it is automatically inserted by the program. It cannot be modified.

Field name Xml
This is the name of the active field in the Xml format and it is automatically inserted by the program. It cannot be modified.

Data type
It is possible to choose between the following predefined types: Text, Number, Amount, Date, Time.

Max and Min length
Maximum and minimum field length.

Max and Min Value
It is possible to enter minimum and maximum values (numbers or characters).

Decimal points
It is possible to define the field decimal points
Field number
This is a number automatically given to the field, and has uniquely a technical purpose.

All caps
By clicking this options all fields data will be shown in caps characters.

**Date, hour and number format**

When the format is modified, the way the date, time and numbers are shown, changes.

If no specific format is specified, the default format of your operating system will be used (date, time and numbers as indicated on the control panel).

In the **Format** area of the **Set up fields/Edit attributes** command (**Data** menu) the user can use other formats. Types of formats, with some examples, are listed below:

### Date format

<table>
<thead>
<tr>
<th>Example for date</th>
<th>1 01 15</th>
</tr>
</thead>
<tbody>
<tr>
<td>d mm yy</td>
<td>01 1 15</td>
</tr>
<tr>
<td>ddd mmm yyyy</td>
<td>Fri Jan 2015</td>
</tr>
<tr>
<td>dddd mmmm yyyyy</td>
<td>Friday January 2015</td>
</tr>
</tbody>
</table>

The letter “d” (day) indicates the day, the “m” (month) indicates the month, and the “y” (year) indicates the year.

### Time format

<table>
<thead>
<tr>
<th>Example for time</th>
<th>04:04:36:089</th>
</tr>
</thead>
<tbody>
<tr>
<td>hh:mm:ss:zzz</td>
<td>4:4:36:89</td>
</tr>
</tbody>
</table>

Naturally the user can also invert the order of the elements making up the date or the time as desired (e.g.: mm dd yyyy).

As far as the separators are concerned, the user can choose between all of those available on the keyboard (for example: #, @, -, /, ., etc.).

### Numbers Format

<table>
<thead>
<tr>
<th>Example for numbers</th>
<th>259</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.</td>
<td>258.85</td>
</tr>
<tr>
<td>0.00</td>
<td>258.848</td>
</tr>
</tbody>
</table>

The number of decimal spaces in a number field can be edited according to the user’s needs. Actual calculations are made using all the inserted decimal numbers. Rounding is only done for what is shown on screen.
**Field name**
Enter the field name of the column to add.

**Field name Xml**
The name of the column to export in Xml and in scripts.

**Data type**
It is possible to choose between the following predefined types: Text, Number, Amount, Date, Time.

**New view**

**View name**
Enter the name of the view you want to add.

**View name Xml**
This is the view name for the Xml export.

After its creation, the new view is displayed in the same place as the existing views and will be added at the right side of the others.

**Format Menu**
In the **Format** menu the following commands are present:

**Default style**

This is the default style for the whole file.

**Points**

Use different points to define the font size.

**Bold and Italic**

**Modify default style**

In order to change the default style:

- attribute the desired style to a row;
- select the **Modify default style** command from the **Format** menu

All the rows with the original default style will then be shown in the new default style.

**Calculate row height**

When the text for a row is very long, the **Calculate row height** command from the **Format** menu allows the user to view it completely, adapting the height of the row. Activate this function on condition that, in the field attributes (Data menu, Set up fields command – Edit attributes button), the **Wrap text** option has been selected.

**Calculate all row heights**

This command operates in the same way as the previous command except that it works on all the rows in a table instead of only one.

**Page break**

At any point in a file, the user can insert a page break

To insert a page break:

- place the cursor on the first row where the new page is to be created;
- open the **Format** menu;
- select the **Page break** command

To remove a page break:

- place the cursor on the row with the page break;
- open the **Format** menu;
- select the **Page break** command again

**Highlight rows with colors**
In order to highlight the rows:

- Select the rows to be highlighted and on the icon  
  , click on the first symbol if you want to color the background, and on the second one if you want to color the text.

- In order to deactivate the color, select the row(s) and click on No color (present in the menu of each color).

**Tools Menu**

**Add new functionalities**

The Add new functionalities command is in the Tools menu. Edit the VAT Amount type column in the transactions

For accounting files with VAT management.

This function allows you to edit the Amount type (VAT amount type) in the Transactions table.

This column allows you to enter, for each transactions, when it is necessary, one of the following VAT amount types:

0 (or empty cell) - it means VAT included (with VAT/taxes)
1 = VAT excluded - it means VAT excluded (without VAT/taxes)
2 = Tax amount - the transaction amount is considered 100% VAT/taxes amount
For each transaction, the programs automatically fills in the data as setup in the VAT Codes table (for each code). If however, exceptionally, this needs to be changed, you can manually enter 1 or 2 in the Amount type column.

**File info**

The File info command, from the Tools menu, displays the characteristics of a file.

**Columns**

By activating the Complete view also the Xml columns are displayed, through which it is possible to transfer the values automatically when exporting the table.

- Section: the Group name of the values
- ID: the specific and explicit identification of the value
- Description: contains an explanation of the value
- The rows in bold print are the section titles that group the different elements together
- Value: the formatted value
- Section XML: The name of the section in English
- ID XML: the identification in English
• Value Xml: the field contents in Xml format.

The Section XML and the ID Xml identify the value unambiguously.

**Program options**

In the Program options window, several technical options are possible for the accounting file.

In the following pages you will find more detailed information.

**Interface**

![Program options window with interfaces and options](image)

**Program**

**Language**
The Program Language is the language used by the program. Use this drop-down menu to select a language if the user wants to use a language different from the default or if the default is not available.

**Font type**
This drop-down menu allows the user to select the desired font.

**%Zoom**
If the user wants the data on the table to be shown in another size, adjust the percentage of Zoom here.

**Show negative numbers in red**
The negative numbers and amounts will be shown in red in the tables.

**Startup**

**Check for updates**
This option establishes a connection to the Banana.ch SA website and checks if there is an update compared to the version that is used.

**Display start page**
The news start page is shown.

**Show recently used files**
In the File menu, all the most recently used files are listed.

**Start Web server**
Makes it possible to access Banana Accounting data through external programs.

**Editor**

![Program options](image)

**Behavior**
**Edit table with single click**
By activating this option, a single click on the selected cell is sufficient to enter in the modification mode. If the function is not activated, you have to double-click on the cell in order to enter in the modification mode.

**Autocomplete text (Smart fill)**
By activating this option, the program automatically selects the first draft text in the drop down list and automatically fills it in the row where you are.

**Add up during selection**
By activating this option, the program will add up the selected amounts. Deactivate this function if this instantaneous addition slows certain operations down. One can select non-adjacent amounts by holding down the Ctrl key while selecting individual cells with the left mouse button.

**On Enter go to the next row**
By activating this option, the cursor will place itself on the next row when pressing the Enter key.

**Input**

**Maximum number of undo operations**
Insert the maximum number of undo operations (one at a time) when using the **Undo** command from the **Edit** menu.

**Smart fill rows limit**
When inserting data, the program reads the data that has already been entered and tries to suggest how to complete an entry. In cases where there are many rows, this function could slow down the process.
The user can define a limit for the number of rows, above which the smart fill will not be used. If there is no value entered or zero, smart fill will always be used.

**Advanced**
**Backup**

**Autosave (in minutes)**
This option allows saving the file automatically according to the desired frequency (in minutes). The program saves the data in a file called auto backup + file name. If the program or the computer crashes, the data can be recuperated by opening this file and saving it with a name (**Save as...**) from the **File** menu.

**Create backup copy (.bak)**
When the user saves to disk using the same name, the version of the file that already existed is renamed with a .BAK extension.

**Files extension**

**Extensions of files considered secure**
This option defines the file types that the software consents to open with a double click on the DocLink column of the Transactions table. This prevents from opening non-secure files by the program.

**Pdf**

**Enable TrueType fonts**
If this option is enabled, the font selected in the Interface tab is used when printing PDF files, otherwise a native PDF file type (Helvetica or Times New Roman) is used. This option must be disabled if in the generated PDF files the texts are unreadable.
**Restore Defaults**

If some settings have been altered, by using this button, the default settings will be restored.

**Developer**

**Developer options**
This tab includes useful options for scripts, apps and http pages developers for Banana Accounting.

**Enable Screenshots (Ctrl+3)**
If this option is activated, with the key combination Ctrl + 3 it will be possible to save screenshots of the program tables and dialog windows.

**Display Debug output panel**
If this option is activated a 'Debug output panel' is shown on the bottom of the main window. In this panel all debug messages are shown to the user. Debug messages allow to check that the program is working properly during scripts or add-ons execution or during web server calls. This option is meant for scripts, add-ons or http sheets developers. For further documentation see the page Debugging.

**System Info**
The System Info card displays information on the Operating System and the work environment. Our technical support might ask for this information. In this case, click on the “Copy to Clipboard” button and paste the data in the e-mail or the contact form.

**Apps Menu**

**BananaApps**

- These are extensions of the program's functionalities, for reporting, calculating, exporting, importing, establishing bills and reminders and other.
- They need to be set up by the user by clicking the appropriate button in the Manage Apps dialog from the Apps menu.
- Execution takes place via the Apps menu or within the specific functionality (for example: Import into accounting).

**Apps menu**

The Apps menu lists all the already installed BananaApps related to the file that is open at the moment. By selecting the command, the indicated App will be executed.
Manage Apps

The Manage Apps... command allows you to search for, install, alter your settings or uninstall BananaApps.

Installation of new Apps

For installing a new App, visit our page Manage Apps... .

Technical information on BananaApps

Herewith some technical information on BananaApps

- They are programs in Javascript that make use of API's available in Banana.
- They are very secure and cannot perform functions that might an impact on the operating system.
- Single Apps.
  A text file with the .js extension, which contains a program in Javascript, indicating the characteristics to be a BananaApps.
- App package
  A compressed file with the .sbaa extension, which can contain several other files, necessary for the application, such as commands, images, dialogues. A package can contain several commands. The title of the package and the commands it contains are indicated in the Apps menu.
  If you disable a package, all Apps will be disabled.

Prerequisites for running Apps

The commands for running BananaApps are only made available if the current file (the one on which you are working) has the features required by the Apps. If an app is not visible in the Apps Menu or is not executable, it will be because none of these features are present.

- Apps are available in specific context:
  - Productivity
    Commands that can be recalled in the Apps Menu.
  - Import.
    Available via the Import into accounting command.
  - Export.
Available in the **Apps** menu. The user should define the file name at the end of the process.

- Invoice report
  Prepares the invoices to be printed. Available via the **Print invoices...** command (Account2 menu -> Clients).

- Reminder report
  Prepares the reminders to be printed. Available via the **Print reminders...** command (Account2 menu -> Clients).

- Statements.
  Prepares the statements to be printed. Available via the **Print statements...** command (Account2 menu -> Clients).

- Association via a File Type.
  This requires the current file to be - for example - an Accounting file, or the double entry file, or addresses.

- Association via a property.
  Some Apps will only be executable if the relevant word is specified in the **File properties**, *Other* section (from the **File** menu).
  For example, the List of Administrators to be printed, that require specific fields, will require the word "Administrator".

**Develop your own Apps**

Anyone can create BananaApps that extend the functionality of the program. However, programming fluency is required.

To develop a Banana application, it is recommended to set out from an existing project.

- Start from an example available on the github.com \ BananaAccounting site
- Please refer to the developer documentation.
- Install the application via the **Manage Apps** command (from the **Apps** menu).

**Manage Apps**

This dialog window allows you to install, modify settings and uninstall Banana applications. Install an Apps in order to be able to use it.

**Installing a new App**

To install an App, proceed as follows:

- Choose the 'language' and 'country'
- From the left menu, select **Online**
- Select the type of App (e.g. productivity)
- Look for the desired App among those listed; or in the Search box, type the name of the App you want
- Click on the **Install** button
- Click on the **Close** button

Below are the available Apps:
The installed Apps will be visible in the 'Apps' menu.

**List of Apps**

This list shows the installed BananaApps and those available for installation.

- The check sign will indicate that the App is installed.
- The App denomination
- Information on the BananaApp.
  - Description
  - Link for main informations, will open the relative internet page
  - Last update
    - BananaApp date and hour
    - Local BananaApp date and hour (as per imported file)
  - Category
  - Typology of the BananaApp
  - Nation
    - Nation where App can be used. International will indicate that App can be used in several nations
  - **Install** button
    - Downloads BananaApps for local use
- Information on installed Apps
  - The "->" symbol preceding a packet will designate a BananaApps packet, that contains several commands.
  - Enablement
    - If the enabled box is not checked, the App will not figure in the menu. For a packet, single commands may me deactivated.
  - Automatic update.
    - When a new version is made available, it will download automatically.
  - Required properties.
    - For Apps to function properly, properties of your accounting file must be set up in the File and accounting properties menu.
  - "Apply properties" button
    - Will apply new properties for your file
  - "Execute" button
    - Will execute the specific command.
    - This button will only highlight if the App is applicable in the context of your current file.
For example, a multi-currency function will only be applicable if the file has been created as a multi-currency accounting file.

- "Settings" button
  Certain Apps allow you to set the settings for execution of your task. They will be related to your currently open file. If you use the same App with another file you must redefine the settings.
  In the invoice reports, for instance, we indicate the elements necessary for printing.
- "Uninstall" button
  Will uninstall the App or the packet.

**Search Apps**

BananaApps are listed according to the following selection criteria:

- Language
- Nation
- Text
- Installed
  Displays locally installed Apps.
- Online
  List of online available Apps.
- System.
  List of preinstalled Apps. You may enable or disable via the check box.

**Add from file**

Let's you add a Banana Apps from a local file. Indicated especially for development of new Apps.

- The file needs to always remain in the same directory.
- If the App is modified, the program will always use the last version.

**Add fro URL**

Allows you to install Apps present in the list of Apps available on the www.banana.ch website.

**Update Apps**

Download the last version of Apps from BananaApps, for which automatic update is not disabled.

**Print label**

From the Labels -&gt; Print command from the Apps menu, you can print the addresses. In the different tabs you can choose different settings, from the label format to the selection of the addresses to be sorted and printed. Each setting can be saved with the Compositions.
For the explanations of the different tabs, please consult the following pages.

- **Options**
- **Label**
- **Extract**
- **Sort**
- **Composition**

<table>
<thead>
<tr>
<th>Mr.</th>
<th>Mrs.</th>
<th>Mr.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paul James</td>
<td>Margaret Smith</td>
<td>David Johnson</td>
</tr>
<tr>
<td>19, Victoria St.</td>
<td>16, Holton St.</td>
<td>23, Church St.</td>
</tr>
<tr>
<td>UK - London N16 1UZ</td>
<td>UK - Oxford OX4 4WY</td>
<td>UK - Birmingham B48 7NA</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Mr.</th>
<th>Miss</th>
</tr>
</thead>
<tbody>
<tr>
<td>Richard Wright</td>
<td>Lisa Revell</td>
</tr>
<tr>
<td>12, Oxford St.</td>
<td>15, Forest Lane</td>
</tr>
<tr>
<td>UK - London SW4 6RA</td>
<td>US - Martinez, CA 94663</td>
</tr>
</tbody>
</table>
First label starting position

Decide on the position of the first label. For example, if 1 is entered in the horizontal and vertical fields, it refers to the upper left-hand corner of the page.

Number of copies for each label

The value of 1, in this field, means only one copy of each label is wanted.

Warn if text exceeds label

If the text goes beyond the margins for the label, the program will warn the user by sending an error message if this cell is activated.

Labels format

You can choose between the label formats available in the list. If the list doesn't have the format you wish, through the Change button, you can access the Label format dialog windows where you can choose your desired settings.

Data

Indicate the data source for the labels to be printed:

- Table - the current table data will be printed. If a data extraction occurred, only the extracted data will be printed.
- Addresses - all table addresses will be printed
- Selected rows only - only the earlier selected addresses will be printed.

Label
**Field list**

This is a list of all possible label fields; to insert a field, it is possible to work in two ways:

- Double-click on an element from the list
- Click on an element from the list, confirming with the **Add Field** key.

The field selected will be inserted at the position of the cursor in the **View labels** area. One can directly insert fields by writing the field name between the < Less and > Greater symbols.

**View labels**

Shows the disposition of the fields. The entries "<NAME FIELD>" will be replaced with the corresponding value of the table.

The symbols Greater and Less are considered field delimiters. In order to make them appear in the text
write "\<" for "<";
write "\>" for ">
and write "\" for "\"

**Preserve line feeds and spaces.**

In case this option is deactivated, the program does not take eventual spaces and empty rows in consideration.

**Extract**

The explanation of this section is available on the page Extract Rows of the Data menu.
Sort

The explanation of this section is available on the page Sort Rows of the Data menu.

Composition

The explanations of this window are available on the following web page: Composition.
Labels format

From the **Apps** menu, **Labels** command, **Formats** option, you can access the labels setup.

The program already offers many predefined label formats; it is however possible to setup personalized parameters through the **Default** command.

The program already offers many predefined label formats; it is however possible to setup or edit the default parameters, as well as your customized ones, through the **Composition (Default)** command.

Page settings - Options
Page

Margins
Input the size in centimeters; if no size is entered, the margin sizes will be zero.

Number of horizontal labels
Input the number of horizontal labels there are on the page.

Number of vertical labels
Input the number of vertical labels there are on the page.

Print Landscape
The page will be printed horizontally if this cell is activated.

Arrange labels from right to left
The labels will be printed from right to left and from top to bottom.

Label

Margins
It is possible to input a margin for each label; the values for the label margins must be input in centimeters.

Center text horizontally
Select this option to horizontally center the text for each label in the cell.

Center text vertically
Select this option to vertically center the text for each label in the cell.

Font size
**Base size**
This field shows the default font size.

**Reduce to fit, but no less than**
The program calculates the maximum font size possible for a given label, starting from 14 points all the way down to 8 points. The calculation is made taking into account both the height and width of the label. If a label has a line that is too long (or has too many rows) to be printed, then an error message will appear in the message window. Even if it is incomplete, the label will still be printed.

**Note:**
the printers will not print on the whole surface of a page because they need minimum margins. The program tries to adapt the single labels to the margin values required by the printer.

**Page settings - Composition**

All the settings that have been activated in the "Options" tab can be saved by using the Compositions and can be displayed when needed.
For more information on this section, consult the [Composition](#) page.

**Installing an App offline**

In order to install an App in an offline mode proceed as follows:

- connect yourself to our Apps[2] webpage, using a different computer connected to the internet
- download the App that you need (a .js or .sba file ) and save it on a USB key or other device
• copy the App on the computer without internet connection
• Open Banana Accounting from your computer without internet connection and open your accounting file
• from the Apps menu, choose the Manage Apps command
• click on the Add from file button and select the path were you saved the App
• the App will now be included in the installed Apps and in the Apps menu

Help Menu

The Help menu gives access to the followings commands:

• User's guide - access to all documentations and explanation of all technical and accounting topics
• Keyboard shortcuts - list of all keyboard shortcuts with detailed use description
• Check for updates... - access to our website to check if there are newer versions of the software
• Support center - access to Banana support web page
• Feedback - link to our website contact form where you can leave a feedback
• Register - access to Banana web page for users registration
• Manage license key - allows to enter the license key for the program
• About Banana Accounting - access to technical information about the program such as version number, serial number, Copyright.....

Keyboard shortcuts

You can also consult the list of keyboard shortcuts directly from the program, by choosing Keyboard shortcuts from the Help menu.

Short-cut Keys

<table>
<thead>
<tr>
<th>Accounting Keys</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>F9</td>
<td>Perform simple recheck.</td>
</tr>
<tr>
<td>Shift+F9</td>
<td>Perform global recheck.</td>
</tr>
<tr>
<td>F6</td>
<td>This key executes different functions depending on the column the user is working on. The functions are explained in the information window.</td>
</tr>
<tr>
<td>Alt+ Left click</td>
<td>Display the Extract rows table or the Account card table when clicking on an account number.</td>
</tr>
<tr>
<td>. (Full stop/Period)</td>
<td>On a date column insert the current date.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Editing Keys</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enter, Tab</td>
<td>Confirming keyed-in text and advance one cell.</td>
</tr>
<tr>
<td>Alt+Enter</td>
<td>Confirming keyed-in text and advance one row.</td>
</tr>
<tr>
<td>Shift+Tab</td>
<td>Confirming keyed-in text and return to previous cell.</td>
</tr>
<tr>
<td>F2</td>
<td>Edit content of cell.</td>
</tr>
<tr>
<td>Key Combination</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Double click</td>
<td>Edit content of cell. Under the program options you can select to edit</td>
</tr>
<tr>
<td></td>
<td>content of cell with a single click.</td>
</tr>
<tr>
<td>Backspace, Space</td>
<td>Delete content of current cell and edit the content.</td>
</tr>
<tr>
<td>Backspace</td>
<td>Delete preceding character.</td>
</tr>
<tr>
<td>Del</td>
<td>Delete subsequent characters.</td>
</tr>
<tr>
<td>Ctrl+C</td>
<td>Copy selected text or cells.</td>
</tr>
<tr>
<td>Ctrl+V</td>
<td>Paste copied text or cells.</td>
</tr>
<tr>
<td>Del</td>
<td>Delete content of selection.</td>
</tr>
<tr>
<td>not assigned</td>
<td>Delete text from the cursor point to the end of the cell.</td>
</tr>
<tr>
<td>F4</td>
<td>Copy previous cell from same column.</td>
</tr>
<tr>
<td>Shift+F4</td>
<td>Copy previous cell from same column and advance one cell.</td>
</tr>
<tr>
<td>Ctrl+Shift+C</td>
<td>Copy selected rows.</td>
</tr>
<tr>
<td>Ctrl+Shift+V</td>
<td>Insert copied rows.</td>
</tr>
<tr>
<td>Ctrl+-</td>
<td>Delete selected rows.</td>
</tr>
<tr>
<td>Ctrl++</td>
<td>Insert rows before position of cursor.</td>
</tr>
<tr>
<td>Ctrl+Enter, Ctrl+Return</td>
<td>Add one row below position of cursor.</td>
</tr>
<tr>
<td>Moving keys</td>
<td>Description</td>
</tr>
<tr>
<td>Left</td>
<td>Scroll towards left.</td>
</tr>
<tr>
<td>Right</td>
<td>Scroll towards right.</td>
</tr>
<tr>
<td>Up</td>
<td>Scroll up.</td>
</tr>
<tr>
<td>Down</td>
<td>Scroll down.</td>
</tr>
<tr>
<td>PgUp</td>
<td>Scroll up one screen page.</td>
</tr>
<tr>
<td>PgDown</td>
<td>Scroll down one screen page.</td>
</tr>
<tr>
<td>Home</td>
<td>Scroll to beginning of row.</td>
</tr>
<tr>
<td>End</td>
<td>Scroll to end of row.</td>
</tr>
<tr>
<td>Ctrl+Home</td>
<td>Scroll to top-left angle of table.</td>
</tr>
<tr>
<td>Ctrl+End</td>
<td>Scroll to bottom-right angle of table.</td>
</tr>
<tr>
<td>Ctrl+Left</td>
<td>Moves towards left to the edge of the current data region.</td>
</tr>
<tr>
<td>Ctrl+Right</td>
<td>Moves towards right to the edge of the current data region.</td>
</tr>
<tr>
<td>Ctrl+Up</td>
<td>Moves up to the edge of the current data region.</td>
</tr>
<tr>
<td>Ctrl+Down</td>
<td>Moves down to the edge of the current data region.</td>
</tr>
<tr>
<td>Alt+PgDown</td>
<td>Next view.</td>
</tr>
<tr>
<td>Alt+PgUp</td>
<td>Previous view.</td>
</tr>
<tr>
<td>Ctrl+PgDown</td>
<td>Next table.</td>
</tr>
<tr>
<td>Ctrl+PgUp</td>
<td>Previous table.</td>
</tr>
<tr>
<td>Ctrl+Tab</td>
<td>Next window.</td>
</tr>
</tbody>
</table>
Ctrl+Shift+Backtab  Previous window.
F5  Scroll to desired row by keying in row number in active window.
Shift+F5  Go to original row.
Selection Keys  Description
Shift+PgUp  Select column moving upwards, page by page.
Shift+PgDown  Select column moving downwards, page by page.
Shift+Left  Select row to left.
Shift+Right  Select row to right.
Shift+Up  Select upper column.
Shift+Down  Select lower column.
Shift+Home  Select back to start of row.
Shift+End  Select forward to end of row.
Ctrl+Shift+Home  Select back to top of table.
Ctrl+Shift+End  Select forward to end of table.
Ctrl+A  Select entire table.
Other Keys  Description
Ctrl+F4  Close active window.
not assigned  Exit program.
Ctrl+N  New file.
Ctrl+S  Save.
Ctrl+O  Open.
Ctrl+P  Print.
Esc  Cancel operation.
Ctrl+Z  Undo operation.
Ctrl+Y  Redo operation.
Ctrl+F  Find.
F3  Find next.
Ctrl+B  Bold text.
Ctrl+I  Italic text.
F1  View help.
Multimedia keyboard  Is performed by
Function key (eg. F6)  Press the fn key as well as the corresponding function key (e.g. Fn+F6).

Error messages

List of messages
• **Complete list of error messages**
• For further information on the Message Error window refer to the Interface page.

**If the program displays error messages**

• revert to the the help page for the reported error: in the 'Info' and 'Messages' (where the error messages appear), next to the error message, the 🤔 symbol will show. By clicking on this symbol, you will be connected directly to the online page corresponding to the error, containing the possible causes and solutions.
• If the error persists:
  ○ Update your software to the latest available version, by downloading it at the following page Download.
  ○ Check Accounting.
  ○ In Multi-currency Accounting, ensure that Exchange Rate differences have been generated and applied.

**Deactivate and Reactivate Error messages**

• Deactivate visualisation of error messages:
  ○ Checking the box "Don't warn" in the dialogue
  ○ Unclick Warning Messages (Window Menu)
• Reactivate visualisation of error messages:
  ○ Click Warning Messages (Window Menu)
  ○ With the Check Accounting command

**Favorites menu**

The names of all the created Compositions appear in the list of the "Favorites menu". When it is necessary to display or print a favorite, just select it from the list of the Favorites menu, without having to edit or modify its configurations.

When you have created compositions for the first time, in order to display them in the Favorites menu, you have to close and reopen the accounting file.

**Composition**

Compositions are saved personalized settings that can be used at a later date.

In this regard, all compositions can be displayed in the Favorites Menu.

It is possible to create Compositions for the following accounting data:

• Account cards
• VAT report
• Enhanced Balance Sheet
• Enhanced Balance Sheet by groups
• Reports
How to obtain Compositions

Compositions can be obtained mainly through the Account1 menu when it is about the Accounting cards, the Enhanced Balance sheet, the Enhanced Balance sheet with groups, the Reports and the VAT report, and from the File menu for the compositions concerning Create Pdf dossier and Export file.

- Once the document to be created has been chosen, start from the corresponding menu (Ex. Account cards or Enhanced balance sheet by groups...) and click on Default
- from the dialog windows that appears click on Composition and on the New button
- enter the name of the new composition
- check the desired options
- click on the Apply button

Each composition, once created, will appear in the menu of the corresponding command and can be edited, renamed, duplicated or deleted.

**Name**

Enter a name to identify the composition (for instance, Quarterly Report).

**Description**

Enter the description for the composition.

**Show this window every time**

If activated (default), when selecting a composition from the menu, the dialogue for editing the settings will be shown. If not activated, the preview of the requested report (Balance sheet, report, etc.) will be shown directly.

**Show in menu... (depending on the menu/command in which one is being positioned)**
If this option is activated, the composition will appear in the menu of the command.

**Show in 'Favorites' menu**
If this option is activated, the composition will appear in the **Favorites** menu.

**Read only**
If this option is activated, it will not be possible to edit the settings.

**New**
This button allows you to create a new composition.

**Delete**
This button allows you to delete an existing composition.

**Duplicate**
This button allows you to duplicate a composition.

**Import**
This button allows you to import a composition from another Banana Accounting file.

**Apply**
This button allows you to save the chosen settings for the new composition.

**Display in the starting menu**
According to the menu you are in, the Default composition and your personal saved compositions will be shown.

**Composition (Default)**
This is the composition used by default from the program, if no other composition has been created.

In the following example the menu of the Accounting reports is shown.

Direct access to the compositions

In the tables where the compositions are being shown and in the previews, the **composition menu** and the **settings icon** are being displayed. These make it possible to easily move from one composition to the next and provide rapid access to the settings in case you want to edit these.
Export

With Banana accounting you can export in different formats, either the data of a single table of the whole file:

Export rows
Choose the Export rows command from the Data menu in order to export the content of a single table.
If you select some rows before launching the command, then the Export selection only option will be activated.

Export file
Chose the Export file command from the File menu in order to export more than one table. In the dialog windows that appears you will find the following tabs:

- Specific tabs of the exporting format
  - Include tab, to define the tables and the reports that must be included in the export
  - Period (Accounting) tab, to define the period
  - VAT tab (in the accounting files with VAT management)
  - Composition tab

Export formats
There are different formats available, each with its own specific options:

- **Pdf**
  This format allows to export all accounting file content in a unique pdf file.

- **Excel**
  This format allows to create Excel spread sheets, comparisons, budgets, index calculations, Balance Sheet analysis, charts directly linked to accounting values.

- **HTML**
  With this format the data and accounting statements can be easily accessed with an Internet browser (Explorer, Mozilla, Opera).
  This format fully complies with the legal requirements related to long-term archiving of accounting data.

- **XML**
  This format is the standard used for exchanging data. The accounting data can be easily read and reused with other programs or with XSLT style sheets.

- **Export rows in TXT**
  This format allows to export the table rows in a text format.
Recheck accounting
By ticking this box, the accounting will be rechecked before it is exported.

Include
By ticking the different boxes, the user can export in MS Excel Xml the various tables and/or all the account cards and the VAT/Sales tax Report.

View
It is possible to select the view where the data are to be imported. This option is available for the export in PDF, Html and Xml format.

Periods
This function lets the user export the accounting data subdivided by period.

Accounts/ Categories by period
This option allows to export the accounts and categories balances according to the selected period.

VAT/ Sales tax report
This option allows to export the VAT/ Sales tax report according to the selected period.

Create periods for the whole year
By selecting this function, the partial balances for the whole year will be exported, and not only the ones of the specified accounting period or the selected export period.

Max number of periods
The maximum possible number of periods.
Export in Excel

Export selection only
When activating this option, the program exports only the selected area.

File Name
In this area it is necessary to insert the name of the new file that the program will create to export the data. If, however, an existing file is selected by using the Browse button, the program will overwrite it with the new data.

Display file immediately
As soon as the MS Excel file has been created, the software to view it will be launched. In this way, the result of the export can be seen immediately.

Options

Create cell names
This option will automatically give a name to each cell as the file is exported. For example, the cell that contains the balance for account 1000 will receive the name: "Accounts_1000_Balance" in Excel. This means the user can univocally identify each cell independently from its position on the sheet and thus create Excel reports that don't have to be corrected if the account plan is changed. The user thus saves having to manually carry forward any accounting data to Excel. However, inserting the names of the cells does slow down the opening of the Excel file.

Create table names
With this option, the program will automatically give a name to the whole area of the cells belonging to a table, at the moment the file is exported. For example, the area formed by the cells belonging to the Accounts table will be identified by the name DB_Accounts. This option is necessary if, when creating reports in Excel, database functions are used.

Use names Xml (English)
The cell names can either be defined in their original accounting language, or with their English name. In the original language, the names will be understandable to someone who speaks that language, but they will not be universally understood like a name in English would be. By selecting...
this option the user would have, for example, "Accounts_1000_Balance" instead of "Conti_1000_Saldo".

Protect tables
The entire content of cells is locked when selecting this option so that it is only possible to edit the format. This prevents the possibility of making any unintentional changes to the exported data. The user can remove this protection at any time by using the appropriate command in Excel.

Export selection only
If this cell is activated, only the selected area is exported.

Other Tabs
For the explanations of the other tabs, please visit the following pages:

- Include
- Period
- VAT
- Composition

Export result
Each accounting table is displayed in a different sheet in the Excel file

Use the cell names instead of the row/column references:

- The names return the desired value even when a new row or column is being entered.
- The names are easy to use and understand
  "Accounts_1000_Balance" refers to the balance of the 1000 account
  "Accounts_1000_Description" returns the value of the cell that contains the description of the 1000 account
- The names can be used in the formulas
  "=Accounts_1000_Balance" returns the value of the cell that contains the balance of the 1000 account
  "=Accounts_1000_Balance/1000" divides the balance of the 1000 account by 1000
- By using the names, it is possible to create links to various files.

A link to a cell is being composed of:

- File name
- Table name
- Cell name
Export in Html

File Name

In this area, the user must insert the name of the new Html file that the program will create to export the data. If however the user selects an existing file through the Browse button, the program will overwrite it with the new data.

Display file immediately

As soon as the Html file has been created, the software to view it will be launched. In this way, the result of the export can be seen immediately. It is best to remember that browsers like Mozilla and MS Explorer use a cache mechanism for files. When the export is made for a second time, it is possible that the user will see the previous version until the browser Reload button is pressed.

File creation options

Headers 1, 2 and 3

These are the file headers.

Other Tabs

For the explanations of the other tabs, please visit the following pages:

- Include
- Period
Html Options Tab

Use style sheet CSS

Selecting this cell will allow the user to connect a style sheet to the exported file. By default the program will automatically use its own style sheets and incorporate it into the document.

Use predefined style sheet

The program's default style sheet will be used. Deactivating the cell will automatically activate the External style sheet option. The user can then select the name of a personal style sheet.

External style sheet

File name

In case an external style sheet is being used, select the file name of the style sheet with the Browse button.

Include style sheet within html file

When data is sent in Html format, the style sheet file must also be sent. To avoid sending two separate files the user can incorporate the style sheet to the Html accounting file by activating this cell.

Selecting the cells will allow the program to file the data with various graphic options:

- Export visible columns only
- Table with border
- **Columns with headers**
- **Preserve page breaks within the table**
  If there are page breaks on the original accounting file, these will be carried over in the export as well.
- **Export as data** - data will be exported without any formatting

**Export in Xml**

![Image of the export in XML interface]

**File Name**
In this area it is necessary to insert the name of the new file that the program will create to export the data. If, however, an existing file is selected by using the Browse button, the program will overwrite it with the new data.

**Display file immediately**
As soon as the file has been created, the software to view it will be launched. In this way, the result of the export can be seen immediately.

**Style sheet XSLT**
In this area, the user can select the style sheet according to which the program should organize the graphic display of the accounting data. Thanks to the style sheets, the user can input his/her own data and conform to the print-outs required by the authorities. On the [www.banana.ch](http://www.banana.ch) various examples and further information on style sheets are available.

**Options**
It is possible to choose between the following options:

- Export visible columns only
- Include view list

**Export selection only**
If this option is activated, only the selected area will be exported.
Other Tabs

For the explanations of the other tabs, please visit the following pages:

- Include
- Period
- VAT
- Composition

Export rows in txt

In order to export rows, please select the Export rows command from the Data menu. Different options are available:

File name
Enter the file name or select an existing one using the Browse button.

Format
Select the desired format.

Display file immediately
As soon as the file has been created, the software to view it will be launched. In this way, the result of the export can be seen immediately. Please notice that browsers such as Mozilla or MS-Explorer have a documents cache mechanism. It is then possible that, when exporting a second time, you will still see the previous version if you don't use the Refresh browser's button.

Options
If activated, different options will allow the export of:

- selected rows only
- visible columns only
- columns header
- unicode (Utf-8)
Save

This window is shown when you need to create a PDF file, export in Html or Excel format, or copy into the clipboard.

File Name
In this area it is necessary to insert the name of the new file that the program will create to export the data. If, however, an existing file is selected by using the Browse button, the program will overwrite it with the new data.

Display file immediately
As soon as the file has been created, the software to view it will be launched. In this way, the result of the export can be seen immediately.

Import

Information on import are available in the single online lessons, listed in the left side menu.

Import into accounting

Supported import formats

With Banana, one can import from whatever format (see the list of current supported formats). In case you should need to import from other file types that are not included in the list, specific Banana Import Apps can be developed.

The Import to accounting command

The Import to accounting command from the Account1 menu makes it possible to import the following data:

- Transactions - to transfer the transactions from another Banana file or from the bank statement
- Accounts - to transfer the accounts from another Banana or a text file
- VAT codes - to transfer the VAT codes from another Banana file or from a text file
- Files - to transfer a complete file in order to convert the Chart of accounts

In order to transfer data just one single time, please consult Transferring data from other accounting
**Procedure for importing**

1. Choose the destination table of the data
2. Choose the file type from which to import
3. Indicate the file name
4. Choose the transactions to be imported

**Destination table**

For each data type, there are specific pages

- Import transactions
- Import accounts
- Import VAT codes
- Import exchange rates

**Import formats**

According to the type of destination table, different import formats are available.

However, the following formats are available for all options:

- Text file with column headers
  These are files that are especially created with other programs (for example, a program that creates invoices) so that the data can be transferred into Banana Accounting.
Technical indications on how to prepare these type of files can be found [here].

- There are also other file types for which a specific import filter exists or has been created.

**File name**

- The name of the file of which the data need to be imported needs to be indicated here.

**Manage apps...**

- To add or to update import filters. Scripts that decode file types can be created.

**Ok Button**

- Starts the import.

**Error messages**

In case error messages appear during an import operation, update, first of all, the [Import App].

**Import transactions**

**Import procedure**

1. From the drop down menu, choose [Import transactions]
2. Choose the file type from which to import (Cash book transactions, Double-entry accounting transactions)
3. With the [Browse] button, choose the file from which to import the transactions

More information about all types of import filters can be found on the [Banana Apps] page.
**File types that can be imported**

- **Import transactions from an Income & Expenses accounting file**
  In order to import transactions from an Income & Expenses accounting file into a double-entry accounting file, it is necessary that the categories of the Income & Expenses file correspond to the accounts of the Double-entry accounting file.

- **Import Cash book transactions**
  Apart from importing the transactions, an import summary per month or quarter can also be obtained.
  See the specific page Import [Cash book transactions](#).

- **Import Double-entry accounting transactions**
  In order to import transactions from a Double-entry accounting file into another Double-entry accounting file, it is necessary that the accounts correspond.

- **Import transactions from Bank statement ISO 20022 or MT 940**
  See page [Bank Statement ISO 20022](#).

- **Import data in Txt / CSV**
  This format must be used by those who want to export data from another software and import them into Banana Accounting.
  See also the technical information on how to create an import file for Banana Accounting.
  This file type is being used to import data from other programs, such as:
  - in order to import monthly transaction from your salaries software
  - in order to import the invoices issued with a invoicing software
  - in order to import the payments made with your invoicing software
  - in order to import your sales transactions from your online shop
  - in order to import data from another accounting software
  - in order to import data from another cashbook management software (for example a restaurants or a hotel).
• BananaApps for importing
  Allows you to transform data exported by another program (proprietary format), in the import format required by Banana Accounting.
  ○ Banana allows for import from several other formats. Please take a look at the updated list of Banana Import Apps.
  ○ It is possible to create one's own scripts that uncode the data contained in one's own files, more info here.

Choice of rows to be imported

After having elaborated the rows to be imported, the program displays a dialog, in which the user can indicate further options.

Destination account

This option is present when data of the bank account (or postal account) statement, or an account's income & expense transactions in a text format, are being imported. Insert the bank account number of the chart of accounts, related to the imported statement.

Select transactions

Start date, End date
Insert the start and end dates of the period related to the transfer of the transactions. The period can also be selected automatically in the boxes under the dates area.

**Don't import if exists same ExternalReference, Date, Amount**

If activated, this function allows the user to not import already entered transactions, in order to avoid recording transactions twice. This option can only be activated when the column "ExternalRef" is present in the transactions that are going to be imported. If not, this option will be deactivated.

**Complete the transactions with**

**Autocomplete values**

The option is only necessary for accounting with VAT/Sales tax and multi-currency. If activated, it allows the automatic completion of values that are missing in the imported data (for example, the exchange rate in the exchange rate table).

**Initial document number**

This option is present when data of the bank account (or postal account) statement, or an account's income & expense transactions in a text format, are being imported. This is the document number assigned to the first imported transaction.

**Group transactions by invoice number**

If the import file contains values in the "DocInvoice" column, it is possible to indicate in the dialogue:

- **Group transactions by invoice number**
  In this case, the rows of the same invoice are being grouped in such a way that there is only one transaction for the same account and the same VAT code. Please check the explanation Import invoice data.

- **Destination account for balance differences**
  When VAT codes are being applied, there may be rounding differences of just a few cents. In this case, Banana creates an additional transaction for every invoice into which this difference can be recorded.
  Of course, it is necessary to pay attention that the data to be imported obtain a balance between debit and credit. If not, the transaction row will contain the difference between debit and credit.

**Edit the imported transactions**

The program creates some transactions and adds them to the Transactions table. Transactions can be edited or deleted.

In a double-entry accounting file, the program adds some symbols in the Debit/Account and Credit/Accounts columns, where in an income and expenses file, the program adds them in the Account and Category columns.

Symbols should be replaced with the appropriate account or category.

- [A]
  This symbol is indicated when no account has been indicated in the dialog.
  You need to replace the [A] with the appropriate bank account.
[CA]

- When this symbol appears, you need to replace it with the appropriate contra-account, so that the Credit transactions will be balanced with the Debit transactions.

In rows with only one contra-account, you will find both the [A] and the [CA] symbols in the same row. In rows with multiple contra-accounts, each row will have its own [CA] symbol. Without the [CA] symbol, it would be impossible to understand if the transactions is a Debit or Credit one.

**Frequently Asked Questions**

**I see don't see the format for the bank statement of my bank**
Click on "Manage apps...", followed by "Update apps" and enable the filter for the desired format.

**I see don't see the format for the Xml account statement of the Postfinance** (file .tgz)
This format is no longer supported. Please contact the Postfinance and ask to receive the statements in ISO 20022 format.

**The following message appears 'This ISO 20022 file doesn't contain a bank statement (camt.052/053/054)'**
This error message is being displayed when the ISO 20022 file doesn't contain a bank statement. The ISO 20022 format is a generic format that can contain different types of information, like the bank statement and the payment confirmations. In Banana Accounting, only the bank statements can be imported (camt.052/053/054).

**My bank is not in the list of supported formats**
It is possible to create apps for formats that have not yet been implemented. We have also paid support available for the implementation of customized formats.

**I can only import collective orders and I cannot see the details (the individual orders)**
When executing a payment in the e-banking (for example in the Raiffeisen bank), you need to choose the option 'individual order' instead of the 'collective order'. Only by doing so you will be then be able to import the payments as individual orders.

**Import ISO 20022 file**

ISO 20022 is an international standard for the transmission of financial data. The CAMT category regroups the formats used for the account statement, reporting of account transactions and account balance confirmation:

- camt052: Account Reporting
- camt053 (including version 4): Account Statement
- camt054: Credit / Debit Notification

**Preview the ISO-20022 file**

Banana offers the possibility to preview contents of a camt file.
Data importing into the current accounting

Proceed as indicated with the Import into accounting (Account1 menu) command. Compressed files can also be opened with this function. In this case, the program will prompt the user to select the file from which to import the data of the compressed file.

Technical notes on converting ISO 20022 files

The ISO 20022 standard encodes the accounting data of the bank statement very precisely. Nevertheless, it leaves some discretion for the insertion of additional information about the account and its transactions. Banana, when reading the file, tries to adapt itself to the ways in which the ISO 20022 file has been prearranged.

- Reads as opening balance the similar encodings
- Reads as closing balance the similar encodings
- All contents are read and converted into transactions
  - Transaction date (Date)
  - Valuta date
  - Transaction amount (positive or negative)
  - Description (Banana - for now - displays the various descriptions as a single text)
    In the future, it will be possible to extract this information on a distinctive basis and indicate the columns where to allocate data.
  - Distinction of transactions between one single and detailed lines.
    For transactions that are to be detailed, there will be a row for the sum and separate rows for the singular transactions that will constitute the total.

National Specificities

Each country and/or bank has the possibility to insert additional information in the ISO 20022 file according to its needs. Banana Accounting offers a generic filter distributed with the application and multiple country- and/or bank-specific filters distributed as BananaApp. To import this additional information into your accounting, you must install and use the filter that is most specific to your country and/or bank.

Import data from a Cash book file

When managing your accounting work, it is possible to manage the cashbook separately and regularly import the transactions in the main accounting file, grouped according to a selected period.

In this case there are two separate files: a file containing all the data of the general accounting, and a second file containing only the data Cash book management. In order to be able to import data from the Cash book file into the main accounting file, those files need to be linked. This can take place in two different ways:

- Attribute to the categories of the cashbook file the same account numbers (for Double-entry accounting), or, the same category numbers (for Income & Expense accounting) as the ones used in the main accounting file.

- In the cashbook file, in the Category2 column of the Categories table, enter the same account...
numbers as the main accounting file (if double-entry accounting) or the same categories numbers (if Income & Expense accounting). If the Category2 column isn’t visible, you need to enable it by selecting the Columns setup command from the Data menu, and double clicking on Category2.

**Example:**
In this example, the account numbers referring to the main accounting file have been entered in the Category2 column.

In order to import the data, do as follows:

- open the main accounting file and choose the **Import to accounting** command from the **Account1** menu
- in the dialogue window that appears, select **Transactions** from the **Import** drop-down menu; then, click on **Cash book transactions (*.ac2)** and with the **Browse** button, select the cash book file.
You can find the explanations of this window at the Import to accounting page.

In accounting

Destination account

You have to select the account number (Double-entry or Income & Expense Accounting) to which the data will be carried over.
**Initial document number**

This is the document number given to the transactions carried over.

**Select transactions**

**Start date / End date**

These drop-down menus specify the start and end dates of the period to which the imported data refer.

**Group Transactions**

In this section the user specifies, by activating the different options, how the transactions of the period must be grouped:

- **No period grouping**
  All the rows are being imported, with the related contents of the columns. The Doc number of the Cash book account is also being imported. If, in the main accounting, you wish to use a different number and at the same time keep the document number of the Cash book, enter the document number in the DocProtocol column of the Cash book.

- **Monthly - transactions are grouped by month**
- **Quarterly - transactions are grouped by quarter**
- **By semester - transactions are grouped by semester**
- **Yearly - transactions are grouped per year**

**One transaction per account**

If more than one category is grouped on a single account but the user needs separate transactions for each category, this cell must be activated; then the program will create transactions for each category. When VAT codes are used, transactions will be created not only by category, but also for each different VAT code in the same category.

**Note:**

When the user is working on an accounting file with VAT, the calculations of the VAT may result slightly different. If the transaction amounts have been inserted as net amounts, the balance of the cash account may also be different because of rounding differences.

The accounting file is updated with the data of the Cash book.

---

<table>
<thead>
<tr>
<th>Date</th>
<th>Description</th>
<th>Debit</th>
<th>Credit</th>
<th>Amount USD</th>
</tr>
</thead>
<tbody>
<tr>
<td>31.01.2020</td>
<td>Total imported 110 Various sales</td>
<td>1000</td>
<td>4000</td>
<td>2250.00</td>
</tr>
<tr>
<td>28.01.2020</td>
<td>Total imported 112 Donations</td>
<td>1000</td>
<td>4510</td>
<td>500.00</td>
</tr>
<tr>
<td>31.01.2020</td>
<td>Total imported 113 Other</td>
<td>1000</td>
<td>4230</td>
<td>360.00</td>
</tr>
<tr>
<td>31.01.2020</td>
<td>Total imported 210 Mailings supplies and stamps</td>
<td>3040</td>
<td>1900</td>
<td>550.00</td>
</tr>
<tr>
<td>31.01.2020</td>
<td>Total imported 245 Payments for goods</td>
<td>3000</td>
<td>1900</td>
<td>900.00</td>
</tr>
<tr>
<td>31.01.2020</td>
<td>Total imported 250 Salaries and personal loans</td>
<td>3010</td>
<td>1900</td>
<td>5500.00</td>
</tr>
</tbody>
</table>

**Import accounts**
This command imports the accounts from a Double-entry or Income & Expenses file (*.ac2) or a text file (*.txt), and integrates them automatically in the existing Chart of accounts.

The accounts or the categories can be carried forward to the existing accounting through activating the following options:

**Options**

**Include Cost Centers**
When there are cost centers, these will also be carried forward.

**Add new accounts**
When this option is activated, all new accounts are added to the accounting plan.

**Replace text description**
If already existing accounts are imported, but with different descriptions, the existing descriptions are replaced by the imported ones when this option is activated.

**Replace opening balance**
If already existing accounts are imported with different opening balances, the existing opening balances are replaced by the imported ones when this option is activated.

**Import VAT codes**

This function is only available in the Accounting with VAT management, and allows the user to import VAT codes from:

- Other accounting files (*.ac2)
- A text file with column headers (text file *.txt)

In order to import VAT Codes, please proceed as follows:

- From the Account1 menu choose the Import into accounting command
- Select VAT Codes
- Select Switzerland: New VAT Rates 2018 - in the lower field the file containing the new VAT
Codes 2018 will be automatically shown
• Confirm by clicking on OK

The following dialog window will follow:

Add new codes and new groups
If this option is checked, the new codes and new VAT groups will be added, without eliminating the ones that are presently in the VAT codes table.

Replace all rows
If this option is checked the existing VAT codes table will be replaced by the one contained in the source file indicated,
Warning

If, after the import, you receive the error message VAT account not found, you need to select the VAT according to VAT report account in the VAT/Sales tax section of the File and accounting properties (File menu).

Update VAT Codes for Switzerland

See the pages for Switzerland in French, German or Italian.

Import exchange rates

This option is only present in Double-entry accounting with multi-currencies. The characteristics are the same as the ones of the Import transactions function.

It lets the user import the exchange rates from:

- Exchange rate table of another file or Exchange rate history file (*.ac2)
- Text file with the column heading (text file *.txt).

**Note:** Exchange rate history files only show the Foreign exchange rate table and keep a record of past exchange rates.

Import file

This feature allows you to import data from another Banana accounting file (with ac2 extension) of the same type.

It is being used when you go from one chart of accounts to another one and when a conversion of the account numbers is necessary.
For more information about the conversion of the chart of accounts, see the page on the accounting data migration to the new accounting plans.

**Source file**
This is the file from which the data are being taken.

**Destination file**
The file that "receives" the data.

**Options**

- **Import transactions**
  All the rows of the Transactions table, present in the source file, will be imported.

- **Import recurring transactions**
  All the rows of the Recurring Transactions table, present in the source file, will be imported.

- **Import budget transactions**
All the rows of the Budget table, present in the source file, will be imported.

**Replace amounts in Account table**

The amounts of the Opening, Budget and Previous columns of the Accounts table of the destination file are being deleted and replaced with the amounts that are present in the source file.

The accounts need to correspond, thanks to the same account numbers, or when there is a replacement, in that case the option "Convert account numbers" should be used.

**Replace accounting properties (basic data)**

The File and accounting properties of the destination file will be replaced by the ones of the source file.

**Convert account numbers**

Using this function, the imported account numbers will be replaced with those indicated in the alternative column.

If you use this function, you must also specify the column that contains the account numbers to be used in the import instead of the existing ones.

Next to the account number column, there should be a column that indicates the alternative number to be used when importing. If no alternative number is specified, the original account number of the source file will be used.

- **The account matches are in the source file**
  
  This option is to be used when for example you keep an accounting file in a country, with a specific number system, and then you need to regularly import your transactions in a different accounting file, that uses a chart of accounts with a different numbering system.
  
  - You need to add a new text column in the accounting plan ([Columns setup](#)) command.
  
  - For each account, indicate the destination account number in the tabel.

- **The account matches are in the destination file**

  This option is used when for example you want to switch to a chart of accounts with a new numbering and grouping.

  - You create a new accounting file with the new chart of accounts.
  
  - In the chart of accounts, you create a new column where you indicate the account matches ([Columns setup](#)) command.
  
  - In this column, indicate the account numbers of the source file.

  Separate the accounts with a semi-colon "1000;1001" to indicate that several accounts need to be grouped into this account.

- **Column containing the account matches (Accounts table)**

  Indicate a column of the chart of accounts that has been added by the user and that contains the account matches.

**Results and possible errors**

The program will have carried forward all the data of the previous accounting, converting the account numbers.

In case the program indicates errors (absence of accounts or other), it might very well be necessary to cancel the import operation, complete the account matches and repeat the import operation.
The program, finding different charts of accounts, cannot automatically execute extended check-ups to make sure that all the data have been imported and grouped correctly.

It is therefore advised to **check the result manually**, verifying that the totals of the Balance sheet and the Profit and Loss statement are indeed correct.

**Advanced import options**

For different and more complex and automated conversion needs, we suggest to use the scripts, that allow a total customization of the conversion and the import.

**Manage Apps**

Filters are extensions that make it possible to add new formats into the **Import into accounting** dialog window: **Account1** menu -> **Import into accounting** -> **Manage Apps...** button. A dialog window will appeare where you can see and manage all Banana Apps, already focused on the import filter. You can refine your results by language and/or country. You can install the desired filters.

In Banana Accounting 9, it is possible extend some of the functions by means of small javascript programs. In order to create your own import filters, see the [Banana Apps info page](#).

More information about all types of import filters can be found on the [Banana Apps](#) page.

---

**Show details**

This command will show you the following information:

- the source file where the Banana App is located
- the App type
- the App date
Lower buttons

**Add from file**

Adds a new App from an existing file. The file should always be available.

**Add from url**

Adds a new App from a link to a document available online.

- the file is downloaded from the internet
- the file is saved in the user's data folder

**Update Apps**

Downloads the filter's most recent version from Banana Accounting's server. The downloaded Apps should not be modified because they will be overwritten when updated. If there are new Apps, they will be added to the list. The imported filters will not be modified.

The Apps will be installed in the user folder. Thus only the user who imported the new Apps or updated the available ones will see them. To install Apps for all users or at a system level, a manual procedure for installing the Apps would need to be followed.

**Help (bottom button)**

It links to this page.

**Import transactions from Paypal**

On the page [web filter for PayPal transactions](#) you will find the information about the new feature that makes it possible to import all the Paypal transactions directly into Banana Accounting and the instructions on how to proceed ([follow the instructions on how to proceed](#)).

We have also prepared specific predefined templates for [double-entry](#) or [multi-currency accounting](#) that you can look at as an example or use as a separate accounting file just for the accounting transactions from Paypal.

More information about all types of import filters can be found on the [Import filters](#) page.

- [BananaApp for importing Paypal transactions](#)
- [examples for the Double-entry accounting](#)
- [examples for the Multi-currency accounting](#)

**Merge file**

It is possible to merge two files, but they have to belong to the same group (for example two double-entry accounting files). It is not possible to merge files belonging to different groups (for example one double-entry accounting file and one simple accounting file).

In order to successfully merge two files, it is crucial that they have the same accounts numbering.
Proceed as follows:

- Open the file which will contain the data of both files
- Select the **Merge File** command from the **Tools** menu
- Select the path and the name of the file to be merged
- Confirm the merge operation
- If the files are not the same, even though they belong to the same group, (for example, accounting with VAT/Sales tax and accounting without VAT/Sales tax), a message will appear advising the probable loss of data.

**Import rows**

In order to import the rows, click on the **Import Rows** command of the **Data** menu.

Activate the options of your choice in the following window:

![Import rows dialog box](image_url)

**File name**
Using the **Browse** button, select the file from which to extract the data. By clicking on the **OK** button, confirm the options selected.

**Format**
This area contains the list of formats with which it is possible to import the data to the table. These include: ASCII format, Text, CSV.

**Options**
- **Import data from clipboard**
  By selecting this box, the user can import data from the Windows clipboard.
- **Autocomplete values**
  It is advisable to select this function when it is necessary to import rows from a less complex accounting file into a more complex one. In this case, in the imported rows, some columns will stay blank. By selecting this function, the program will automatically complete the missing values with those from the current accounting.

**Fields header**
By selecting this box, not only data, but field headers will be included in the import.

**Unicode (Utf-8)**
By selecting this box, all the data will be imported in a format readable by Unicode programs.

## Transferring data from other software

### Recurring data importing from other programs

It can often happen to be regularly needing to import data from other programs.

For example:

- in order to import monthly transaction from your salaries software
- in order to import the invoices issued with a invoicing software
- in order to import the payments made with your invoicing software
- in order to import your sales transactions from your online shop
- in order to import data from another accounting software
- in order to import data from another cashbook management software (for example a restaurants or a hotel).

In these cases you can proceed in two different ways:

- make sure that your application exports the data in a txt file format specifically set to be imported in Banana.
  For more information please consult the technical information on how to create a file to be imported in Banana;
- create an import script that will transform data exported from another program so that they can be imported in Banana; depending on the installed import filters (see the Manage filters page), many formats can be available. See also how to create filters (Banana App)

### One time data importing from other programs

If you are starting to work with Banana for the first time and you need to import your data from another software, you can easily transfer data from any accounting program, passing through MS-Excel.

1. With your old accounting software, export the data in a format that can be read by Excel (CSV, txt, ...)
2. Open the exported file with Excel
3. In Excel, organize the data (columns) in the same order as they appear in the Banana tables (Accounts, Transactions)
4. Open your new accounting file in Banana
5. In the Accounts or Transactions table, add as many empty rows as there are rows to transfer from Excel.
6. In Excel, select the data to be copied and use the **Copy** command
7. Go in Banana and execute the **Paste** command.

This method is useful to transfer data from MS-Money, Intuit Quicken and Quickbooks, and from most other accounting programs.
Developers, please also see our webpage Import data.

Printouts/preview

Print preview

All the printouts of the various accounting documents can be saved in PDF, HTML, MS Excel and copied to the Clipboard, allowing the user to also access them many years later.

Print

The button pulls up the Printer Setup window from Windows. The selections are only valid for the current working session. Permanent alterations need to be input using the Windows control panel.

Horizontal or vertical printing needs to be input under Page Setup and is only valid for each view.
Exporting in other formats

Printouts can be exported in different formats:

- Pdf
- Html
- Excel
  Data are not really exported to Excel, but they are exported in html format with the .xls extension.
  Excel warns that data are not in Excel format but opens the file anyway and keeps some (but unfortunately not all) formats.

Accounting printouts

You can find information on specific printouts for the different accounting types at the following pages:

- Double-entry accounting
- Multi-currency accounting
- Cashbook and Income & Expense accounting
- VAT Report
- Swiss VAT form - page in Italian, German or French

Page setup

Allows to define the printing properties. Each view has its own printing setup.
Header left

This is where the title for the current view is shown. The title can be edited to appear at the top left of the printed page.

Header right

It is possible to enter a different text that will be printed at the top right-hand side of the page.

Logo

Press the Change button on the right and then select Add, as we also explain in the Setup a logo page; add your own logo.
Back to the Page setup window, choose Logo instead of none.

Margins

Press the Change button on the right and then select Add, as we also explain in the Setup a logo page; add your own logo.
Back to the Page setup window, choose Logo instead of none.
It is possible to input the page margins here: Left, Right, Top, Bottom. Measurements are in centimeters.

**Shrink page to printable area**

This function makes it possible to adapt the printable area when the print goes past the earlier defined page margins.

**Include in print**

When these functions are being activated, they allow to display the following data:

**File Headers**

This is the text that is being entered in the File and Accounting properties found in the File menu.

**Page Headers**

The page header will also be included in the printout.

**Table Name**

The table header (f.i. Accounts, Transactions, etc.) is also being included in the printout.

**Column headers**

These are the headers for the various table columns.

**Large font**

The program prints the headers using a slightly larger font.

**Page break**

When activated, this option maintains the entered page breaks; if not, they will be ignored, even if they are present.

**Page numbers**

Activate this option to request that the pages be numbered.

**Print time**

Activate this option to include the hour when the page was printed.

**Print date**

Activate this option to include the date when the page was printed.

**Row number**

Activate this option if a progressive number is to be given to each row.

**Grid**
The grid can be printed just as it is viewed on screen.

**Layout**

The program automatically adapts the page dimension.

**Font size %**

This allows the increase or decrease, on a percentage basis, of the size of the font to be printed.

**Reduce to page width**

If some columns exceed the width of the page, the program reduces the columns or reduces the zoom so that all the columns will be printed correctly on the page.

**As on screen**

The print-out will be carried out exactly as presented on the screen.

In case the contents goes past the page dimension:

- If the option "Reduce to page width" is being activated, the font size will be reduced;
- If the option "Reduce to page width" is not being activated, the part that goes past the paper will not be printed.

**Print black and white**

All colors will be converted in grey scales.

**Print landscape**

To print in landscape format which makes the page read horizontal.

**Page numbering**

You can access the page numbering feature by clicking on the icon on the Print Preview toolbar.

![Page numbering dialog box](image)

In this dialog box are set the options for page numbering. The printing of the page number is enabled
or disabled by using the settings of page setup or report.

**Start with**
The starting number for page numbering.

**Add prefix**
The prefix to insert to the page numbering.

**Period**

This tab appears in many dialogs (for example the Account card) and can specify the period to be show or to be calculated.

If for example a quarter is selected: in the account card only the transactions of the selected quarter will be shown, and in the balance sheet only the results for the selected quarter will be calculated.

![Create Pdf dossier dialog](image)

**All**
If this option is selected, the entire accounting period is included.

**Period selected**
If a specified period is desired, indicate the start and end dates.

**Transactions with no date**
If there are transactions with no date, they will be considered only if you chose the whole period (All...)
If however you enter the initial and final dates January 1sr and December 31, the transactions with no date will not be included in the report.
Accounting

Banana Accounting is a professional accounting software offering various options, tailored for multiple uses and users with different training backgrounds. The program runs on one single calculation engine, which is based on Double-Entry accounting. Therefore all applications share most of the double-entry functionalities.

- **Cash Book.** For management of a single accounting, with the possibility of classifying income and expenses by category.
- **Income & Expense accounting.** To manage comprehensive accounting with various balance sheets and categories, to which income and expenses are attributed. This is a simplified mode of use, that doesn't require knowing about Debit and Credit. There are however Balance Sheet and income statement reports..
- **Double-entry accounting.** Full comprehensive accounting solution, according to the double-entry method. Operations are classified by indicating the Debit and Credit account. The financial statements are complete with Balance Sheet, Income statement, Journal and Account cards.
- **Multi-currency accounting.** Multi-currency accounting. Double-entry accounting with the possibility of managing accounts in different currencies.

**Features available in all accounting**

The various accounting applications provide different functionalities - click on the links to learn more:

- **Accounting setup**
- **Files and data saving**
- **Chart of Accounts**
- **Transactions**
- **Blockchain**
- **Standard and customized reports**
- **Charts**
- **VAT management**
- **Financial Planning**
- **Invoices to Customer**
- **Check Accounting**
- **Year-end closing and Creation of New Year**
- **Various**
- **Multi-currency accounting**

These can be activated or added as per your requirements. The program is easily applied because, if a feature is not used, it is not activated.

- **Accounting setup:**
  - It supports any currency. Symbols are chosen from list or freely set.
  - Possibility to alter the number of decimals (generally 2), from 0 to 12 decimals to manage crypto-currencies.
  - Accounting period is set as a calendar or freely set (start and end date).
  - Choice of accounting language.
- **Files and data saving (similar to Excel), applicable to all Banana applications:**
  - Create new file starting from preset templates or from own files.
  - The data for an accounting year are saved in one single file.
The file can be located on any media, computer, network, cloud or sent by email.
Possibility to manage unlimited number of accounting files, of any kind.
Data is accessible to multiple users simultaneously, but to only one person in edit mode.

- **Chart of Accounts:**
  - Plan and structure of accounts are fully customizable.
  - Numeric or alpha-numeric account and group number.
  - Possibility to add notes or further columns.
  - Grouping and totals are adaptable and according to any nationally required grouping scheme.
  - Balance, account movement and totals are displayed and updated in real time.
  - Cost and profit centres, for detailed control of costs and revenues of specific activities or projects.
  - Segments for reporting by sector (branch), thanks to Segments.
  - Customer details with monitoring of pending invoices, reminders and statements.
  - Supplier statements with monitoring of paid and pending invoices.
  - Management of customers and suppliers, also as non-Balance Sheet accounts (with cost centre) for accounting managed with the cash method.
  - Off-Balance sheet accounts.

- **Transactions:**
  - Single or collective transactions.
  - Accrual or cash method.
  - Use of Excel type interface, select, copy and paste, add lines, search and replace.
  - Suggestions, autocomplete and memorization of repetitive operations for faster input.
  - Automatic or customized numbering of documents.
  - Ability to edit data entered, organize or add columns and any other information.
  - Link to files of receipts in digital format (pdf, images) and opening of documents by a click.
  - Import of data from bank statements, with the possibility to complete or remove imported operations.
  - Row colouring.
  - Possibility to have different displays of columns.
  - Contextual information concerning account balance, differences or errors.

- **Blockchain:**
  - Protection of movements entered with digital data certification technology (similar to Bitcoin).
  - Compliance with legal requirements.
  - Transfer of data to auditor with the certainty of impossibility of tampering.

- **Standard and customized reports:**
  - Customization and saving of print settings.
  - Export and link data to Excel.

- **Charts:**
  - Overview of account evolution.
  - Comparison of Budget and Final Accounts.
  - Real time display while entering.

- **VAT management. Any national specification supported:**
  - VAT code table to indicate the different VAT rates and case studies. Any VAT transaction supported.
  - Automated VAT calculation, net or gross.
  - VAT control reports.
  - National extensions for VAT reporting based on the requirements of tax authorities.
• Financial Planning.
  ◦ For existing companies or startups.
  ◦ Inclusion of planning by means of transactions in budget.
  ◦ Automatic assumption of repetitive expenses or income (rent, wages, bank charges, etc.).
  ◦ Possibility to indicate item code, quantity and price.
  ◦ Javascript calculation formulas to automate the dependent values (calculation of interest on the actual use of a loan).
  ◦ The program automatically sets up financial plans, complete with liquidity planning, balance forecasts, balance sheet and provisional income statement and movements on an account.
  ◦ Automatic financial projections for several years.
  ◦ Choice of display per period or
  ◦ Comparison between Budget and Finalized Balance Sheet.

• Invoices to Customer:
  ◦ Entering invoices as regular rows of transactions.
  ◦ Column.
  ◦ With or without VAT.
  ◦ Possibility to modify or correct.
  ◦ Print a single invoice with a click or several invoices simultaneously.
  ◦ Choice of different print formats available and parametrizable.
  ◦ Export in digital format through extensions.
  ◦ Customizable reminders and statements.

• Check Accounting:
  ◦ Check accounting command. In one click, the accounting is recalculated as if all transactions were inserted again.
  ◦ Any erroneous settings, differences or errors will be reported.
  ◦ Each report is linked to a help page that explains the causes and provides the solution.
  ◦ Possibility to correct.

• Year-end closing and Creation of New Year:
  ◦ Automatic process for creating new year files, with report of balances.
  ◦ You may start working on the new year, even if you have not closed the previous one.
  ◦ Command to report the final balances when the previous year has been closed.
  ◦ Possibility to add and print year-end notes.
  ◦ Command for archiving all data and printouts in pdf format.

• Various:
  ◦ Creating new files starting from an existing file.
  ◦ Converting from one accounting type to another, in order to grow and add functionalities.

• Multi-currency accounting:
  ◦ Accounts as well as customers and suppliers in different currencies.
  ◦ Recording with current, historical or freely set exchange rates.
  ◦ Invoices in the client's account currency.
  ◦ Balance sheet and Transaction entries in the account's base currency or in account currency.
  ◦ Calculation of unrealized exchange gains and losses (exchange rate differences).

**Double-entry accounting**

The professional tool to manage assets, liabilities, expenses and income according to the international rules of the Double-entry (debit and credit) and to obtain a Balance Sheet and a Profit/loss Statement.
The double-entry accounting application is available with or without the VAT management option.

**Characteristics**

- Manages the estate accounts and the profit/loss accounts (assets, liabilities, expenses and revenue)
- The accounting type with VAT features the VAT calculations and VAT reports
- Produces all the accounting extracts: journal, account cards, balances by period and annual balances
- Allows Cost Centers and Segments management
- Offers different ways of data presentation
- Exports data to Excel, Html, Xml, Pdf
- Imports data from different files formats

**Tables and File properties**

The double-entry accounting is composed by the following tables:

- **Accounts table**
  Where the accounting plan is located with opening balances, and where groups and subgroups can be defined along with cost centers and segments.
- **Transactions table**
  Where the accounting transactions are entered.
- **VAT Codes table**
  Where the VAT/Sales tax codes are set, only if the VAT management option has been chosen.
- **Exchange rates table**
  Where the different currencies are defined, only if the multi-currency accounting option has been chosen.
- **File properties**
  Where the accounting general settings are defined.

**Changing accounting type**

In order to change your file language, rounding system, or in order to add VAT or multicurrency columns, please refer to the **Convert to new file** command, from the **Tools** menu.

**Learn more**

- Learn Accounting
- Elements of Accounting
- Mathematical basis
- Organizing your accounting documents
- Debit and Credit
- Accounting on turnover or collected

**File and accounting properties**

This is where the main data of the accounting file are entered, such as the printout heading, the opening and closing dates, the basic currency, the company address, the profit and loss from exchange rate variation account (if you have a multicurrency accounting file), the VAT account (if you
have chosen the VAT management option), the password, ...

The File and accounting properties window has the following tabs:

- **Accounting tab**
- **Options tab**
- **Address tab**
- **VAT/ICMS tab**
- **Foreign currency tab**
- **Texts tab**
- **Password tab**
- **Other tab**

**Chart of accounts**

**Financial situation under control**

You need to setup you chart of accounts in the **Accounts** table: setup the accounts and the groups where the accounts must be totalized. With this operation you create the accounts that will be used when entering the transactions. The chart of accounts structure is the same that will show in all Balanche sheet and Profit & Loss statement presentations.

In the Accounts table there are also the columns of the initial balances, movements and current balance, which are automatically updated by the program.

The chats of accounts therefore provides an immediate and complete view of your financial situation.

- Liquidity accounts
- Balance sheet
- Profit & Loss statement
- Result of the current year
- Clients and Suppliers register
- Cost and Profit Centers
Different kinds of rows and sections

The Accounts table (charts of accounts) is both the setup tool and the viewing tool for the economic and financial situation.

In the chart of accounts (Accounts table) all data necessary to group the movements are entered:

- **Accounts**
  They indicate on what account (debit or credit) the transactions must be registered. Each account has a code or number (account number), a description, a class and a group to which it belongs; they also have an opening balance, the current balance, the budget, etc.

- **Costs and Profits centers**
  They are special accounts whose number is preceded by a full stop ".", a comma ",," or by a semi-colon ";". Their purpose is to be able to assign some amounts to special accounts other than the basic accounting accounts.

- **Segments**
  They are a sort of sub-accounts who's number is preceded by a ":". Their purpose is to be able to assign some transactions to subcategories of the accounting plan.

- **Groups**
  Their purpose is to create rows where the program adds up the amounts of other rows.

- **Sections**
  They indicate the accounting plan divisions for the Balance Sheet and Profit and Loss Statement printouts, ...
  - Clients register
  - Suppliers register

The columns of the double-entry accounting charts of accounts

- **Section**
  Codes are being entered that allow the user to only print determined parts of the Chart of accounts, when printing the Enhanced Balance sheet by groups.

- **Group**
  Contains the code that defines that this is a group row. The group code is then used in the GR column to indicate the totalization of an account or group.
• **Account**
The account number, cost center or segment is being entered.

• **Description**
A text to indicate the name of the account, group, or section.

• **Disable (only visible in the Other view)**
By entering 1, the account does not appear in the autocomplete list, but can be used in the Transactions table;
By entering 2, the account is disabled and cannot be used.

• **BClass**
It indicates whether the account is 1 = Assets, 2 = Liabilities, 3 = Expenses, 4 = Revenue, see the Accounts.

• **Gr (Totalize in)**
It indicates a group so that the program can totalize this line in the group.

• **Gr1 and Gr2**
Additional grouping codes to use with external accounting report files.

• **Opening balance**
Insert the account balance at the beginning of the year.
The amounts in credit must be entered preceded by a minus sign. The total of the debit amounts (positive) and those in credit (negative) must balance and result in zero. If the opening balances do not balance a difference is shown in the information window.
If you have added or pasted accounts and the difference is not correct, proceed with a Recheck of the accounting (Shift + F9)

• **Movement Debit and Movement Credit** (Protected columns)
The total of the debit and credit movements included in the Transactions table.

• **Balance** (Protected column)
The balance of the account includes the opening balance and the movements in debit and credit.
The balance in debit is positive, while a credit balance is negative (minus sign).

• **Budget**
The budget amount for the current year is being entered.
The budget amount for the Expenses (debit) must be inserted in positive, the Revenue in negative (credit).

• **Difference Budget** (Protected column)
The difference between Balance and Budget amount.

• **Previous**
The balance of the account at the end of the preceding year.
With the command “Create new year” or "Update opening balances", the values in the Balance column of the file of the preceding year are being carried forward.
When a new accounting is being created and the user wants to obtain printouts with the amounts of the preceding year, the values of that year have to be entered manually.

• **Prev. yr. Difference** (Protected column)
The difference between the Balance and the amount of last year.

• **VATNumber**
The VAT number in case this account is linked to a client or a supplier.

• **VATCode**
The VAT code that needs to be applied automatically, when this account is being entered in the debit A/c or credit A/c column of the Transactions.

• **Adresses columns**
It is possible to have the program add addresses columns in order to manage customers or suppliers data.
Adding or moving columns

- When an Amount column is being added in the Chart of accounts, the program composes the total of the amounts according to the selected grouping scheme.
- Added columns of the Number type, on the contrary, are not being totaled.
- With the Columns setup command, the columns can be made visible, the sequences can be altered and it is also possible to add other columns.
- With the Page setup command one can also define the layout of the print (portrait or landscape) and the zoom.

Accounts list ordered by description or other criteria

In you need to order your accounts in a different way, use the Extract and sort rows command from the Data menu.

Views

The chart of accounts is created with default views.

- Base Displayed are the principal columns, the grouping columns and the balances
- Transaction Displayed are the columns with the Debit and Credit transactions.
- Budget Displayed are the Budget column and the Difference Budget column.
- Previous Displayed are the Previous column and the Difference Prior columns regarding the previous year
- Other The Disable column, the VAT number and the Fiscal number column are being displayed.
- Print Just the Account column, the Description and the Balance is being displayed.

The views can be customized and others can be added with the command Views setup.

Trial Balance sheet

At any time, positioning yourself in the Accounts table and using the Print or Print preview commands (from the File menu), you can view and print the account plan or part of it. Also from the Accounts table, if you select Movement view, you can view and print your trial balance sheet.

Advanced printouts

The following commands allow the user to display and print the accounts in a different way:

- Accounting report
  It is possible to select just the accounts with transactions, to obtain temporary groupings or accounts grouped according to the BClass or an external grouping scheme.
- Enhanced Balance sheet
  Prints all the accounts of the accounting divided by Assets, Liabilities, Expenses and Revenue
- Enhanced Balance sheet by groups
  Allows the user to obtain customized printouts with groups
- Specific advanced printouts are available using the BananaApps link
Accounts

Bookkeeping accounts

In order to create an account, go to the Accounts table and enter a number or a code in the Account column. This same number is then used in the Transactions table as Debit or Credit account.

- The account number can be composed by numbers, letter and separations characters.
- It is not possible to have more than one account with the same number.
- Each account must have a BClass and must belong to a group.

The BClass

Each account must belong to one of the following BClasses:

- 1 for Assets
- 2 for Liabilities
- 3 for Expenses
- 4 for Income

The BClass number must be as indicated, regardless the account or group code. It is also possible to create Off Balance Sheet accounts (for example for warranty down payments, conditional commitments), that must have the following BClass:

- 5 for Off Balance Sheet: Assets
- 6 for Off Balance Sheet: Liabilities

Opening balances

The opening balance of each account is entered in the Opening + currency symbol column.

- The Assets balances are shown normally
- The Liabilities balances are entered with the minus sign (negative)
- Usually only the Assets and Liabilities opening balances are entered.

In order to automatically transfer the opening balances for the following year, please visit the Create New Year lesson.
Opening balances differences

In a correct accounting file, the total of the Assets opening balance should be equal to the total of the Liabilities opening balance, so no differences are shown. If the totals do not match, the program will show a warning message telling you that there is a opening balances difference (Information window).
If you have changed some account numbers and you think the error message is not correct, please Recheck the accounting.
When using Banana Accounting for the first time, the opening balances must be entered manually.

Accounts with addresses

It is possible to add a few columns in the chart of accounts, to include the addresses management: Tools menu -> Add new functionalities command
This command will add in the Chart of accounts the following things:

- several columns (name, last name, company, town, ...) where you can enter the client / supplier / member address and data
- the Address view where you can see the added columns (in order to change the view or the views organization please consult the Tables setup page)

Clients/supplier register
When in the accounting plan you need to manage a clients/supplier register, meaning a specific account list for all clients, you need to have complete data with address, phone number, email, VAT number, etc. in this case adding the columns of the Address view is very useful.

Groups

The grouping and totaling system
The Banana grouping and totaling system is based on the following columns:

- Group (TOTAL row)
When, in a row, a group identifier is being entered, the row becomes a TOTAL row. In this row the amounts of the Gr column, that contain the same identifier, are being totaled. When a group is present, there cannot be an account.

- **Gr** (Adds this row into the TOTAL row)
The number here must be one of the numbers defined in the Group column.

With this system, an account can be totaled in a group row, the group in another group and so on... in order to create different totaling levels. This totaling system is very powerful and flexible, but it takes some "getting used" to it, in order to be able use it well.

**Examples of the main groups in the Double-entry accounting**

Every Chart of accounts uses its own totaling system. Hereunder the main groups of the Double-entry accounting are being explained.

In the Double-entry accounting, the total of the Debit balances (positive) together with the Credit balances (negative) have to result in 0 (zero).

- The 00 is the row where all the amounts are being added together. It is the "Summa summarum" of all the Debit & Credit balances.
  - In case the Balances columns do not amount to zero, it means there is a Debit/Credit difference and thus most likely a mistake. In these cases it is useful to proceed with a checking of the accounting (see next point).
  - In the Debit and Credit columns of the Transactions view (Accounts table), there are only positive amounts, so also in the row of the 00 group, there will be the total of the transctions not equal to zero.

The calculation sequence to arrive at 00 is therefore as follows:

- The 1000 account -> group 1 (Total Assets) -> Group 00
- The 2000 account -> group 2 (Total Liabilities) -> Group 00
- The 3000 account -> group 3 (Total Revenue) -> Group 02 (result Profit & Loss Statement) -> Group 297 (Profit/Loss of the current year in the Balance Sheet) -> Group 2 (Total Liabilities) -> Group 00.
- The 4000 account -> group 4 (Total Expenses) -> Group 02 (result Profit & Loss Statement) -> Group 297 (Profit/Loss of the current year in the Balance Sheet) -> Group 2 (Total Liabilities) -> Group 00.

**The result of profit & loss statement is added in equity**

As you can see in the example, the Group 02 (Profit/Loss from Profit & Loss statement) is totaled in the 297 liabilities group (current year result).

With this group organization, we have several advantages:

- In current year operating result is displayed in the balance sheet
- The Total Liabilities will match the Total Assets (provided that there is no accounting error).
### Adding or deleting subgroups

#### Adding a totaling level

With this system it is easy to add totaling levels. When we want to create a subgroup for the *Cash & Cash equivalents* accounts:

- Enter an empty row after the bank account
  - Enter the value 10 into the Group column
  - Enter the value 1 into the Gr column
- Indicate the Gr 10 in the accounts 1000 et 1020
- The sequence for the calculation becomes:
  The 1000 account -> Group 10 (Cash & Cash equivalents) -> Group 1 (Total Assets) -> Group 00.

In case you want to insert another subgroup, "*Current Assets*", proceed in the same way.

- Add an empty row above the row of the Total Assets.
- In the new row:


---

<table>
<thead>
<tr>
<th>Accounts</th>
<th>Transactions</th>
<th>Totals</th>
</tr>
</thead>
<tbody>
<tr>
<td>Row</td>
<td>Account</td>
<td>Description</td>
</tr>
<tr>
<td>---</td>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>1</td>
<td>1000</td>
<td>Cash on hand</td>
</tr>
<tr>
<td>2</td>
<td>1020</td>
<td>Bank account</td>
</tr>
<tr>
<td>3</td>
<td>1100</td>
<td>Due to clients or Debtors</td>
</tr>
<tr>
<td>4</td>
<td>1200</td>
<td>Due from clients or Creditors</td>
</tr>
<tr>
<td>5</td>
<td></td>
<td><strong>Total Assets</strong></td>
</tr>
<tr>
<td>6</td>
<td></td>
<td><strong>LIABILITIES</strong></td>
</tr>
<tr>
<td>7</td>
<td>2000</td>
<td>Short-term loans</td>
</tr>
<tr>
<td>8</td>
<td>2100</td>
<td>Equity at the beginning of the current year</td>
</tr>
<tr>
<td>9</td>
<td>2200</td>
<td>Total Liabilities</td>
</tr>
<tr>
<td>10</td>
<td></td>
<td><strong>PROFIT &amp; LOSS STATEMENT</strong></td>
</tr>
<tr>
<td>11</td>
<td>3200</td>
<td>Revenue</td>
</tr>
<tr>
<td>12</td>
<td>3800</td>
<td>Expenses</td>
</tr>
<tr>
<td>13</td>
<td></td>
<td><strong>Total Revenue</strong></td>
</tr>
<tr>
<td>14</td>
<td></td>
<td><strong>Total Expenses</strong></td>
</tr>
<tr>
<td>15</td>
<td></td>
<td><strong>Profit / (Loss)</strong></td>
</tr>
<tr>
<td>16</td>
<td></td>
<td><strong>Difference should be = 0 (Bank coll)</strong></td>
</tr>
</tbody>
</table>
Indicate the number 11 in the Group column
Indicate the number 1 in the Gr column
• In the Clients and Goods for resale (inventory) rows, indicate the Gr 11.

Deleting subgroups

In case the Chart of accounts shows subgroups that are no longer needed or not wanted, these can be deleted. Just delete the row of the subgroup and modify the Gr of every account that was part of that subgroup.

Checking of the structure

Once the Chart of accounts has been set up, execute the Check accounting command of the Account1 menu. In case there are errors, the program issues a warning.

Infinite loop error

This warning appears when a Group is being totaled in a Group of a lower level, reason for which an infinite error loop is being created.
There would be an infinite loop when, in the preceding example, the Assets Group (1) would be totaled in Group 10.
The program, after having calculated the Group 1, would total the amount in Group 10, which in turn would total the amount in Group 1, and then again in 10 without ending.

Profit & Loss Statement with Gross Profit

It is also possible to use a Profit & Loss Statement that starts with the total Business result and that subtracts the costs.
Hereunder the example of the Swiss PME Chart of Accounts is shown.
Extended use of the totaling system

The totaling system is very flexible:

- In one Group, it is possible to add Groups as well as Accounts
  This can be seen in the earlier shown example where the Group Cash & cash equivalents (10) and the accounts (1100 and 1300) are being totaled in the Assets
- You can use whatever kind of numbering
- You can create up to a hundred totaling levels
  - The Total row can be after the rows
  - The Total row can be before the rows
  - The Total row can be completely elsewhere, in a separate position
    This is being used to create registers (for example, a client register)
- The accounts and the Groups can be totaled in one single other Group.
  It is not possible to total one and the same account at the same time in two groups.
- This system is also being used to total the Cost centers and the Segments
  Pay attention though to not use different groups for normal accounts and for cost centers, because the resulting amounts will not be correct.

Totaling of the Amount columns

The calculation procedure totals the amount columns

- The amount columns defined by the system are being totaled.
- The amount columns added by the user are being totaled.

The sequence of the calculation

The programme calculates the totals in the following manner:

- Sets the values of the Amount columns of the Groups rows on zero
- Totals the amounts of the Account rows into the Group rows (first calculation level)
- Adds the balance of the Group rows into the Group(s) of a superior level
  Repeats the operation until all the levels have been calculated.

Related Documents

- Opening balances

Sections

In order to create automatically an Enhanced Balance Sheet with groups, the chart of accounts needs to be configured with special codes that are to be entered in the Section column:

* Title 1 the asterisk separates the sections and indicates the main headers
** Title 2 to be entered for the secondary headers
1 Assets to be entered in the row of the Assets title
2 Liabilities to be entered in the row of the Liabilities title
3 Expenses to be entered in the row of the Expenses title
4 Revenue to be entered in the row of the Revenue title
01 Client's Register to be entered in the row of the Client's Register title
02 Supplier's Register to be entered in the row of the Supplier's Register title
03 Cost Centers to be entered in the row of the Cost Centers title
04 Profit Centers to be entered in the row of the Profit Centers title
# Notes to be entered in the row of the Notes title
#X Hidden data to be entered in the row from whereon the data have to be hidden

Sections in the Assets

- Enter a * on the same row as the Balance Sheet title
- Enter 1 on the same row as the Assets title

Sections in the Liabilities

- Enter 2 on the same row as the Liabilities title

Sections in the Profit & Loss Statement

- Enter a * on the same row as the Profit/Loss Statement title
- Enter 4 on the empty row below the Profit/Loss Statement title
Note: when there is a clear distinction between Revenue and Expenses in the Chart of accounts, you need to:

- Enter 3 on the same row as the Expenses title
- Enter 4 on the same row as the Revenue (Income) title.

Sections in the clients/suppliers register

- Enter * in the same row as the Clients/Suppliers register title or on an empty row (as in the following example)
- Enter 01 on the same row as the Clients register title
- Enter 02 on the same row as the Suppliers register title

The amounts will be shown in the same way as for the Assets and the Liabilities. This encoding is also valid when the clients and suppliers are configured as cost centers.

In case there are cost or profit centers configured, enter the following elements

- An * on the row of the Costs and Profit Centers title, or on an empty row
- 03 on the same row as the Cost centers title or on an empty row preceding the Cost Centers
- 04 on the same row as the Profit centers title or on an empty row preceding the Profit Centers

The Cost Centers amounts will be shown as positive (in black) like the expenses; the Profit Centers amounts will be shown in negative (in red) like the revenue;
For more information please visit the Sections logic page

**Related document:** Enhanced Balance Sheet with groups

**The Sections logic**

The sections different encoding entered in the **Section column** determines how the printout will come out.

Each section is printed as a separate table.

**The directories**

- **Title 1** creates a level 1 directory. 
  It can contain level 2 sections or directories. 
  It is useful to group sections that need to be printed together, such as the Balance sheet, which contains Assets and Liabilities.
- **Title 2** creates a level 2 directory.

**The Base sections**

The section number or code determines:

- how the amounts are printed; the amounts can be visualized just like in the Balance sheet or inverted.
  If the Credit amounts (in negative) are inverted, they will be visualized in positive, and the positive amounts will be visualized in negative.
- which amount columns will be used; the **Balance column** or the **Period Movement column** are used.
  The **Balance** column indicates the account balance at a specific date (balance at Jun 30th).
  The **Total Period Movement** column indicates the movement amount on the indicated period.
  It is used for the Profit and Loss Statement and indicates the costs or the revenues for a certain period.

Here is the explanation of the different sections
• **1 Assets** (amounts as in the accounting plan, balance column)
• **2 Liabilities** (inverted amounts, balance column)
• **3 Costs** (amounts as in the accounting plan, total movement column)
• **4 Revenues** (inverted amounts, total movement column)

This section can be also used alone and it can include both costs and revenues (in case of a Profit & Loss Statement that starts with the total Business result and that subtracts the costs). In this case revenues would be displayed in positive and costs in negative.

These sections must be unique. Therefore there can only be one 1 Assets, or one 2 Liabilities section. For other sections, like clients/suppliers register or cost center similar sections can be used.

**Derivatives Sections**

Those are Sections that are similar to the Base Sections

• **01 Similar to Assets** (amounts as in the accounting plan, balance column)
  It is used for the clients register.
• **02 Similar to Liabilities** (inverted amounts, balance column)
  It is used for the suppliers register.
• **03 Similar to Costs** (amounts as in the accounting plan, total movement column)
  It is used for Cost Centers.
• **04 Similar to Revenues** (inverted amounts, total movement column)
  It is used for Profit Centers.

**Other Sections**

There are other kinds of sections

• # Indicates a Notes Section (it prints only the Description column)
  It is used for the Balance sheet attachments
• #X Hidden Section. This section is not included in the sections selection and it is not printed.
  It is used to indicate parts not to be printed.

**Column width in printout**

The columns width is automatically set by the program.

Sections 1, 2, 01, 02 have the same column width

Sections 3, 4, 03, 04 have the same column width.

**Segments**

**Introduction**

Segments are being used to have a more detailed classification of the costs, also to obtain calculations of components or departments of the company. By using the segments you can obtain a Profit & Loss Statement per unit, department or branch, without having to create specific accounts for each unit.

For example a museum can use the segments in order to know the income, the personnel expenses or the setting up expenses for each exhibit.
Segments are being used when a systematic attribution is necessary, that follows the transaction in debit or credit.

Cost centers, on the contrary, are normally being used for additional cataloging, less structured and when the account sign is not necessarily being followed.

Cost centers and segments can be used at the same time.

**Characteristics of the segments**

- Segments are accounts preceded by a colon ":::"
- Segments codes can consist of numbers or letters.
- There may be up to 10 levels of segments.
- The number of colons preceding the symbol for the segment indicates the number of level.
  - ::LU segment of level 1
  - :::P1 segment of level 2
  - :::::10 segment of level 3
- For each level there may be an unlimited number of segments.
- The different levels of the segment are independent of each other.
- The segments do not have BClasses and do not have a currency symbol
- The calculations for segments are done in basic currency.
- In the transactions, the segment follows the debit and credit account. It is not possible to record on a segment without having an account.
- In the transactions, one can use a "-" as a separator instead of a ":::" if on the File properties (Basic data) of the File menu the option *Use the minus sign (-) as segments separator* has been activated.
- Account cards of the transactions on single segments can be obtained.

**Setting up segments**

The segments have to be configured in the **Accounts table**, Account column, at the end of the chart of accounts.

- Insert an asterisk in the **Section column** in order to define the section relative to the segments
- In the **Description column** enter the Segments title
- Enter the description of the first-level segments, and in the **Account column**, insert ":::"
  - List the segments of the first level, entering an identification code for each one of them in the **Account column**, preceded by ":::"
  - Proceed by entering the segments of the second level (and, if necessary, those of the third), in the same way as those of the first level, with the only difference that the segment codes need to be preceded by ":::" or by ":::", depending on their level.
Segment balance

The segment is a subdivision of what has been entered on an account. The segment amount is thus always relative to an account, and in order to have the segment total, you need to use an Accounting report (from the Account1 menu), with a subdivision by segment (Subdivision tab).

In the chart of accounts the segment balance is indicated. This balance will be zero if the segment is used in both Debit and Credit accounts, since the amounts compensate themselves. The segment balance will be visible only when using it with the Credit or the Debit account, associated with the Profit and Loss statement account.

Transactions

The segments are being entered in the Transactions table, followed by the main account from the account segment.

Each segment is preceded by the colon, or by the minus sign (-), in case the option Use the minus sign (-) as segments separator has been activated in the File and Accounting properties (File menu).

If the chart of accounts contains accounts with "-" or ",", as for example in the clients/suppliers register’s accounts), you can't use the same symbols as segments separators; in this case you need to deactivate the corresponding option and use the ":" symbol.

When a segment that belongs to more than one level is being recorded, the segment of the first level needs to be entered right after the main account; then, continue with the code of the second level.

Report

Reports of the segments are obtained with:

- Enhanced balance sheet with groups
- Accounting report.
- Account card
- Multi-level report

In order to obtain reports that combine accounts and segments (for example, all the expenses of the LU Branch for P1), the features of the Banana applications need to be used.
Report subdivision by level

In the Enhanced Balance Sheet with groups, in the Subdivision tab, indicate the segment level to be used.

Summary Report

This is a summary with the segment that have been setup in the Accounting plan section, with a possible subdivision (if desired) by period or by segment.
Segment non assigned

The "empy" segment gathers all the amounts that have been recorded without specifying a segment. It is possible to setup the title for this segment in the Accounts table. Please also select the Segment heather: Description option in the Subdivision section.
Managing different projects

With the **Segments** feature, it is possible to manage different projects, obtaining balance sheets that determine the profit or the loss of each project.

**Example**

In an association, there are two projects that need to be managed:

1. Courses
2. Events

On top of that, there are different branch offices with the same projects to be managed:

- Rome
- Milan

The user wishes to obtain a balance sheet which indicates the profit or the loss of each project and branch office.

**How to proceed:**

- Insert the **segments** at the end of the chart of accounts
Enter the transactions, and complete the debit and the credit accounts with the segments. Segments can be registered either with the colon (:) or with the minus sign (-).

If you want to enter segments with a minus sign in front of the segment code, you must activate the option 'Use minus sign (-) as segments separator', in the File menu, File properties (basic data) command, 'Options' tab.

From the Account1 menu, activate the Enhanced balance sheet with groups command.

Select the available configurations in the different tabs; in the Sections tab in particular, deactivate the display of the Balance sheet accounts, the Client/Suppliers accounts and the Cost centers. The segments usually refer to the accounts of the Profit & Loss statement.
In the Subdivision tab, activate the Subdivision by segment option. Select the segment for which the balance sheet should be obtained (by project or by branch office).

Click on the OK button in order to display the report.
# Profit & Loss Statement

## Segments

<table>
<thead>
<tr>
<th></th>
<th>Courses</th>
<th>2020</th>
<th>2020</th>
<th>2020</th>
</tr>
</thead>
<tbody>
<tr>
<td>Personnel wages</td>
<td>2000.00</td>
<td>2000.00</td>
<td>2000.00</td>
<td></td>
</tr>
<tr>
<td>Company allied to third parties</td>
<td>7500.00</td>
<td>7500.00</td>
<td>7500.00</td>
<td></td>
</tr>
<tr>
<td>Hotel expenses</td>
<td>500.00</td>
<td>500.00</td>
<td>500.00</td>
<td></td>
</tr>
<tr>
<td>Publicity and promotions</td>
<td>1500.00</td>
<td>1500.00</td>
<td>1500.00</td>
<td></td>
</tr>
<tr>
<td><strong>Total expenses</strong></td>
<td><strong>19000.00</strong></td>
<td><strong>19000.00</strong></td>
<td><strong>19000.00</strong></td>
<td></td>
</tr>
</tbody>
</table>

## Revenue

<table>
<thead>
<tr>
<th></th>
<th>Courses</th>
<th>2020</th>
<th>2020</th>
<th>2020</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contributions</td>
<td>12000.00</td>
<td>15000.00</td>
<td>27000.00</td>
<td></td>
</tr>
<tr>
<td>Income from assets</td>
<td>5000.00</td>
<td>5000.00</td>
<td>5000.00</td>
<td></td>
</tr>
<tr>
<td>Publicity and promotions</td>
<td>4800.00</td>
<td>4800.00</td>
<td>4800.00</td>
<td></td>
</tr>
<tr>
<td><strong>Total Revenue</strong></td>
<td><strong>17400.00</strong></td>
<td><strong>25400.00</strong></td>
<td><strong>57400.00</strong></td>
<td></td>
</tr>
</tbody>
</table>

| Profit and Loss | 7780.00 | 23440.00 | 24718.00 |
Cost and Profit Centers

The Cost and Profit centers (hereunder being indicated as Cost centers) allow the user to catalog the transactions according to different criteria than the usual accounts.

Characteristics of Cost centers

- The Cost and Profit centers (CC) are accounts, preceded by the ".", "," and ";" signs
- There are three cost center levels:
  - CC1 preceded by a period "."
  - CC2 preceded by a comma ","
  - CC3 preceded by a semicolon ";"
- Each level is independent of the other
- For each level, there can be an unlimited number of cost centers.
- A superior level can be used without using an inferior
- Cost center codes can be alphabetic or numeric
- Cost centers can have their own grouping, different than those of normal accounts. For the same level of cost centers, subgroups can be created. Be careful to not mix cost centers groups with other groups of a different level or with normal accounts or segments.
- Each cost and profit center has its own account card, complete with transactions and balance
- Recording on the cost center is independent of the account recorded in debit or credit. One can
even record on a cost center without any account in the debit and credit column.

**When to use cost centers**

Cost centers are usually being used to catalog certain expenses to specific activities, that are not necessarily linked between each other.

- Projects, Events, Construction sites
- Clients and suppliers, Members, Sales agents
- Extra details for certain expenses

The **segments**, on the contrary, follow the debit and credit accounts, and are being used as further subdivisions for expenses and revenue.

It is possible to use cost centers and segments together at the same time.

**Setting up cost centers in the Accounts table**

- Create a specific section for the cost centers.
  This setup will be necessary for the presentation of the cost centers in the Enhanced Balance Sheet by groups.
    - Enter a **section with an asterisk** * for a section change
    - In the next row, enter **03** (or 04 for a profit center).
- Add some empty rows for the cost center
  - In the **Group** column, enter the group to which the cost center account belongs
  - In the **Account** column, enter the cost center account preceded by a **full stop** "." for those to be registered in **CC1** column (Transactions table), a **comma** "," for those to be registered in **CC2** column and a **semicolon** ";" for the ones to be registered in the **CC3** column.
  - In the **Gr** column, indicate the group in which the amounts have to be totalized.
  - In a Multi-currency accounting, the account currency is also specified.
- Add the cost center groups
  - In one and the same group, totalize only one specific level.
  - As for normal accounts, different levels can be created.
### File Properties (VAT amount)

In the **File and accounting properties command**, in the **VAT tab** you can set the amount of cost centers with the following options:

- **Use transaction amount** - The amount of the cost center is registered according the registration amount
- **Use amount excluding VAT** - The amount of the cost center is registered net of VAT.
- **Use amount including VAT** - The amount of the cost center is registered including the VAT.

### Transactions

In order to register on the cost centers, it is assumed that the cost center accounts have already been entered into the Chart of accounts.

To proceed with the recordings, you need to be in the **Transactions** table, in the Cost centers view; in the **CC1**, **CC2**, **CC3** columns, you need to enter the cost center account **without the punctuation** that precedes it.

- To record on the cost center in credit, the cost center needs to be entered preceded by the minus sign (\(-\)).
- For the Income & Expense accounting, in the File and accounting properties, you can define for the cost centers to follow the sign of the category.
- In order to record a global amount on more than one cost center of the same level, a different row needs to be created for each different cost center.
If you wish to display the Cost Center description in the **Transactions** table, you need to activate the corresponding column (CC1Des., CC2Des. or CC3Des.) with the **Columns setup** command from the **Data** menu.

### Cost center account card

The cost center is treated as any other account, so each cost center has its own account card with account balance and account transactions.

In order to view all cost center account cards, click on the command **Account/Category cards** in the **Account1** and then on the **Cost centers** button (Filter option).

**Related documents:**

- [Managing partners of an association](#)
- [Customers and suppliers with VAT on paid invoices](#)

### Membership list

In order to obtain the membership list with all the data that are useful for an association, the user needs to proceed as follows:

- In the **Accounts** table, at the end of the Chart of Accounts, the membership list can be created by using the CC3 cost center column.

  - Activate the **Address** view, selecting from the **Tools** menu, the **Add new functionalities** command
  - In the window that appears, confirm the option **Add addresses columns in Accounts table**
  - Insert the data of the members
For a print-out: select the rows that need to be printed and activate the printing option only Selection.

In order to record the transfers from every member in the Transactions table, insert the CC3 account for each member, using the CC3 column. In order to display the CC3 column, click on the Columns setup command of the Data menu; double click on CC3 and activate Visible check box.

In the Accounts table, the balance of the member's transactions is shown.

To see all of a member's transactions, double-click on the CC3 account number.

Related document:
- Cost and Profit centers
- Banana Accounting example files (Income & Expense accounting for Swiss associations or Double accounting for Swiss associations)
Add / Rename

Adding a new account or category

- Position yourself in the row above the one where you want to add the new account
- Add a new empty row with the command Add rows from the Edit menu
- In the columns, insert the account number, the description, the BClass (1 for the Assets, 2 for the Liabilities, 3 for the Expenses and 4 for the Revenue), and the Gr which needs to be the same as the one inserted for the accounts belonging to the same Group.

Note: If you first enter a transaction with a non-existing account and later you create the new account in the accounting plan, you will first get an error message, that will go away only if you recheck the accounting with the Shift + F9 key, or the Recheck accounting command from the Account1 menu.

Adding a new group

- Position yourself in the row above the one where you want to add the new group
- Add a new empty row with the command Add rows from the Edit menu
- In the columns, insert the group number, the description and the Gr which needs to be the same as the group you wish this group to be totalized.

Renaming an account or a group

- Position yourself in the Account or Group column in the Accounts table, or in the Category column of the Categories table (or in the VAT code column in the VAT codes table)
- Choose the Rename command from the Data menu
- Enter the new account, group, category or code number

The program will automatically update the Transactions table with the new number or code.

Deleting an account or a group

- Position yourself on the row number that contains the account that is to be deleted
- From the Edit menu, click on the Delete rows command
- Enter the number of rows that you wish to delete

After deleting an account, a category or a group it is necessary to use the Recheck accounting command from the Account1 menu. The program will give you a warning message if the deleted account, category or group was used in the Transactions table.

Opening balances

When using Banana Accounting for the first time, the opening balances need to be inserted manually in order to create the opening balance sheet.

After having set up the Chart of Accounts, proceed as follows:

1. Place yourself in the Accounts table, Base view, Opening column.
2. Manually enter the opening balances of the Assets and Liabilities accounts. The Liabilities are entered preceded by the minus (-) sign.
3. Check if the total Assets equals the total Liabilities so that your accounting balances. If there
are differences in the opening balances you need to check and correct them.

In order to automatically transfer the opening balances for the next year, consult the lesson Create New Year.

Transactions

Entering Transactions

Transactions must be entered in the Transactions table.

The columns of the Transactions table

The columns listed hereunder and preceded by an * are usually not visible. In order to make them visible, use the Columns setup command from the Data menu.

Date

The date the program uses to attribute the transaction to a certain time frame. The date should be
within the limits of the accounting period defined in the Basic data of the accounting. In the Options tab, one can indicate whether the transaction date is required, if not this value can also be left empty. If there are locked transactions, the program gives an error message when an equal or earlier date than the one of the lock is being entered.

*Date Document
The date of the document can be entered, for example the date of issue for an invoice.

*Date Value
The value date of the bank operation can be indicated. This value is being imported from an electronic bank statement.

Document
The number of the voucher that serves as a base for the accounting transaction. When entering transactions, it is advisable to indicate a progressive number on the document, so that the accounting document can be easily traced from the transaction.
The autocomplete feature proposes progressive values as well as transaction codes that have been defined earlier in the Recurring transactions table.

The program proposes the next document number, that can be resumed with the F6 key.

- In case of a numeric numbering, the program simply increases the highest value found in the Doc column.

- Alphanumeric numbering: the program increases the final numeric part; this is useful when one would like to keep a separate numbering for cash and bank movements.
  If earlier Doc number C-01 has been entered, and one starts to type C, the program proposes C-02.
  If earlier Doc number B104 has been entered, and one starts to type B, the program proposes B-105.
  If earlier Doc number D10-04 has been entered, and one starts to type D, the program proposes D10-05.

In the recurring transactions you can setup transactions groups that can be reloaded with a single code.

In order to add a large number of document numbers, you can also use Excel. You can create in Excel the desired quantity of document numbers and then copy and paste it into Banana, in the column of the Transactions Table.

*Document Protocol
An extra column in case an alternative numbering for the transactions or for the document is needed. The autocomplete feature proposes progressive values that function in the same way as the ones in the Document column.

*Document Type
Contains a code that the program uses to identify a type of transaction. If you prefer to use your own codes, it is advisable to add a new column.

- 01 In the reports, this transaction is considered an opening transaction, so it doesn't show in the period but in the opening balances.
- from 10 to 19: codes for customers' invoices
• from 20 to 29: codes for suppliers' invoices
• from 30 to 1000: codes reserved for future purposes.

*Document Invoice
A number of an issued or paid invoice that will be used together with the invoice control feature for customers/suppliers

*Document Original
The reference number present on a document, to enter, for example, the number of a credit note.

*Link to external file
Serves to enter a link to an external file, usually the accounting voucher. Pressing on the little arrow on the upper part of the cell, the program opens the document.

*External reference
Any reference number all allocated by a program that generated this operation. This value can be used to check whether a given task is imported twice.

Description
The text of the transaction. The autocomplete feature proposes the text of an already entered transaction, or of one that has been entered in the preceding year when the appropriate option has been activated. When pressing the F6 key, the program retrieves the data of the preceding row with the same description and completes the columns of the active row.

In case the description begins with #CheckBalance, the transaction is being considered as one that serves to checkup the balance.
Please consult our page Check accounting for more information on the subject.

*Notes
Useful to add notes to the transaction.

Debit Account
The account that will be charged.
It is possible to also enter a segment in the Debit account column. These are usually separated by a ":" or a ":-".
In the accounts list, pressing the key with the segment separator symbol, one goes immediately to the next segment.
If instead the Enter key is being pressed, the input finishes and one moves to the next column.
The autocomplete feature proposes the accounts and segments. One can also enter a search text and the program shows all the accounts that contain that text in one of the columns.

*Debit Account Description
The description of the entered account retrieved from the Chart of accounts.

Credit Account
The account that will be credited. We refer to the explanation under Debit account for the rest of the information.

*Credit Account Description
The description of the entered account retrieved from the Chart of accounts.

Amount
The amount that will be entered unto the debit- and credit account.

**VAT columns**
Information on the VAT columns can be found at the [VAT columns in the Transactions table](#) page

**CC1**
The Cost center account preceded by ".

**CC2**
The Cost center account preceded by ","

**CC3**
The Cost center account preceded by ";"

**CC1 Description**
The description of the Cost centre, retrieved from the Chart of accounts.

**CC2 Description**
The description of the Cost centre, retrieved from the Chart of accounts.

**CC3 Description**
The description of the Cost centre, retrieved from the Chart of accounts.

**Expiry date**
The date before which the invoice has to be paid.

**Payment date**
Used in combination with the Show Expiry dates command.
When instead using the invoices customers/suppliers control feature in order to check on the payments, a transaction has to be entered for an issued invoice and another one for the payment thereof.

**Lock Number, Lock Amount, Lock Progressive, Lock Line**
More information at the [Lock Transactions](#) page.

**Additional columns**
The following columns are added with the 'Tools' -> 'Add new functionality command, Add items columns in the Transactions table' (Refer to the [Items columns in the Transactions table](#) documentation for further information:

**Item**
The identifier of the article in the Items table. If you insert an article in the Items table, the description, unit, unit price, VAT code and account are added.

**Quantity**
The quantity multiplied by the unit price will produce the total amount (can also be a negative number).

**Unit**
A description referring to the quantity, for example: mq, ton, pz.
**Unit/Price**
The unit price multiplied by the quantity, will produce the total amount (can also be a negative number).

If a value is entered in the Quantity or Unit Price columns, the amount is calculated on the basis of the contents in these two columns and converted to a positive value.

**Adding new columns**

With the [Columns setup](#) command, it is possible to display, hide or move the order of columns, add new ones, or indicate that a column should not be included in the printout.

- The added columns in the Transactions table will be added also in the Recurring transactions table, in the Account card and in the VAT report, without being made visible. In order to display these columns in the other tables, use the [Columns setup](#) command.
- If a column of the "amount" type is being added, the entered amounts will be added up in the Account card.

**Views**

When a new accounting is being created, the following views are being automatically created as well:

- **Base**: the main columns are being displayed
- **Cost centres**: the CC1, CC2 and CC3 columns are being displayed
- **Expiry dates**: the columns Expiry date and Payment date are being displayed
- **Lock**: the columns relative to the Lock function are being displayed.

With the [Views setup](#) command, the views can be customized and personal, added views can be created.

With the [Page setup](#) command, you can modify the print mode of the view.

**Info window**

In the Information window at the bottom part of the screen, error messages and extra information about the used accounts and VAT codes are being displayed.

For the accounts, the Account number, the Description, the Amount of the transaction (debit or credit) and the Current balance of the account is being indicated.

**Transaction types**

**Simple transactions**

Simple transactions are the ones regarding two accounts (one Debit account and one Credit account) and entered in one single row. Each transaction has its own document number.
Composed transactions

Composed transactions with more than two accounts involved, have to be entered on several rows. The user should enter one account per row. The counterpart account for the entire transaction has to be entered on the first row.

The document number, entered on the different rows, is the same because we are dealing with one and the same transaction.

Note:
In composed transactions, the dates of the transaction rows should be the same, otherwise, when doing calculations by period, there may be differences in the accounting.

Recurring Transactions

Recurring Transactions table

In order to avoid rewriting always the same texts, it is possible to store transaction groups in the Recurring transactions table (Account2 menu). These groups are identified with a code and can be retrieved and entered into the Transactions table just by entering the corresponding code.

When positioned on the Doc column of the Transactions table, the program proposes the list of the recurring transactions, grouped by code. If one of these codes is selected:

- the program enters the recurring rows that have the same code
- the program completes the entered rows with the date and other values that have been entered earlier
- the program enters the progressive number in the Doc column (based on earlier entered values)

Entering recurring transactions
• You need to enter into the **Recurring transactions** table (or copy from the **Transactions** table) the transaction rows that should be retrieved regularly.

• Enter the code related to the recurring transactions group into the **Doc** column. Rows with the same group code will be retrieved together (transaction on multiple rows).

![Recurring transactions table](image)

Progressive numbering of documents "docnum"

If, when retrieving recurring transactions, you wish to have a **Doc** number different from the automatic one, you need to create a row containing the code "docnum" in the **Doc** column, and your desired text in the **Description** column. For the following rows, the text specified in the **Description** column, will be applied in the **Doc** column when retrieving the transactions

- **"0"** when no automatic numbering is desired
- **"1"** progressive numbering
- **"cash-1"** progressive numbering with the prefix "cash-" (cash-2, cash-3)

The program replaces the number indicated at the end of the text with the next progressive number.

If you wish the program to suggest just one row per code, the description has to be preceded by:

- An **"*"**: displays just this row and not the others with the same code.
- An **"****: displays just this row, but don't retrieve this row (only title row).
- An **"\*"** allows the user to start the description with an asterisk, without it being interpreted as a command.

It is not possible to save customized setups in the Recurring transactions table; it uses the views and columns setup of the Transactions table.

**Retrieving the recurring transactions into the Transactions table**

• Enter the date and the information of the other columns that should not be modified

• In the **Doc** column, choose one of the codes defined in the **Recurring Transactions** table and press **Enter**.
  - The program enters all the transactions with the same code, repeating the data column and other already entered values.
  - In the **Doc** column, a progressive number is being inserted or one as specified in the...
Copying transaction rows into the Recurring Transactions table

In order to copy rows from the Transactions table into the Recurring transactions table:

- In the Transactions table, select the rows that need to be copied;
- Edit menu -> Copy rows command;
- Go into the Recurring transactions table;
- Edit menu -> Insert copied rows command;

Formatting columns and views

The Recurring transactions table uses the same formats and views as the Transactions table. It is not possible to have a separate format only for the Recurring transactions table. It is however possible, from the Transactions table, to add a new View, setup a new columns format, and use this same view in the Recurring transactions table.

Bank checks

To enter issued bank checks, the user needs to insert an Issued checks account in the Liabilities.

The check is issued at the moment of paying a supplier and later on is being debited from the Bank current account.
The **Issued checks** account card after the transactions.

**Credit card registration with advance payment**

**Advance payment on Credit cards**

Before taking you through the procedure, check that an account for Credit card exists in the liabilities part of the Chart of Accounts. Create it if that is not the case.

The credit card account is added to the group or sub-group of short-term debts, as long as this is prerequisite in the chosen Chart of Accounts. If there are no sub-groups, it must be listed in the liabilities section.

**Example:**

As per 10.01.2019 Frs 1'000 are transferred from the bank account to the credit card.

- The bank account is credited and the Credit card account is debited.
Register your credit card bill

Upon reception of the credit card bill, you must record all the costs listed on the credit card.

Example:

On 15.02.2019 we receive the January credit card bill for a total of Frs 790 (details: 560 Frs for computer purchases, Frs 150 for hotel expenses, Frs 80 purchase of office supplies) (Doc.25)

- It will be registered on several lines. All the costs relating to the expenses listed in the credit card are recorded in the Debit column; we register one expense per row; in Credit, the credit card account is registered (total of the bill).

Check the credit card account balance

Each time you pay an advance towards the credit card and once all the costs listed on the credit card have been recorded, you must verify that the credit card balance matches the balance stated on the credit card.

Importing transactions from your credit card

Banana accounting allows the importation of movements from the credit card into the main accounting file.
A couple of requirements are necessary to perform the import:

- The giro account must have been set up in the Plan of Accounts.
- The format of data provided by the credit card issuing bank must be compatible with the formats provided by Banana Accounting.

To find and determine the formats you need to:

- Open BananaApps in the Account menu, Import to accounting ..., click Manage Apps..., button, select import.
- Select the bank that issued the credit card and click on the Install button. The format will be displayed in the Import to Accounting dialog.

When data from the credit card, and even bank transactions, are imported, the problem of recorded down payments needs to be addressed. In this case, two registrations are created on the credit card account:

- Presence of a credit card account as a counterpart to bank charges for credit card payments.
- Presence of the credit card account in the movements imported from the credit card.

To avoid any overlap, the giro account is used at the moment of import.

How to perform the import:

- Select Transactions in the Import to accounting... window.
- Select the type of format of the credit card issuing bank.
- Using the Browse button, select the file provided by the bank and confirm with OK
- Enter the period and indicate the giro account. Confirm with OK. All movements will be imported into the transactions table.
- Indicate the Cost centre for each row.

Printouts

Enhanced Balance sheet with groups - colored columns

This example has been realized with the following features:

- Enhanced Balance sheet with groups
- Columns setup to indicate which columns are to be displayed (in the example the columns of the Current and the Preceding year are being displayed)
- Colors (Column properties) to indicate the color of a column.
Profit & Loss Statement with budget

This example has been realized with the following features:

- **Enhanced Balance sheet with groups**
- **Columns setup** to indicate which columns are to be displayed (in the example the columns of the Current year, the Budget and the Preceding year are being displayed)
- **Colors (Column properties)** to indicate the color of a column.

Enhanced Balance sheet

This example has been realized with the following features:

- **Enhanced Balance sheet- Base tab**
- **Style setup** (for this printout the Berlin style has been chosen)
Subdivision by quarter

This example has been realized with the following features:

- **Enhanced Balance sheet with groups**
- **Subdivision -> Subdivision by period** in order to set up the subdivision by period
- **Columns setup** to indicate which columns are to be displayed
- **Colors (Column properties)** to assign different colors to the columns.

Subdivision by segment

This example has been realized with the following features:

- **Enhanced Balance sheet with groups**
- **Subdivision -> Subdivision by segment** in order to choose the segment level to be displayed.
- **Print style**
  When printing the segments, it is not possible to set up the colors of the columns.
Pdf dossier with all the accounting data

The file is being created with a summary that gives access to the different printouts in an easy way.

The following data can be saved in PDF

- Balance sheet and Profit & Loss statement
- Accounts table, Transactions, VAT Codes, Totals
- VAT reports
- Account cards

If you save this file on a non-rewritable CD (to keep together with your accounting documents), this satisfies the legal requirements for archiving the accounting data.

This example has been realized with the following features:

File menu, Create Pdf dossier command

Printing an extra column

In order to print, in the Balance sheet, an extra column, the following features have been used:
• **Columns setup**, Data menu, in order to display or add a new column in the Accounts table
• **Enhanced Balance sheet with groups**
• **Columns - advanced**, to make the column visible.

**Enhanced Balance Sheet**

• The Balance Sheet represents all the Assets, Liabilities, Expenses and Income in a specific moment. The difference between Assets and Liabilities gives the personal capital.
• The grouping of the accounts is done according to the contents of the **BClass** column.
• The Enhanced Balance Sheet, shown in the preview, can be saved in different formats (PDF, HTML, MS Excel) and can be copied in the clipboard.
• In order to calculate, display and print it at the end of year or the end of a period, activate the **Enhanced balance sheet** command from the **Account1** menu.
• Transactions without date are being considered as opening transactions and will not appear in the printouts of the Profit & Loss Statement.

**Including a logo in the Enhanced Balance Sheet**

From the Banana **version 9.0.3** it is possible to include a logo and to define its settings (width, height, position) from the **File** menu > **Logo setup** command. It is also possible to create and save **Compositions** with different logo settings.

This feature is a simpler alternative to the logo setting with the **Documents Table**.

From the following window several printing options can be activated, appears.
See also **Print Examples**.
Page header

Rows 1 thru 4
In this field, enter texts to use as headers when printing.

Print cover page / Print date / Print page numbers
The activated options will be shown in the print-out.

Column header (Balance / Profit and Loss)
The first two vertical fields refer to the Balance Sheet, the two second ones refer to the Profit and Loss Statement.

Current year
Insert the final date of the current accounting.

Previous year
In this field, enter the final date of the previous year's accounting.

Print pages / Include in printout
By selecting the appropriate cells, it is possible to choose the options that should be activated in the printouts.

Other tabs
The explanations for the other tabs are available at the following pages:

- Period
- Style
- Texts
- Margins
- Composition

Results
### ASSETS

<table>
<thead>
<tr>
<th>Description</th>
<th>31.12.2015</th>
<th>%</th>
<th>01.01.2015</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cash on hand</td>
<td>33,278.50</td>
<td>-7.1%</td>
<td>36,579.59</td>
</tr>
<tr>
<td>Bank account</td>
<td>209,452.00</td>
<td>32.4%</td>
<td>192,551.99</td>
</tr>
<tr>
<td>Bank account EUR</td>
<td>242,409.00</td>
<td>0.3%</td>
<td>251,024.99</td>
</tr>
<tr>
<td>Bank account USD</td>
<td>-7,497.08</td>
<td>0.0%</td>
<td>14,539.22</td>
</tr>
<tr>
<td>Bonds and stocks</td>
<td>6,500.00</td>
<td>2.2%</td>
<td>20,000.00</td>
</tr>
<tr>
<td>Internal transfers</td>
<td>403.00</td>
<td></td>
<td>500.00</td>
</tr>
<tr>
<td>Due from clients or debtors</td>
<td>-58,746.00</td>
<td>1.1%</td>
<td>-26,146.00</td>
</tr>
<tr>
<td>Provision for doubtful debts</td>
<td>-3,100.00</td>
<td>0.4%</td>
<td>-3,100.00</td>
</tr>
<tr>
<td>Advances and loans</td>
<td>9,900.00</td>
<td>0.8%</td>
<td>9,900.00</td>
</tr>
<tr>
<td>Withholding tax</td>
<td>7,650.00</td>
<td>0.4%</td>
<td>5,650.00</td>
</tr>
<tr>
<td>Receivables from social insurance and social security institutions</td>
<td>9,500.00</td>
<td>1.2%</td>
<td>9,500.00</td>
</tr>
<tr>
<td>Source tax</td>
<td>6,000.00</td>
<td>0.6%</td>
<td>6,000.00</td>
</tr>
<tr>
<td>Various short-term receivables</td>
<td>2,600.00</td>
<td>0.2%</td>
<td>2,600.00</td>
</tr>
<tr>
<td>Goods for resale</td>
<td>23,500.00</td>
<td>3.1%</td>
<td>27,500.00</td>
</tr>
<tr>
<td>Raw materials</td>
<td>9,123.00</td>
<td>0.7%</td>
<td>66,123.00</td>
</tr>
<tr>
<td>Auxiliary material</td>
<td>993.00</td>
<td>0.1%</td>
<td>993.00</td>
</tr>
<tr>
<td>Consumables</td>
<td>1,300.00</td>
<td>0.2%</td>
<td>1,300.00</td>
</tr>
<tr>
<td>Finished products</td>
<td>10,000.00</td>
<td>1.0%</td>
<td>10,000.00</td>
</tr>
<tr>
<td>In-process products</td>
<td>8,300.00</td>
<td>0.7%</td>
<td>8,300.00</td>
</tr>
<tr>
<td>Non-inventor services</td>
<td>9,650.00</td>
<td>1.2%</td>
<td>6,650.00</td>
</tr>
<tr>
<td>Prepaid expenses</td>
<td>1,200.00</td>
<td>0.1%</td>
<td>1,200.00</td>
</tr>
<tr>
<td>Accumulated income</td>
<td>9,920.00</td>
<td>0.8%</td>
<td>9,920.00</td>
</tr>
<tr>
<td>Bonds and stocks</td>
<td>7,650.00</td>
<td>0.4%</td>
<td>7,650.00</td>
</tr>
<tr>
<td>Investments</td>
<td>17,000.00</td>
<td>2.2%</td>
<td>17,000.00</td>
</tr>
<tr>
<td>Machinery</td>
<td>2,500.00</td>
<td>0.3%</td>
<td>7,000.00</td>
</tr>
<tr>
<td>Office furniture and equipment</td>
<td>10,000.00</td>
<td>1.3%</td>
<td>10,000.00</td>
</tr>
<tr>
<td>Office machinery, information and communication technology</td>
<td>9,600.00</td>
<td>1.1%</td>
<td>9,600.00</td>
</tr>
<tr>
<td>Motor vehicles</td>
<td>8,900.00</td>
<td>1.0%</td>
<td>8,900.00</td>
</tr>
<tr>
<td>Tools and equipment</td>
<td>9,600.00</td>
<td>1.2%</td>
<td>9,600.00</td>
</tr>
<tr>
<td>Patents, know-how, licences, rights and development</td>
<td>29,979.94</td>
<td>3.9%</td>
<td>29,979.94</td>
</tr>
<tr>
<td>Share capital rights not paid or non-paid Foundation capital</td>
<td>20,000.00</td>
<td>2.6%</td>
<td>20,000.00</td>
</tr>
<tr>
<td><strong>TOTAL ASSETS</strong></td>
<td>822,736.86</td>
<td></td>
<td>799,005.96</td>
</tr>
</tbody>
</table>

### LIABILITIES

<table>
<thead>
<tr>
<th>Description</th>
<th>31.12.2015</th>
<th>%</th>
<th>01.01.2015</th>
</tr>
</thead>
<tbody>
<tr>
<td>Suppliers or creditors</td>
<td>39,110.00</td>
<td>4.4%</td>
<td>29,150.00</td>
</tr>
<tr>
<td>Deposits received</td>
<td>8,000.00</td>
<td>0.7%</td>
<td>6,100.00</td>
</tr>
<tr>
<td>Due to banks short-term</td>
<td>20,000.00</td>
<td>2.3%</td>
<td>20,000.00</td>
</tr>
<tr>
<td>VAT according to VAT report</td>
<td>179,732.86</td>
<td>2.2%</td>
<td>83,136.86</td>
</tr>
<tr>
<td>Other short-term liabilities</td>
<td>21,010.00</td>
<td>2.6%</td>
<td>21,010.00</td>
</tr>
<tr>
<td>Accrued expenses</td>
<td>2,500.00</td>
<td>0.3%</td>
<td>2,500.00</td>
</tr>
<tr>
<td>Short-term provisions</td>
<td>10,000.00</td>
<td>1.2%</td>
<td>10,000.00</td>
</tr>
<tr>
<td>Due to banks</td>
<td>29,000.00</td>
<td>3.5%</td>
<td>29,000.00</td>
</tr>
<tr>
<td>Financial leasing commitments</td>
<td>9,900.00</td>
<td>1.1%</td>
<td>8,900.00</td>
</tr>
<tr>
<td>Debenture loans</td>
<td>5,900.00</td>
<td>0.7%</td>
<td>5,900.00</td>
</tr>
<tr>
<td>Other long-term debts (non-discounted)</td>
<td>22,960.00</td>
<td>2.8%</td>
<td>22,960.00</td>
</tr>
<tr>
<td>Provisions</td>
<td>13,070.00</td>
<td>1.6%</td>
<td>13,070.00</td>
</tr>
<tr>
<td>Equity partner A at the beginning of the year</td>
<td>78,500.00</td>
<td>9.5%</td>
<td>70,000.00</td>
</tr>
<tr>
<td>Contributions to equity/equity withdrawals partner A</td>
<td>20,000.00</td>
<td>2.4%</td>
<td>20,000.00</td>
</tr>
<tr>
<td>Private account partner A</td>
<td>20,000.00</td>
<td>2.5%</td>
<td>20,000.00</td>
</tr>
<tr>
<td>Profit / Loss for the year partner A</td>
<td>10,000.00</td>
<td>1.2%</td>
<td>10,000.00</td>
</tr>
<tr>
<td>Equity sponsor A at the beginning of the year</td>
<td>58,020.10</td>
<td>7.2%</td>
<td>89,020.10</td>
</tr>
<tr>
<td>Contributions to equity/equity withdrawals sponsor A</td>
<td>15,900.00</td>
<td>1.9%</td>
<td>15,900.00</td>
</tr>
<tr>
<td>Private account sponsor A</td>
<td>30,000.00</td>
<td>3.6%</td>
<td>30,000.00</td>
</tr>
<tr>
<td>Profit / Loss for the year sponsor A</td>
<td>12,000.00</td>
<td>1.5%</td>
<td>12,000.00</td>
</tr>
<tr>
<td>Profit and Loss</td>
<td>22,000.00</td>
<td>2.7%</td>
<td>22,000.00</td>
</tr>
<tr>
<td><strong>TOTAL LIABILITIES</strong></td>
<td>822,736.86</td>
<td></td>
<td>799,005.96</td>
</tr>
</tbody>
</table>
Enhanced Balance Sheet with groups

The Balance sheet with groups differs from the Balance sheet for the following characteristics:

- Includes also subgroups in the printout, as in the chart of accounts (and not only groups).
- Offers the possibility to exclude groups or accounts (for instance, to display only the total of the group and not the accounts of which the total is composed).
- In the Chart of accounts - Sections it is possible to select which accounts to include or leave out in the printouts
  - It is possible to choose, for a given period, what kind of subdivision you want (for example in the first semester, you can choose whether to obtain the data by month or by quarter)
  - It is possible to have a subdivision by segment
  - ... and much more!

In order to calculate, display and print the Enhanced Balance sheet by groups, click on the Enhanced balance sheet with groups command from the Account1 menu; a window appears, with different sections that allow the user to define the print setup.

See also Print Examples.

FAQ

- If I exclude the groups with a zero balance, the title rows that refer to the excluded groups are still being displayed; how can I erase them?
  
  Go to Sections and activate Hide current row on the title rows that you wish to exclude.

- I would like to exclude the display of the period in the titles of the printouts ("1st Semester 2013"); how can I do it?
Go to the **Headers** section and deactivate the **Print period** option.

- **On the cover page, when there are long titles, I would like to be able to choose how to subdivide the texts on two rows and whether I wish to apply bold print. Is it possible?**

  It is impossible to change the fonts on the cover page.

- **Some amounts are not included in the indicated period. Why?**

  Transactions without a date are being counted as openings and do not appear in the printouts of the Profit & Loss statement. Be sure to enter the date into all the transactions.

- **The Total groups that contain all the accounts of the classes 3 and 4 are being renamed with the text Profit or Loss, depending on the result of the accounting period. Can I change that?**

  Go to the **Sections** and overwrite the original text in the **Alternate text zone** of the active row.

- **In case the Show previous year option is being activated, and in the previous year file there are groups that are no longer present in the current year, the program will give error messages. Can I do something about it?**

  In order to print the Balance sheet with data of the previous and the current year, the groups of the previous year have to also be present in the current year.

**Headers**

**Header 1, Header 2, Header 3, Header 4**

Enter as headers the text you wish appearing in the printouts. They will be on the cover page and on each page headings.

**Print period and/or subdivision**

This option is active only when a specific period has been defined. When you deactivate this option, the period will not be indicated in the titles of the printouts.
**Footer**

**Print page numbers**
By activating this function, page numbers will be printed.

**Print date**
By activating this function the date will be printed.

**Print cover page**
By activating this function the cover page will be printed.

**Logo**

From the Banana version 9.0.3 it is possible to include a logo and to define its settings (width, height, position) from the File meu > Logo setup command. It is also possible to create and save Compositions with different logo settings.

This feature is a simpler alternative to the logo setting with the Documents Table.

When you print the Balance sheet with groups - Account1 menu -> Balance sheet with groups command, Header and footer tab -> Header, as Logo you can select your own image (with the Edit button), instead of the none option.
Zoom
The printout layout will change according to the entered value.

Page orientation
You can select the page orientation: automatic, landscape and portrait.

Margins
Top, Bottom, Left, Right
It's the distance between the page border and the content.

Header
It's the distance between the page header and the content.

Footer
It's the distance between the page footer and the content.

Increase margins to printable area
If the content exceeds the page margins it will be automatically adjusted to fit the printable area.

Sections
This section can vary depending on the settings of the Section column of the accounting plan - See the related document: Sections in the accounting plan

**As on Accounts table**

The display and the printout settings of the Enhanced Balance Sheet with groups, are the same as in the Accounts table. Depending on the selection, there are different sections with different options:

- sections 1, 2, 3, 4, 01, 02, 03, 04... refer to the main items of the Balance Sheet
- account sections refer to the selected account
- group sections refer to the selected group

**Section***

If you select a section with an asterisk, you will have the following options:

- Hide section
- Hide current row
- Start on new page
- Alternative text

**Hide section**

Click on the section that you wish to hide.
**Hide current row**
Click on the row that you wish to hide.

**Start on new page**
Click on the header that you want to have on a new page and activate the option.

**Alternative text**
Enter an alternative text if you want to have a different one for the selected section or row.

If you select a number or a group section (1, 2, 3, 4.....), there are extra options:

**Group for % calculation (%)**
This option is visible when selecting a section (Assets, Liabilities, ...). It is possible to indicate which group the % calculation should be based on.

**Hide child rows**
If you select a group and you activate this function, child rows of this group won't be printed in the Enhanced Balance Sheet.

**Show as account**
If you select a group and you activate this function, the group will be displayed as an account in the Balance sheet.

**External accounting report**
Print the Enhanced Balance Sheet by groups, based on the structure of the Accounting report file.
Report File
You can select the file of the External Accounting report with the **Browse** button.

Grouping column
Column in which the accounts refer to the groups defined in the External Accounting report. Available columns: **Gr1, Gr2, Gr, BClasse and GrVat.**

Signal missing grouping
Checks whether all accounts belong to a group in the External Accounting report.

Rows
Accounts, accounts with zero balance, accounts with transactions, groups with zero balance, empty rows.
By activating the different options, you can include them in the printouts.
Balance Sheet, Profit & Loss Statement and Notes

You can choose the options you wish to include in the Balance Sheet, in the Profit and Loss Statement and in the Notes:

- **Account number**
- **Current**: the balance or movement in basic currency referred to the selected period or period subdivision
- **Foreign currency**: the balance in the account currency referred to the selected period or period subdivision
- **% of row**: includes the column with the percentage referring to the total (for example, % total Assets)
- **Opening**: opening balance at the beginning of the period
- **Budget**: budget amount referred to the selected period or period subdivision
- **Previous period**: the amount of the period previous to the selected period or period subdivision
- **Previous year**: the amount of the same period in the previous year
- **Difference**: the difference between the amounts of the current period and the other column (Budget, Previous period, Previous year)
- **% Difference**: is the difference, expressed in percentage, between the current period and the other column (Budget, Previous period, Previous year)
- **Year-to-date**: the balance or movement from the beginning of the accounting until the date of the last transaction.

Headers editing, color or display change of the columns

Each section has the Advanced button from where it is possible to change the column's settings and options.
Columns (Advanced)

By pressing the **Advanced** button, it is possible to change the column's header:

- **in order to make the column visible in the printout**, check the corresponding checkbox
- in order to change the sequence of the columns, drag up or down the name of the column you wish to move, or use the **Move Up** and **Move Down** buttons
- In order to add new columns to be shown in the report (choosing them from a list) use the **Add** button
- In order to remove some columns from the list, use the **Remove** button
- In order to edit the display properties of a column (**colors**, headers, etc.) use the **Properties** button

**Headers and options (Columns properties)**
Headers

Row 1 / Row 2 / Row 3
It is possible to change the columns headers by selecting the Text option (from the drop down menu) and by entering the new header. If you select the Column option, the column name of the selected column will be shown.

Options

Visible
If this cell is activated, the column header will be shown.

Display as a total column
If activated, this option only shows the amounts in the Totals column.

Columns - add

Add / Delete

In the Balance sheet, Profit and Loss Statement and in the Notes, it is possible to add new columns (from the ones included in the list), or to delete the undesired ones. Starting from the Account1 menu -> Enhanced Balance sheet with groups -> Columns -> Advanced button -> Add button.
If one or more options are being activated, the program includes:

**Accounts Table Columns**

If you click on the header a list of all the columns of the Accounts Table will be shown:
You can then include in the printout any column existing in the Accounts Table

**Accounting amounts**

These are the columns with the amounts calculated by the program, the opening balances and the entered transactions, for the indicated period or for the subdivision period

**Amount in the Account currency**
The account balances in foreign currencies will also be displayed.

**Current**
The balances of the current year will be displayed.

**Opening**
The Opening balances will be displayed.

**Previous (period)**
The balances of the previous period are being displayed (month, quarter, semester, etc).
**Previous Year**
The balances of the previous year are being displayed.

**YTD (Year To Date)**
This column is only available in the Profit & Loss Statement. The balances from the beginning of the year until the last transaction date are being displayed.

**Budget amounts**
See also [Budget information](#). These are the columns with the amounts calculated by the program based on the budget amounts entered in the Accounts Table or in the Budget Table. If you created the Budget table and if some rows have been entered, the program will use the data of this table for its calculation, even if there are values in the Budget column of the Accounts Table.

**Budget (Current period)**
The amounts related to the foreseen budget of the current period are being displayed.

**Budget Previous**
The amounts related to the foreseen budget of the previous period are being displayed.

**Budget Previous Year**
The amounts related to the foreseen budget of the previous year are being displayed.

**Notes on calculation period**
The program cannot calculate amounts for periods overlapping between several accounting years or years with [initial and final accounting dates that do not match](#).

**Colors (Columns properties)**
You can access this window by pressing on the Properties button, Colors tab (from the Enhanced balance sheet by groups command - Columns, from the Account1 menu)

**Change**
With this button you can change the text or the background color

**Default color**
With this button you can restore the default color for the text or the background.

**Subdivision**

From the Account1 menu choose the Enhanced Balance Sheet with groups command and select the Subdivision tab.

**None**
The whole period is shown.
Subdivision by period
This function makes it possible to display the dates of the selected period per day, month, bi-monthly, per quarter, per 4 months, per semester or per year. The selected period will be shown in the column headers.

Only segment
Only the data related to the selected segment are being shown.

Create periods for the whole year
When the accounting period is not the same as the solar year, but when the user still wants to see all months, this function needs to be activated.

Totals column
This function creates a Totals column for the selected periods in the Profit / Loss Statement and in the Totals view of the Accounting reports command (Account1 menu).

Max number of divisions
The default maximum number of periods is 36. In particular cases, if the user would want to obtain special and very detailed statistics over a long time span, this value can be changed manually. A very high maximum number of periods can slow down the program.
**Subdivision by segment**

The data related to the selected segment are being shown. This option is only available if segments have been set.

- Select all - all options will be selected
- Void - only the amount not assigned to any segment is shown
- Segments subdivision - Each subdivision will have the header given in the accounting plan. The data of the selected subdivision are shown.

**Totals column**

When this option is being activated, the totals for the selected segment will be obtained.

**Segment header**

You can choose the text to be displayed as column header for the segments.

**Period**

Explanation on the Period tab are available at the following link:


**Style Tab**
Use style
There are different models of the Enhanced balance sheet provided. By selecting one, the user can obtain the Enhanced balance sheet of his choice.

Style property
For each style, the color of the fonts and the backgrounds can be defined.

Value / Change... / Default
These functions allow the user to change style or to restore the default style.

Ignore line formatting
If this function is activated, the formatting will not be maintained.

Number formats
**Divide by 1'000**
If there are big amounts, by activating this option, three zeros will be taken off.

**Show cents**
By activating this option the cents will be shown.

**Show zero amounts**
By activating this option it is possible to choose between having the zero amounts shown with the **0,00** number or with the **-,,-** symbol.

**Negative numbers**
Negative amounts can be shown with a minus sign before the amount, after the amount or the amount can be shown between parenthesis. You can also activate the option to have the negative numbers shown in red.

**Texts**
This tab is used to alter the texts of the program columns headers for print-outs.

In order to change the Value column you just have to double-click on the cell you want to edit.

Attachments

This sections allows you to add text that will be printent with the Balance sheet and Profit & Loss statement.

- texts are printed after the Balance sheet and Profit & Loss statement.
- each document begins on a new page
Documents

All documents listed in the Documents table (Html or text format) are listed here.

- You can change the report sequence, just by dragging the item with your mouse
- All documents with a check mark will be printed.

Edit...

A text editor will open allowing you to enter new text or edit the existing one.

Add

This button will open a text editor where you can add new text.
If you haven't created the Documents table yet, the program will automatically add it.

Remove

This button will remove the selected element and its content.

Notes

- This feature is not available in previous versions.
  If the file is open with a previous version of the Banana Accounting software, you will get a
message that the file is not totally compatible.

- If you edit this section and you press **OK**, in order to undo the operation you need to give the **Undo** command more than once.

### Composition

Explanations on the Composition section are available at the following link:

http://doc8.banana.ch/en/node/2768

### Journal

With Banana Accounting the Journal corresponds to the **Transactions** table. It is possible to print the whole journal or just a part of it, selecting the rows that you wish to print.

In order to personalize the journal printout you can change the columns order and headings: you can find all the information on how to proceed in the **Columns setup** page; you can also choose several options in the printout; please visit the **Page setup** page.

There are different ways to print:

- place yourself in the **Transactions** table and click on the **Print** icon
- place yourself in the **Transactions** table and launch the **Print** command from the **File** menu
- from the **Account1** menu click on the **Print journal by period** command; in this case you should then indicate if you wish to print the whole table or just a specific period
The information on the **Period** tab are explained in detail in the **Period** page of the General settings.

In the **Sort column** tab in is possible to choose the criteria the journal should be sorted and printed.

**Accounting report**

- This command allows the user to visualize the amounts of accounts with a specific grouping, for a specific period or with a specific subdivision.
- In order to calculate, obtain and print reports, choose the **Accounting reports** command form the **Account1** menu.
- Transactions without date are being considered as opening transactions and will not appear in the printouts of the Profit & Loss Statement.

**Include a logo in the accounting report printout**

From Banana Accounting 9 it is possible to include a logo in the accounting report printout as well. After obtaining your accounting report, go to **File** menu -> **Print preview** command. From the print preview click on the the Setup icon, and in the dialog window that will open, in the **Logo** option, select your logo instead of the none option.
You can also check the [how to setup a logo](#) page.

Base tab

**Report**
You can select the desired grouping scheme:

- **As on Accounts table** - the Report will show a list of all accounts just as in the Accounts table with the Opening balance and Balance columns
- **Accounts by class** - the Report will show the list of the accounts but without subgroups
- **External accounting report** - the Report will show the data according to a grouping system preset in a separate file ([File menu, New command, Double-entry accounting](#) group, Accounting Report).

**Options**
You can select the accounts to be included or excluded:

- **Show group totals only** - only the group totals will be shown
- **Include accounts with transactions** - only accounts with transactions will be printed
- **Include accounts with 0 balance** - accounts with zero balance will be printed as well
- **Exclude groups without accounts** - groups that contain only accounts with zero balance will not be printed.

**Other tabs**

The explanations for the other tabs are available at the following pages:

- [Period tab](#)
- [Subdivision tab](#)
- [Composition tab](#)
Report result

A new table is created where the results are shown.

Account/Category cards

The account card gives a complete list of the accounting transactions for one or several accounts, cost centers, segments and groups.

Opening the Account card

There are two methods to open an account card or a category card:

- Select the **Account/category Card** (Cash book and Income & Expense accounting) command or the **Account card** (Double-entry accounting) command of the **Account1** menu in order to open and print several or all account cards.
- On the account number cell there is a **small blue symbol**; click on it just once in order to obtain the account card.

The groups of the Chart of accounts have the same symbol available as well, in order to display the account card.

Updating the accounting card

The account card table is temporary and it is calculated when the command is given to do so. If, in the Transactions table, transactions are altered or added, they are not automatically updated on the account card - the user needs to select the **Account Cards** command again or click, in the Transactions table, once more on the account number's blue symbol, or in case the account card is still open, click on the small **Refresh** button on the right side (see image hereunder).
Note:

It is not possible to modify the data in the Account card. Double-click on the row number to go back to the original corresponding row of the Transactions or Budget table.

The AccountSelected column

In the AccountSelected column, which can be made visible, starting from any Account card, through the Data menu -> Columns setup, the account on which the transaction took place is being displayed.

When you get an account card of one or more accounts, groups and segments, you will see the exact account that has been used.

The contra account in the account cards

In the Account cards, the Contra Account column (C-Acct.), which indicates the account that completes the transaction, is being shown.

When there are transactions on multiple accounts (transactions on multiple rows) as in the example hereunder, and there is one account entered in debit and several accounts in credit, or the other way around, the software deducts the possible contra account using the following logic:

- In the first transaction row, the 1020 account is considered the common contra account of the transactions that follow.
On the Account card 1020, the composed transaction (Payment various invoices) shows the contra account indicated by the [*] symbol. It is impossible to have the indication of the contra accounts directly in the account card, because the account has several contra accounts (4500, 6700, 6700). For this reason the program indicates the [*] symbol in the C-Acct (Conta-Account) column, which means that we are dealing with a transaction on multiple accounts.

On the Account cards of the next transaction rows (4500, 6700, 6700), the common contra account is indicated between square brackets ("[1020]"), and indicates a deducted contra account.

Cards of groups and classes

In the Account card of a group or a class, all the transactions of the accounts that belong to the selected group or class are being grouped together. The accounts of the group or the class can be displayed by making the AccountSelected column visible.

Print all account cards

To print the Account cards:

- **Account1** menu, **Account cards** command
- By means of the **Filter**, all the account cards that need to be printed completely or partially (for
example, only accounts, cost centers, segments) can be automatically selected

- In the various sections **Period, Options, Composition**, activate the desired options (for ex. period, 1 account per page, ...)
- Press **OK** to confirm, after having selected the desired options.

For the explanations of the different tabs, please visit the next few pages: Accounts/Categories tab, Period and Options.

The program will show the selected account cards.

In order to print, choose the **Print** command from the **File** menu.

When you have activated the **Budget** table in your file, you may choose which transactions you want to see (actual transactions or budget transactions).

### Include a logo in the account cards

From Banana Accounting 9 it is possible to include a logo in the account cards printout as well. After obtaining your account cards details (with the **Account1 -> Account cards** command), go to **File** menu -> **Print preview** command. From the print preview click on the the Setup icon, and in the dialog window that will open, in the **Logo** option, seleg your logo insted of the none option.

You can also check the how to setup a logo page.

### Save the settings

In case you regularly print the account cards of specific accounts, for example, all those that concern the Sales accounts, it is useful to create a specific composition.

- Go to the **Composition** tab
- Create a new composition, using the **New** button
- Indicate the name of the composition, for example "Sales accounts", in the **Description** field of the window
- Select the accounts that you want to be printed.
Every time you wish to print these accounts, you can select the composition that you created.

**Page setup**

In **Page setup**, you can specify the margins & other settings of the page.

**Accounts/Categories tab**

You can access this windows by choosing the **Account1** menu -> **Account cards** command (see the **Account cards** page)

**Search**

Enter the account or the description in order to filter the accounts list.

You can also enter the account to be displayed with segments.

Accounts and segments can be combined (see developer explanations):

- **10000:01** will show all transactions of the 1000 account with the 01 segment.
- **1000|1001** will show the transactions for account 1000 and 1001.

**Accounts**

The list of all available accounts appears.

If you wish to print one or more account cards activate only the desired accounts.

- **(Select All)**
  By activating this option, all the accounts that are part of the Chart of accounts are
automatically selected.

- **Filter**
  This function allows you to filter all account cards or just a selection, specifically:
  - Accounts, cost centre and segments - if no selection is made they are filtered by default
  - Accounts/categories (existing cost centres and segments are excluded)
  - Accounts, Cost centres (only segments are excluded)
  - Cost centres (accounts and/or categories and segments are excluded)
  - Segments (accounts and/or categories and cost centres are excluded)
  - Groups - existing groups will be shown - you need to select the ones to be printed
  - Classes - all classes will be shown - you need to select the ones to be printed.

**Actual or Budget**

When you have activated the Budget table in your file, you may select:

- **Actual transactions**
  The entries in the Transaction tab will be processed.
- **Budget transactions**
  The entries in the Budget tab will be processed.
  In the absence of the Budget tab, the amounts in the budget column of the account card, will be converted to monthly amounts on the basis of the opening and closing dates of the accounting file (if this one year, will be devided by 12 monthly instalments).

**Differences in accounting entries (account card 00)**

If differences in accounting entries occur (refer to the DEBIT - CREDIT difference error page), open the Group 00 account card (or the one in your Chart of Accounts that contains all the accounts of BClass 1,2,3,4).
You will have a list of all transactions with the successive balances, which after each entering should equal zero. The row which balance is not at zero contains the error.
**Period tab**

The explanations of the Period tab are the same as those for the [Save file in Pdf - Period tab](#).

**Options tab**

![Account/Category cards](image)

**Lines before end of page**
This function was created in order to avoid printing an account partially on one page and partially on the following. If the account card to be printed doesn't have at least a number of lines correspondent to the number input in this field, printing the whole card will be moved to the next page.

**One account per page**
By activating this function, each card will be printed on a separate page (even those with few transactions).

**Repeat column's headers**
By activating this function, the column headers will be repeated for each account, within the page.

**Include accounts with no transactions**
By activating this function, cards without transactions will be printed as well.

**View**
You can select the columns view to be included in the account cards display and printout:

- Base
- VAT
- Cost centers
- Expiration dates

If no criteria is specified the program will keep the order present in the transactions table.

**Sort column**
In the account card, transactions can be sorted according to different data criteria:

- Document date
- Value date
- Expiration date
- Payment date

**End of Year PDF printouts**

From the print preview of a document, you can save in PDF format and print.

You can save in a PDF format the following documents:

- Balance sheet and Profit and Loss Statement
- Accounts, Transactions, VAT, Totals tables
- VAT Reports
- Account cards

This PDF file will have an index that will allow to access easily the different printouts.
If you save this file on a non rewritable CD (to be kept along with the accounting documents), you will meet the law requirements for accounting data archiving.

**End of the Year closure and New Year**

At the end of every accounting year, before printing and filing the Balance Sheet and the Profit & Loss Statement, it is necessary to recheck the accounting file.
Please visit the [Recheck the accounting](#) page.
Tax aspects

Before closing the accounting, it is necessary to proceed with a series of operations that have fiscal implications. The merchandise account needs to be adapted, the transactions for depreciations need to be entered, the accrued income and liabilities, the VAT declaration needs to be completed, establish how and unto which accounts the profit or loss has to be attributed and there are many other operations for verification and checking.

From the program's point of view, there is no difference whether the profit is high or low. However, from a fiscal point of view, it implies a lot. These aspects need to be verified with your own tax advisor or accountant. It can be very useful, especially when you manage an accounting for the first time and before you proceed with the closing of the books, to consult a specialist in order to understand what is required. The accountants are very busy at the beginning of the year and during the period preceding the deadline for the tax declaration. It can therefore be useful to meet with your accountant - or send him the accounting file - a few months before the closing of the books, so that you can inform yourself on how to proceed.

Create a New Year

In order to start recording in the new year, with the Create New Year command of the Account2 menu and starting from the current year's file, a new accounting file is being created. Once the new year has been created and the file has been saved under a new name, the user can work in the file of the new year, but also in the one of the preceding year.

You can thus create the file of the new year, even before having closed the year in which you are still working. After having entered the last modifications in the previous year, use the Update Opening balances command of the Account2 menu, to retrieve the opening balances and again attribute the profit of the last year.

Performed Operations

The Create New Year command:

- Creates a new file (with no name) with the chart of accounts and all the settings identical to your current file, but without transactions.
- Copies the data from the Balance column of your current file to the Opening column of the new file (only for the selected classes)
- Adds the selected amount to the opening balance of the Profit or Loss from previous year account(s) in the new file.
- Copies the data from the Balance column of your current file to the Previous Year column of the new file (for all the accounts).
- Updates the opening and closing dates in the File and accounting Properties of the new file.
- In the Multi-currency accounting, enters the closing exchange rates of the previous year as opening exchange rates.

Create New Year command

- Open the current file and click on the Create New Year command from the Account2 menu: a window, that shows a difference corresponding to the profit or loss that has not yet been allocated, will appear. There may also be differences due to accounting errors.
From the list that appears, the user can select the account to which the result of the accounting period has to be allocated, or one can directly confirm with OK if the allocation of the result has to be postponed.

**Carry forward account opening balances**
The opening balances of the selected options are carried forward. Indicate which accounts are required to have opening balances carried forward. Usually the Profit and Loss Statements balances are not carried forward. For specific needs you can always activate the option.

**Allocation profit/loss**

**Total to allocate**
The program will indicate the profit/loss that needs to be shared between various accounts.

**Accounts/Amounts**
If only one account is selected, the amount will automatically entered. Select the account or accounts (up to three) in which the result of the accounting period has to be allocated. In case there are several destination accounts for the result of the accounting period, the amounts should be inserted manually in the different boxes. The program will automatically update the opening balances. The Total Assets will exactly match the Total Liabilities.

**Allocation of the result of the accounting period on more than three accounts.**
In this case, allocate the result of the accounting period automatically on the Profit or loss brought forward account as usual, and continue to proceed with the creation of the new year.
In the new year (new file), Transactions table, proceed with a composed transaction in order to allocate the result of the accounting period from the Profit or loss brought forward account to the different destination accounts.

- Confirm the **File and accounting properties** for the new year.
- From the File menu, activate the **Save as...** command, indicating the folder where the new accounting file needs to be saved.

**Updating opening balances command**

The **Updating Opening Balances command:**

- Retrieves the closing data of the indicated file
- Copies them as data of the previous year in the current file (see **Create New Year** command).

This command doesn't influence the already entered recordings. In fact, it is like when creating a new year, as if you are recording in the current year.

**Opening balances must be updated** in the following situations:

- When you have created the new year and afterwards you entered more transactions - or made corrections - in the previous year
- When the profit/loss of the previous year has not been allocated.

Here is how to proceed to make the update:

- Open the current year accounting file and choose the **Update opening balances** command from the **Account2** menu
- Select the previous year accounting file through the **Browse** button
- Follow the same steps as the ones of the Create New Year command (see top of the page)

![Image of the opening balances function]

**Recommended operations at year-end**

- **Create a Pdf dossier** for the entire accounting
- **Lock transactions** with the Lock transactions command
- In case of a multi-currency accounting, **record the exchange differences** at 31.12, using the official exchange rate.

**Differences in the opening balances**

*At the opening of the Accounting year*, the amounts of the Total Assets should correspond to the Total Liabilities, otherwise it is not possible to have a correct balancing. You need to check that in the
information window there is no **Opening balances difference** message. If there is, you first need to correct the opening balances of the Balance Sheet so that the Total Assets balances the Total Liabilities (Opening balance column).

In the following example the program shows an error message reporting a difference of 150.- CHF.

![Opening balances difference message](image)

After having corrected the opening balances the Total Assets must correspond to the Total Liabilities.

It is also possible to check the balancing in the Totals table.

### Accounting report file

The Accounting Report is a file type in which the presentation of a report is being set up, indicating the way in which the accounts are being grouped.

Thereafter, the Accounting report can be executed through the commands of the accounting:

- **Enhanced balance sheet with groups** (Chart of accounts, Sections, External accounting report)
- **Accounting report** (External accounting report section).

The grouping system, created in this manner, can be linked to the accounting to extract and totalize
There are two ways of doing this:

- **Grouping based on the indicated groups**
  This manner is useful when one wants to group the accounts according to different criteria, for example, present the Balance sheet and the Profit/Loss statement according to a grouping system that is different than the one set up in the *Accounts* table.
  - In the Report, the grouping system is being created.
  - For each account of the *Accounts* table in the accounting, in the GR1 column (or another column), indicate the group in which the account has to be grouped.
  - When the Report is being executed, all the accounts that are marked with groups in the report file are being carried forward.

- **Grouping based on the indicated accounts**
  This manner is useful when one doesn't want a report with all the accounts but with only a few selected accounts.
  - In the Report, indicate the accounts of the *Accounts* table from the Accounting file that should be included.
  - When the Report is being executed, only the indicated accounts are being carried forward.

**How to create an Accounting report file**

In order to create an Accounting report file:

- **File** menu, **New** -> **Double-entry accounting** -> **Accounting Report**
  - It is possible to choose an existing model or get started with a new one
  - Once created, save the file under a new name.

The columns of the Accounting report

The Accounting report file includes the same columns as those in the Chart of accounts of the accounting file. They make it possible to create the groupings and the totals.
**Sections**

This column is being used to indicate the value that is to be used in the presentation.
For the different possibilities, see the documentation about the [Sections](#).

**Group**

The group in which the accounts of the accounting have to be totalized or a group of the report.

**Account (only visible in the Complete view)**

The account that has to be included in the report.

- If there are accounts, when the report is executed only those indicated will be carried forward.
- In case no account has been indicated, the accounts that have been linked through a group will be carried forward.

**Description**

Description for the grouping or of the row itself.

**Gr**

In the Gr column, one indicates the total in which the row has to be totalized.

**Tot**

If the word “Yes” is being entered, only the Total row is being displayed and not the accounts that are a part of this total.

Please look at ‘Show groups' totals only' in the [Accounting report](#).

**Keep**

Usually, the totalization rows that have accounts with balances are included in the report.

If you indicate “Yes” in this column, the row is in any case always displayed. This can be applied to both the totals and to the accounts.

**With mov.**

This applies to groups that have a zero balance.
The row will only be displayed if there have been transactions (movements) during the time period.

Creating a Report linked through the group

- In the Report, create a system of groups and subgroups as desired.
- In the **Accounts** table one indicates, in the **Gr1** or **Gr2** column, the group in which the account has to be totalized.
  
  In case the **Gr1** column (or another preferred one) is not visible, make it visible with the **Columns setup** command.
- The accounts that are not being linked will not be included in the Report.
- Execute the Report through the commands:
  - Enhanced balance sheet with groups
  - Accounting report.

Creating a report that groups only some selected accounts of the accounting

This modality is active even when in the report only one account has been indicated.
Do not indicate any account, if you wish that the report is being executed in the group modality.

In the report are being indicated:

- The accounts of the accounting that have to grouped together.
  Only the indicated accounts will be included in the report.
**Multi-currency accounting**

Multi-currency accounting is based on the double-entry accounting method and can also manage accounts and transactions in foreign currencies.

Many topics of the multicurrency accounting are the same as the double-entry accounting. In order to find missing lessons or in-depth information, we advice you to consult our internet pages on the **Double-entry accounting**.

**Characteristics**

- Manages the accounts also in foreign currency.
- Calculates the conversion automatically, based on the exchange rate inserted in the Exchange rate table
- Calculates the exchange rate differences automatically
- Offers Balance Sheets and Profit and Loss Statements in a second currency as well.

In order to change from a double-entry accounting file to a multi-currency accounting file, check the **Convert to new file** command

**Information**

**Chart of accounts, file properties and exchange rates table**

We suggest to choose one of the already configured examples and to personalize it according to your needs. Please note that the chart of accounts must include the account for profit and loss from exchange rate variation and there must be accounts in foreign currencies.

- **Setup the chart of accounts**
- **Groups and subgroups**
Transactions
Accounting transactions must be entered in the same way as the double-entry accounting transactions

- Different transactions' types
- Entering exchange rate differences

Printouts

- Account cards
- Journal
- Enhanced balance sheet
- Enhanced balance sheet with groups
- Accounting reports

Conversion

In order to add multicurrency features to a double entry accounting file, please visit the Convert to new file page.

If you want to change the basic currency of an existing accounting file (for example if your accounting file is in EUR and you want it in USD), proceed as follows:

- Save the file under a different name
- In the File properties
  - Indicate the new basic currency
  - Delete the reference to the previous year file
- In the Exchange rates table enter the exchange rates referred to the basic currency
  - If there are many transactions to be converted, in the exchange table you can enter intermediate exchange rates (for example for each month, indicating the beginning of the month's date). The program will use the historic exchange rate in the transactions.
- In the accounting plan
  - Replace the old currency with the new one
    You can use the Find and Replace function also (selected area only)
  - If there are opening balances, you need to re-enter them in the new currency
  - Also the Previous year balance, budget and other columns must be converted
- In the Transactions table
  If there are transactions, you need to correct them row by row:
  - For those transactions that are already in the right currency, with the F6 key the program recalculates the amount in the new basic currency.
  - For other transactions you need to enter the right amount in the basic currency and then press F6
- In the Budget table
  Proceed just as in the Transactions table
- Use the Check accounting command, fix possible errors, and keep using the Check accounting command until there are no more error messages.
Theoretical part

In this part, the basic theoretical notions about currency exchange are being explained.

Exchange rates and accounting issues

Every nation has its own currency and to obtain another currency it is necessary to buy it using the appropriate exchange. The price of a currency compared to another is called the exchange rate. To change money means to convert the amounts of one currency to another. The exchange (exchange rate) varies constantly and indicates the rate of conversion.

For example, on January 1st

- 1 Euro (EUR) was equal to 1.32030 US Dollar (USD)
- 1 US Dollar was equal to 0.7580 Euro
- 1 EUR was equal to 1.60970 Swiss Franc (CHF)
- 1 EUR was equal to 157.2030 Japanese Yen (JPY)

Multi-currency Accounting One talks about multi-currency accounting or multi-value accounting when accounts in different currencies are kept. It is necessary to have multi-currency accounting when a company has bank, cash, and debtors’ accounts in more than one currency. Even if just one account is in a foreign currency it is necessary to administer a multi-currency accounting.

Basic Currency

The amounts referring to different currencies cannot be totaled directly. It is necessary to have a basic currency to refer to and to use for the totals. The main point of accounting is that the totals of the “Debit” balances must correspond to the totals of the “Credit” balances. To verify that the accounting is balanced, there must be a single currency with which to do the totals. If there are different currencies, the basic currency must be indicated before anything else. Once the basic currency has been chosen and some operations have been executed, the basic currency can no longer be changed. To change the basic currency, the accounting must be closed and another opened with a different basic currency. The basic currency is also used to establish the Balance Sheet and to calculate the profit or loss of the operation.

Each amount has its equivalent in basic currency

To be able to add the totals and verify that the operations balance, it is necessary to have the equivalent in basic currency for every transaction. In this way you can check that the total of the Debit entries is the same as the total of the Credit ones. If the basic currency is Euros and there are transactions in US Dollars, there needs to be an exchange value in Euros for every transaction in US Dollars. All the Euro amounts will be totaled to verify that the accounting balances.

Account currency

Each account has its own currency symbol which indicates in which currency the account will be administered. You must therefore indicate what the currency of the account will be. Each account will then have its own balance expressed in its own currency. Only entries in this currency will be permitted on this account. If the account is in Euro, then there can only be Euro entries on this account; if the account is in USD, then there can only be entries in the specified USD currency on this.
account. When you have to administer entries in YEN, then you have to have an account whose symbol is the YEN.

**Account Balance in basic currency**

For each account, alongside the balance in the account’s own currency, the balance in basic currency will also be kept, in order to calculate the balance sheet in basic currency. The account card for the USD bank account has to correspond exactly to the bank statement as far as the USD amounts are concerned. The value in basic currency will always be specified for each accounting entry. If the account is in USD, in the entries there will be, beyond the amounts in USD, also its value in EUR. The EUR balance will be given by the sum of all the entries expressed in EUR. The actual balance in basic currency will depend on the exchange rate factors used to calculate the exchange value of each, single entry to EUR.

If on a given day you take the actual balance in USD and convert it to EUR at the daily exchange rate, you will get an exchange value that differs from the balance of the account in basic currency. This difference is due to the fact that the exchange rate used for entries on a daily basis is different from the actual daily exchange rate. Thus there is a difference between the actual value at the daily exchange rate and the accounting balance in basic currency. This accounting difference is called the exchange rate difference. The difference between the balance in basic currency and the calculated value has to be registered, when the accounting is closed, as an exchange rate profit or loss.

**Balances in another currency (currency2)**

All the accounting reports will be calculated in basic currency. If you take the basic currency values and change them to another currency, you will get the balance in another currency. The program has a Currency2 column where all the values are automatically entered and presented in the currency specified as Currency2. The logic for the conversion of the amounts is the following:

- If Currency2 is the same as the account or operation currency, then the original value will be used.
- If the account is in USD and Currency2 is USD, the USD amount will be used.
- In all other cases the basic currency amount will be used and changed into Currency2.
- The daily exchange rate is used. Even for past entries, the exchange value in Currency2 will be expressed on the basis of the most recent exchange rate, and not on the historical one used on the day of the entry.

You need to pay attention to the fact that a balance converted to another currency will show small differences in the totals. Often the converted value of a total is not equal to the sum of split exchange values, as can be seen from the following example:

<table>
<thead>
<tr>
<th>Moneta base EUR</th>
<th>Moneta 2 USD</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cash</td>
<td>1.08</td>
</tr>
<tr>
<td>Bank</td>
<td>1.08</td>
</tr>
<tr>
<td>Total Assets</td>
<td>2.16</td>
</tr>
<tr>
<td>Personal capital</td>
<td>2.16</td>
</tr>
</tbody>
</table>
In the basic currency, total assets are equal to total liabilities. It is permitted to present a Balance Sheet that contains differences only if they are understandable and if it is indicated that they were due to calculations from another currency.

Accounts table, Currency 2 view

### Converting currencies

#### Variability of exchange rates

The purchase/sale of currencies occurs in a free market. The price (exchange rate) is based on the law of supply and demand. The differences in the exchange value can be more or less important according to the fluctuations of the exchange rate.

<table>
<thead>
<tr>
<th>Date</th>
<th>Exchange rate EUR/USD</th>
<th>Equivalent in EUR of USD 1000.00</th>
<th>Equivalent value difference compared to 01-01</th>
</tr>
</thead>
<tbody>
<tr>
<td>01-01</td>
<td>1.32030</td>
<td>1'320.03</td>
<td></td>
</tr>
<tr>
<td>31-03</td>
<td>1.33350</td>
<td>1'333.50</td>
<td>13.47</td>
</tr>
<tr>
<td>30-06</td>
<td>1.34750</td>
<td>1'347.50</td>
<td>27.47</td>
</tr>
<tr>
<td>30-09</td>
<td>1.42720</td>
<td>1'427.20</td>
<td>107.17</td>
</tr>
</tbody>
</table>

### The exchange rate

The exchange rate refers to the basic currency. There are always two different exchange values between two currencies, according to the currency that is used as the basic currency.

For the USD and Euro currency, there are therefore two different exchange rates:

- If the basic currency of the exchange is EUR then the exchange rate is 1.32030
  1 Euro (EUR) corresponds to 1.32030 US Dollars (USD)
- If the basic currency of the exchange is USD then the exchange rate is 0.75800
  1 US Dollar corresponds to 0.75800 Euros
In the current document, the Euro will be regularly used as the basic currency, to which other currencies will be compared.

**Inverse exchange rate**

Having the exchange of EUR/USD at 1.32030, it is possible to find the exchange rate of USD/EUR by dividing 1 by the exchange rate.

<table>
<thead>
<tr>
<th>Exchange rate</th>
<th>Inverse exchange rate</th>
<th>Inverse exchange rate rounded to 6 digits</th>
</tr>
</thead>
<tbody>
<tr>
<td>EUR/USD 1.32030</td>
<td>0.75800</td>
<td>0.758000</td>
</tr>
</tbody>
</table>

The exchange values calculated with an inverse exchange can turn out to be different from the originals because of the roundings.

<table>
<thead>
<tr>
<th>Exchange rate</th>
<th>Inverse exchange rate</th>
<th>Exchange value 10000 x original exchange rate</th>
<th>Exchange value 10000 x inverse exchange rate</th>
<th>Difference</th>
</tr>
</thead>
<tbody>
<tr>
<td>EUR/USD 1.32030</td>
<td>0.75800</td>
<td>13’203.00</td>
<td>13’192.61</td>
<td>10.39</td>
</tr>
</tbody>
</table>

Don't use inverse exchanges rates in order to avoid differences. For example, for the transition to Euros, it was prohibited to use inverse exchange rates.

**Multiplier**

There are currencies that have very large exchange rates.

Always on January 1st

- 1 US Dollar = 670,800 Turkish Lira
- 1 Turkish Lira (TRL) = 0.00000149 US Dollar (USD)

Instead of using so many zeros, it can be said that

- 1000 Turkish Lira (TRL) = 0.00149 US Dollar (USD)

In this case, the multiplier is 1000 instead of 1.

**Precision**

As a rule, an exchange rate is specified with a precision of at least 6 figures after the decimal. There are, however, cases where it is necessary to use more precision.

- 1 Turkish Lira (TRL) = 0.00000149 US Dollar (USD)

When the precision is changed and the exchange is rounded in a different way, the amounts also change. The precision with which the exchange is specified is very important.

**Lowest denomination**

For coin and paper money, especially, low denominations are used. As a rule the lowest denomination for Swiss francs is five centimes (0.05). When an exchange occurs, for example EUR/CHF:
1 EUR = 1.60970 CHF

<table>
<thead>
<tr>
<th>EUR</th>
<th>Exchange rate</th>
<th>Actual exchange value in CHF</th>
<th>Rounded to lowest CHF denomination</th>
<th>Difference</th>
<th>Effective exchange rate</th>
</tr>
</thead>
<tbody>
<tr>
<td>10.00</td>
<td>1.60970</td>
<td>16.09</td>
<td>16.10</td>
<td>0.01</td>
<td>1.61</td>
</tr>
</tbody>
</table>

**Calculation of exchange rates and values**
When the Euro is the basic currency

The exchange factor for EUR/USD is 1.32030
1 Euro (EUR) is equal to 1.32030 US Dollars (USD).

Calculation of the exchange value:
Multiply the basic currency amount by the exchange factor:

EUR 100 x 1.32030 = USD 132.03

Calculate the basic currency amount:

Divide the destination currency by the exchange rate:

USD 132.03 / 1.32030 = EUR 100

Calculate the exchange factor:

Divide the basic currency amount by the destination currency amount:

EUR 100 / USD 132.03 = 0.7574

**Exchange rates for purchases and sales**
Banks carry out the purchase and sale of currencies and maintain a margin of earnings. They apply different exchange rates depending on whether a determined value is being bought or sold.

**Sale:** the bank receives domestic money and gives (sells) foreign money.

**Purchase:** the bank receives (purchases) foreign money and gives domestic money.

**Currency exchange and banknotes exchange (premium)**

**Currency exchange:** exchange for written transactions (from one account to the other).

**Banknote exchange:** exchange for banknotes.

**Premium:** commission for converting a written amount to cash.

To exchange currency, the banks maintain a lesser margin (the difference between purchase/sale) compared to exchanging banknotes. When a written value is to be transformed (credit on the account) into cash currency, the bank applies a commission, called a premium.

**Differences when changing back to basic currency**
When an amount is exchanged into another currency, it is expected that the reverse exchange will render the same amount as it was originally.
<table>
<thead>
<tr>
<th>Basic amount</th>
<th>Exchange rate</th>
<th>Exchange value</th>
<th>Return</th>
</tr>
</thead>
<tbody>
<tr>
<td>100.00</td>
<td>1.32030</td>
<td>132.03</td>
<td>100.00</td>
</tr>
</tbody>
</table>

However, you do not always come up with the same amount when converting currency back. Because of rounding errors, there can be cases where the same return value cannot be obtained.

<table>
<thead>
<tr>
<th>Basis amount EUR</th>
<th>Exchange rate</th>
<th>Exchange value in USD</th>
<th>Return in EUR</th>
<th>Difference in EUR</th>
</tr>
</thead>
<tbody>
<tr>
<td>328.67</td>
<td>1.32030</td>
<td>433.94</td>
<td>328.66</td>
<td></td>
</tr>
<tr>
<td>328.68</td>
<td>1.32030</td>
<td>433.95</td>
<td>328.67</td>
<td>0.01</td>
</tr>
<tr>
<td>328.69</td>
<td>1.32030</td>
<td>433.96</td>
<td>328.68</td>
<td>0.01</td>
</tr>
</tbody>
</table>

**Differences of totals through splitting**

The total exchange value of the components of an amount does not always give the same exchange value as the overall amount.

In this example, the amount of 2.16 EUR gives an exchange value in USD of 2.03. By splitting the amount and adding the two exchange values, 2.04 can be obtained.

<table>
<thead>
<tr>
<th>Amount in EUR</th>
<th>Exchange rate</th>
<th>Exchange value in USD</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.16</td>
<td>1.32030</td>
<td>2.85</td>
</tr>
<tr>
<td>1.08</td>
<td>1.32030</td>
<td>1.42</td>
</tr>
<tr>
<td>1.08</td>
<td>1.32030</td>
<td>1.42</td>
</tr>
<tr>
<td>Totale 2.16</td>
<td></td>
<td>2.84</td>
</tr>
<tr>
<td>Differenza</td>
<td></td>
<td>0.01</td>
</tr>
</tbody>
</table>

These mathematic differences cannot be eliminated if they are not recorded properly.

**Revaluations and exchange rate differences**

Exchange rates vary all the time and therefore also the exchange value to basic currency varies. Between one period and another, there will inevitably be exchange rate differences.

Exchange rate differences are not accounting errors but simple adjustments of the values made necessary in order to keep the accounting figures in step with normal fluctuations.

As you open the accounting, the figures in the balance column are equal to those present in the opening column. When there are entries, these will update the figures in the balance column.

The calculated balance column contains the exchange value to basic currency for the account balance, at the daily exchange (on the exchange rate table). The difference between the balance in basic currency and the calculated balance is the exchange rate difference.
At March 30th the EUR/USD exchange rate is different from the one at the beginning of the year. In the above example there were no accounting entries during the three-month period. The situation, from an accounting point of view, has not changed since the beginning of the year. Despite this the total of the updated balance, using the rate at the end of March, is different when compared to the beginning of the year. The credit bank balance and the loan in USD have a different value in EUR. There are therefore consequences for the accounting even though there have been no entries.

In the above example, you will notice that the Euro is now worth less against the dollar compared to the beginning of the year. The dollar is therefore worth more against the Euro.

The exchange value of the balance on the account in USD is greater than it was at the beginning of the year. You have a greater estate and therefore a profit on the exchange rate.

On the debit side there is a USD 500.00 loan. Now the exchange value in EUR is greater compared to the value input at the beginning of the year. The value of the loan has increased and brings about a loss due to the exchange rate difference.

In the following example we shall use the hypothesis that there has been the opposite development. We imagine that the Euro has increased in value and is therefore worth more against the USD. The exchange value in EUR of an amount in dollars is less than the one at the beginning of the year.
As a consequence of an increase in the Euro/dollar exchange rate, you have a USD bank deposit with an exchange value in EUR which is less than at the beginning of the year. The total worth has diminished and there is therefore a loss.

The USD loan has a lower exchange value in EUR. A lesser liability is an advantage for the company and there is thus an exchange rate profit.

**Exchange rate profit**

You have an exchange rate profit when:

- The exchange value of your assets increases (increase of the investments)
- The exchange value of the liabilities decreases (decrease of the loans).

**Exchange rate losses**

You have an exchange rate loss when:

- The exchange value of your assets decreases (decrease of the investments)
- The exchange value of the liabilities increases (increase of the loans).

**Accounting features for exchange rate differences**

Exchange rates can evolve in different ways. Often they rise, only to fall again. The principle rule for accounting is that the figures written on the Balance Sheet must be true ones. When you present your Balance Sheet, the exchange values of foreign currency accounts must be made at the exchange rate on the day of presentation.

The exchange rate difference is calculated as if you had to definitively convert the amount to basic currency. In reality there is no definitive conversion so you are only dealing with a correction to the accounting.

**Closing exchange rate**

At the end of each year it is necessary to prepare the complete Balance Sheet. The exchange rates
thus have to be updated with the closing exchange rates. It is also necessary to enter the exchange rate differences once and for all; if these are not entered, then there will be differences in the opening balances.

**Enter the exchange rate differences**

<table>
<thead>
<tr>
<th>Currency balance</th>
<th>Account balance EUR</th>
<th>Calculate balance at 30.03.200xx EUR (hypothetical)</th>
<th>Exchange rate difference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exchange</td>
<td>1.32030</td>
<td>1.36150</td>
<td></td>
</tr>
<tr>
<td>Bank</td>
<td>USD 100.00</td>
<td>75.74</td>
<td>-2.30</td>
</tr>
<tr>
<td>Exchange rate difference</td>
<td>EUR</td>
<td>-2.30</td>
<td></td>
</tr>
<tr>
<td>Bank</td>
<td>USD 100.00</td>
<td>73.44</td>
<td>73.44</td>
</tr>
</tbody>
</table>

As can be seen from the above example, the bank balance is USD 100.00. For the accounting it has been valued at 75.74 EUR. Today’s actual exchange, though, is only EUR 73.44. There is a difference of EUR 2.30 EUR in basic currency. The entry must therefore decrease the EUR amount. You proceed with a transaction that debits the bank account and credits the exchange rate loss account by EUR 2.30. As you can see, the actual bank account balance of USD 100.00 has not been altered. The entry only alters the basic currency balance.

When entering the exchange rate difference, you need to be sure that the exchange value in basic currency corresponds to the actual exchange value, calculated at either the daily exchange rate or the closing one. The figures in the account currency must not be altered. You must therefore proceed to make an entry that only alters the basic currency balance on the specific account.

As the account on the other side you will have the exchange rate profit or loss account.

**Transactions with exchange rates at the time of purchase**

**Enties on account valued with the exchange rate of the time of purchase**

When the positions, valued with exchange rates of the time of purchase (historical ones) are increased or decreased, you have to calculate the exchange of the exchange rate table, taking into account the development of the amounts being brought forward.

<table>
<thead>
<tr>
<th>USD amount</th>
<th>Exchange</th>
<th>EUR exchange value</th>
<th>Total USD</th>
<th>Total EUR</th>
<th>Historical Exchange</th>
</tr>
</thead>
<tbody>
<tr>
<td>Acquisition of shares</td>
<td>100'000.00</td>
<td>0.9416</td>
<td>106'202.00</td>
<td>100'000.00</td>
<td>106'202.00</td>
</tr>
</tbody>
</table>
Increase of shares  |  50'000.00  |  0.8792  |  56'870.00  |  150'000.00  |  163'072.00  |  0.919839

**Investments and special exchange rates**

**Investments valued at the exchange rate of the time purchase**

Certain investments (shares, real estate abroad) are valued using the exchange rate of the time of purchase (historical exchange) and not the current one. The exchange rate profit and loss is not accounted for until it is actually realized. You must therefore make certain these accounts do not get valued using the current exchange rate.

In order to input a fixed, historical exchange, you need to create a supplementary currency on the account table (e.g. USD1) with a fixed exchange rate. This currency will then only be used for this account with a fixed rate. If you have to make a transfer from the USD account to the USD1 account, you proceed exactly as if you were working with two different currencies. For this reason you will have to use a two-line entry.

**Opening with special exchange rates**

Inputting the opening balances in the “opening” column, foreign currency amounts will be converted to basic currency at the opening exchange rate.

If this system proves not to be flexible enough (you need various special rates or there are rounding differences) the opening can be done manually by making normal entries, indicating the amounts and the exchange rates you want for each account. In this case, the “opening” column of the Accounts table will be left blank.

**File properties (Foreign currency)**

![File and accounting properties window](image)

**Account for exchange rate profit**

From the accounts list, select the one for the exchange rate profit present in the [Chart of Accounts](#).
Account for exchange rate loss
From the accounts list, select the one for the exchange rate loss present in the Chart of Accounts.

Currency2
It is possible to select a second currency in order to view the balances in a currency different from the basic one.
It is possible to add new currencies that might be missing from the list, please proceed as follows:

- in the Exchange rates table enter a new row; in the Ref.Currency column enter the basic currency for your accounting file, in the Currency column enter your desired currency
- From the File menu -> File and accounting properties... command, in the Currency tab the new currency (that you entered in the Exchange rates table) will be visible, and it can be chosen as Currency2.

Decimal points Currency2
This is the number of decimal points to be used when rounding the amounts in currency2.

The multi-currency chart of accounts
The Chart of accounts of the multi-currency accounting is the same as the one of an accounting without foreign currency, except for the specifics that are indicated here below.

Basic currency
In the File and accounting properties, the basic currency should be defined and in the Exchange rate table, the foreign currencies should be defined.
In the example here below, the basic currency is the CHF, which, as can be seen, appears in the column headers with the amounts in basic currency.

Account currency
Each account has a currency symbol, which can be the same as the basic currency or a currency symbol that is different from the basic currency, indicated in the Exchange rate table.

- The Assets and the Liabilities (Balance sheet accounts) can be in basic currency or in foreign currency.
- The Costs (Expenses) and Revenue accounts must be in basic currency.

Assets and Liabilities accounts, other than in basic currency (CHF in the example), can also be set in different currencies.
Income and Expenses accounts must be set in basic currency.

Explanation of the columns of the multicurrency accounting

- The opening balance in basic currency. A protected column, calculated by the program based on the opening balance in currency and the opening exchange rate (exchange rate of the exchange rate table indicated in a row without date).
- The current balance in currency. Calculated by the program, using the opening balance in currency and the currency amount indicated in the transaction rows.
- The current balance in basic currency. Calculated by the program, using the opening balance in basic currency and the amount in basic currency indicated in the transaction rows.
- The calculated balance. Is the balance in the account currency converted at the current exchange rate (exchange rate of the exchange rate table indicated in a row without date).
- In the Other view from the Account table, there is the Exch. rate Diff. Acct. In this column, for specific account/accounts, you can enter an account (or several accounts, separated by a semicolon) in order to enter the exchange rate differences. These are different accounts from those in the File and accounting properties (account for exchange rate profit and loss).

If in the Exch. rate Diff. Account column there are no accounts, the program will register exchange rate differences on the accounts indicated in the File and accounting properties; if however accounts are indicated both in the File and accounting properties and in the...
Exch.rate Diff.Acct. (Other view), the program will only consider the accounts indicated in the Exch.rate Diff.Acct., and ignore the File and accounting properties indications.

Opening Balances

- Before entering the opening balances, the opening exchange rates for the different currencies have to be indicated in the Exchange rate table.
  - The opening exchange rate is the one indicated in the Rate Opening column in the row of the exchange rate without date.
  - The opening exchange rate must be equal to the closing exchange rate of the preceding year. See Differences in the Opening Balances.
- The Opening balances have to be inserted in the Accounts table, in the Opening currency column, Base view. This operation needs to be done for both basic currency and foreign currency accounts.
- The Opening Basic currency column is protected; the program automatically calculates the value in the basic currency on the basis of the opening exchange rate shown in the Exchange rate table.
- The opening balances for the liabilities have to be entered with the minus sign (-) in front of the amount.
- The opening balances of assets and liabilities have to balance out; for more information please visit the Recheck the accounting page.

Revaluation accounts and historical exchange rates

The exchange rates are fluctuating. The actual value of the balance in the account currency varies therefore depending on the foreign exchange fluctuation.

The basic currency amount of an account is being calculated using the opening exchange rate and the exchange rates that are indicated in the transactions. Because this value corresponds to equivalent of today's exchange rate, it is necessary to revaluate the account.

The revaluation takes place by calculating the exchange rate differences. We need to record on the account just an amount in basic currency (exchange rate difference), so that the balance in basic currency results equal to the equivalent (calculated balance).

This alignment operation is done at the end of the year, before closing the accounts, or when you want to print a balance sheet with exchange values that correspond to the current reality. See the command Create transaction for exchange rate variation.
There are accounts (related to, for example, investments) for which a so-called historic exchange rate is being used. By an historical exchange rate we mean an exchange rate that doesn't vary over time.

In order to have exchange rates that don't change, an extra currency symbol (for example EUR2) must be created in the Exchange rate table. To this currency, the same exchange rate is always being applied.

You can create as many currency symbols as you need for the different accounts with historic exchange rates.

### Group totals in foreign currency

Normally, the columns with amounts in foreign currency don't have totals, as it has little sense to calculate totals for values in different currency.

If you have a group that includes only accounts in a specific currency, the currency symbol can be indicated at a group level and, in the Accounts table, the program totalizes these amounts. If there would be accounts with various currency symbols, there would be no amount indicated (the program would not report an error either).

### Differences in the opening balances

When, in the preceding year, the exchange rate differences have not been calculated, the program signals, in the New Year, a difference in the opening balances.

In order to resolve this problem, there are two possibilities:

If the preceding accounting year has not yet been audited, calculate the exchange rate differences in the preceding year,

- Insert in the Exchange rate table, Exchange rate column, the official exchange rates at
31.12
- Activate, from the Account2 menu, the **Create transaction for exchange rate variation** command.
- Open the file for the New Year and **update the opening balances**.

If the preceding year has already been closed and revised, you must proceed with an adjustment of the opening balances of the new year:

- Open the file of the New Year
- Insert in the Assets or the Liabilities (Accounts table), according to the situation, a new account **Unrecorded Exchange rate differences** or record the amount in the 1090 Internal transfers account (as in the following example)
- In the **Opening Currency** column, insert the amount corresponding to the exchange rate difference.

At 01.01, the exchange rate difference account has to be put to zero by means of a transaction (Transactions table), using the account related to the exchange rate differences (Exchange rate profit/loss) of the profit/loss statement as its counterpart.

After the transaction to arrange the exchange rate differences has been made, the account that has been used should have a balance of zero, or equal to the amount corresponding to the balance prior to the transaction.
Exchange rates table

Before entering multi-currency transactions it is necessary to define the parameters of the used currencies in the Exchange rates table.

Columns of the Exchange rate table

Date
The date for the exchange rate.

- **Exchange rate rows without date.** Actual and Opening exchange rate.
  For each used foreign currency, it is necessary to have a row in the Exchange rate table with an exchange rate and without a date.

  - **Exchange rate**
    This is the one that is considered to be the most recent and also the closing exchange rate.
    It is being used for the calculation of the Balance Calculated column (Accounts table) and always when there is no historical exchange rate.

  - **Rate Opening**
    It is being used to convert the opening balance amounts of foreign currencies into the opening balance amounts of the basic currency of the accounting.

- Rows with a date (**historical exchange rates**)  
The program chooses the exchange rate with a the date equal to the transaction row or with the closest preceding date to that row, in the following cases:

  - If you have an historical exchange rate, the value in the Exchange rate column will be used as default exchange rate when you insert a new transaction
  - When the exchange rate differences transactions are created and the option to use the historical exchange rate is activated
  - When entering an exchange rate with a date, the Opening exchange rate is not used.
Ref. Currency
This is the currency that serves as the basis for the exchange rate (the CHF in our example.)

Currency
This is the destination currency, the one into which the value of the “Ref. Currency” will be converted.

Text
A text to indicate the foreign currency that we are dealing with.

Fixed
True or false. If there is a fixed exchange rate, enter Yes in this column. The used exchange rate is specified in the Exchange Rate column.

Mult.
The multiplier is usually 1, 100 or 1000 and is used to obtain the effective exchange rate. The multiplier is used for currencies which have a very low unit value in order to avoid having to insert exchange rates with many zeros. The multiplier can also be negative (-1). In this case, the program will use an inverted exchange rate or else it will act as if the currencies inserted in the Currency and Reference Currency columns had actually been inverted. **Do not alter the multiplier** once there are already transactions in the same currency, otherwise the program will signal a transaction error due to erroneous exchange rates.

Exchange rate
This column shows the actual exchange rate or the closing exchange rate for the currency compared to the reference currency.
It is also being used for calculating the exchange rate differences. Before calculating the exchange rate differences or closing the accounting, this value must be updated by entering the closing exchange rate.

The exchange rate and the multiplier are being applied according to the following formulas

- With multiplier > 0
  \[ \text{Currency amount} = \text{Ref. currency amount} \times \frac{\text{exchange rate}}{|\text{mult.}|} \]

- With multiplier < 0
  \[ \text{Ref. currency amount} = \text{Currency amount} \times \frac{\text{exchange rate}}{|\text{mult.}|} \]

Opening Exchange rate
This is the exchange rate at the moment the accounting is opened. To be indicated only on a row without date.

- It is used to convert the opening amount of the foreign currency into the opening amount of the accounting’s basic currency.
- Should be corresponding to the closing exchange rate of the preceding year.
  If the closing exchange rates are not equal to the opening exchange rates, the Assets and Liabilities might result into different totals; see **Differences in the Opening Balances**.
- The opening exchange rate should never be changed in the course of the year, otherwise exchange rate differences are being created in the total of the opening balances.
- When creating a new year or when updating the opening balances, the program defines the opening exchange rate with the value indicated in the Exchange rate column (row without date) of the accounting of the previous year.

Minimum
This column shows the minimum exchange rate accepted. If a lesser exchange rate is used during the entry, there will be a warning.

**Maximum**
This column shows the maximum exchange rate accepted. If a greater exchange rate is used during the entry, there will be a warning.

**Decimal Points**
This column shows the number of decimal points to be used when rounding the amounts in currency2.

**Modifications in the Exchange rate table**

The exchange rates entered in the transactions are standalone and independent of the exchange rates shown in the Exchange rate table. If you change an exchange rate in the Exchange rate table, there will be no repercussions in the transactions already submitted.

However, the following modifications do have repercussions:

- **Modification of the Opening exchange rate**
  The next time you recalculate the accounting, the balances in basic currency of the accounts will be recalculated with the new exchange rate. Therefore, pay attention when modifying the Opening exchange rates once you have inserted the opening balances.
  If you modify the Opening exchange rates and there are opening balances, it is important to recalculate the accounting.
- **Modifying the multiplier**
  - When changing the multiplier of a currency already used in the Transactions table, the program will report a warning as soon as the accounting is being recalculated or will move to the transaction row.
    The transaction amount and the correct amount in the basic currency will have to be reentered.
  - When the accounting is being recalculated, as a result the opening balances in basic currency will be recalculated.

**Direct an indirect exchange rates**

- **Direct exchange rates** are those where the basic currency and the foreign currency are being indicated on the same row.
  In the example below there are direct exchange rates USD->EUR and USD->TRL.
- **Indirect exchange rates** are those where a direct exchange between two currencies is not being indicated (not recommended).
  The exchange rate is deducted by the program based on other combinations of entered exchange rates
  In this example, the EUR->TRL exchange rate has not been defined, and the program relies on combining the USD-EUR and USD-TRL.

The program supports indirect exchange rates. However, we recommend **using only direct exchange rates**. Avoid the use of accounts where the direct exchange rate between the basic currency and the currency of the account is not specified. With indirect exchanges, it might not always be clear which exchange rate is being applied.
Historical exchange rates - exchange rate history

As explained above, if an exchange has a date, the program considers it to be a historical exchange rate; the program chooses the exchange rate with a date equal to the transaction row or with the closest preceding date to that row, in the following cases:

- If you have an historical exchange rate, the value in the Exchange rate column will be used as default exchange rate when you insert a new transaction
- When the exchange rate differences transactions are created and the option to use the historical exchange rate is activated
- When entering an exchange rate with a date, the Opening exchange rate is not used.

You can import changes from another .ac2 file or copy / paste historical exchange rates from Excel for example.

If you import several historical change rates at the end of your accounting period, that is when you have already entered accounting transactions, to make sure that the program uses the imported exchange rates instead of those entered in the transactions simply manually delete the transactions exchange rates (Exchange rate column, Transactions table).

Incompatible exchange rates from previous versions

When the basic currency is entered as the reference currency, the exchange rates with a multiplier greater than 1 can present calculation differences between Banana 9 and the previous versions. In these rare cases, while opening an accounting file of a previous version, a warning message appears and the file is being opened as "read only".

To get the same amounts, correct the multiplier and the exchange rate as follows:

- Open the file in Banana 9 and confirm the warning message;
- Recheck the accounting (Shift + F9);
- The warning messages "Transaction multiplier is not the same as the one in the Exchange rate table" can be ignored;
- Verify whether the balances and the result of the accounting period present differences compared to those displayed in earlier versions. If there are no differences, just save the accounting under a new name; otherwise, it is necessary to proceed as follows:
- In the Exchange rate table, for the exchange rates with a multiplier greater than 1, correct the exchange rate by multiplying it with the value of the multiplier and define the multiplier as 1. For
example, if we have a multiplier of 100 and an exchange rate of 0.9944608, correct the exchange rate to 99.44608 and the multiplier to 1;

- Recheck the accounting (Shift + F9);
- The warning messages "Transaction multiplier is not the same as the one in the Exchange rate table" can be ignored, or it is possible to delete them by clicking, in the corresponding transaction row, on the amount in basic currency and by pressing the F6 key;
- Verify whether the balances and the result of the accounting period correspond with the ones indicated in earlier versions;
- Save the file under a new name;
- At this time, you can define the exchange rates and the multiplier in the preferred format, reverse or direct, with or without multiplier, verifying the balances and the result of the accounting period after each modification.

Transactions

With regard to the exchange rates, multiplier and historical exchange rates, please refer to the page Exchange rates table.

Explanations of the columns

In the Transactions Table of the multi-currency accounting, other than the columns of the double-entry accounting, there are the following extra columns:

- **Currency amount**
  This is the amount of the currency specified in the column with the currency symbol. This amount is used by the program to update the balance of the related account in currency.

- **Currency**
  This is the currency symbol of the currency to which the amount refers. The currency symbol has to be the Basic currency, specified in the File and accounting properties, or the currency symbol of an amount indicated in the columns Debit A/C or Credit A/C.
  You can also use a different currency as long as the indicated Debit A/C and the Credit A/C are Basic currency accounts.
  In this case the amount in currency is used as a reference, but will not be used for accounting purposes.

- **Exchange rate**
  Used to convert the foreign currency amount in its Basic currency equivalent.

- **Amount in Basic currency**
  The transaction amount, expressed in Basic currency.
  This amount is used by the program to update the balance of the related account in Basic currency.

- **Exchange rate multiplier**
  Normally not visible in the view, this value is multiplied by the exchange rate.

Types of entries in the multicurrency accounting
Please note

All amounts, those in basic currency as well as those in foreign currency, have to always be entered into the Currency Amount column.

For each transaction, there are two accounts (debit account and credit account). In the program, only one foreign currency per transaction row can be used. So there can be the following direct combinations:

- **Entries between two accounts in basic currency with the amount in basic currency.**
  (in the image, transactions n.1 in the Doc column)
  The account currency is the basic currency.

- **Entries between two accounts in basic currency with the amount in foreign currency**
  (Doc 2)
  The indicated accounts are in basic currency, but the currency symbol and the amount in currency, indicated in the transaction row, are not in basic currency, but in a different currency. To insert the different currency, the user has to manually change the currency symbol. This is being used when one goes abroad and money is being changed in order to pay in local currency. In this case we do not have a specific account.
  For the calculation of the balance (both accounts being in basic currency) only the amount of basic currency column is being used.

- **Entries between an account in foreign currency and one in basic currency** (Doc 3)
  The currency needs to be the one of the account in foreign currency.
  For the calculation of the balance of the account in foreign currency, the program uses the amount in foreign currency and for the balance in basic currency, the program uses the amount in basic currency.

- **Entries between two accounts with the same foreign currency** (Doc 4)
  The currency needs to be the same as account currency of both accounts.

- **Entries with two accounts in different foreign currencies** (Doc 5)
  For example, the bank makes an exchange operation between two foreign currencies:
  In this case, the transaction needs to be recorded on two rows.
  The amount in basic currency needs to be the same. It is useful to use an amount close to the current exchange rate to avoid excessive exchange rate differences.
  In order for the amounts in basic currency to be equal, the amount in basic currency needs to be indicated manually, and the program will calculate the exchange rate.

- **Exchange rate differences** (Doc 6)
  The goal of this transaction is to realign the balance of the Basic currency account with the equivalent of the Foreign currency account at today's exchange rate.
  On the Foreign currency account, only the amount in Basic currency related to the exchange rate differences is being recorded.
  They are automatically generated with the Create transaction for exchange rate variation
command.

- For the exchange rate profits, the program automatically indicates the account to be revaluated in debit and the exchange rate profit account in credit. The exchange rate profit account is indicated in the File and Accounting properties (Basic Data), or in the specified account -> Exchange rate differences account column of the "Other" view (intended for one or several specific accounts).
- For the exchange rate losses, the program automatically indicates the account to be revaluated in credit and the exchange rate loss account in debit. The exchange rate loss account is indicated in the File and Accounting properties (Basic Data), or in the specified account -> Exchange rate differences account column of the "Other" view (intended for one or several specific accounts).
- The Currency amount is being left empty
- The Currency symbol is the basic currency
- In the Basic currency amount column, the amount of the revaluation of the account (profit or loss) is being indicated.

Establishing the exchange rate

The accountant is the one who decides which exchange rate to use for each single operation. Generally, the following rules are being applied:

- For normal operations, the exchange rate of the day is being used
- For buying or selling currency, the values indicated by a money exchange office or a bank are being used.
  First the amount in foreign currency is being indicated in the program and then the amount in basic currency. The program calculates the exchange rate. The exchange rate indicated by the bank can be slightly different, because banks specify exchange rates with few figures after the decimal point and often round the amounts.
- When several operations with the same exchange rate are being recorded, it is useful to update the exchange rate in the Exchange rate table, so that the program can automatically apply it.
- For operations from abroad that are subject to VAT, the national authority might impose a standard exchange rate. In this case, that exchange rate should be inserted in the Exchange rate column of the transaction
- To purchase real estate or equity investments, an historical exchange rate is being used. In that case, a currency symbol needs to be created in the Exchange rate table (for example USD1) with an historical exchange rate, that is not being subject to the fluctuations of the exchange rate.
  One can create as many currency symbols as desired for all historical exchange rates.

Transactions with VAT

The VAT account and the account from which the VAT is being deducted have to be in basic currency. It is impossible to use a VAT code to deduct the VAT from a foreign currency account. In order to record operations with VAT that have accounts in foreign currency as their counterpart, two transaction rows have to be used:

- First, the amount of the purchase is being recorded on an Internal transfers account in basic currency and the related VAT code is being applied. The amount in basic currency has to be calculated using an exchange rate in accordance with the requirements of the Tax administration.
- In a second row, the balance of the Internal transfers account is being put to zero; as its
counterpart, the account in foreign currency should be entered. The amount used for this transaction, both in basic currency and in foreign currency, has to be excluding VAT. Obviously, the exchange rate that has to be used is the same one as the one being used in the preceding transaction.

In the example, the basic currency is the CHF. We are dealing with a national purchase, but paid from a foreign currency account (EUR).

VAT and foreign currency transactions

In transactions with foreign currency accounts, it is possible to record VAT with a gross amount (Amount type 0, with VAT).

If you enter net values (Amount type 1, without VAT), the program indicates an error, because the calculation of the gross value would in many cases be incorrect due to the rounding up of VAT and of the exchange rate.

In these cases it is advisable to enter the gross value. See also the Explanations of the error.

Automatisms while entering multicurrency transactions

When a new transaction is being entered, the data in the above mentioned columns have to be completed.

When some values of the transaction row are modified, the program completes the transaction with the predefined values. If these values do not satisfy the user's requirements, these have to be modified in the transaction row.

The modification of the values in the Exchange rate table have no effect on already entered transaction rows. Thus, when the exchange rate in the Exchange rate table is modified, this has no influence whatsoever on already inserted transactions.

- When the amount in currency is entered and there is either a Debit A/C or a Credit A/C, and no other values are entered, the program operates as follows:
  - the currency symbol is retrieved from the account in use, giving priority to the account that is not in basic currency;
  - the exchange rate, defined in the Exchange rate table, is applied with the following logic:
    - the historical exchange rate is applied, with a date earlier or equal to the transaction date
    - if there is no historical exchange rate to be found, the exchange rate from the row without date is applied.
  - the multiplier, defined in the Exchange rate table, is applied or the number 1 if it is the basic currency;
  - the amount in basic currency is calculated.

- When the amount in currency is modified (and there are already other values present), the
program operates as follows:
- the amount in basic currency is calculated with the existing exchange rate
- If the currency symbol is modified the program operates as follows:
  - the exchange rate with the multiplier is applied and the amount in basic currency is calculated (like above)
- If the exchange rate is modified the program operates as follows:
  - the amount in basic currency is calculated using the entered exchange rate
- When the amount in basic currency is modified the program operates as follows:
  - the exchange rate is recalculated.

More help

- While being positioned on the Currency Amount column and pressing the F6 key, the program rewrites all values with the earlier explained logic, as if there were no values present. This feature is useful when the Debit A/C or the Credit A/C is modified.
- If there is a registration with a single account in basis currency (in 'Multiple transctions' - see Transaction types) and its value of the column 'Currency' has been changed manually in a currency symbol of a foreign currency, it is necessary to be positioned on the cell of the column 'Currency' and press the F6 key in order to update the Exchange rate and calculate the amount in basic currency.
- Smart fill for the Exchange rate column
  The program suggests several exchange rates, picking them up from the Exchange rates table or from exchange rates previously used in the transactions.

Info window

In the info window, the program indicates:

- Differences, if any, between the Debit and Credit total movements in basic currency
- Explanation on the different uses of the F6 key

For the accounts related to the transaction row on which one is positioned, the program always indicates in the Info windows:

- the account number
- the account description
- the transaction's amount in basic currency
- the current account balance in basic currency
- the account currency symbol
- the transaction's amount in the account currency (if different from the basic currency)
- the current account balance in currency (if different from the basic currency)

Data transfer from earlier versions

In version 4 or earlier, the absence of a currency symbol in the Transactions table was being interpreted as a transaction in basic currency.
In version 7 and in version 8, each transaction needs to have its own currency symbol. Therefore, when you update from version 4 to version 7 or 8, in the accounting file, the transactions without a currency symbol need to be completed. To do this, a new "Currency" column must be added to the Transactions table by executing the Columns setup command from the Data menu.
Exchange rate differences

Create transactions for exchange rate differences

For theoretical aspects please visit the Revaluations and exchange rate differences page.

- The exchange differences transactions are adjustment transactions that balance out the foreign currency account balance with the basic currency calculated balance. In essence, it is a matter of re-adjusting the values in the basic currency, taking into account exchange rate loss or gain, due to the fluctuations of the exchange rates.
- If these exchange rate differences are not recorded, there may be differences in the opening balances of the following year.
- The exchange rate differences can be calculated at the end of the closing year or during the accounting period (for example at the end of a quarter). In this case the historical changes can be useful, as they allow you to have different exchange rates at specific dates.
- The program calculates the exchange rate difference based on the balances at the specified date. It is therefore possible to calculate the exchange rate difference at a specific date, even if you have entered transactions after that date.

For further explanations, see also the Exchange rate differences not booked page.

The Calculate exchange rate differences dialog

The Create transaction for exchange rate variation... command, from the Account2 menu, calculates the revaluations for the foreign currencies accounts.

Date of the transactions for the exchange rate differences
Enter the date your exchange rate differences transactions should have. The program can create the transactions for the exchange rate differences even if there are transactions past the indicated date.

- The program will suggest the final date of the current month, related to the last entered transaction.
- If there are transactions for exchange rate differences with the same date, the program asks whether they should be replaced. The program considers the transactions for the exchange rates differences as existing if they have the same date, doc, description, accounts and
currency and when there is no amount in the account currency.

**Document number**
Enter the document number your exchange rate differences transactions should have.

**Use historical exchange rates (exchange rate rows with date)**

- **when this option is not active**
  - if in your Exchange rate table there are not historical exchange rates (exchange rates with a date) this option is not active
  - if the option is not checked the program will use the exchange rate in your Exchange rate table for the rows without date
  - if you are using historical exchange rates for the year closure, be careful that the exchange rate used should be the same as the current one.

- **when this option is active**
  - The program shows the date of the exchange rate, found in the Exchange rates table, that will be used to calculate the exchange rate differences. It is going to be the exchange rate with a date equal or prior to the indicated date.
  - When calculating exchange rate differences at year end we suggest this option not to be activated
  - When booking exchange rate difference transactions at year end, the historical exchange rate must be the same as the current exchange rate, otherwise you get an error message saying that the exchange rate differences have not been calculated (even though they have been).

**Values used to create the transactions**

For more information, we refer to our page [Multi-currency transactions](#).

**Amount of the transaction**

- Transactions for exchange rate differences are being created only for the accounts in foreign currency which, at the specified date, have a different balance in basic currency compared to the calculated one.
- For the amount in basic currency, the difference between the account balance in basic currency and the account balance in foreign currency converted in basic currency is being used.

**Account balance**

For the calculation of the exchange rate differences, the balances in the account currency and in basic currency are being used, at the specified date.

**Exchange rate profit and exchange rate loss accounts**

As exchange rate profit and loss accounts are being used, in order of priority:

1. The indicated accounts entered in the specific column of the chart of accounts.
2. The exchange rate profit & loss accounts indicated in the File and Accounting properties.

**Position of inserted rows**

If, while imparting the command, you find yourself in the Transactions table, the rows are being inserted at the position of the cursor.

Otherwise, they will be inserted at the end or at the previous position in case they are replacing existing transactions.
Before using the command

1. In the **File and Accounting properties** of the File menu, Foreign Currency section, make sure that the Exchange rate profit and loss accounts are being indicated. It is equally possible to indicate the same account for both the exchange rate profits or losses.

2. Make sure that the accounts in foreign currency are being updated and that the balances in foreign currency of these accounts (for example bank accounts) correspond with the balance indicated by the bank.

3. Update the current exchange rates of the **Exchange rate** table.

You should indicate the closing exchange rates or those of a period’s end in the **rows without a date**, in the **Exchange Rate** column (do not modify the opening exchange rate in the Rate Opening column). In order to calculate the Exchange rate differences, the program uses the exchange rates of the rows without a date. If these last ones are absent, the program gives an error message.

### Exchange rates for the New Year

To have the Opening balances of the New Year in Basic currency correspond exactly with the closing balances of the preceding year, the **Opening Exchange rates of the New Year**, indicated in the Exchange Rate table, have to be the same as those being used for the closing of the accounting, so:

- The closing exchange rates have to be indicated in the Exchange rate column of the rows without a date;
- The opening exchange rates have to be indicated in the Rate Opening columns of the rows without a date.

The procedure of **creating a new year or of the updating of the opening balances**, copies the closing balances (Exchange rate column, rows without date) of the previous year into the opening exchange rates (Exchange rate table, Rate Opening column, rows without date) of the new year’s file.

At the latest when the accounting period is being closed, the currencies need to revaluated in Basic currency, creating adjustment transactions for exchange rate loss or gain, due to the fluctuations of the exchange rates (for the theoretical aspects, please check **Revaluations and exchange rate differences**).

### Differenze di cambio con i centri di costo

Il comando **Crea registrazioni differenze di cambio** non include eventuali differenze di cambio presenti nei centri di costo in moneta diversa da quella della contabilità. Queste differenze devono essere registrate manualmente a fine anno. La registrazione deve presentare unicamente l'importo in divisa della contabilità; indicare dapprima questo importo, poi il centro di costo interessato e la
moneta del centro di costo. Al momento d’inserimento della moneta l’importo in divisa della contabilità verrà cancellato e dovrà quindi essere reinserito.

Account card

Columns and views of the account card

In the Account card, there are three groups with of columns with transactions Debit, transactions Credit and the Balance in different currencies.

- Basic currency
  Indicated are the Opening Balance, the Transactions, and the Balance in Basic currency.

- Account currency
  The Transactions in the Account currency are being indicated.
  When the accounts are in Basic currency, these values are identical to those of the Basic currency.

- Currency2
  For every transaction, the amount in Currency2 is being indicated. The amount in Currency2 is the equivalent of the amount in Basic currency, converted at the actual rate for the Currency2 currency symbol.
  Please consult Exchange rates and accounting issues.

- Base view
  At the same time, the columns in Basic currency and the columns in the Account currency are visible.

In the column headers, the related currencies are being indicated.

With the appropriate commands, it is possible to modify the disposition of the columns and create other views.

Data editing

It is not possible to modify the data in the Account card. Double-click on the (underlined) row number to go back to the original corresponding row of the Transactions or Budget table. More details are
available on the Account card page (paragraphe Updating the Account card).

**Info Window**

In the lower part of the screen, the Info window, the values of the accounts related to the active transaction are being indicated.

- Account number
- Account description
- Transaction amount of the account in Basic currency
- Actual Account Balance in Basic currency
- Account's currency symbol
- Transaction amount of the account in the Account currency
- Actual Account Balance in Account currency

**Enhanced Balance Sheet**

The Enhanced Balance Sheet in the multi-currency accounting is done the same way as the one in double-entry bookkeeping. Information is available at the following link: Enhanced Balance Sheet.

The difference consists in the fact that the foreign currency accounts report the amounts in foreign currency as well as in the basis currency (amount converted).
# BALANCE SHEET

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Cash on hand</td>
<td>-</td>
<td>26,892.37</td>
<td>26,576.00</td>
</tr>
<tr>
<td>Bank account</td>
<td>-</td>
<td>21,817.65</td>
<td>19,525.00</td>
</tr>
<tr>
<td>Bank account EUR</td>
<td>EUR</td>
<td>9,552.41</td>
<td>9,524.00</td>
</tr>
<tr>
<td>Bank account USD1</td>
<td>USD</td>
<td>-2,236.55</td>
<td>1,463.02</td>
</tr>
<tr>
<td>Bank account USD2</td>
<td>USD</td>
<td>1,000.00</td>
<td>963.84</td>
</tr>
<tr>
<td>Cash and cash equivalents</td>
<td>-</td>
<td>25,859.53</td>
<td>24,729.00</td>
</tr>
<tr>
<td>Bonds and stocks</td>
<td>-</td>
<td>26,000.00</td>
<td>26,000.00</td>
</tr>
<tr>
<td>Short-term Assets listed in Stock Exchange</td>
<td>-</td>
<td>26,000.00</td>
<td>26,000.00</td>
</tr>
<tr>
<td>Intercompany</td>
<td>-</td>
<td>61.50</td>
<td>-</td>
</tr>
<tr>
<td>Transfer accounts</td>
<td>-</td>
<td>0.00</td>
<td>-</td>
</tr>
<tr>
<td>Due from Clients or Debtors</td>
<td>-</td>
<td>-12,000.00</td>
<td>-28,140.00</td>
</tr>
<tr>
<td>Provision for Doubtful Debts</td>
<td>-</td>
<td>-3,000.00</td>
<td>-3,000.00</td>
</tr>
<tr>
<td>Accounts receivable</td>
<td>-</td>
<td>-18,000.00</td>
<td>-31,700.00</td>
</tr>
<tr>
<td>Advances and loans</td>
<td>-</td>
<td>6,900.00</td>
<td>6,900.00</td>
</tr>
<tr>
<td>Withholding tax</td>
<td>-</td>
<td>3,000.00</td>
<td>3,000.00</td>
</tr>
<tr>
<td>Receivables from Social Insurance and Pensions</td>
<td>-</td>
<td>9,000.00</td>
<td>9,000.00</td>
</tr>
<tr>
<td>Source tax</td>
<td>-</td>
<td>6,000.00</td>
<td>6,000.00</td>
</tr>
<tr>
<td>Various short-term receivables</td>
<td>-</td>
<td>3,000.00</td>
<td>3,000.00</td>
</tr>
<tr>
<td>Other short-term receivables</td>
<td>-</td>
<td>22,100.00</td>
<td>22,100.00</td>
</tr>
<tr>
<td>Goods for resale</td>
<td>-</td>
<td>25,000.00</td>
<td>25,000.00</td>
</tr>
<tr>
<td>Raw materials</td>
<td>-</td>
<td>6,123.00</td>
<td>6,123.00</td>
</tr>
<tr>
<td>Auxiliary materials</td>
<td>-</td>
<td>800.00</td>
<td>800.00</td>
</tr>
<tr>
<td>Consumables</td>
<td>-</td>
<td>1,300.00</td>
<td>1,300.00</td>
</tr>
<tr>
<td>Finished products</td>
<td>-</td>
<td>1,000.00</td>
<td>1,000.00</td>
</tr>
<tr>
<td>In-process products</td>
<td>-</td>
<td>6,000.00</td>
<td>6,000.00</td>
</tr>
<tr>
<td>Non-stocked services</td>
<td>-</td>
<td>9,000.00</td>
<td>9,000.00</td>
</tr>
<tr>
<td>Inventories</td>
<td>-</td>
<td>12,700.00</td>
<td>12,700.00</td>
</tr>
<tr>
<td>Prepaid expenses</td>
<td>-</td>
<td>1,200.00</td>
<td>1,200.00</td>
</tr>
<tr>
<td>Account income</td>
<td>-</td>
<td>6,900.00</td>
<td>6,900.00</td>
</tr>
<tr>
<td>Prepaid Expenses</td>
<td>-</td>
<td>8,000.00</td>
<td>8,000.00</td>
</tr>
<tr>
<td>Current assets</td>
<td>-</td>
<td>63,897.54</td>
<td>59,596.00</td>
</tr>
<tr>
<td>Bonds and stocks</td>
<td>-</td>
<td>3,000.00</td>
<td>3,000.00</td>
</tr>
<tr>
<td>Loans</td>
<td>-</td>
<td>8,000.00</td>
<td>8,000.00</td>
</tr>
<tr>
<td>Financial assets</td>
<td>-</td>
<td>17,600.00</td>
<td>17,600.00</td>
</tr>
<tr>
<td>Investments</td>
<td>-</td>
<td>17,600.00</td>
<td>17,600.00</td>
</tr>
</tbody>
</table>

**TOTAL ASSETS**: 318,140.00
## Assets

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Machinery</td>
<td>12'900.00</td>
<td>7'000.00</td>
</tr>
<tr>
<td>Office furniture and equipment</td>
<td>10'000.00</td>
<td>10'000.00</td>
</tr>
<tr>
<td>Office machinery, information and communication technology</td>
<td>9'700.00</td>
<td>8'000.00</td>
</tr>
<tr>
<td>Motor vehicles</td>
<td>9'400.00</td>
<td>8'000.00</td>
</tr>
<tr>
<td>Tools and equipment</td>
<td>9'800.00</td>
<td>9'000.00</td>
</tr>
<tr>
<td>Intangible assets</td>
<td>87'375.00</td>
<td>447'391.00</td>
</tr>
<tr>
<td>Patents, knowhow, licences, rights and development</td>
<td>2'970.04</td>
<td>2'970.04</td>
</tr>
<tr>
<td>Intangible fixed assets</td>
<td>29'970.04</td>
<td>29'970.04</td>
</tr>
<tr>
<td>Share capital, rights not paid or non-paid Foundation capital</td>
<td>300'000.00</td>
<td>300'000.00</td>
</tr>
<tr>
<td>Capital or non-paid Foundation capital</td>
<td>300'000.00</td>
<td>300'000.00</td>
</tr>
<tr>
<td>Fixed Assets</td>
<td>419'005.87</td>
<td>433'579.94</td>
</tr>
<tr>
<td>Total Assets</td>
<td>832'913.21</td>
<td>789'046.96</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>---------------------</td>
<td>------------</td>
</tr>
<tr>
<td>Suppliers or creditors</td>
<td>29,980.00</td>
<td>24,180.00</td>
</tr>
<tr>
<td>Deposits received</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>Suppliers or creditors</td>
<td>37,980.00</td>
<td>39,150.00</td>
</tr>
<tr>
<td>Due to banks/short term</td>
<td>20,000.00</td>
<td>26,000.00</td>
</tr>
<tr>
<td>Short-term oronous debts</td>
<td>20,000.00</td>
<td>20,000.00</td>
</tr>
<tr>
<td>VAT according to VAT report</td>
<td>-37.03</td>
<td>89,139.96</td>
</tr>
<tr>
<td>Other short-term debts</td>
<td>21,010.00</td>
<td>21,610.00</td>
</tr>
<tr>
<td>Other short-term debts</td>
<td>20,972.97</td>
<td>20,623.86</td>
</tr>
<tr>
<td>Annual expenses</td>
<td>2,500.00</td>
<td>2,500.00</td>
</tr>
<tr>
<td>短期项目</td>
<td>15,000.00</td>
<td>15,000.00</td>
</tr>
<tr>
<td>Accruals and deferred income</td>
<td>17,500.00</td>
<td>17,500.00</td>
</tr>
<tr>
<td>Short term third party capital</td>
<td>99,422.97</td>
<td>96,973.92</td>
</tr>
<tr>
<td>Due to banks</td>
<td>20,000.00</td>
<td>25,000.00</td>
</tr>
<tr>
<td>Financial leasing commitments</td>
<td>8,900.00</td>
<td>8,900.00</td>
</tr>
<tr>
<td>Derivative loans</td>
<td>89,000.00</td>
<td>89,000.00</td>
</tr>
<tr>
<td>Long-term oronous debts</td>
<td>0.00</td>
<td>33,000.00</td>
</tr>
<tr>
<td>Other long-term debts</td>
<td>26,960.00</td>
<td>22,960.00</td>
</tr>
<tr>
<td>Provisions</td>
<td>13,070.00</td>
<td>13,070.00</td>
</tr>
<tr>
<td>Provisions and similar statutory posts</td>
<td>12,070.00</td>
<td>13,070.00</td>
</tr>
<tr>
<td>Long-term third party capital</td>
<td>129,530.00</td>
<td>129,530.00</td>
</tr>
<tr>
<td>Employment</td>
<td>129,530.00</td>
<td>129,530.00</td>
</tr>
<tr>
<td>Equity partner A at the beginning of the year</td>
<td>78,500.00</td>
<td>78,500.00</td>
</tr>
<tr>
<td>Contributions to equity/equity withdrawals partner A</td>
<td>260,000.00</td>
<td>260,000.00</td>
</tr>
<tr>
<td>Private account partner A</td>
<td>260,000.00</td>
<td>260,000.00</td>
</tr>
<tr>
<td>Profit/Loss for the year partner A</td>
<td>10,000.00</td>
<td>10,000.00</td>
</tr>
<tr>
<td>Equity partner A at the beginning of the year</td>
<td>89,000.00</td>
<td>89,000.00</td>
</tr>
<tr>
<td>Contributions to equity/equity withdrawals partner A</td>
<td>180,000.00</td>
<td>180,000.00</td>
</tr>
<tr>
<td>Private account partner A</td>
<td>180,000.00</td>
<td>180,000.00</td>
</tr>
<tr>
<td>Profit/Loss for the year partner A</td>
<td>10,000.00</td>
<td>10,000.00</td>
</tr>
<tr>
<td>Profit</td>
<td>12,000.00</td>
<td>12,000.00</td>
</tr>
<tr>
<td>Equity</td>
<td>613,892.24</td>
<td>571,862.10</td>
</tr>
<tr>
<td>Total liabilities</td>
<td>833,013.21</td>
<td>759,065.06</td>
</tr>
</tbody>
</table>
Enhanced Balance Sheet by groups

The Enhanced Balance Sheet by groups in multi-currency accounting is done the same way as the one in double-entry bookkeeping. Information is available at the following link: Enhanced Balance Sheet by groups.

The difference consists in the fact that the foreign currency accounts report the amounts in foreign currency as well as in the basis currency (amount converted).
Accounting Reports

Accounting Reports in multi-currency accounting are done the same way as the ones in double-entry bookkeeping. Information is available at the following links: Accounting report; External accounting report.

Income & Expense accounting

Introduction

Income & Expense accounting is the ideal tool to manage the accounts of small to medium size companies, associations, private enterprise or project planning. It can be configured with or without VAT. On the other hand, it does not have the multi-currency options, that you will find in the double-entry book keeping version.

It does include:

- **Income & Expense** - allows you to manage income and expense for several accounts.
- **Cash book** - used to keep track of the income and expenses of one single account.

Features

- Manages your balance sheet and income statement (assets, liabilities, income and expense)
- VAT option allows VAT calculations and VAT tax returns
- Process all your accounting records: accounting journal, account cards, periodical and annual reporting
- Lets you manage your Cost Centres and their Segments
- Multiple options to present your data
- Export to Excel, Html, Xml, Pdf
- Import various types of data files.

Tables and Properties files
Income & Expense accounting contains the following tables:

- **Accounts**
  Where you find the Chart of Accounts, the opening balances and define your groupings.

- **Categories**
  Define the categories of Income & Expense here, the cost centres and segments.

- **Transactions**
  Record your transactions here.

- **VAT Codes**
  If you have selected the VAT option, enter your VAT codes here. By selecting one of the VAT templates, VAT codes will be allocated correctly, allowing you to have a facsimile of your official VAT statement.

- **File and accounting properties**
  Manage the general settings of your accounting here.

**Immediate information**

The account balances will be displayed instantly in the Accounts and Categories tables, after the income and expense recordings. Balances will be adjusted automatically after each registration of a transaction and you will not need to require a specific report to have an overview of your accounts, which you can call up via the Accounts and Categories tabs.

**Support**

- Detailed information on the different functionalities of the program, with concrete examples and screenshots of the software, for your use
- Free support for one year included.

**Topics similar to Double-entry accounting**

- Add, cancel an account
- Rename an account
- Insert groups
- Cost and profit centers
- Segments

**Commands**

- Check the accounting
- Lock transactions
- Create New Year

- Creating invoices

**Printouts**

- Journal
- Account/category cards
- Enhanced statement
- Enhanced statement with groups
- Accounting report
**Accounts**

Estate accounts are entered in the Accounts table. Only one account is entered in the cash register (cash, bank, postal account ...); In Income/Expense accounting more accounts are entered (cash, customers, suppliers ...) and the accounts that refer to existing debt must have the opening amount with preceded by the minus sign (-).

![Accounts Table Example](image)

**The columns of the Accounts table:**

**Section**
Enter an asterisk to signal a section change. For example, to distinguish Total Assets from Cost Centers.
Values must be entered in the Sections table for presenting the enhanced Statement with groups. Refer to the [Sections](#) page for further details and information.

**Group**
Values are added up for the categories that have the same GR. They are fundamental for totalization.

**Account**
Enter the number or initials of the account to be managed (cash, bank, post).

**Description**
Enter a description for the relative account.

**Gr**
Enter a value that identifies the category belonging to a specific group.

**Opening**
Entering an account balance is only necessary if a new file is opened or Banana Accounting 9 software is used for the first time. When creating a new accounting year, balances will be generated automatically.

**Income**
This locked column displays the balance of incoming entries. The balance will be updated automatically after each registration.

**Expenses**
This locked column displays the balance of expenses. The balance will be updated automatically after each registration.

**Balance**

This locked column displays the balance resulting after income and expenses. The balance will be updated automatically after each registration.

**Opening balance**

The first time Banana Accounting 9 software is used and new file is created, opening an account balances must be entered manually in the Accounts table Opening column.

Balances for Liabilites accounts must be entered preceded by a minus (−) sign. When creating a new accounting year, balances for the new year will be generated automatically.

**Categories**

The headings for Income and Expenses are entered in the Categories table via two principal groupings, which may - in their turn - contain subgroups. The set of categories will determine the profit or loss for the accounting period.

**Groupings:**

In the example below, there are three principal groupings:

- Group 3 - Total for Categories that have 3 in their Gr column (total Income)
- Group 4 - Total for Categories that have 4 in their Gr column (total Expenses)
- Group 00 - Total for groups 3 and 4 (Total Income and Expenses), which will determine the result for the accounting period.
The columns of the Categories table:

**Section**

Enter an asterisk in the row that contains the title, to signal a section change, that will be displayed in the enhanced Statement with groups. (the asterisk is inserted in the "Operating Result" title row in our example).

If different sections than Income and Expense are planned, such as Cost and Profit centers, another asterisk may be entered on the respective title row. Refer to the Sections page for further details and information.

**Group**

Enter an identifier (numerical or sign) identical to the one entered for each category in the GR column. The totals for each category belonging to the same GR will then be added up (in our example, Group 3 totals the Income Category and group 4 the Expenses category).

**Description**

Enter a description for the relative Income or Expense Category.

**GR**

Each Category has an identifier that allows the establishment of the totals for the relevant Group (in our example all categories of Income are GR3, because they will be total in Group 3, Total Income).

**Income**

This locked column displays the balance of incoming entries. The balance will be updated...
automatically after each registration.

**Expenses**
This locked column displays the balance of expenses. The balance will be updated automatically after each registration.

**Balance**
This locked column displays the balance resulting after income and expenses. The balance will be updated automatically after each registration.

**Transactions**

The transactions are entered in the **Transactions** table.
For every transaction enter the date, document number, description, incoming or expense, the account and the category.

- **Income/Expenses**: enter the amount coming in or going out.
- **Account**: enter one of the Estate accounts (cash, bank, post, clients, suppliers...).
- **Category**: enter an income or expense category.

**Speeding up the recording of the transactions**

In order to accelerate the recording of the transactions, you can use

- the **Smart fill** function that allows the automatic autocomplete of data that have already been entered at an earlier date.
- the **Recurring transactions** function, used to memorize recurring transactions into an appropriate table.
- **importing bank or post office statement**.

**Examples of transactions without VAT**

![Image of Transactions Table]

**The columns of the Transactions table**

**Date**
Enter the date for the transaction of Income or Expense

**Doc**
Enter Doc number. The number of the paper document is normally assigned here; this will facilitate retrieval of documents at later dates.

**Description**
Enter a description for the relative Income or Expense.
Income
Enter Income amount.

Expenses
Enter Expense amount.

Account
Enter the Estate account (cash, bank, Post, clients, suppliers...).

Category
Enter a category of Income or Expense, as defined in the Category table.

Examples of transactions with VAT

Additional columns

Depending on the type of Income / Expense accounts setup (with or without VAT) there are additional columns where VAT data is entered.

VAT Code
Enter the VAT code referring to a sale or a cost. There must be a code in the VAT Codes table.

Refer to the Transactions page for explanations of VAT codes and further information.

In the Account and Category columns, instead of entering the account and category number you can also write the text you wish to find.
The software will show you the list with all the accounts and categories containing the entered text.
With the Arrow down key you can move directly in the list and select the desired account number by pressing the Enter key.

In order to display the movements of an account or a category, after entering the transactions, click on the small blue symbol in the account/category cell (top right corner of the selected cell).

Account and category card

In the account or category card, the presentation of the transactions is very similar to the ones of the Transactions table. If you enter further transactions or make changes (always operated in the Transactions table), you can update the account/category card by clicking the Refresh icon on the right side of the screen.
Printouts

Instant information

Account balances, income and expense are on ready display in the Accounts and Category tables. After each entry of a transaction, balances are adjusted automatically and there is no need to run a report, as you can simply display the Accounts or Categories tables.

Advanced printouts

All printing is run from the Account1 menu, where the different functions for printing are located:

- **Journal** by period command. You can display and print the whole table or just a specified period.

- **Account/Category cards** command. You may select all cards or define your selection. Define the required period in the Period tab and click the required settings in the Options tab. Print settings can be saved in the Composition tab so they can be resumed without them to be having defined again.

- **Enhanced statement** command. You may also print a defined period and various options and compositions may be included.

- **Enhanced statement with groups** command. You may also print a defined period and various options and compositions may be included.

- **Accounting report** command. The required options are displayed in the Accounts table. Reports are possible for current, previous periods or previous years; each period may contain subdivisions and the compositions can be saved.

Example of printout of Enhanced statement with groups
Enhanced statement with groups

This feature is only available in version 7.0.4 or higher. It allows the user to obtain the Enhanced statement with groups, with all the options that are available in the Double-entry accounting.

The Enhanced statement with groups makes it possible to:

- Include all the groups that are present in the Accounts- and the Categories tables in the printout,
- Exclude groups or accounts individually
- Select a subdivision by period
  (for example, in the first semester, one can select to have a subdivision by month or per quarter)
- Select a subdivision by segment.

Below are listed the explanations pertaining to the Income & Expense only; for complete documentation, please refer to the explanations of the Enhanced Balance sheet with groups page.

See also Print Example.

Sections
The sections present in the Accounts- and/or Categories table make it possible to define a set of accounts and categories to be printed with the 'Enhanced statement with groups' command from the 'Account1' menu.

- The sections are indicated in the Sections column of the Accounts- and the Categories table
- An * (asterisk) indicates the beginning of a section
- A ** (double asterisk) indicates the beginning of a subsection
- A # indicates the beginning of the Notes section
- A section ends once the next one begins
- Contrary to the Double-entry accounting, it is not possible to use numerical identifications for the sections
- In case no section has been indicated, the program will enter them automatically when the command is used for the first time
  - In the Accounts table "Estate"
  - In the Categories table "Operating result"
- It is recommended to create separate sections if there are cost centers, segments or clients/suppliers registers.
  In this way, it is possible to print reports with just the information that concerns the user.
Configurations of Accounts & Categories

In the dialogue window, you can define how to print the accounts and the categories.

- The accounts, present in the Accounts table, will always be printed with the balances at the end of the indicated period.
- The categories will always be printed with the movements of the indicated period.

Enhanced Statement

- The Enhanced Statement gives an overview of the progression of the Estate situation and the operating result of the year. This function is present in the Income & Expense accounting.
- The Enhanced Statement is calculated and displayed by means of the Enhanced Statement command, from the Account1 menu.
- In the window that pops up, you have the possibility to insert the header that will display on the first page of the Enhanced Statement; furthermore, a series of options can be selected in order to include further details in the printout.
- Transactions without date are being considered as opening transactions and will not appear in the printouts of the Profit & Loss Statement.

See also Print Example.
**Page headers**

**Rows 1-4**

These rows allow the definition of the Statement's headers.

**Column headers**

**Initial date**

Insert the initial date of the accounting.

**Data finale**

Insert the final date of the accounting.

**Previous year**

Insert the final date of the previous year's accounting.

**Print pages**

Checking the boxes you define the options you desire to appear in the statement printout:

**Accounts**

The accounts will be printed.
Initial page

The initial page of the document with the file headers will be printed.

Categories

The categories will be printed.

End of page after Accounts

The accounts and the categories will be printed on two different pages.

Include in printout

By selecting the boxes, you choose the options that must appear in the printout.

Other Tabs

The explanations for the other tabs are available at the following pages:

- Period
- Style
- Texts
- Margins
- Composition

Non-profit Organization XXX
Accounting 2015

<table>
<thead>
<tr>
<th>Estate</th>
<th>01.01.2015</th>
<th>31.12.2015</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cash</td>
<td>500.00</td>
<td>1832.50</td>
</tr>
<tr>
<td>Post office current account</td>
<td>4200.00</td>
<td>4200.00</td>
</tr>
<tr>
<td>Bank current account</td>
<td>25000.00</td>
<td>25000.00</td>
</tr>
<tr>
<td>Credits</td>
<td>8900.00</td>
<td>8900.00</td>
</tr>
<tr>
<td>Withholding tax</td>
<td>96.60</td>
<td>90.00</td>
</tr>
<tr>
<td>Office machinery, information and communication technology</td>
<td>35000.00</td>
<td>35000.00</td>
</tr>
<tr>
<td>Current Liabilities Short term</td>
<td>-9500.00</td>
<td>-9500.00</td>
</tr>
<tr>
<td>Liabilities Long term</td>
<td>-25000.00</td>
<td>-25000.00</td>
</tr>
<tr>
<td>Total</td>
<td>42986.00</td>
<td>44452.50</td>
</tr>
<tr>
<td>Estate increase</td>
<td>--</td>
<td>1033.00</td>
</tr>
</tbody>
</table>

Operating result

<table>
<thead>
<tr>
<th>Income</th>
<th>Expenses</th>
</tr>
</thead>
<tbody>
<tr>
<td>Membership fees</td>
<td>--</td>
</tr>
<tr>
<td>Various sales</td>
<td>100.00</td>
</tr>
<tr>
<td>Donations</td>
<td>2000.00</td>
</tr>
<tr>
<td>Reimbursements expenses to volunteers</td>
<td>--</td>
</tr>
<tr>
<td>Rental</td>
<td>--</td>
</tr>
<tr>
<td>Telephone &amp; fax</td>
<td>--</td>
</tr>
<tr>
<td>Advertising, printing and photocopies</td>
<td>--</td>
</tr>
<tr>
<td>Total</td>
<td>2330.00</td>
</tr>
<tr>
<td>Profit</td>
<td>--</td>
</tr>
</tbody>
</table>
Accounting report

- This command displays the amounts of accounts according to a certain grouping, for a specified period or per subdivision.
- Transactions without date are being considered as opening transactions and will not appear in the printouts of the Profit & Loss Statement.

Display

You select the desired grouping scheme:

- **Accounts** - the Report will show a list of all accounts with the following columns: opening balance, income, expenses and account balance
- **Categories** - the Report will show a list of all categories with the following columns: opening balance, income, expenses and account balance.

Options

You select the accounts to be included or excluded:

- **Exclude accounts** - only the categories will be printed
- **Include accounts with no transactions** - accounts with no transactions will be printed as well
- **Include accounts with 0 balance** - accounts with zero balance will be printed as well
- **Exclude groups without accounts** - groups of accounts with zero balance will not be printed.

Other Tabs

The explanations for the other tabs are available at the following pages:

- Period
- Subdivision
**New Year**

You can automatically transfer to the New Year in the following ways:

- Open the file of the terminated year and click on the Create New Year command from the Account2 menu.
- Confirm the basic data of the Accounting properties.
- Save the file under a new name.

The program will automatically carry forward:

- The accounts, the opening balances
- The categories will be carried forward without an opening balance, because you start from scratch, in order to determine the business result for the New Year.

**Cash book**

**Introduction**

The ideal tool to manage the cash account of small sized companies, associations, private enterprises or project planning.

It can be configured with or without VAT. On the other hand, it does not have the multi-currency functions.

**Features**

- Manages your cash account, or another estate account and income and expenses
- VAT option allows VAT calculations and VAT tax returns
- Process all your accounting records: accounting journal, account cards, periodical and annual reporting
- Manage the Cost Centers and Segments
- Several posibilities to submit and present your data
- Export to Excel, Html, Xml, Pdf
- Import various types of data files.

**Tables and Properties files**

The Cash book is part of the Income & Expense accounting type. It contains the following tables:

- **Accounts**
  Where you find the Cash account or another estate account you manage and the relative opening balance.
- **Categories**
  Define the categories of Income & Expense here, the Cost Centres and their segments.
- **Transactions**
  Record your transactions here.
- **VAT Codes**
If you have selected the VAT option, enter your VAT codes here. By selecting one of the VAT templates, VAT codes will be allocated correctly, allowing you to have a facsimile of your official VAT statement.

- **File and accounting properties**
  Manage the general settings of your accounting here.

### Immediate information

The account balances will be displayed instantly in the Accounts and Categories tables, after the income and expense recordings. Balances will be adjusted automatically after each registration of a transaction and you will not need to require a specific report to have an overview of your financial situation, which you can call up via the Accounts and Categories tabs.

### Support

- Detailed information on the different functionalities of the program, with concrete examples and screenshots of the software, for your use
- Free support for one year included.

### Topics similar to Double-entry accounting

- [Add, cancel an account](#)
- [Rename an account](#)
- [Insert groups](#)
- [Cost and profit centers](#)
- [Segments](#)

### Commands

- [Check the accounting](#)
- [Lock transactions](#)
- [Create New Year](#)

- [Creating invoices](#)

### Printouts

- [Journal](#)
- [Account/category cards](#)
- [Enhanced statement](#)
- [Enhanced statement with groups](#)
- [Accounting report](#)

### Transactions

The transactions are entered in the **Transactions** table.

For further information relative to the columns used in the **Transactions table** of the **Cash book**, refer to the [Transactions (Income & Expense accounting)](#) page.
For each operation enter the following:

- the date
- the document number
- the description
- the income or expense amount
- the category relevant to the income or expense in the Category table
- should the transaction be subject to VAT tax, enter the VAT code in the VAT code column. The VAT codes are listed in the VAT codes table.

**Speeding up the recording of the transactions**

In order to accelerate the recording of the transactions, you can use

- the **Smart fill** function that allows the automatic autocomplete of data that have already been entered at an earlier date.
- the **Recurring transactions** function, used to memorize recurring transactions into an appropriate table.
- **importing bank or post office statement.**

**Examples of transactions without VAT**

**Examples of transactions with VAT**
Category card

To display the entries of a category, click once on the small blue arrow appearing in the upper right corner of the cell.

The display of entries in the Categories table is identical to the one in the Transactions table. To update the category or group cards, following new entries or changes in the Transactions table, you must click on the two circular arrows symbol, located at the top right corner of the category or group card.

Printouts

Instant information

The account balance and those of the income and expense categories are on ready display in the Accounts and Category tables. After each entry of a transaction, balances are adjusted automatically and there is no need to run a report, as you can simply display the Accounts or Categories tables.

Advanced printouts
All printing is run from the **Account1** menu, where the different functions for printing are located:

- **Journal** command. You can display and print the whole table or just a specified period.

- **Account/Category cards** command. You may select all cards or define your selection. Define the required period in the Period tab and click the required settings in the Options tab. Print settings can be saved in the **Composition** tab so they can be resumed without them to be having defined again.

- **Enhanced statement** command. You may also print a defined period and various options and compositions may be included.

- **Enhanced statement with groups** command. You may also print a defined period and various options and compositions may be included.

- **Accounting report** command. The required options are displayed in the Accounts table. Reports are possible for current, previous periods or previous years; each period may contain subdivisions and the compositions can be saved.

**Example of printout of Enhanced statement with groups**

![Image of Enhanced statement with groups]

**Customers sub-menu**

**Customers' register and checking of open invoices**

Directly in the accounting you can:

- **Prepare customers' accounts**, with the related addresses and other customers' data.
• Add to the transactions:
  - the data related to the issued invoices (invoice number, customer, amount, due date).
  - the data related to the payment for the invoices and the issuing of credit notes, if any.
• Retrieve the list of your Payments schedule

Other features available:

• Print invoices
• Print statements
• Print reminders
• Print Credit notes

Setting up and using the customers and invoices features

1. Setting up accounting on actual bills issued (accrual principal) or setting up accounting on a collected cash basis.
2. Setting up Customers and Suppliers' settings
3. Setting up the Transactions table and entering the invoices
4. Reports for open, overdue and issued invoices
5. Generating invoices

Notes

• Multi-currency accounts: reports are based on the customer's account currency balances; possible exchange rate differences will not be taken into account.
  In the Issued invoices table, the recordings of exchange rate differences are also listed, while in other prints only the customer's currency amount is used.
• The Description column will replicate the first for recorded row for each invoice.
• For the accounting files based on cash received, you can setup a customers register with the Cost Centers.

Example file

• Customers_suppliers.ac2

Management of turnover (accrual principle)

Introduction

Banana Accounting allows you to manage the accounts and also the customer and supplier invoices both on an accrual basis and on a cash basis.

The following explains how to set up separate accounts for each customer and a group for customers, so that you can have a list of separate invoices per customer available.

In case you only have a few invoices and don't want to keep a detail per customer, you may also keep one account only to record all customer invoices. The list of invoices will thus apply for all customers and not for any single customer.

Setting up the Clients' register
Account and/or groups of clients can be set up as regular accounts in the Plan of Accounts directly, in the Assets section.

It is also possible to create a separate section for the customer account. This way, only the customer group total will be displayed in the Assets, and all customer accounts will be present in the customer register.

In order to create the customer register in a separate section, the following need to be added at the end of the Plan of Accounts:

- Each client is a separate row in the chart of accounts and has its own account number
- There is a group that groups all the customers accounts
  This group is then grouped in a group present in the Assets.

At the end of the Chart of accounts, add:

- A * section (header) (see Sections)
- A 01 section for the Clients (see Sections)
- The Clients accounts that are required (see Adding a new account). Each customer will be allocated one row in the Plan of Accounts and a his/her single account number. Account numbers is at your discretion (see Accounts) it is however advisable to use numbers only, especially for the management of payments.
- A group where all customer accounts are totalled.
- This group, in turn, is totalised into a group present in the Assets.

The total for Clients will be totalised in the summary group 110A of the Gr column.
- The same code or number used for the Gr (110A), must be used in the Assets Group column, in the row corresponding to the Total Customers of the Balance Sheet.

The groups' numbering can be freely chosen (see Groups).
Recording an issued invoice

- Enter the transaction date
- Position yourself in the Invoice column cell and click on the F2 button. If the F2 button doesn't work, you need to activate your customers/suppliers settings, by entering your register's group (ex.: Account2 menu, Customers, Settings). A list of all open invoices will display.
- Alternatively, you may also start by entering the invoice number, the customer/supplier name or the amount, and the program will show you the list of the open invoices according to your search data.
- Select the desired invoice and press Enter.
- The program completes the Transaction with the Description column, the Credit account and the Amount. The program will report a difference if the account number of the counterpart is not inserted.

Enter the account into which the invoice amount has been transferred
Recording a credit note

In order for the amount to be deducted from the original invoice, the same invoice number needs to be used. If the corrective document (for example, a credit note) presents a different number that needs to remain available, such a reference can be entered in another column, such as Doc. Original. Refer also to Print credit notes.

Cash method of Accounting (Cash principle)

Setting up the clients/suppliers register with cost centres

For all Swiss users who manage the VAT on cash received, this setup is the best to manage the VAT.

It is possible to manage the customers/suppliers register as cost centres (see also the Cost and Profit Centers page). A detailed explication is available in the Accounting on turnover or collected page.

- It is advisable to use the CC3 cost centre (where the accounts are preceded by a semi-colon ";")
- The cost centre balances for customers and suppliers will not appear in the Balance Sheet.
Transactions

More information is available at the page Clients and suppliers with VAT, using the Cash principle.

Miscellaneous operations

- Displaying the Invoice column in the Transactions table
- Autocomplete of invoice data
- Extract invoice rows and Open invoice link commands
- Activating the Address columns (optional)
- Setting up the expiration date for invoices
- Setting up the Customers' parameters

Displaying the Invoice column in the Transactions table

The invoice number has to be entered in the Invoice column (DocInvoice) which, in the default settings, is not visible in the Transactions table.
In order to display the column:

- Select the **Transactions** table
- **Data** menu
- **Columns setup** command
- Activate the **Visible** option for the **DocInvoice** column

The Invoice columns becomes visible.

The **Open Invoice link** and **Extract invoice rows** commands, described below, are linked to the Invoice column (right click on the Invoice column's cell).

**Autocomplete of invoice data**

When a payment is being recorded or an issued invoice is being corrected, the program offers suggestions to complete the transaction automatically. Proceed as follows:

- Create a new transaction row and add the date
- In the Invoice column, press the F2 key; the list of open invoices will appear. If you type an invoice number or an account number, the list will be filtered based on the entered text.
- Select the required invoice and press Enter. The program will automatically complete the transaction with the description, debit or credit account and the amount. These data can also be modified manually.
- Apart from the date, you may also indicate the Customer account before pressing F2 in order to display the list of open invoices; in this case the list will be filtered, based on the Customers account of the transaction row.

**Note**

The list displayed in the Invoice column includes both the Customers' and Suppliers' invoices. A supplier's invoice may have the same number as the invoice of another supplier, because the criterion for display takes into consideration the invoice number besides the Supplier's account number.

The **Open Invoice link** and **Extract invoice rows** commands, described hereunder, are linked to the Invoice column (right click on the Invoice column's cell).

**Extract invoice rows and Open invoice link commands**
The **Extract invoice rows** command displays the transactions for the selected invoice. The command is available by clicking on the small blue symbol at the upper right corner of the cell or with the right mouse button.

The **Open Invoice link** command provides the text, as defined in the Customers' settings (Account 2 - Customers - Settings - Advanced - Link to the Invoice document).

For example, if the invoices have been created with Winword and saved in the Documents folder, these files can directly be opened by setting up the command line with the text 'C:\Users\myname\Documents\<DocInvoice>.doc'. The program substitutes <DocInvoice> with the text corresponding to the column and executes the command.

In the command line, it is also possible to indicate other columns of the table by using their XML names.

If the message 'File with extension considered unsecure' is displayed, add the extension (for example .doc) using the command Tools - Program Options, Advanced, File extension command.

**Activating the Address columns (optional)**

It is possible to add some specific columns in the Chart of Accounts, to insert the address and other customers data:

- Choose the **Add new functionalities** command from the Tools menu
- Choose the **Add addresses columns in the Accounts table** command
  (If you don't see this option in the list, it means that this function has already been activated).

In the Accounts table the program will add:

- An **Address** view, where the added columns are made visible.
The columns that allow the insertion of the address data and other information.

- To display one or more of these columns, use the **Columns setup** command from the **Data** menu.
- To create other views with only selected columns, use the **Tables setup** command (**Data** menu).

Select **Accounts table, Address view** and add the required information to the customers' accounts.

### Setting up the expiration date for invoices

To set / modify invoice expiration dates, you may intervene on three levels, where higher priority is given to the first one. Expiration data will be displayed in the payments schedule and printed out on the invoice document.

**1. level - setting the expiration date on an individual invoice**

In the row of the Transactions table, where your invoice is entered, you will find an Date Exp. column when using the Due Date view. If a date is set up, it will have priority over dates set up on the 2nd or 3rd level.

**2. level - setting the expiration date on an individual customer/supplier account**

In order to set up an expiration date on a client level, for example +20 days after issuance of the invoice, select the account in the Accounts table, using the Address view, go to the Days Column (PaymentTermInDays) to set up the number of days to be used.

**3. level - general setup**

Expiration dates applying to all Customers/Suppliers can be set up via menu **Account2>Customers>Settings**...

### Setting up the Customers' parameters

- Select the **Account2 - Customers - Settings** command
- Please indicate the group of the Chart of Accounts in which the different customers' accounts are grouped in "Group or account".
- For an explanation of the different options, go to **Customers and Suppliers settings**.
Payments schedule

Displaying invoices issued to customers

Account2 menu - Customers command - Invoices issued to customers...

This dialog box is identical for both Customers and Suppliers functions. The following explains the functions related to customers, but they also apply to suppliers.

All customers

Displays the account statement of all customers belonging to the group, as defined in the Customers and Suppliers settings.

A single customer

Displays the account statement for the customer selected belonging to the group defined in the Customers and Suppliers settings.
Displaying open invoices

Command: Account2 - Customers - Open invoices by customer

Invoices showing an open balance are being listed in this table.

Displaying overdue invoices

Command: Account2 - Customers - Open invoices by due date

In this table, invoices showing an open balance are being listed, filtered by expiration period.

Creating invoices

Banana Accounting invoices: new functionality of Banana 9
In **Banana Accounting 9 software**, invoices to be sent to customers are generated based on the accounting transaction, issuing the invoice. This method differs from all other accounting programs where, as a rule, the invoice is created prior to entering the accounting transaction.

### How to create a new invoice

1. In the Chart of Accounts (**Accounts** table) indicate an [account for each customer](#), with the address and other data you might need.  
   In case you have clients of different nationalities, it is also possible to setup a different language to create the invoices for each client ([see how to define the language for each client](#)). If you don't define a specific language for your client, the invoice will be printed in the language used to create the file ([File menu -> File and accounting properties -> Other tab](#)).

2. In the **Transactions** table enter the rows of transactions, that will constitute the rows of your invoice.  
   - Indicate the date of transaction and the invoice number. Those values will have to be repeated for other rows appertaining to the same invoice.  
   - Indicate the debit account of the customer.  
   - Indicate the accounting counterparty (Sales account, Consulting or other) and the amount.  
   - A VAT code may also be used to indicate the percentage applicable to the transaction.

3. The **Print invoices** command ([Account2 menu > Customers](#)) will display a preview of the invoice, for which the data of the **Accounts** table and the invoicing rows of the **Transactions** table are used.

### In which file should you manage the invoices?

There are two solutions:

- **Direct invoicing in the accounting file**
- **Separate file for invoicing only**

#### Direct invoicing in the accounting file

The entries of the invoices are registered directly in the accounting file of the company. This method is recommended if **invoices are to be registered in your accounting when they are issued**.

- Real estate companies that register, at the start of the year, the rent for the entire year  
- In general for all those who manage their accounting based on the issued/received invoices

There is a direct link between the entries to the accounts and the content of the invoices. Entering records and printing your invoices directly will prevent possible errors in carryover of information. Accurate knowledge of accounting is a prerequisite for establishing invoices.

With the simple Copy/Paste you can easily create similar invoices. For example in order to create similar invoices for all members of an association, you can create the first invoice rows and then you
can just change (or paste) the account number of the different members. If necessary, you can create rows in Excel and paste them into Banana.

**Adjusting an existing accounting file in order to include and print invoices**

1. In the **File** menu -> **File and accounting properties**... you can setup your company's address and data, which will be used as the header of the invoice.
2. In the **Accounts** table, **you can setup your clients/suppliers register and manage your clients settings** via the **Account2** menu -> **Customers** -> **Settings**.
3. Always in the **Accounts** table, you can select the **Address** view and enter your clients data. If the **Address** view is not visible, you can add it using the **Tools** menu -> **Add new functionalities**... command -> **Add Address columns in the Accounts table**.
4. In the **Transactions** table, insert one (or several) row(s) of the invoice, using an account of the client's register and indicating the invoice's number in the **Invoices** column; if not displayed, add via the **Data** menu -> **Columns setup** command.
5. Additional columns are also available if you require more detail (Quantity, Price, Unit) and can be activated via the **Tools** menu -> **Add new functionalities**... command -> **Add Items Columns in Transactions table**. Same process for the **Type** column: if not displayed, use the **Data** menu -> **Columns setup** command.
6. To use the company logo on the invoice or on the print, please refer to the paragraph "Logo on the invoice or on the print" of the **Documents Table** page.

If you still don't have your own accounting file you can **create an accounting file** with the **New** command from the **File** menu. You will find some preset templates with clients/suppliers register. The accounting types that support the creating of invoices are the Double-entry accounting and the Income & Expense accounting (both can be applied - or not - with the VAT and multi-currency options).

**Separate file for invoicing only**

A new file is created, completely separate from the accounting file, where in the Chart of Accounts only the accounts for managing the clients and those necessary for the invoicing are being entered. You then enter the transactions for your invoicing. This method is recommended if:

- Invoices are registered only when cash settled. The amount is only entered in the accounting file when the invoice has been paid.
- A segregated management of invoicing is required. As in the case of membership fees for an association, for instance.

**How to create a separate file to manage the invoices**

- Download the **invoices.ac2** file template, open it and adjust for your requirements. Alternatively, you may start from any existing template and adapt it for the use of invoices, as indicated earlier.

**Columns of the Transactions table specific to invoices**
**Date**
The invoice's date is reported in this column. All rows appertaining to the document must report the same date.

**Invoice**
It is mandatory that you enter an invoice number (Invoice column) and an account belonging to the client's register (Debit/Credit columns). Only digits are allowed [0-9].

**Extra columns:**

**Type**
In the Type column, rows can be defined as a specific line, for totalisation or term of payment, for instance. Refer to DocType column page for examples.

**Qt. (Quantity)**
You can enter the product quantity. If it is not visible, you can add this column using the Tools menu -> Add new functionalities... command -> Add column Quantity in the Transactions table.

**Unit**
You can enter your unit (ex. pc for pieces, kg, etc.)

**Unit/Price**
You need to enter your unit price referred to the service or good. The program will automatically calculate the total amount based on the quantity enter in the Quantity column.

**Printing your invoices**
After entering the invoice in your Transactions table,

- use the Account2 menu -> Customers -> Print invoices

**Invoice preview**
Define the invoice language for each client

As already mentioned above, in order to create (and then print) invoices, you need to have the Address view visible in the Accounts table. In the Address view there are several columns related to the customer data: Name, Address, Tel, .... one of these columns is the Language column. If the Language column is empty, the program uses the file creation language to print invoices (File menu -> File and accounting properties -> Other tab).

If there is a specific language code in the Language column, the program uses the language indicated for printing invoices of that specific client. In this way, invoices can be printed in different languages for different customers.

It is also possible, for each language, to set up predefined texts that will be displayed at the end of the invoice, for example greetings or bank details (for more information see the Print invoices page).

Useful resources:

- Example of invoicing in Income/expense accounting
- Example of invoicing in Double-entry accounting
- Invoicing example with customers set up as cost centers

Roundings in the invoices

When you print out an invoice in CHF, the total will rounded to the next 5 cents, if necessary. If the total on printed invoice does not match the transaction amount, the user will be notified of the difference.

If the rounding up of the total amount is not required, select command Account2->Customers->Settings->Advanced in order to set the desired rounding, such as 0.01, which will match the total of the invoice to the transaction amount.
When the rounding is generated in the Transactions table the printed invoice will not appear in the printed invoice. See example:

Print invoices

Print invoices dialog window

By confirming with OK, you will see the preview of the invoice.

Print tab

Invoice numbers

In order to print single invoices, indicate

- The number of the invoice for a single print;
- The numbers between commas "1,3,6" for multiple prints.
- The numbers separated by hyphen "1-3" to print a range.

If the invoice itself contains a '-', for example if you have an invoice number '2016-1', this must be enclosed in brackets {}, to distinguish the numbering of a range of documents {2016-1}-{2016-3}.
Invoices from

This option allows you to print all invoices included in the selected period. You need to enter an initial and final date.

Unprinted invoices

Invoices where the 'Printed' column of the Transactions table is empty are printed. All unprinted invoices are therefore printed.

Layout

The styles allow you to change the invoice layout. Templates with logos, with quantity column or with ISR slip are available.

Other templates

This button takes you to the Manage Apps dialog window, where you update your templates to the most recent version or to add your own.

Settings

You can setup specific parameters for the selected style, refer to explanations in the Templates page for further information.
The main options are: Include page header (yes/no), Print ISR (yes/no), select colors, depending on the selected style.

Update the 'Printed' column after printing

You can make this column visible by using the Data menu -> Columns setup command.

The program will update the content of this column after the print preview, adding the text '1'. This will allow the Select unprinted invoices command to only print the invoices with no content in this column.

Templates Options tab

In this tab it is possible to add free texts, such as for example your bank details.
Select the Print invoices command from the Account2 menu -> Customers.
In the Templates Options tab enter the desired text and then press OK. You will see the print preview.

You also choose in which language to print the invoice. For more information please visit the Creating invoices page.
Print credit notes

If you wish to print a credit note without using any specific style, simply change the title of invoice printing in the Amount Type column of the Transaction Table.

- Generate the Recording of a credit note
- To change the title of the document, add a row for recording as follows:
  - Enter the date of the credit note in the Date column
  - Enter the number of the credit note in the Doc. Original column
  - Enter '12:' in the Type column and select in the Title dropdown menu: 12:tit will figure as wording
  - Enter the title of the document in the Description column: 'Credit Note' in this example
- Print the document via Account2 . Customers - Print invoices ...

Print payment reminders
The program automatically creates the payment reminders from the overdue invoices. In addition to the printouts, the program directly creates the transactions in the Transactions table, which are used to recreate the issued reminders history. These transactions show the document date and the document Type: 16-1 first reminder, 16-2 second reminder and 16-3 third reminder.

**Use last payment reminders**

If in the Transactions table there are reminder transactions with the indicated date, the program will suggest to print these reminders.

**Create new payment reminders**

For all expired invoices new reminder transactions are created, that can be then printed.
Payment reminders

The program will show the expired invoices, which you can deactivate if you do not wish to send the reminder.

Template

The styles allow you to change the print layout.

Manage apps

Use this button in order to update the templates with the most recent ones or to add your own templates.
Use this button in order to setup the selected style parameters.

Print statements
Statement date

This is the date printed on the statement. It is not possible to set up a date prior to the date of the last existing transaction.

Layout

The styles allow you to change the print layout.

Manage apps

Use this button in order to update the templates with the most recent ones or to add your own templates.
Use this button in order to setup the selected style parameters.

DocType column

In this column you can enter special rows into the invoice, like subtotals, notes, or a different invoice address.

Printing of a credit note

To print out a credit note, use the Print invoices command and simply alter the title to Credit Note from Invoice.

- Create your document, as if it were a regular Invoice by indicating it's number in the Invoice column. Accounts will be attributed accordingly for your credit note, i.e. amounts will appear in negative.
- To change the title of your document, add a row in the Transactions table as follows:
  - Enter the date identical to the one used in the document you have just created in the Data column of Transactions
Enter the number of the created document, corresponding to your Credit note, in the **Invoice** column.
Enter ‘**10:**’ in the **Type** column and select **Title** in the drop-down menu; **10:tit** should be displayed.
Enter the title of your document in the **Description** column, ‘Credit Note’, in this case.

- Print your document with the Account2>Customers>Print invoices ... command.

**Subtotals**

In order to enter subtotals or payment terms into the invoice, you need to add additional transaction rows in the **Transactions** table.

- In the **Type** column enter ‘**10:**’ and from the drop-down menu choose **Total**; the text **10:tot** will show. Enter ‘:**’ once again and select **Total 1**
- In the **Description** column, enter the appropriate description for the total (for example, Total merchandise).
- Enter the invoice number (mandatory if you want the total to be printed).

**Specific payment terms per individual invoice**

In order to enter payment terms into the invoice, you need to:

- Enter an extra row with the same invoice number into the **Transactions** table.
- In the **Type** column, enter ‘**10:**’ and from the drop-down menu choose **Terms**; the text **10:ter** will show.
- In the **Description** column, enter the text (for example, 30 days, 60 days).

When the invoice will be printed, the entered value will be shown as the term for payment.
### All the options Document Type 10: column: (invoice)

<table>
<thead>
<tr>
<th></th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>:adr First name; Last name; Business name; Street 1; Street 2; Street 3; Postal code; City; State; Country</td>
</tr>
<tr>
<td></td>
<td>Invoice address that is different from the one indicated in the Accounts table, Address View</td>
</tr>
<tr>
<td>10</td>
<td>:gre Greetings</td>
</tr>
<tr>
<td>10</td>
<td>:not Note</td>
</tr>
<tr>
<td>10</td>
<td>:ter Payment terms</td>
</tr>
<tr>
<td>10</td>
<td>:par Parameters Go to: Printing custom data</td>
</tr>
<tr>
<td>10</td>
<td>:tit Document title The title 'Invoice' can be replaced by another wording, for example 'Price Quote'.</td>
</tr>
<tr>
<td>10</td>
<td>:tot Total Level 0; Total Level 1; Total Level 2 Totals</td>
</tr>
</tbody>
</table>
Templates

Predefined Templates

Several templates for invoicing, sending reminders and reports are available in the program. Printing characteristics are different for each template.

You can install or remove the templates through the commands **Account2 > Customers > Print Invoices** or **Manage Apps** (from the **Apps** menu).

**Available templates**

Change template parameters

For each template some parameters can be set up and changed, such as including (or not) of a header, ISR payment slip (Switzerland only), Logo height in mm (when present) modifying text- or background colors. Here is how to proceed:

- Choose the **Print invoices...** command from the **Account2 > Customers** menu
- In the **Layout** box choose the preferred template from the list
- Click on the **Parameters** button to define your preferences.

Select a different template

- Choose the **Print invoices...** command from the **Account2 > Customers** menu
- In the **Layout** box you can see all the templates downloaded from the **Manage Apps...** command (**Apps** menu)
- In case you want to change template, select one of the other templates in the list or click on the **Other templates...** button to go back to the **Manage Apps...** dialog window and download new ones.

Update predefined templates

The default templates are being updated automatically, or you can force the update through the **Manage Apps...** dialog window:

- Click on the **Manage Apps...** button from the **Apps** menu
- Click on the **Update apps** button at the bottom of the window.

Create your own customized invoice

Banana allows you to modify the layout of your invoice; if none of the predefined templates matches your needs, you may create your own by customizing an existing one or by creating one from scratch, but knowledge of JavaScript language is required in this instance.

More information can be found on the [developers page](#).
**Settings of the invoices**

**Print VAT information**

Display of the VAT amounts will depend on the invoice template being used. Some templates will display amounts with VAT included and others will display amounts excluding VAT, and then add the VAT separately to the total.

**Rounding of invoice total**

The totals of the invoices in CHF are automatically rounded off to 5 cents. You can disable the rounding by using the **Settings** command in the **Account2 -> Clients** menu. In the dialog, select the tab **Advanced, Invoice rounding** and write **0.01** (which corresponds to 1 cent).

**Languages**

Templates are available in: it = Italian, de = German en = English, fr = French, nl = Dutch

Invoices are printed in the language defined in the accounting file's preferences, unless a different language for the customer was defined (**Accounts table, Address view, Language** column.)

**Logo**

Some templates are set up to use the existing logo of the company. Refer to the **Documents table** page (Paragraph "Adding an image to use as a logo when printing the invoices") for information about inserting your own logo.

**Swiss ISR payment slip policy:**

For the invoice templates that start with CHxx, you can choose whether you want to print the ISR (orange inpayment slip for Switzerland). In order to print the ES (red inpayment slip), use model [CH09]:

To activate printing of the ISR payment slip in the Print invoices dialog, under Layout, select your template and click on **Settings...**. Select number **1** in **Print ISR** for **YES**, print ISR, or **0** for **NO**, don't print ISR.

In order to print the ISR, the following information is required from Postfinance or your bank:

- **Bank Account:**
  - ISR account: for example 01-9999-9
  - ISR Membership number (ID), for example 113456 (enter without hyphens)

- **Postfinance Account:**
  - ISR account: for example 01-9999-9
  - (The filed ISR subscriber number is left empty in the settings.)

**Personal text**

You can enter lines of text in the lower part of the invoice. This can be useful, for example, entering bank data.

Select **Account2 -> Customers -> Print invoices** and click on the tab **Template options**. Enter the desired text in the **Final text** field and confirm with 'OK' to obtain a print preview of the invoice.
Adding notes

There are two possibilities:

- create one or more records that show the desired text with date and invoice number, the other columns remain empty. In this mode the text will correspond to one line of invoice detail.
- create one or more records that show the desired text with date and invoice number, and in the Type column (DocType) indicate the value 10: not. In this mode the text will be shown at the end of the invoice.

Customers' & suppliers' settings

This dialog box is identical for both customers and suppliers functions. The following explains the functions related to customers, but they also apply to suppliers. As long as you have not indicated the customer or supplier group, the customer menu choices are disabled.

General

Group or account

Select the generic group or account that contains the Customers or Suppliers list. The group or the account needs to be already present in the Accounts table. See Setting up the Customers' register and Setting up the Suppliers' register.

Due date invoices (in days)

The program uses the following order of priority to calculate the invoice deadline:

- The due date if you entered it into the transaction row.
  If there is more than one date for the same invoice number, the most recent one applies.
- If the number of days is indicated in the PaymentTermInDays column of the Accounts' table, the date of the transaction, incremented by the number of days set.
- The date of the transaction is incremented by the days indicated in the settings dialog box.
Include transactions from previous (years)

- If 0, the program will not display invoices from the previous year, but only the opening balances of the customer account.
- If 1, the program will also include the invoices of the previous year in the customer card.
- If 2 or more, the program will also include invoices from years before in the customer card.

Advanced

Link to the invoice document

You can insert a link to an invoice file (pdf, doc or other) in the Link to an invoice field. If a link is inserted in the Transactions table and the invoice number is entered in the Invoice column, the program will open the document, allowing you to access all the data contained.

The link may contain:

- The XML name `<DocInvoice>` or the name of another column contained between `<>`. If you use the "<DocInvoice>.pdf" command and you are on the row with invoice number 100, the program will try to open the "100.pdf" file. You can also prefix the filename with the name of a directory.
- You can use any file name extension. This extension must, however, be included in the list of file extensions considered safe (Tools- Program options-Advanced).
- It is also possible to indicate a path preceding the field name, that consists of the name for the document to be opened.
- With the link "c:\temp\<DocInvoice>.pdf" and the invoice number 100, the program proceeds to open the file c:\temp\100.pdf.
- The name of the directory is relative to the directory where the file is located.

Opening an invoice document

- Position yourself in the Invoice column of the transaction row related to the invoice you wish to open
- Click the right mouse button to open the context menu
- Choose the command Open invoice link.
Suppliers sub-menu

The features, present in the Suppliers sub-menu (from the Account2 menu), allow you to obtain the following lists:

- Display open invoices
- Display overdue invoices
- Display invoices issued to suppliers

Logic for checking Suppliers' invoices

In order for the program to be able to prepare the lists of received invoices:

- In the Invoice column of the Transactions table, indicate the invoice number.
- In the Debit or Credit column of the Transactions table, indicate the account number of the Supplier

Also, before entering the transactions:

- In the Chart of accounts, Supplier accounts and/or groups need to be created
- If desired, address columns can be added
- In the Suppliers set up, indicate the Suppliers group or the general Suppliers account.

You also need to choose if, in the Chart of accounts, you need to have:

- An account for each Supplier.
  This is necessary when the list of invoices needs to be presented separately by supplier.
  In this case, a row needs to be created for the Suppliers and each supplier account refers to this group in the GR column (see hereunder).
- One single account in which all the Suppliers are contained
  The list of the open, expired invoices will be for all the Suppliers together and not per each individual Supplier.

Notes:

- Reports are based on the account currency balances; possible exchange rate differences will not be taken into account.
- The reports Description column will reproduce the first row description for each invoice.
- For the accounting files based on cash received you can setup a suppliers register with the Cost Centers.

Detailed explanations

Setting up Suppliers accounts

- Setting up the register
- Activating the address columns (optional)
Setting up the suppliers' settings

**Entering transactions**

- Displaying the Invoice column in the Transactions table
- Entering the invoice that is being issued
- Entering a payment
- Entering a credit note
- The Extract invoice rows and Open invoice link commands

**Reports and printouts**

- Displaying the open invoices
- Displaying the expired invoices
- Displaying the Invoices received from Suppliers

**Automatic autocomplete**

**Example file**

- clients_suppliers_menu.ac2

**Setting up the accounts**

- Setting up the register
- Activating the Address columns (optional)
- Setting up the Suppliers' parameters

**Setting up the Suppliers' register**

The Suppliers accounts & groups can be entered just like regular accounts, directly into the Chart of accounts.

It is equally possible to create a separate section with the Suppliers' register. In this way, only the total of the Suppliers' group is visible in the Chart of accounts and in the register all the individual Suppliers' accounts are being displayed.

To create the Suppliers' register, add at the end of the Chart of accounts:

- A * section (header) (see Sections)
- A 02 section for the Suppliers (see Sections)
- The Suppliers' accounts that are needed (see Adding a new account). The account numbering can be freely chosen.
The total Suppliers will be totalized in the summary groupe 200A of the Gr column.

The same code or number used for the Gr (200A), must be used in the Liabilities Group column, in the row corresponding to the Total Suppliers. The groups numbering can be freely chosen (see Groups).

Managing the Suppliers' register with the Cost centers

In case you don't want Suppliers to be visible on the Balance Sheet (for example, for transactions with VAT on cash received), Suppliers accounts can be created by using the Cost centers (CC3). This process is similar to the Clients cost centers.

Activating the Address columns (optional)

It is possible to add some specific columns in the Chart of accounts, to insert the address and other Supplier data:

- Choose the Add new functionalities command from the Tools menu
- Choose the Add addresses columns in the Accounts table command
  (If you don't see this option in the list, it means that this function has already been activated).

The programme adds in the Accounts table:

- An Address view where the added columns are visible.
- The columns that allow to insert the address data and other information.
  - To display one or more of these columns, use the Columns setup command from the Data menu, also in the other views.
  - To create other views with only certain columns, use the Views setup command.

Select the Accounts table, Address view and add the desired information to the Suppliers accounts.
Setting up the Suppliers' parameters

- Select the **Account2 - Suppliers - Settings** command
- Please indicate in "Group or account", the group of the Chart of accounts in which the different Suppliers' accounts are grouped.
- For an explanation of the different options, go to **Customers and Suppliers settings**.

Entering transactions

Displaying the Invoice column in the Transactions table

The invoice number has to be entered in the Invoice column (DocInvoice) which, in the default settings, is not visible in the Transactions table.

In order to display the column:

- Select the Transactions table
- Data menu
- Columns setup command
- Activate the Visible option for the DocInvoice column
Autocomplete of invoice data

For the automatic completion see the explanation on the page Entering client transactions.

Recording a received invoice

- Insert the Transaction date
- Place yourself on the Invoice column and press the F2 key
  The list of Open invoices will be opened.
- Select the desired invoice and press Enter.
  The program completes the Transaction with the Description column, the Debit account and the Amount.

Recording a payment

- Insert the Transaction date
- Place yourself on the Invoice column and press the F2 key
  The list of Open invoices will be opened.
- Select the desired invoice and press Enter.
  The program completes the Transaction with the Description column, the Debit account and the Amount.

Enter the account used to pay the invoice.
Recording a credit note

In order for the amount to be deducted from the original invoice, the same invoice number needs to be used. If the corrective document (for example, a credit note) presents a different number that needs to remain available, such a reference can be entered in another column, like Doc. Original.

Extract invoice rows command and Open invoice link

The Extract invoice rows command displays the transactions of the selected invoice.

The command is available by clicking on the small blue symbol above at the upper right corner of the cell or with the right mouse button.

The invoice rows can also be extracted by clicking on the invoice number with the right mouse button, Extract invoice rows command.
The **Open Invoice link** command establishes the text that has been defined in the Suppliers' settings (Account 2 - Suppliers - Settings - Link to the Invoice document).

For example, if the invoices have been created with Winword and saved in the Documents folder, these files can directly be opened by setting up the command line with the text ‘C:\Users\myname\Documents\<DocInvoice>.doc’ . The program substitutes <DocInvoice> with the text corresponding to the column and executes the command.

In the command line, it is possible to also indicate other columns of the table by using their XML names.

If the message 'File with extension considered unsecure' appears, add the extension (for example .doc) through the command Tools - Program Options, Advanced, File extension.

**Reports and printouts**

- Displaying the open invoices
- Displaying the overdue invoices
- Displaying the Invoices received from suppliers

**Displaying the open invoices**

Command: **Account2 - Suppliers - Open invoices by supplier.** In this table, the invoices that have an open balance are being listed.

**Displaying the overdue invoices**

Command: **Account2 - Suppliers - Open invoices by due date**

In this table, the invoices that have an open balance are being listed, grouped by aging period.
Displaying the Invoices received from suppliers

Command: **Account2 - Suppliers - Invoices received from Suppliers**

In this table, all the invoices that are part of the Suppliers' register, or that belong to an individual supplier, are being listed.

VAT Management

Pages with more in-depth information:

- [VAT management in Switzerland](#)
  
  There are several pages with specific information for Switzerland, for example on how to set up the VAT codes table, enter the VAT transactions and prepare the declaration.
- [VAT management in Italy](#) - this page is in Italian
- Import VAT codes

**Theory**

VAT (Value-added Tax) is a tax that weighs on the final consumer. Every VAT subject must calculate and periodically deposit the tax to the Revenues Authority.

Every country has its own VAT rates that are established in different percentages depending on the type of merchandise or service. Certain merchandise and services are exempt or excluded.
The percentages vary according to the financial necessity of the country; therefore, there can be changes over the years.

**VAT rate**

In this document, to make calculations easier, we will use the following rates:

- 10% normal rate
- 5% reduced rate
- 0% excluded operations or exempt operations

**VAT calculation**

Net Price x VAT Percentage / 100 = VAT Amount

Example:
Net price 300
Tax rate 10%
VAT amount = 300 x 10 / 100 = 30

**Gross price calculation**

Net price + VAT Amount = Gross Price

Example:
300 + 30 = 330

Sometimes the gross amount is known and it is necessary to find the net and VAT amounts.

**Net price calculation**

Gross Price / (100 + VAT rate) x 100 = Net Price

Example:
330 / (100 + 10) x 100 = 300

The net price represents the cost (purchase) or the revenue (sale) of the company

**VAT amount calculation**

Gross Price - Net Price = VAT Amount

Example:
330 - 300 = 30

or

330 - [330 / (100 + 10) x 100] = 30
The VAT amount represents the debit (sales) or the credit (purchases) towards the Revenues Authority.

**VAT rate calculation**

\[
\text{VAT Amount} / \text{Net Amount} \times 100 = \text{VAT Rate}
\]

Example:
\[
30 / 300 \times 100 = 10\%
\]

or
\[
\left[330 - 330 / (100 + 10) \times 100\right] / 100 = 10\%
\]

Another example:
\[
20 / 400 \times 100 = 5\%
\]

This way of calculating is used when the rate is not known.

**VAT Codes Table**

The VAT Code table setup allows the definition of all the parameters that are necessary to manage the transactions with VAT. The setup refers to:

- VAT due or recoverable
- Transaction amount recorded as net, gross, or VAT amount at 100% (Customs VAT)
- Freely definable applicable VAT rates
- Freely definable account in which VAT must be recorded
- Special rounding off for each code
- Definable grouping and totaling method

The VAT Codes table has a **Base** view and a **Complete** view (see top of the table hereunder). The difference between the two is the fact that the Complete view presents several columns that are not available in the Base view. These columns serve to accommodate some specific options.

**How to calculate**

The parameters indicated in the VAT Codes table are being used to calculate the VAT of the individual transactions. The parameters established in the VAT Codes table cannot be changed in the transactions. This modality guarantees that the VAT calculations are correct and uniform.

**Please note:** if the values of a VAT Code, which has already been used in the transactions, are being modified, the changes are not active immediately; in this case it is necessary to activate the Recheck accounting command (Account1 menu -> Recheck accounting). When the VAT Codes table is being modified, the program invites the user, through a message in the Info window, to execute a complete recalculation as a precaution.

**The following table refers to the codes being used according to the Swiss legislation:**
**Detailed description of the columns**

In the following columns, insert the following data:

- **Group**: a code or number that identifies the group to which the code belongs. In the example we have inserted 1 for the sales, 2 for the purchases, T for the total.
- **VAT Code**: the code to identify and carry forward the VAT code in the transactions.
- **Description**: a text for the description of the VAT Code or the group.
- **Disable**:  
  - Entering 1, the VAT code isn't displayed in the autocomplete list (Transactions table), but can still be used;  
  - Entering 2, the VAT code is disabled and cannot be used.
- **Gr**: code of the "Group" in which the row has to be added.
- **Gr1**: In the image of the table above, the grouping codes representing the numbers for the Swiss VAT declaration are being shown.
- **Gr2**: code for additional groupings.
- **Due VAT**:  
  - If the word **Yes** is being inserted, this means that the VAT is at debit (due to the State)  
  - If the cell is empty, this means that the VAT is at credit (recoverable)
- **Amount type**: indicates how the software considers the transaction amount:  
  - 0 (or empty cell) with VAT/sales tax (the transaction amount is considered VAT included)  
  - 1 = without VAT/Sales tax (the transaction amount is considered VAT excluded)  
  - 2 = VAT amount (the transaction amount is considered the VAT amount)
- **% VAT**: VAT code percentage
- **Non ded.**: if, for a VAT code, it is not possible to deduct the full 100%, enter the non deductible percentage here (example 100%)
- **VAT% on gross**: is usually being left empty. In special cases, the word "Yes" has to be inserted only if the VAT percentage has to be applied on the gross amount (VAT included) and not on the taxable amount.
- **VAT account**: the account on which the calculated VAT is being automatically.  
  In the [File and Accounting properties (File menu)](file-action), a general account, that will be used as the VAT account, can be defined.  
  It is also possible to set up a specific account for every individual VAT code.
- **Round Min**: minimum value for rounding, to be used only in particular cases. By preference, the rounding indicated in the basic data of the accounting (f.i. minimum rounding value 0.05) is
being used.
- **Don't warn**: there are particular transactions that the software could interpret as mistaken, but which, in reality, are correct. In order to avoid for the software to signal error messages, insert the word **Yes** for the code that is concerned.

When the transactions with VAT are inserted, by applying the VAT Code in the **VAT Code** column, the software calculates automatically all the amounts related to the VAT and transfers them in the VAT account.

**Rechecking of the accounting file**

When rechecking the accounting file, if transactions are not locked, the program will reload the VAT parameters assigned to each code. If a VAT code setting has been changed, the change will be taken into account in the corresponding transactions columns (that cannot be edited by the user).

For this reason, when editing the **VAT** table, the program suggests to operate a full accounting recheck.

**Adding a new percentage**

When a new percentage is added, a new row has to be added; in the new row, insert the data of the new VAT code with the new percentage, while paying attention to insert the correct grouping. Don't change a code that has already been used in the transactions.

**Groupings**

By creating groups with multiple totaling levels, the user can obtain the totals that are necessary for the VAT declaration. In the VAT report, by activating the option **Use own grouping scheme**, the software calculates the totals exactly as indicated in the sequence of the indicated groupings in the VAT Codes table. The groupings are being used to obtain totals for groups of transactions, for example, the totals for all exportations or importations.

**Related document**: [Import VAT codes](#)

**File properties (VAT/Sales tax tab)**

This tab only appears if an accounting with VAT/Sales tax management is chosen.
**VAT Account**

The Automatic VAT account, that is present in the chart of accounts, is defined here as default. In this case, the VAT account does not need to be inserted in the VAT Codes Table.

**VAT/Sales tax rounding**

This is where the user inserts how the VAT/Sales tax amounts should be rounded; if, for example, the user inputs 0.05, the VAT/Sales tax amounts will round to multiples of 0.05.

**Cost Centers 1 (CC1), 2 (CC2), 3 (CC3)**

For each type of Cost Center, the user can select which amount to use for the transaction in the cost center.

- Use transaction amount
- Use amount inclusive VAT/Sales tax
  (When cost centers are being used for Client/Suppliers accounts)
- Use amount without VAT/Sales tax
  (When cost centers are being used for Revenue and Expenses)

**Note:** If one of these parameters is modified, the accounting must be recalculated.

**Related documents:** VAT Management, Cost and Profit Centers

**Associate VAT code to the account**

In an accounting with VAT, in the Accounts table, it is possible to associate a VAT code to the income/expense accounts, so that, when the sales and purchases are being recorded, the program automatically inserts the VAT code and completes the columns with the VAT data while entering the account number.

In order to associate the codes:

- Click on the Other view. In this view, the VAT code column is visible by default. In case you wish to display the VAT code column in the Base view, click on the Data menu, Columns setup command (see Related document at bottom of this page).
- Insert the VAT codes for the income/expenses in the VAT code column.
Accounting Charts templates included in Banana Accounting are already set with the VAT accounts, the VAT according to VAT report account (automatic), both in the chart of accounts and in the File and accounting properties of the File menu - VAT tab (in this case you don't need to enter any VAT account into the VAT codes table).

In case you are not using the Charts of accounts already available in Banana, make sure that the necessary VAT accounts are present in your own Chart of accounts. Our advice is to use a "VAT according to VAT report" account and to enter it into the File and Accounting properties, VAT/Sales tax Tab.

In the VAT codes table, there are codes both for the sales and the purchases. When entering the transactions, use the appropriate VAT code.

The software automatically splits the VAT amounts and records them in the "VAT according to VAT report" account or in the VAT account that has been indicated by the user in the File and Accounting properties.

VAT columns in the Transactions table (Complete VAT view)

You can find the full explanation of the main Transactions table columns in the Transactions page.

In the Double-entry accounting files with VAT or in those of the Income & Expense accounting with
VAT, you will find the following VAT columns:

- **VAT Code**: for each transaction with VAT you need to enter one of the VAT codes from the VAT codes table
- **VAT %**: the program automatically enters the VAT percentage associated with the VAT code you entered
- **VATExtraInfo**: A code related to extra info about the VAT, to be used only in very exceptional cases. It is possible to enter a symbol to identify specific VAT cases. The program suggests options, corresponding to the VAT Codes that start with a colon ":"
- **%Eff.**: the program automatically enters the VAT percentage referred to the net amount. This percentage is different from the normal percentage when this one is referred to the gross amount.
- **Taxable**: once you enter the VAT code, the software automatically indicates the taxable amount (without VAT)
- **VAT amount**: the program automatically indicates the VAT amount
- **VAT A/C**: the account where the VAT is registered is automatically indicated (for Switzerland normally is the 2201 VAT report account); this account was previously entered in the File Properties, VAT tab (from the File menu).

- **Amount type**: this is a code that indicates how the software considers the transaction amount:
  - 0 (or empty cell) with VAT/sales tax, the transaction amount is VAT included
  - 1 = without VAT/Sales tax, the transaction amount is VAT excluded
  - 2 = VAT amount, the transaction amount is considered the VAT amount at 100%
  - Amount type not editable: Default mode.
    - The column is protected
    - The program uses the associated value of the VAT Codes table
    - When you edit the value in the VAT Codes table and you recalculate the accounting, the program uses the new value associated with this VAT Code.
  - Amount type editable: this option can be activated with the Add new functionalities command. The activation of the option cannot be undone.
    - When you edit the VAT Code, the program uses the Amount type associated with this code.
    - The value can be edited manually
    - When the accounting is being recalculated, the value indicated in the Transactions table is being maintained.

- **Non. Ded. %**: this indicates the non deductible %.
  - When you enter or change the VAT Code, the program uses the Non. Ded. % associated to this VAT Code in the VAT Codes table.
  - You can manually edit the value

- **VAT Acc.**: this is the VAT amount registered in the VAT account.
  It is calculated by the program according to the Transaction amount, the Amount type and the non deductible percentage.

- **VAT number**: this is the code or VAT number of your client/supplier.
  When you enter a transaction with VAT, it is possible to enter the VAT number of your counterparty. If in the Accounts table, in your clients/suppliers register, you also enter their VAT number, this is automatically loaded in the Transactions table, in the VAT number column.
Transactions with VAT

Before entering transactions with VAT, we advise you to visit the Transactions page.

The most common way of entering a VAT transaction is to enter the gross amount (amount including VAT), then apply to it the appropriate VAT code, choosing it among the ones included in the VAT codes table and according to your transaction type (Purchase, Sale, Discount, ...).

How to correct VAT transactions

If you see the mistake right away, you can just edit the transaction row; this is only possible if you haven't sent your VAT report yet and if there is no transactions lock.

If however your accounting file is locked or if you have already sent your VAT report, you cannot simply delete the wrong transaction, but you need to operate some cancellation-transaction and then re-enter the correct transaction.

In order to rectify VAT operation you need to:

- make a new transaction by inverting the Debit and Credit accounts used in the wrong transaction
- enter the same amount
- enter the same VAT code but preceeded by the minus sign (ex.: -V77)
- enter a new transaction with the correct accounts, amount and VAT code

Depending on the entity of the mistake, you should consider informing your local VAT office; usually they ask you to download a specific form for correcting mistakes in the previous VAT period.

Transactions with different VAT codes

When the total amount of an invoice is composed by several amounts with different VAT percentages, you need to register as follows:

- each amount with a specific VAT percentage needs to be entered on a different row with its own
VAT code (enter the gross amount)
- once you finish the multiple registration, check that the sum of the different amounts and the VAT amounts correspond to the invoice total.

Here is an example:

VAT EXEMPTION
If in your invoice you also have some items VAT exempt, you need to operate as above, choosing the VAT exempt code from the VAT Codes table.

Credit note

In case an operation, that has been entered at an earlier date, needs to be cancelled, the same VAT code that has been used for the initial operation needs to be entered with the minus sign (-). In this way the VAT is being rectified.

Instead of using the minus sign prior to the VAT code, it is also possible to use the specific VAT codes for discounts that have been configured in the VAT Codes table.

Example of a credit note on a sale

When a client finds a defect on a sold product, usually a credit note on his behalf is being issued. The credit note implies a decrease of the income and as a result a recovery of the VAT (Sales tax).

For example, we enter a sale amount of 12'000 including a 7.7% VAT. We then issue on the client's behalf a credit note of CHF 200.- for a product defect.

For a recovery of the VAT on the amount of the credit note, the VAT code of the sales has to be entered with a minus (-) sign.
Example of a credit note on a purchase

When we receive a credit note from a supplier, the same process as explained above applies: we use the same account codes but reverted, and we use the same VAT code with the minus (-) sign.

For example, we enter a purchase amount of 3'000 (invoice payment) including a 7.7% VAT. We then receive a credit note of CHF 300.- from our supplier for a product defect.

Period closing and VAT payment

VAT account reset at the end of the quarter report

At the end of the period, the VAT account balance will be charged to the Due VAT account (or to the Treasury VAT account).

VAT account card before charging the period balance to the Due VAT account

Transaction for charging the quarter balance to the Due VAT account
VAT account card after charging the period balance to the Due VAT account

VAT payment

The Due VAT account (or the Treasury VAT account) will have a zero balance when you pay the due VAT.

With this system you can control your balance each quarter and in case of mistakes you can find in which period the balance does not correspond any more.
**Note:** the VAT payment process we just explained refers to the Swiss effective VAT payment method and the Swiss flat rate payment method with VAT separation.
If you use the Swiss flat rate payment method without VAT separation, you can find specific information on the VAT payment and accounting assessment page (available only in **Italian**, **German** or **French**).

**How to register a credit note (Switzerland)**

If at the end of a period, when calculating the VAT report, the previous VAT is bigger than the due VAT, your VAT report has a Debit balance.

In order to charge the VAT report account you need to enter a transaction as follows:

- put in Debit A/C the Due VAT account
- put in Credit A/C the VAT report account

Usually in Switzerland the VAT credit is reimbursed, without having to move the credit to the following period.

When your VAT is reimbursed you need to enter a transaction as follows:

- put in Debit A/C your equity account
- put in Credit A/C your Due VAT account (where the balance should go to zero)

**VAT Report**

The VAT Report elaborates and displays the VAT calculation according to the selected period and parameters.

**Procedure:**

- Select, from the **Account1** menu, the **VAT report** command

When activated, the following options allow the user to include the following data in the VAT report:

![VAT/Sales tax report](image-url)
Include transactions
All the transactions with VAT/Sales tax are included.

Include totals by Account
All totals of operations with VAT/Sales tax, grouped per individual account, are included.

Include totals by Code
All totals of operations with VAT/Sales tax, grouped per individual VAT code, are included.

Include totals by Percentage
All totals of operations with VAT/Sales tax, grouped per individual percentage, are included.

Include unused codes
Also the unused codes of the VAT Codes table will be listed.

Use own (Group, Gr) grouping scheme
The operations with VAT/Sales tax are grouped according to the groupings of VAT Codes table.

Sort transactions by
By activating this cell, the transactions are sorted on the basis of a preselected option (Date, Doc., Description, etc....).

Partial report
By specifying a code or a group and by activating the necessary options, the software calculates the total of the operations with VAT/Sales tax of

- only code specified (by selecting from the list)
- only group specified (by selecting from the list).

Other sections
The information relating to the other sections are available on the following internet pages:

- Period
- Composition

VAT Report / transactions with totals by code
The overall total in the last row of the VAT report has to correspond with the amount for the end of period of the Automatic VAT account, Balance column, on the condition that both of them refer to the same period.

The data of the VAT report can also be transferred to and elaborated by other programs (f.i. Excel, XSLT) and be presented in formats that are similar to the forms of the tax authority For Switzerland, one can automatically obtain a document similar to the form that has to be sent to the VAT office. This form shows the amount to enter for each number.  Please consult (in German, French, or Italian) Swiss VAT Report.

**Budget and Financial planning**

You can also use Banana Accounting to set up budgets and financial planning. You have a choice between two approaches:

- **Annual Budget in the Accounts or Categories table**
  Indicate the budget for annual or expense next to each account.

- **Financial planning with Budget table**
  Financial planning is carried out by entering provisional movements in the **Budget** table. This innovative system will allow you to set up professional financial plans rapidly, complete with Financial Statements, Forecast balances and planning for liquidity.

**The Plan of Accounts**

Planning will use exactly the same Chart of Accounts that has been set up in the **Accounts** or **Categories** table. You can view the Balance Sheet and the Income Statement directly in the **Accounts** and **Categories** table, with current balances and budgeted amounts. The structure of accounts and groups can be customized at one's discretion, by editing, adding, deleting, and creating accounts, groups and subgroups. You are also able to use cost and profit centres, segments as well as accounts for customers and suppliers.
The Budget table

Planning is prepared by entering transactions in the Budget table. This is like keeping your account records, but they're about the future. Recurring operations such as rent are indicated only once, by setting the repetition option and a possible end term. The annual sum is displayed in the Total column. You can add as many rows as you wish, for the current or following years, make changes or modifications at any time.

Reports available

Almost all possible reports for accounting are available. Choose the calculation period and display the Budget column.

- **Balance sheet preview**
  Liquidity, final and intermediate balances are accurately displayed for you.

- **Profit and Loss statement**
  You will know your expenses and revenues for the different periods and whether there will be a profit or a loss.
  - You are able to analyse each item in detail thanks to the account card.
  - You can determine the projection period.
  - You can choose the subdivision by months, quarters, years.
  - Compare the estimate with the actual figures.
  - Use the cost centres to get details about individual projects or geographical areas.
  - Create reports and save the presets to be called up whenever you need.
Advanced planning functions

- Use quantity and prices for transactions in your budget
- Use formulas for automatic calculation of interest, depreciation and taxes.
- Create your own calculation functions with Javascript.

Examples of available reports

Plan with monthly subdivisions
Financial plan for 4 years with annual subdivisions

Account card with details of future movements
This allows you to check which elements are affecting liquidity in detail. For making changes, return to the Budget row by double-clicking on the row number.

Budget in the Accounts or Categories table

If you do not need a full financial planning, but only a budget for revenues and expenses per account, do not add the Budget table, but use the Budget column of the Accounts or Categories table instead.

When the Budget table is absent, the Budget column in the Accounts and Categories table can be edited and is where you enter the values budgeted for each individual account. The amount entered refers to the accounting period.

As a rule of thumb, only estimates for expenses and revenues are indicated.

Budgeted values must be entered individually; the program will calculate the totals in automatic and determine the profit or loss.

- For double-entry accounting, revenues (in credit) must be entered with a negative value in the Accounts table. Expenses (in debit) with a positive value.
- For income and expense accounting, revenues are entered with a positive value and expenses with a negative value in the Categories table.

Budget Difference column

The program will calculate the difference between the balance and the value in the Budget column.
Print per period

When printing by month or quarter, the program divides the value indicated in the Budget column into monthly quotas.

The program proceeds as follows for subdivisions:

- The number of months, based on the start and end date indicated in the accounting properties (File menu -> Properties and basic data), is calculated.
- The budgeted amount is divided by the number of months calculated.
- Any rounding differences will be added to the last month.

If, for example, you have indicated an amount of 10'000, this will be divided into 11 monthly amounts of 833.33 and one salary of 833.37.

If quarterly preview has been selected, the value will be that of the quarter and not the annual yearly value divided by quarters.

Financial planning with Budget table

By adding the Budget table to your accounting, you can set up a comprehensive and professional financial planning.

Budget and integrated Financial planning based on accounting

With Banana Accounting, planning is made much easier and faster, as it is carried out within the accounting program.

Everything is already set up and the budgeted Profit and Loss and Balance Sheet accounts, as well as planning for liquidity are readily available.

Proceed as follows:

1. Create a new accounting file to be used for financial planning.
2. Customize this file:
   - Enter basic data and period.
   - Conform and adapt the Plan of Accounts to your needs.
3. Enter the budgeted movements.

Learn with an existing example

Learn with the Starting a new financial planning page

Chart of accounts for the Budget

Opening column

Enter the initial balance of your accounting period in the Opening column of the Accounts table. This will serve as:
- Initial balance for the accounting (Transactions table)
- Initial balance for budgeting data (Budget table).

**Budget column**

If there is no Budget table, the Budget column of the Chart of Accounts can be adapted and used to enter estimates for the current year in tabular form.

If the Budget table is set up, the Budget column of the Chart of Accounts is protected, and the values are calculated automatically on the basis of the budgeted movements, as defined in the accounting period. The value displayed in the Budget column is the balance at the end of period, and therefore includes both the initial balance and the movement for the period.

**Customize the Chart of Accounts**

The Balance Sheet and the Profit and Loss Account are set up in the Accounts or Categories table, with the total for accounts and groups.

The columns of the amounts are updated by the program, so the relevant table will provide an immediate picture of the current financial situation and of the estimated one, where the account balance, movement, budget and other important information are shown next to each account and group. With one click, the account card is displayed.

The Chart of Accounts is set up according to the user's needs. New accounts and groups may be added, their number or description changed or cancelled, at any time you.

For your planning, normally start with a few accounts and then add new ones when more detail is available and considered useful.

**Planning with more detail**

Different types of accounts can be set up in the Chart of Accounts. When recording movements, it is possible to indicate detailed amounts for:

- Customer and Supplier accounts
  Allows for planning allocated to each customer, with the relative turnover and costs.
- Cost and profit centres
  Allows for detailed planning for a particular project or sales made by individual agents.
- Segments
  Manage profit and loss accounts by Department, Branch etc.
Budget table

The Budget table is where planning is entered. It's setup is identical to the Transactions table. Specific columns are depending on whether you are working with Income/Expense or Double-Entry accounting.

Enter Financial budgeting Movements

Financial planning movements are entered in the Budget table. This is like entering accounting transactions, but about future movements.

For each budgeted event indicate:

- The date when the event is expected to occur.
- The repetition code for recurring movements.
- Accounts with high activity.
- The amount of the movement.

Transactions may be of two types:

- Single, occurring on one specific date.
- They are repeated with a fixed frequency.
  
  In this case they are entered only at their first occurrence, with indication of a repetition code.
  
  For an automatic forecast over several years, enter repetition code "Y" for all operations that will be repeated on an annual basis.

Repetition

To designate a repetitive movement, the following columns are to be used:

- Repeat.
  
  Indicating "M" = Monthly for example, will be like entering the registration for all the following months.
  
  If no repeat code is assigned, the transaction will take place once only.

- End (Date).
  
  Use in combination with Repeat and indication of the last date on which the operation is to be repeated.

- Total.
  
  The total amount entered for the current year.

Repetitive movements can be indicated. They are entered once only, the program will then take charge of following occurrences.

Repetition is the central function for planning with Banana and is useful for four reasons:
1. Planning is made very fast, because recurring movements such as rent, bank fees, salaries and so on are entered on a single registration row. Once the user has indicated the transaction a first time, the program will then repeat it automatically.

2. The program is capable of creating financial projections for several years.
   - Not only repetitive operations are indicated each month or quarter, but also those repeated annually. The "Y" repetition code designates all operations that will be repeated every year.
     - Depreciation and other year-end closing operations.
     - Other amounts occurring on an annual basis.

3. Repetition can be linked to a formula in order to create a progression.

4. When you modify your planning, altering the relevant row in question will instantly update all other data.

**Forecasting with quantities and prices**

Quantities and unit prices can be inserted. This way the program will automatically calculate the amount of the transaction.

For a restaurant, for instance, you will be able to indicate the number of meals served and their average cost. This will provide you with a more precise idea of the elements that make up for your planning. By adjusting unit prices you might evaluate the impact of the change.

**Calculation formulas**

Formulas in Javascript can be inserted in the Formula column. Calculations, assignation and use of variables and recall functions can be entered.

Planning data will be made available for up to that point.

Examples of use:

- Calculation of depreciation.
  - If the value of the investment is altered, depreciation will be adjusted.
- Calculation of interest.
  - Interest is calculated on actual basis (365/365 days).
- Calculation of commissions.
  - Apply a percentage to be paid to sellers, based on revenues for a determined period.

With formulas you can automate the correlated transactions. Higher revenues will lead to higher commissions and lower interest. Lower investments will automatically lead to lower depreciation and interest.

**Adding the Budget table**

Financial planning is done by adding the **Budget table**.

If your accounting file doesn't have the Budget table yet, proceed as follows:

- **Tools menu** -> **Remove the Budget table**
With the **Add new functionalities** ... command (in the **Tools** menu) you can also remove the **Budget table**.

**Warning:** This operation can not be undone. Once the command is executed all budgeted movements will be erased.

If you have the possibility to return to previous version, make sure to save a copy before executing.

Once the **Budget table** is removed, the **Budget column** will again be available for modifications in the **Accounts** table.

### Budget table columns

The **Budget table columns** are very similar to the **Transactions table** columns. To facilitate understanding, letters are being used for account designation in the following example. Normally you would use your own account numbers.

In order to prepare a budget it is normally sufficient to use the **Amount column**.

For more elaborate budgets you may also indicate the quantity, the unit prices, or you can enter a formula. The program will automatically calculate the amount in the **Amount column**.

Below you will find explanations for each budget column (not all columns are visible in the image above):

- **Date column**
  The future date, when you expect the operation to take place:

  - If you cannot an exact date is not available, for example a monthly sales budget, enter the end of the month date.

- **Repeat column**
  A repetition code can be entered, possibly preceded by a number
(3M quarterly, 6M per semester, 7D weekly, 3ME quarterly end of month)

- **Empty**: no repetition is taking place
- **“D”** for a daily repetition (Day)
- **“W”** for a weekly repetition (Week)
- **“M”** for a monthly repetition (Month)
- **“ME”** monthly repetition, but with a date at the end of the month.
  If started the 28.02.2017, the next date will be 31.03.2017
- **“Y”** for a yearly repetition (Year)
- **“YE”** yearly, but with a date at the end of the month.
  If started the 28.02.2015, the next date will be 29.02.2016.

- **End** column
  The date beyond which no more repetition should appear is being indicated.

- **Variant** column
  A possible variant form of the budget can be indicated here, in combination with the Apps.

- **ForNewYear** column
  Here you can indicate how the transfer is to take place when Creating the New Year
  - No value: the date is being augmented by a year
  - “1” The date remains the same
  - “2” The operation is not being transferred to the new year

- **Debit account and Credit account, CC1, CC2, CC3** columns
  Just as in the Transactions table, you use these columns to define on which accounts the operation should be registered.
  You can also use segments and cost centres, to obtain a budget by segment or cost centre.

- **Quantity** column
  In this column you should enter the quantity description, for example sqm, ton, pc, ..

- **Price/Unit** column
  The unit price that, multiplied by the quantity, should result as the total amount.
  - In the Income & Expenses accounting files, you should enter the price unit in negative (with a minus sign), so the amount will be entered in the Expenses column

- **Amount** column (in basic currency)
  The amount to be recorded.
  If the row has a repetition, the amount is indicated only in the first transaction; the amounts of the following transactions is shown in the account card.
  The program will automatically calculate the amount in the following cases:
  - If there is a value in the **Quantity** or **Price/Unit** columns, the amount is automatically calculated according to the content of these two columns.
    - In a double-entry accounting file the result will be a positive amount
    - In an Income & Expenses accounting file, if the result is positive it will be considered an income, if it is negative it will be considered an expense.
    - In case a formula was entered, the amount will be the result of the formula.
      Formulas have priority over quantity and price/unit.

- **Total** column
  This is the sum of the amounts of the repetitive rows that are part of the specific accounting period.
  To display the different amounts, use the **Account cards** command.

- **Formula** column (in basic currency)
  This column offers the user the possibility to enter calculation formulas, with javascript language, as well as the programming functions of Banana Apps
  If there is a formula (or whichever text) the value of the **Amount** column is being set up according to the result of the formula. See below how to use it.
  - In a double-entry accounting file the formula result must always be a positive amount
- In an Income & Expenses accounting file, if the result is positive it will be considered an income, if it is negative it will be considered an expense.

- **Amount in account currency** column
  This is the transaction amount in account currency (see multi-currency transactions). This amount is necessary to calculate the value in basic currency, at the indicated exchange rate. 
  If there is a formula, the value is the result of the calculation of the formula. 
  In case of repetition, the first amount is being indicated.

- **Formula amount in account currency** column
  A calculation formula can be entered. 
  In case of repetition, the first amount is being indicated; the amounts of the following transactions is shown in the account card.

- **Total amount in account currency** column
  This is the sum of the amounts in account's currency of the repetitive rows, that are part of the specified accounting period. 
  If there is no date or if the initial or final date are not part of the accounting period, this column will be empty.

**Formulas and calculations**

The following functions can be used in the **Formula** column of the **Budget** table.

**Example files**

In order to find out more about using formulas, please visit the following pages:

- Transactions template with use of **Quantity and Formula columns**.
- Transactions template for the multi-currency accounting with use of the **Formula column in basic currency**.

**Amount column**

Ai fini della pianificazione fa stato il valore della colonna **Importo**.

Il valore della colonna **Importo**:

- Può essere inserito manualmente.
- Può essere il risultato di un calcolo:
  - Se sono inserite una quantità e un prezzo, l'importo sarà il risultato della moltiplicazione di questi valori.
  - Se c'è solo la quantità o il prezzo, l'importo sarà 0.
- Se viene inserita una formula, l'importo sarà il risultato della formula. La formula ha priorità anche sulla quantità e sul prezzo. Se c'è una formula il contenuto delle colonne **Quantità** e **Prezzo** non viene considerato.

**Entering formulas**

**Javascript language**

La formula deve essere espressa nel linguaggio Javascript (da non confondere con il linguaggio Java).

If there is a formula (or any text), the value in the **Amount** column is set according to the formula result.

It allows you to enter calculation formulas, in the JavaScript language, plus the **Banana Apps programming functions**.

**Decimal separator**

As decimal separator JavaScript only uses the point "." If you use a different separator, the number is likely to be truncated.

**Sequenza di calcolo e mancanza di valori futuri**

Come è spiegato in seguito, le righe sono ordinate per data e risolte partendo dalla più bassa. Se ci sono operazioni con la medesima data, l'ordine è quello di inserimento. Quando una riga viene risolta, ci sono solo i risultati delle righe precedenti. Non sono ancora state elaborate le righe successive, quindi nella formula del budget si hanno solo i valori fino a quel momento.

**Viene ripreso il risultato dell'ultima operazione**

Il valore inserito nella colonna **Importo** è il risultato dell'ultima operazione eseguita.

- 10*3 //30 will be returned
- If there is a sequence of several operations separated by a semicolon ",;", the last operation will be resumed.
  10*3;7; //7 will be returned
- Se vi è il return viene ripreso il valore dopo il return.
  return 10; // viene ripreso il 10

**Variabili automatiche**

- **budgetCurrent**
  It is a table that contains the budget rows after the repetitions creation. Servono per riprendere i valori, in congiunzione con il JReapeatNumber.
- **DEBUG** is a variable that can be true or false.
  If true, in the messages, all the results of the formulas are being displayed.
- **row**
  Is a javascript object that refers to the current row.
  The values of the cells can be retrieved with the value function ("columnNameXml").
  row.value("date") returns to the date of the transaction.
  - row.value ("JReapeatNumber") returns the progressive of the repetition.
Funzioni Budget

Altre API budget definite nell'API della classe contabilità, ci sono delle funzioni specifiche.

**budgetExchangeDifference (account, [date, exchangeRate])**
This formula recalls the Banana.document.budgetExchangeDifference function.

**BudgetGetPeriod(tDate, period)**
Returns to the start date (startDate) and the end date (endDate) relative to the date and the period where the period can be:

- "MC", "QC", "YC" to indicate the month, the quarter or the current year.
- "MP", "QP", "YP" to indicate the month, the quarter or the previous year.
- \[ t = \text{BudgetGetPeriod('2015-01-01', 'MP')} \]
  
  - t.startDate // 2014-12-01
  - t.endDate // 2014-12-31

// example

\[ t = \text{BudgetGetPeriod('2015-01-01', 'MP')} \]

- t.startDate // 2014-12-01
- t.endDate // 2014-12-31

Funzioni budget specifiche

Le seguenti sono simili a quelle disponibili con Banana.document, però possono essere usate senza fare indicare l'oggetto Banana.document.

Da tenere conto:

- Invece del parametro startDate può essere usata una delle sigle "MC", "QC", "YC", "MP", "QP", "YP" spiegate nel budgetGetPeriod.
- Se viene specificata una sigla periodo come data viene usata la data della registrazione corrente.
- Ha senso usare la data fine solo se è precedente a quella della riga. Se è uguale o superiore, comunque non ha effetto perché i valori successivi alla riga attuale non sono ancora disponibili, perché non sono stati elaborati.

Elenco funzioni disponibili in tutte le contabilità:

- budgetBalance(account, startDate, endDate, extraParam)
  Il saldo fino alla riga attuale.
  budgetBalance('1000', 'MP'); //ritorna il saldo del 1000 alla fine del mese precedente
- budgetOpening(account, startDate, endDate, extraParam)
  Il saldo all'inizio del periodo.
- budgetTotal(account, startDate, endDate, extraParam)
  La differenza fra movimento dare e avere del periodo.
  budgetTotal('1000', 'MC'); //ritorna il movimento totale del conto 1000 per il mese corrente
- budgetInterest( account, interest, startDate, endDate, extraParam)
  Calcola l'interesse su un conto, per il periodo indicato (al massimo la data corrente).
  Se si usa per calcolare l'interesse su un conto a fine periodo, la riga dove è indicata la formula...
deve essere sempre l'ultima per questa data.
- parametro interest,
  Indica il tasso di interesse in percentuale.
  - positivo (2.5, 4, 10) calcola l'interesse sul movimento dare del conto.
  - negativo (-2.5, -4, -10) calcola l'interesse sul movimento avere del conto.

Funzioni per contabilità multi monete:
Si possono usare anche per contabilità senza multi moneta, in questo caso il conto è sempre in moneta base.

- budgetBalanceCurrency(account, start_date, end_date, extra_param)
  Il saldo nella moneta del conto fino alla riga attuale.
- budgetOpeningCurrency(account, start_date, end_date, extra_param)
  Il saldo nella moneta del conto fino alla riga attuale.
- budgetTotalCurrency(account, start_date, end_date, extra_param)

credit(amount)

- If the amount is under 0 returns the amount in positive
  credit(-100) // returns 100
- If the amount is greater than 0, returns 0
  credit(100) // returns 0

Questa funzione è utile in abbinamento alle altre funzione budgetBalance per lavorare solo sui saldi che servono.
Se si vuole calcolare la percentuale sulle vendite, usando questa funzione è più semplice.
credit(budgetTotal('1000')) // inserisce il valore solo se è negativo.

debit(amount)

- If the amount is greater than 0 returns the amount
  debit(100) // returns 100
- If the amount is negative returns 0
  debit(-100) // returns 0

Utile se si devono fare calcoli usando solo l'importo dare ed evitare di usare quello avere.

- include
  Includes and executes a javascript file, with the possibility to create its own functions and variables that can be recalled in the script.
    - include "file:test.js"
      Executes the contents of the indicated file. The name refers to the file on which one is working.
    - include "documents:test.js"
      Executes the contents of the text document contained in the documents table. This has to be a file of the "text/javascript" type.

Variables
It is possible to define and use variables directly in the rows. The variable must have been previously defined.

```
price = 10;
total = price * 5;
```

**User defined functions**

The user can define personal function with the JavaScript language, and recall them in the formulas. It is possibile to define functions:

- Directly in a formula
- In a JavaScript coded attachment; this attachment must have as row id the "_budget.js" name
- In a text of the Documents table, that needs to be included with the Include command

```
function Taxcalculation(profit)
{
    var percentage = 10;
    if (profit > 50000)
        percentage = 10;
    else if (profit > 100000)
        percentage = 20;
    return profit * percentage / 100;
}
```

**Calculation and recalculation sequence**

Each time that you change an amount in the **Budget** table, or that you manually recalculate the file (Shift+F9), the program:

- If it exists, first of all the program executes the "_budget.js" document content.
- It recalculates the Budget table rows:
  - The program generates the repetitive row according to the **Initial Date**, **Final Date** and **Repetition** columns.
    - If there is in January a row with a monthly repetition, 12 identical rows will be created, each one with a date of a different month.
  - The budget rows are sorted by date (if they have the same date they will be listed in the order they were entered)
    - The transaction amount is calculated according to the quantity and unit price or, if there is a formula, according to the formula result.
    - For the multi-currency accounting, the program executes first the formula in the account currency, and then in the basic currency.
      - If there is no formula for the basic currency, the program will use the historic exchange rate and calculates the value in the basic currency.
    - For the accounting files with VAT, the VAT is calculated according to the transaction's amount.
  - Rows previously processed will be used for the calculation of the following rows.
    - The accounts balance, at the budget row's date, will include the amounts previously processed.
      - If for example, in a February transaction you enter a formula to calculate the balance for the whole year, you will only get the balance up to the end of February.
- It recalculates the budget values in the **Accounts** column, according to the budget transactions
and to the opening balances.
- It updates the Total column amount in the Budget table.

If the initial or final date of the accounting is modified, as well as other values that are used for the calculation of the budget amounts (for example the VAT table), you need to operate a manual recalculation (Check accounting command from the Account1 menu).

If you have many rows, with many recurring transactions and with a long calculation period, the program may slow down when recalculation the Budget table. In this case we suggest you to uncheck the manual recalculation in the File & accounting properties (File menu).

More resources for translators:

In the Formula column you can enter a formula in JavaScript language, plus the Banana Apps programming functions.
If there is a formula (or any text), the value in the Amount column is set according to the formula result.
It allows you to enter calculation formulas, in the JavaScript language, plus the Banana Apps programming functions.

- Last operation result.
  The formula is executed and the result displayed.
  10*3 //30 will be returned
  If there is a sequence of several operations separated by a semicolon ";", the last operation will be resumed.
  10*3;7; //7 will be returned
- Decimal separator.
  As decimal separator JavaScript only uses the point "."
  If you use a different separator, the number is likely to be truncated.
- DEBUG is a variable that can be true or false.
- If true, in the messages, all the results of the formulas are being displayed.
- row
  Is a javascript object that refers to the current row.
  The values of the cells can be retrieved with the value function ("columnNameXml").
  row.value("date") returns to the date of the transaction.
  row.value ("JRepeatNumber") returns the progressive of the repetition.
  The first repetition is 0.
- budgetCurrent
  It is a table that contains the budget rows after the repetitions creation.
- budgetExchangeDifference (account, [date, exchangeRate])
  This formula recalls the Banana.document.budgetExchangeDifference function.
- BudgetGetPeriod(tDate, period)
  Returns to the start date (startDate) and the end date (endtDate) relative to the date and the period where the period can be:
  - "MC", "QC", "YC" to indicate the month, the quarter or the current year.
  - "MP", "QP", "YP" to indicate the month, the quarter or the previous year.
  t = BudgetGetPeriod('2015-01-01', 'MP') returns
  t.startDate // 2014-12-01
  t.endtDate // 2014-12-31
- The following functions are similar to those available with Banana.document, however, with
the added possibility to indicate as `startDate` the period of `BudgetGetPeriod` so that the function uses the current date and as a start date and end date the date returned of `BudgetGetPeriod`.

```
budgetBalance('1000', 'MP'); //returns the balance of 1000 to the end of the previous month
budgetTotal('1000', 'MC'); //returns the total movement of the 1000 account for the current month.
```

- `budgetBalance(account, startDate, endDate, extraParam)`
- `budgetOpening(account, startDate, endDate, extraParam)`
- `budgetTotal(account, startDate, endDate, extraParam)`
- `budgetBalanceCurrency(account, startDate, endDate, extraParam)`
- `budgetOpeningCurrency(account, startDate, endDate, extraParam)`
- `budgetTotalCurrency(account, startDate, endDate, extraParam)`
- `budgetInterest(account, interest, startDate, endDate, extraParam)`

- `credit(amount)`
  If the amount is under 0 returns the amount in positive, if not 0 returns.

- `debit(amount)`
  If the amount is greater than 0 returns the amount, if not 0 returns.

- `include`
  Includes and executes a javascript file, with the possibility to create its own functions and variables that can be recalled in the script.
  - `include "file:test.js"`
    Executes the contents of the indicated file. The name refers to the file on which one is working.
  - `include "documents:test.js"`
    Executes the contents of the text document contained in the documents table. This has to be a file of the "text/javascript" type.

### Accounting common features

- **Check accounting**
- **Link to a document**
- **Lock transactions**
- **Displaying expiry dates**

### Check accounting

You can recalculate and check your accounting in different ways:

- with the **Shift + F9** keys (Windows and Mac) or **Cmd + 9** (Mac)
  Primary accounting recheck
- with the **Check accounting** command from the **Account1** menu
  this solution includes several extensive control options - Extensive accounting recheck

If there are error messages or differences you should correct them.

### Primary accounting recheck

This command will execute the following operations:
○ it will reset the accounts balances, as well as the cost centers and segment balances
○ it will verify and report if there are errors in the various tables (Accounts, Transactions, VAT Codes and Exchange rates tables)
○ it will re-enter all the operations as if they were being entered for the first time
  ▪ for the multi-currency accounting, it will recalculate the opening balances in the basic currency using the latest exchange rates
  ▪ if the transactions rows are not locked, it will recalculate all transaction rows:
    ○ the VAT percentages are taken from the VAT Codes table and the VAT amounts are recalculated again
    ▪ it will update the account balances, as well as the cost centers and the segment balances
    ▪ in the Cashbook the progressive account balance in the Transactions table is recalculated
○ it will recalculate the Accounts and Categories table totals (income and expenses)
  ▪ it will update the Diff. Budget and the Previous year columns
  ▪ in the multi-currency accounting, it will update the Calculated balance with the latest exchange rate and the exchange rate difference

**Extensive accounting recheck - the Check Accounting window**

On top of the basic accounting recheck, additional checks are executed.

**Recalculate accounting plus additional checks**
This is one of the most useful features: the entire accounting file is being rechecked, all the balances are recalculated and the user is notified if errors are found.

**Accounting properties**
This option is being activated by default. The program verifies whether the data entered into the File and accounting properties correspond to the actual accounting (for example: opening and closing
date, VAT account, accounts for exchange rate differences, etc.).

**Transactions**

**Differences within transactions**
If this option is activated, the program verifies whether there are differences between Debit and Credit or between Accounts and Categories in the Income & Expense Accounting. The rows where the differences occur are being indicated in the Messages Window. Also, the program shows the total difference amount in the Information window at the bottom of the screen (only when being positioned in the Transaction table).

**Include intermediary differences**
If this option is activated, the program verifies whether there are differences between Debit and Credit, in composed transactions (transactions over multiple rows). Often differences are caused by incomplete entries or errors in the amounts (as for example in the following example, in the transaction n. 8).

**Balances checks (#CheckBalance)**
By activating the Transactions option as well as this one, The program checks whether an account balance is equal to the one being inserted for verification (for example, between the bank account balance on the bank statement and the balance of that same account in the accounting file). In case the balances don't match, the program indicates the error.

In order to proceed with this check, one has to:

- In the Transactions table: enter #CheckBalance in the Description column, as well as the currency code and the balance of the account (example: #CheckBalance CHF 28'000..00). Into the Debit column, enter the account to be checked. The Amount column remains empty. The amount to be checked has to be entered with the same number of decimals as the one of the account to be checked.
- Activate the option through the Account1 menu
- While the accounting is being checked, when there are differences between the checking balance and the account balance, the program shows the error while indicating the row.
The program has detected a difference between the checking balance and the account balance in the file.

**Same document with different dates**

If this option is activated, the program will alert if transactions with the same Doc number have a different date. On composed transactions (=transaction on more than one row), where there is no correspondence between Doc and Date, the program cannot correctly determine the counterparty.

**Accounts**

**Chart of accounts structure**

If this option is activated, the program checks whether the chart of accounts structure is correct.

**Existence of exchange rate differences**

If this option is activated, the program checks whether there are unrecorded exchange rate differences.

**Opening balances differ from last year’s balances**

If this option is activated, the program verifies whether the opening balances of the new year match with the closing ones of the previous year.

**Personalized checks (Add On)**

If this option is activated, the program runs checks on the functions that have been added by user (Add Ons), for customized verifications.

**Include additional checks with the shortcut Shift + F9**

When this option is activated, the program will run all the checks activated in the dialog window, when pressing **Shift+F9**. Otherwise only an accounting recalculation will be done (Mac version: **Shift + Cmd + 9**).
Link to a document

Connecting digital documents to your accounting transactions

With Banana, you can enter, for each transaction, links to digital documents stored on your computer.

- Arrange a folder where you will save all your digital documents. It can be the folder where you keep your accounting file or subfolder.
- Use this folder to save all files containing documents, invoices, receipts, etc.
- Link the transaction to the digital document.
- From the Account 2 menu choose the Link -> Open Link command to view the contents of the digital document.

The DocLink Column

The **DocLink** column (Transactions table) makes it possible to enter a link to an external file (usually a scan of a receipt or an invoice).

- The **DocLink** column is usually not visible.
  In order to display it, use the **Columns setup** function.
- Once the **Link** column is visible, you can edit the file name.
- The file name is related to the accounting file; if the documents are in a sub-folder, the file name - in the DocLink column - will be preceded by the directory name.
- It is equally possible to manually enter a web address in the Link cell.
  In order to open the linked document, click on the **Open link** command of the **Account2** menu, or click on the small square that appears on the upper right hand corner of the cell that contains the link.

Entering a link to a file

There are two ways to enter a link to a document:

- Place yourself on the row of the Transactions table and the activate the **Add link** command from the **Account2** menu -> **Links**;
- Select the file that corresponds to the document which needs to be linked and click on the **Open** button; the program inserts the link automatically.
  The program enters the file name in the DocLink column, even if this last one would be invisible.

Or

- Display the **DocLink** column in the Transactions table. See: **Columns setup**;
- Click on the small square at the upper right hand corner of the cell;
- Indicate the path where the file can be found and select it.
Editing a link

Proceed in the same way as when entering a new link.

Opening the link

There are two ways to open the link:

- Place yourself on the row of the Transactions table and the activate the **Open link** command from the **Account2** menu -> **Links**;
- Place yourself on the DocLink cell and click on the icon to open the link.

For security reasons, the program opens only files with an extension that is considered secure, see **Program Options** -> **Advanced**, from the **Tools** menu.

Removing the link

There are two ways to remove the link:

- Place yourself on the row of the Transactions table and the activate the **Remove link** command from the **Account2** menu -> **Links**;
- Delete the contents of the DocLink cell.

Lock transactions

Blockchain data certification

Banana uses a digital certification system for the accounting data, using what is now called blockchain technology. Transactions can be locked and marked with digital codes that can guarantee, even after many years, that the accounting data are authentic. They also allow the user to make sure that the accounting data have not been modified.

Banana.ch was the first company in the world to use the blockchain technology in the accounting field. This method ([US Patent No. 7,020,640](https://www.uspto.gov/patents trovare)) was developped and patented in 2002..

This method, based on the blockchain calculation system, is considered so reliable that it is employed to ensure the validity of the bitcoin and of all other modern crypto-currency. This method guarantees one of the highest levels of data integrity and conformity to international law prescriptions. You can also see the evaluations on this matter of the audit company [Ernst&Young](https://www.ernstyoung.com), who verified the system conformity to the legislation requirements. The new versions of the Banana Accounting software don't use the MD5 method anymore (the one mentioned in the documents), but
use the Hash SH256 method.

- Ernst&Young, compatibility check to Swiss legislation (pdf in German)
  See also: Verordnung über die Führung und Aufbewahrung der Geschäftsbücher, 24.04.2002 (in German)
- Ernst&Young, compatibility check to German legislation (pdf in German)
- Securing accounting Data (2002). Introduction document to the blockchain technology used in Banana Accounting software.

**The lock transactions command**

With the **Lock transactions** command of the **Account2** menu, the accounting transactions are locked and marked with control codes that can certify, over the years, that the transactions have not been modified.

- The validity of a possible already existing lock is being verified
- The transactions until the lock date are being numbered progressively and are being locked. For each transaction, the digital code of the row and the progressive one are being calculated. The calculation of the digital codes is being done according to the sequence of the columns.
- In the accounting is being indicated that transactions with an equal or earlier date than the lock date will no longer be accepted.

![Lock transactions dialogue box](image)

**Date of new lock (inclusive)**
Specify the date up until when the transactions will be locked.

**Password (optional)**
It is possible to insert a password to eventually unlock the transactions or to carry out a new lock in the future.
If the program finds no errors in the transactions included in the lock date, it will lock the transactions, calculate and assign individual numbers and codes to each row of transactions which can be viewed in the **Lock** view on the **Transactions** table.
**Last lock**
The data of the following fields are automatically filled out by the program based on the last executed lock.

**Lock valid**
A "Yes" is shown if the lock is valid.

**Date of lock**
The date of the last executed lock is shown.

**Lock number**
This is the value automatically entered by the program in the last row of the LockNum column. When the lock is repeated, if the value of the last row lock number is unchanged, it means that the lock is valid and that the data have not been altered; if however the value is changed, the program shows the following codes:

- (-1) if the lock is invalid from the first row
- (-2) if there are rows that have the same LockNum.

**Progressive Hash**
This is the control code present in the last transaction.

**Lock View**
All digital codes are shown along with all the information that the program used to create the digital signature.

- **LockNum**: the progressive number that identifies the row
- **LockAmt**: the cumulative transactions total, similar to the total at the end of the page, as required by some national regulations
- **LockLine** (hidden column): the digital code calculated according to the row values.
- **LockProg**: the global electronic signature (SHA-256).

**The digital code LockProg**
This is the main element of the certification; it uses the blockchain methodology. The digital code is calculated according to the following values:

- The contents of the current entry, including amounts, descriptions and the description of the account at the moment of the lock
- The progressive number (LockNum)
- The cumulative balance (LockAmt)
The progressive code of the preceding entry (LockProg).

In case the accounting data undergo even the slightest modification (for example, a date or an amount is changed), the digital code will be different. If the control number remains the same, it implies that the data are original and therefore have not been changed.

**Check Lock**

With the **Check lock info** command of the **Account2** menu, the program verifies the validity of the lock and displays the data.

- The program recalculates the digital control codes and verifies if they correspond with the ones related to the transactions.
  - If the codes correspond, the lock is considered valid, and therefore the data are original.
  - If they do not correspond, it means that the data have been changed and that they are not the original ones calculated at the time of the lock.

**Unlock transactions**

The **Unlock transactions** command removes the lock and the control codes. If the lock was set with a password it will be necessary to reenter the password in order to remove the lock. If later on you want to relock the transactions, and they have not been modified, the control numbers will be the same as the ones of the earlier lock; if however some data have been changed, the control numbers will be different.

**Partial lock**

If the transactions have been locked, it is possible to unlock them even partially, from a specified date. If a lock password has been set, in order proceed unlocking the transactions, you need to enter it in the specific field.
Why unlock the accounting?

In principle, the locked accounting should not be unlocked. It might happen that, after the lock, you find errors in the accounting and see the need to make corrections. To have the opportunity to make further changes, users kept a copy of the file before the lock. If they found errors, they would restore the previous situation. In the meantime other transactions had perhaps been made, so often it happened that restoring previous versions of the accounting proved wrong. To avoid this unnecessary waste of time it was decided to make the Unlock transactions command available.

The certification must not be confused with data security. The data certification is a methodology that ensures that the accounting data are original. To prevent data from being modified, the methodology is the one related to data security. Data security procedures, however, can only be implemented in an environment that limits data access.

If the file is fully available to the user, such as when it is on a PC, people have complete control of the data. They can thus replace files easily. With a certification one cannot prevent that the data are being altered, but it will allow you to know if the data are the original ones.

The person who keeps the books is responsible for the accounting and decides whether a change is permissible or not.

Organizing the certification and data verification

Once you locked the transactions of the period, you need to:

- Print the lock information or print the last certified transaction row with its specific certification number (LockProgr).
- Sign and store this information along with the accounting documentation or in any other safe place.
In order to check that the accounting data are the original ones, you need to proceed as follows:

1. Impart the **Show lock info command**.
2. Go back to the document that shows the digital control number
3. Check whether the row identified with the LockNum still has the same digital control number
   - If the number matches, the accounting data are the same as those certified
   - If the number does not match, it means that the accounting data have been modified.

Banana works on developing applications that make it possible to compare two files and obtain indications regarding data that have been altered.

**Data security**

Digital certification ensures that the data are still the original ones. It does not prevent the modification of data.

It is the responsibility of the accountant to ensure that the data are not altered. Each administration must be organized according to its size and needs.

Those who want to make sure that the data are not being altered by unauthorized persons, must employ other methods and tools, such as:

- Save the data to a secure system (protected network drive), password protected.
- Keep the copies of the data.
- Encrypt archives.

**Long-term archiving**

The accounting file contains the entered data. In order to open the file and obtain a report or an account card, you need to have the program at your disposition.

Banana Accounting gives the possibility to **export all the accounting data**, and its printouts as well, to **Pdf, Html and Xml**.

The generated file can be saved on a CD and accessed on any computer even after many years, even by persons who do not have the Banana Accounting software.

**Displaying expiry dates**

**Customers & Suppliers Management**

In order to manage the invoices issued or received, we advise you to use the **Customers Menu** and the **Suppliers Menu**.

**Associate an expiry date to a transaction**

As an alternative to the customers and suppliers management, or for simpler checking purposes, you can also enter the payment date in the transaction row.

This is an operating mode that consents simplified checkup.
With the **Columns Setup** command (from the **Data** menu), you should make visible the **Date Exp.** and **Date Pay** columns.

You should then enter the invoice expiration date in the **Date Exp.** column, and the invoice payment date in the **Date Pay** column.

**Show expiry dates**

With the **Show expiry dates** command from the **Account2** menu, the program displays the transaction rows that have an expiry date but no payment date.

**Documents table**

The new **Documents** table allows you to include texts, images (including a logo) or programming codes (scripts) into your accounting file. This table is normally automatically created when attaching some documents to the Balance sheet, using the **Account1 - Balance sheet** command or the **Account1 - Balance sheet with groups** command -> **Attachments** section.

You can also add the table to your accounting file using the command **Tools** -> **Add new functionalities**.
The **Documents** table has the following columns:

- **Id** column  
  This is the document's name.  
  Documents beginning with the "_" sign have specific meanings.  
  - "_budget.js"  
    You can enter specific functions created for the [Budget](#) table.

- **Description**  
  A short file description (optional)

- **Attachments**  
  Contains the file.  
  If you click on the cell, an icon will appear to add or edit the file content.

### Logo on the invoice or on the print

Some invoice templates are already set to resume a possible logo uploaded in the documents table. To add the image:

- Add a new row
- In the **Id** column, write 'logo'; write the word in lower case
- In the **Description** column, you can write a desired text
- In the **Attachment** column, double-click on the cell, or select the Edit symbol, select the type of **Image** document and select the picture you want to insert in the printout.

You can also add other images, to be used in customized templates.

### HTML Editor

![HTML Editor](image)

**Adding the **${...}** field**

The **${...}** field allows the user to add dynamic text to the document, for instance an account's balance or a Banana table. The Banana API interface is available at the following web address
The command can be added manually or through the command **Edit - Add script**

Printing the current balance of account 1020

```javascript
${Banana.Converter.toLocaleNumberFormat(Banana.document.currentBalance('1020','','').balance);
}
```

Output of the Accounts table, columns: Account, Group, Description, Balance (command not yet available)

```javascript
${HTML

Banana.document.table("Accounts").toHtml(["Account","Group","Description","Balance"],true);
}
```

It is possible to write the javascript code in a separate document and include the script through the command **Banana.include**.

The scripts can be saved in the **Documents table** or in a local file.

```javascript
${Banana.include("documents:myscript1");rtnValue}
${Banana.include("c://temp//myscript16.js");rtnValue}
```
Adding a page break

The command can be added manually or through the command **Edit - Add page break**

Text in the first page

`${PAGEBREAK}`

Text in the second page

The command `${PAGEBREAK}` is not yet available, the current command to add a page break is: `<!--pagebreak-->`

Add accounting functionalities

Adds functionalities to your file. Also see [Add new functionalities](#).

Add upper and lower case in account numbers and codes

The program normally converts account numbers to Uppercase.
When Uppercase/Lowercase is enabled, account numbers are not converted to Uppercase. Accounts in Uppercase/Lowercase are useful when the account number also serves as a description.
When entering account numbers in the Transactions table, the program will revert toUpper or Lowercase, as specified in the Chart of Accounts.
Using this option will require you to pay attention to case sensitivity, as the the "Cash" account, with first letter in Uppercase, will be different to "cash" account in Lowercase.

Add Items table
Revert to information available on Items table page.

**Add Items columns in the Transactions table**

Revert to information available on Items columns in Transactions table page.

**Add Address columns in the Accounts table**

For accounting files.

This function adds the columns that allow the insertion of client addresses, suppliers, members or others.

To add this function, proceed as follows:

- Click on Tools in the menu.
- Select the Add new functionalities ... command.
- Select Add Items Columns in Accounts table (If the options does not display in the list, it means it has already been activated).

The following will be added in the Accounts table:

- Address view where added columns will be displayed.
- The columns that allow you to enter address data and other information.
  - In order to display one or several columns, also in other views, use the Columns setup ... command in the Data menu.
  - In order to create different views, with specific columns, use the Tables setup command in the Data menu.

**Add and remove the Budget table**

This function enables the use of the Budget function, by adding the Budget tab to the Transactions table, where transactions relating to financial planning can be registered.

For more information see Budget table.

**Modify the VAT amount type in the Transactions table**

For accounting files with VAT.

This function enables the modification of the Amount type column (VAT Amount type) in the Transactions table.

The column allows you to enter one of the following VAT amount types, where applicable:

0 (empty cell), inclusive of VAT
1 = VAT excluded, exclusive of VAT
2 = VAT amount, the registration amount is considered to be 100%.

For each registration, the program automatically enters the default data in the VAT Code table in the Amount Type column (relative to each code). If, occasionally, the Amount type changes for a VAT code, you may enter 1 or 2 manually.

Note
There are incompatibilities of VAT data with previous versions when using this feature, as that did not have this functionality.

**Items table**

To speed up the creation of invoices, you can use the Items table, where you can insert recurring products or services.

When creating the invoice, simply press the F2 key in the Items column and select the product from the list; the registration will be completed with the data taken from the Items table.

To use the Items table you will need to:

- Add the Items table.
- Add the Items columns in the Transactions table.
- Display the Items column in the Transactions table (Data menu> Columns setup ...)

**Add Items table**

Use the **Tools -> Add new functionalities -> Add Items table.**

In the Items table you may enter items, products and others. It may also be used as an inventory control, to some extent.

- **Group:** Generates the totals.
- **Item:** Item code.
- **Description:** Item description.
- **Gr:** Group for allocation of total.
- **Account:** account used in Transactions table.
- **Currency:** Currency to be used (for multi-currency accounting only).
- **CVATCode:** VAT code to be used (for VAT accounting only).
- **Unit:** abbreviation allocated to the type used.
- **Selling:** Unit sale price.
- **Cost:** Unit cost.
- **Begin Qt.**: initial quantity amount.
- **Price Begin**: initial price of unit.
- **Value Begin**: initial quantity times Price Begin.
- **Current Qt.**: current quantity, calculated by program, taking into account Begin Qt. and registrations of Item in Transactions table. The Quantity column of the Transactions table is being used.
- **Price current**: current Price of Item.
- **Current value**: current quantity multiplied by current price.
Items columns in the Transactions table

The Items columns in the Transactions table are used to enter quantity and price. The amount of the transactions is calculated on the base of quantity and the applicable price.

Add the Items columns in the Transactions table

Use the Tools menu-> Add new functionalities … command -> Add Items Columns in Transaction table, to insert columns to be added to the table (refer to Transactions page for further information).

- Item
  Item listed in Items table.
  The program's preset will not display the Items column in the Transactions table. You will have to activate it via the Data > Columns setup … , checking the ItemsID box in order to use this function.
- Quantity
  May be a positive or negative value.
- Unit
  Unit/Price May be a positive or negative value.

Add Transactions

- When a quantity and a unit price are entered, the amount will be calculated automatically.
- A negative amount may be entered to account for items leaving the warehouse.

Link to the Items table

If there is an Items table when you enter a registration with the Item and the quantity, the current quantity of the respective row in the Items table is updated.

Refer to the Items table page.
Utility applications

The Utilities application allows you to create the following file types:

- **Address book**: for addresses and labels management
- **Library and collections**: for the management of books or other objects (ex.: art collections, jewelery, ...)
- **Simple table**: the user can create a personalized table
- **Depreciable assets register**: the user can manage the depreciable assets (only available in the Banana 9 version)
- **Time sheet**: to enter and keep track of the working time schedule, worked hours, holidays, vacation days, leaves, etc.

Additional useful functions for the utilities

The following commands are particularly useful when used with these applications:

- **Extract and sort rows**
  In order to create lists of existing data.
- **Print labels**
  In order to print addresses or items labels.
- **Add new functionalities**
  - New table documents (Swiss Balance sheet attachment...)
  - New simple table
- **App menu**
  In order to create personalized reports, calculations or else.
Link between tables

You can create a link between a field of one table to another one, through the Id field. For example:

- Add a new simple table named "Projects"
  - In the Id column indicate a project symbol and in the Description column a small explanation.
- In another simple table, add the following text columns:
  - ProjectsId (Table name plus "Id")
    When you go into edit mode a list of the available projects will be displayed.
  - ProjectsDescription (Table name plus "Description")
    This column must be protected.
    When you change the ProjectsId contents, the description text will be displayed.
- When you add a column, proceed with a check of the accounting or close and reopen the file to activate the link.

Time sheet / Attendance

The Time sheet functionality simplifies and accelerates the recording and presentation of the working hours. It is completely free, you just have to download and install Banana Accounting 9.

Characteristics

Designed for employees with flexible working hours or for those who are required to record their presence at the job.

- Similar to Excel, you can copy and paste, correct.
- Planning of scheduled hours, with customizable weekly schedule.
- All calculations, hours due, hours worked, holidays and illness in hours:minutes.
- Very fast input of hours, in two possible ways:
  - Start and end time with daily total calculation
    - Automatically enters the current time
    - Deviation + or - from current time possible.
    - When you've arrived earlier or you're leaving soon.
  - Total daily hours worked
- Difference between scheduled and performed hours.
- Instant count of working hours, vacations and absences.
- Totals for each day, week, month and year.
- Carry forward by month and year
- Easily customizable, it adapts to all work schedules.
- Possibility of setting the holidays and paid leave.
- Possibility to add columns, to record expenses, kms travelled or other.
- It can be used for the entire year or for specific time frames.
- Prints a monthly report, even with totals in decimal hours.

Important things to know

- The time sheet is composed by a table called Journal where the working hours and settings are
entered
- The start and end times of the work are entered.
- Vacations, sick leave, absences and others are indicated with hours and minutes.
- The program always shows the reports based on the hours and minutes.

How to start

We recommend that you create your own file from an existing template.

1. From the File menu -> New command
2. Select an available template or click on New empty and from the Utilities section select Time Sheet.

1. Define the basic parameters of the new file (language and decimals) in the following window:
2. Save the file under a new name (for example your name and the year)

3. Enter the hours that need to be carried forward and your work schedule in the File properties. See Setting up the work schedule.
   - Fill in the Holidays and work hours that need to be carried forward
   - Set up your weekly time schedule.
   - Set up working days and holidays.
4. Set up your own working hours.
5. Save the changes.

Enter daily working hours

1. Open the file
2. Go on the current Day (yellow) -> Menu Utilities1 -> Go to today.
3. Set the begin and end times.
   1. Press "," to enter the computer's time.
   2. If you enter +5 or -5 (or any other number), the program displays the current time with 5 minutes more or less than the computer time.
   3. With the Utilities1 Menu, Fill week command it is possible to carry forward the previous week schedule.
   4. With the key or button "F4" or "Cmd4" (Copy from above), the previous row value is copied.
4. Enter holidays or absences.
   1. Indicate the hours of holidays or absences of the day in the appropriate columns.
   2. If you go into Edit mode, the program shows the daily scheduled hours
   3. If you enter the hours in decimal format (e.g. 1.75), the software will show the value in hours and minutes (e.g. 1:45).

Prints and reports

- With the File menu -> Print command, you can:
- Print the table.
- Print a specific part of the table that you have selected
  - With **Utilities1 -&gt; Monthly report:**
    The monthly report will be printed.

**Conversion from Decimal hours to hours: minutes**

If the number of hours per day is based upon decimal hours (43 hours per week, for 5 days) you will have to work 8.6 hours per day.

  - In the Journal, to know the correct hours and decimals, if you enter the point and decimal points after the hour, the program opens a small window with autocompletion of values, where the time is shown in minutes (example you have to enter 8.6, the program indicates 8:36).
  - Carry forward the proposed value.

**Specific Commands (Utilities1 menu)**

**Go to today**

Sets the cursor on the current day.

**Fill day**

Resumes the working time and absence of the current day with the values from the same day of the previous week.

**Fill week**

Resumes the working time and absence of the current week with the values of the respective days of the previous week.

**Monthly report**

Prints the totals and rows of the current month.
You can select the printing period.

**Create rows for period**

Creates the rows for each day, from the beginning, and the total for the indicated year.

**Import timesheet**

Imports the values from an external timesheet.

  - Indicate the file from which the software will import the data.
  - Specify which values to import.
    - Import only holidays.
      The software imports the values of the **Holiday** column
      It will import also the **Notes** related to the imported values.
    - Import everything.
      Carries forward the values of **Holiday, Notes, Worked, Absences, Corrections, Due** and **Split**.
The program looks in the imported file for rows with equal date and section and it imports the values. If in the imported file there are several rows for the same date, values subsequent to the first row are not imported.

**File properties - Base**

Select **File and accounting properties** ... from the **File** menu and set up the following in the **Timesheet** tab:

- Name and Surname,
- Start and End date for the current year
- Work percentage and other data, if applicable.

![File and accounting properties](image)

**File properties - Start**

Select **File and accounting properties** ... from the **File** menu and set up the following in the **Start** tab.
Carry forward

Initial values of the period or previous year are displayed

- **Worked hours**
  Input the hours not accounted for the current period or the previous year (ie extra hours worked but not yet paid or not yet scheduled). Those hours are taken into account in the Carry forward line.
- **Holidays hours**
  Input hours of unused holidays of the previous year. They will display in the Holiday column of the Journal.

Weekly setup

Input your weekly values.

- **Due hours**
  Working hours for the days of the week are defined here. A flexible timetable for a part-time work is presented in our example.
- The program automatically reports the total of weekly hours
- **Festive**
  Determines Working or Non-working day.
  - Working day. Reported in the Journal tab.
  - (1) Not a working day. Reported in the Journal tab, in the Festive column.
  - (0) Festive. Reported in the Journal tab, in the Festive column.

Journal table

In this the table working hours are inserted, as well as notes and eventual returns.
Working Days and Festives

Days are considered as working days unless a "0" value is inserted in the Festive column.

Settings for the week are defined in the File Properties -> Start, but may be altered using codes in the Festive column, for example:

- If you never work on Sundays, enter "W0" on the first Sunday. The program will tag all subsequent Sundays with "(0)".
- If you do not work on the first day of the year, enter "0". Use same for all other days of the year that are holidays.
- Enter "1" (or any other value starting with 1) for other days that you do not have to work, but which are not holidays.

Temporal values in hours and minutes

All temporal values are expressed and visualized in hours and minutes (e.g. 10:55). An hour and a half is visualized as '1:30' (an hour and thirty minutes). The "." mark divides the hours from the minutes and the minutes from the seconds. The dot "," divides the seconds from the milliseconds.

If you enter a value preceded by the ">" or "<" sign (minor or major), the software considers it a decimal value and converts it in hours and minutes.

- "<1.50" becomes 1:30.
- "<1.75" becomes 1:45 (one hour and three quarters).
Colours and row formats

The colour of the rows is automatically generated

- The starting row and the total row will be displayed in bold.
- Daily rows:
  - Festives are in red.
  - Non working days are blue.
  - Today's date, highlighted in yellow.

Columns of the Journal table

- Section
  The identifier of the row, which can be empty (rows of daily values) is composed as follows:
    - By period:
      - All. For the rows.
      - Year. For rows of the year.
      - Month. For the rows of the month
      - Week. For the rows of the week.
      - Day. For the rows of the day.
    - By type
      - CarryForward.
        Rows that are carried forward
      - Start
        Beginning rows, in which to insert starting values.
        - Holiday hours balance.
        - Adjustments.
      - Total
        Rows for the total of the values from the relative columns.
        The following are added:
        - The values: of the daily rows.
        - The adjustments from the Start section, and
      - Balance
        For the holiday hours balance. The sum of the holidays found in the rows
        "CarryForward" and "Start", minus the sum of the daily holiday hours.
    - Date
      The date of the day
    - Festive
      A code can be inserted to signal that the day is festive.
      If you do not insert a code the default values will depend on the file properties.
      - Empty. Working day
      - 0 The day is festive (the row will be red).
        (0) Automatically set festive day.
        No value will appear in the "Due" column.
      - 1 The day is non-working (the row will be blue).
        (1) Automatically set non-working day.
        No value will appear in the "Due" column.
      - 2 (or any other value that doesn't begin with 0 or 1) The current day is a working day. It
        overwrites the predefined value.
- Codes beginning with W (week day).
  This code sets up the predefined value for the relative week day.
  - W Sets the current weekday as working.
  - W0 Sets the current weekday as festive.
  - W1 Sets the current weekday as non-working
  - WR (reset) resets the current value with the predefined one from the file properties
  - WA resets all days with the predefined ones from the file properties

- Day description
  Text automatically completed by the software.
  If in a day's row a text preceded by an hashtag is inserted (e.g. "#Christmas",
  "#Thanksgiving"), the inserted value will be kept.

- Description
  The column will be automatically filled out by the software

- Notes
  To insert one's own notes.

- Code
  To be used to signal an optional project code or a client's identifier.

- Worked hours
  - Work1 and Work2
    To signal a value in terms of worked hours
  - Start1,Stop1, Start2, Stop2, Start3, Stop3, Start4, Stop4, Start5, Stop5
    These columns allow the user to enter the start and the end of a working period.
    The starting value must not be lower than the preceding End value.
  - Worked
    Calculated by the software. The sum of worked hours.

- Sick Leave
  Hours of sick leave.
  Autocompletion will suggest the daily difference
  - Sick leave
  - Holidays
  - Service
    For mandatory absences, e.g. mandatory military service.
  - Other
  - Absences
    Calculated by the software, the sum of absences.

- Adjustment
  Adjustments in term or working hours

- Total
  The sum of worked hours, leaves and adjustments.

- Due
  The due daily hours

- Due Code
  If the Due code is left empty, the due value is completed by the software, according to the file
  basic data settings (available from the File menu -> File and accounting properties -> Start)
  - Codes to be entered in the Due code column, in order to edit the daily due from the row
    you are in. You will then need to enter the new value in the Due column.
    - DS (Set Today)
      Sets the due hours for the current day, without changing any other day.
    - WS (Set Week Day)
      Sets the due hours for a specific week day (Tuesday for example) and for the same
      following days (following Tuesdays)
- PS (Set Predefined)
  Sets the due hours from that day on
- Codes to be used to reset the daily due
  - WR (Reset Week Day).
    Resets the predefined value for the week day.
  - WA (Reset All Week Days)
    Resets all predefined values related to the weekdays.
  - PR (Reset Predefined)
    Resets the general predefined value. Removes the general predefined value.
  - PA (Reset Predefined and Week Day)
    Resets the general predefined value and the ones of the week.
    It will be like starting from scratch.
- Code to reset the Progressive calculation
  - RP (Restart progressive)
    The Progressive column amount will restart from zero.

○ Due
  The due hours for the day
  The due value from the starting rows is not used to calculate the "Difference" and the "Total".
  - If there's no Due Code, the hours will be completed automatically by the software using the predefined values.
    The rows marked as "Festive" (0) or "Non-Working" (1) are not completed.
  - If there's a code the respective value will be used.

○ Difference.
  The "Total" minus the "Due".
  In the starting rows, the "Total" will not take account of the "Due".

○ Progressive.
  The "difference" of the row added to the "difference" of the previous one.

○ Split1 e Split2
  Time fields that can be used to keep track of the hours invested in a particular project.

Adding new columns

With the command "Data" -> "Columns setup" it is possible to add new columns.

If columns are of the data type "Number", "Amount" or "Time counter" the values will be summed up. Columns can be added, for example, to keep track of expenses, miles traveled or any other value that can be of interest to the user.

Views of the Journal table

The following views are created automatically:

○ Base
  With the base columns.
○ Minimal
  With the editable columns.
○ Complete
  All columns are displayed.
Setting up the work schedule

It's possible to define your schedule in the following places:

- In File properties - Start.
- In the journal table in the rows:
  - Festive. You can define a working day, a festive day and a non-working day by double-clicking the appropriate cell in the column "Festive".
  - "Due" and "due code" rows. You can overwrite the values defined in File properties - Start by using different codes inside the "due code" rows.

Working days and festives

By default every day is considered a "working day", unless a value starting with "0" is indicated in the "festive" column.

The weekly schedule is defined in File properties - Start. You may however edit it by inserting some codes in the "festive column". For example:

- If you never work on Sunday, insert "W0" on the first Sunday. The software will automatically edit all following Sundays with "(0)".
- If you don't work on the first day of the year, insert "0". Do the same for all days of the year that are festive.
- Insert "1" (or any other value beginning with 1) for other days were you don't have to work but that are not festives.

Day description

In the column "day description" the software will automatically write the name of the day of the week. If you insert an hashtag, like #Christmas or #ThanksgivingDay, the new value will be saved.

Working hours due, as defined by contract

If the salary is calculated on an hourly basis, you will have to indicate the hours worked for each day of the week.

The weekly schedule is defined in File properties - Start. You may however edit with different codes:

- If you work 8 hours each day:
  - Enter "PS" in "Due code" and "8:00" in "Due".
  - The software will repeat "8:00" in all following working days.
- If you have different working hours for different days of the week:
  - Enter "WS" in "Due code" and the hours in "Due", for each day of the week (only for working days). The software will automatically repeat the settings for the following days.

Paid holidays or paid leaves, as defined by contract
If some holidays are already included in your schedules:

- Indicate number of paid holiday hours in the "Start 2020" initial row.
  - Insert the number of paid holidays hours under the "holiday" column.
  - For example, if you have a right to 20 days of paid holidays and each day is 8 hours, insert 8*20=160.
  - For example, if you work 4 hours a day and you have a right to 20 days of paid leave, insert 80.
- Paid leave, considered as holidays:
  - Insert the number of paid leave hours you are due the "Start month" row (for example, Start February)
- Payment of holidays
  - After your holidays are being paid, at the start of the month insert the hours that have been paid preceded by a minus sign.
  - In the column "notes" write "payment of holidays"

**Adjustments**

The "adjustments" column allows editing of the total number of due/worked hours.

- If your overtime is being paid:
  - In the row of the day you are being paid in:
    - Enter the hours paid in the "adjustments" column, preceded by a minus sign
    - In the notes write "payment of overtime hours"
    - The total of overtime hours will decrease.
- If accumulated holidays are being paid
  - In the row of the day you are being paid in:
    - Enter the number of paid hours, preceded by a minus sign in the "Holiday" column
    - In the notes, write "payment of accumulated holiday hours"
    - The total of accumulated holidays will decrease.

**Counting hours without "Due"**

If you are paid based on the number of hours worked

- You don't have to specify "due" and "holidays".
- Simply insert the hours of work.

**Type of salary**

Hereafter the setting up of time sheets for the different types of salary are explained.

**Fixed salary**

The employee receives a fixed monthly salary, which involves a certain number of hours worked and paid vacations.
Take into account that all values, even holidays, are indicated in hours.
1. Open the template that has been set up.

2. In the **File** menu, use the **File and accounting properties** command and indicate:
   - Enter the first and last names in the **Timesheet** in the **Header left** and **Header right** sections, as well as start date and end date and the work percentage.
   - Enter eventual worked hours to carry forward from previous period in the **Start** section, hours and/or holidays (always expressed in hours).
   - Enter total hours worked for each day in the **Due Hours** boxes.
     - Indicate the planned hours for each working day.
     - Select Working day, Festive or Not a working day for each day of the week.

3. In the **Journal** Tab, indicate the number of holiday hours in the initial row of the Holiday column.
   (Ex. If a person is due 4 weeks of holiday and works 40 hours a week: 40 * 4 = 160).

4. Insert effective hours worked, or absences (sick leave, holidays) for each day in the Journal tab.
   - The **Total** column reports the sum of hours.
   - The **Due** column reports the sum of daily hours. The software will report as per the hours due that are indicated in the Start section of the File and accounting properties command.
   - The **Progressive** column displays the difference in hours (plus or minus) between hours due and the actual ones.
   - The **Total** row displays the total number of hours for the period.
   - The **Carry forward** rows display the number of progressive hours (since the start).

**Percentage change during a working year**

If the work percentage of working hours is altered during the year, as per 1st of Feb, you can reset those directly in the Journal tab.

**New work percentage as per a set date**

If for example, Tuesday and Wednesday will only be worked 4 hours per day instead of 8, proceed as follows:

- Insert the WS code in the Due code column (working day setup).
- Insert 4 in the Due column.
- As per that day, the Due column will show 4 hours and for the rest of the year.
- Punctual change for a few days.
  (Ex. 4 hours worked every day for just one week).
  In the Journal tab, for each day:
    - Insert code DS (sets up day) in the Due code column.
    - Insert 4 in the Due column.
- Leave of absence:
  If leave is granted for a certain day:
    - Insert code DS (sets up day) in the Due code column.
    - Insert 0 in the Due column.

**Adjustment of holiday days**

If the assigned holiday hours change during the year, it is necessary to:

- Insert the number of available hours in plus or minus in the Journal tab, initial row for the month and in the Holiday column.

**Payment of extra work hours**
If the employee accumulates extra hours other than those due and they are to be paid, there are two possible ways to reset the Progressive column to zero:

- Indicate "Payment 10 extra hours" in the Notes column. If the Notes column is not displayed, set it up via the Data menu, Columns setup ... command.
- Alternatively insert DS in the Due code column and the number of hours due in the Due column, plus those paid.

**Salary per hour**

In this case the employee is paid according to actual hours worked.

The employee receives a fixed monthly salary which includes a certain number of hours of work and paid vacations.

It must be taken into account that all values, even holidays, are indicated in hours.

1. Open the template already set up.
2. In the File menu, use the File and accounting properties command and indicate:
   - Enter the first and last names in the Timesheet in the Header left and Header right sections, as well as start date and end date and the work percentage.
   - Enter eventual worked hours to carry forward from previous period in the Start section, hours and/or holidays (always expressed in hours).
   - Select Working day, Festive or Not a working day for each day of the week.
3. In the Journal Tab, indicate the number of actual hours worked or leave of absence (sickness, holidays):
   - The Total column reports the sum of hours.
   - The Progressive column displays the difference in hours (plus or minus) between hours due and the actual ones.
   - The Total row displays the total number of hours for the period.
   - The Carry forward rows display the number of progressive hours (since the start).

**Progressive resetting**

When hours are paid, it will be necessary to reset the Progressive column to zero. There are two possible ways:

1. Indicate "Payment 10 extra hours" in the Notes column of the Journal on the day the hours are paid and insert the hours paid in the Adjustment column.
2. Alternatively insert DS in the Due code column and the number of hours paid in the Due column.

**Address Book**

This is an application for managing data lists and printing labels.

Characteristics:

- Free definition of the fields
- Possibility of printing only the selected rows
- Free setting of the label format
- Copy/Paste addresses from other programs (Excel and Word)
The Address Book presents three tables:

- Groups
- Contacts
- Diary

**Groups**

In the Groups table, one can define for each row, in the Id column, an identification code for a Group and enter the corresponding description in the Description column (es. cli - Clients, sup - Suppliers, col - Colleagues, etc.)

<table>
<thead>
<tr>
<th>Id</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>cli</td>
</tr>
<tr>
<td>2</td>
<td>sup</td>
</tr>
<tr>
<td>3</td>
<td>col</td>
</tr>
</tbody>
</table>

**Contacts**

The table presents the columns where the addresses can be entered.

**The columns**

There are different columns. The biggest part of the columns is invisible. The [Columns setup command](#) has to be used in order to:

- Display the columns
- Change the order of the displayed columns
- Add other columns

The name is based on the VCard standard.

- **Id** is the contact number.
  This is needed when you want to connect a contact to the diary, to the loans or to another table.
  While being on that column and pressing F6, there is an automatic progressive numbering.
- **Prefix**: you can enter "Mr", "Mrs", etc.
- **Family or Company name** (if it concerns a company).
  If the contact is a contact person for a company, you can enter the company or entity to which the contact belongs in the Organisation column.
  When pressing **F6** on the **Name** or **Family Name** column, the program separates or inverts the name and last name.
  If there are more than two names, this feature is not able to distinguish which one are the names or family (last) names.
- **LetterStart**: is the greeting that is being used at the beginning of a letter. This is being used for a mail merge.
For example: Dear John or Dear Mr Smith.
The program suggests possible texts according to the contents that have already been entered into the columns.

The views

There are different views available and each view distinguishes itself from another one through the presence of specific columns; in this example (Address Book file), we have the Base, Name, Address2, Archive and Complete views. In the Complete view, all the columns are visible.

Diary

In the Diary table, you can record all kind of notes, day after day and refer to the entered contacts.

Synchronize the data with Google

Manages your own Address book with the Google contacts.

When clicking on the Synchronize with Google (Download) command of the Utilities1 menu, a window appears that displays a Chrome browser page integrated in Banana and that asks for your Google login.

- Enter your email address and the password of your own Google account.
- Banana saves only the email corresponding with the Google account.
  The session's data and the password are not being saved in Banana, but are being managed by Google chrome.

Download

This feature takes the contact data from Google into Banana, or updates the Banana contacts.
In the **Groups** table, the groups that are present in Google are being resumed.

- In case there are already data in the table, the program merges the different data.

**Send**

Sends the modified data to Google, or updates the Google contacts.

- If in the "**GoogleNotSynchronized**" column "**Yes**" is being indicated, the contact is not being synchronized with Google.
- In order to send the data, these have to be downloaded earlier.
  - If you have edited the data on your telephone, you need to first download the data and then press Send.

**References**

For the technical details referring to the connection made, please consult the Google Api documentation.

- [https://developers.google.com/google-apps/contacts/v3/](https://developers.google.com/google-apps/contacts/v3/)
- [https://developers.google.com/gdata/docs/2.0/elements#gdReference](https://developers.google.com/gdata/docs/2.0/elements#gdReference)

**Printing Addresses/labels**

Information on printing addresses/labels can be found on the following web page [Print label](https://developers.google.com/gdata/docs/2.0/elements#gdReference).

**Manage, edit, back up Google contacts**

The Google contacts command allows you to edit, update and generally manage your Google contacts, saved in your Android phone directory more easily.

**Google contacts commands**

Synchronizes content with Google contacts.

When you activate the Google contacts demand for the first time:

- A window appears with a display of the Chrome browser page integrated into Banana and ask for the Google login.
- You must enter the email address and password of your Google account.

Banana only saves the email corresponding to the Google account. Session data and password are not saved within Banana, but are managed by the Google Chrome application that is used within Banana Accounting.

**Synchronization commands**

**Download changes**
This function imports data from Google and updates the values in Banana.

- If there is already data existing in the table, the program will merge the various data in the tables
  - Groups.
  - Contacts.

### Send changes

Send modified data to Google, updating your Google contacts.

- To be able to send data, you must have previously downloaded it.
  If you have made changes on your mobile, you have will have to first download the data and then send it.

A window with the elements modified, added or deleted will display.

![Commit changes window](image)

It is not recommended to use the "GoogleNoSynchronize" column because it will no longer be used in subsequent versions. If Yes, the contact will not be synchronized with Google.

### Download and Replace existing contacts

Banana will not always be able to synchronize all changes.
This command will delete the contacts in the contact table and replace them with the existing Google contacts.

This command will also deletes items marked as "GoogleNoSynchronize"

### Conversion of values in the table

Google contacts manages addresses, phone numbers and e-mail in a structured form. In the Contact stable, the data are instead managed via the column.

### Telephone numbers and e-mails
Google allows you to define different e-mails and phone numbers. For each one a label and an indication by default is designed. In Banana you must follow these directions:

- If there are different types of telephone or e-mail, you will indicate them in the appropriate column (work, home, other).
- If for each type there are several telephone numbers or e-mails, indicate them in the column, separated by a semicolon ";".
  Telephone work "+1234567890;+21234567890". E-mail work "example@gmail.com;example@yahoo.com"
- If the phone number or e-mail has a particular label, it will be indicated in the "Other" column, with the label followed by a colon ":".
  If there are several numbers, separate them with a semicolon ";;"
  "Holidays:+1234567890*;Cousin:+1234566777".
  "Temporary:example@gmail.com;Mama:example@yahoo.com"
- To indicate that the phone is a number by default, mark it with an asterisk "*" after the number. Between the different numbers there can be only one default number.

Addresses

Google allows you to have multiple addresses for the same contact.
Banana Accounting instead allows to synchronize only one address, the "Home" being main one.

Groups

Groups defined in Google are imported into the Groups table and my be added on to.

In the Group column of the Contacts table you can insert multiple membership groups by separating them with a semicolon ",;".

Create a backup of your Google contacts

1. Create a New empty Address Book file.
2. Utilities1 Menu>Google contacts>Download changes
3. Save the file on your computer with the day's date in the name.

Manage your Google address contacts

If you have multiple addresses in your address book, it will be easier to use the Banana address book to sort out your addresses. You can quickly correct errors, add information and remove duplicates and much more.

1. Download data from Google contacts
2. Effectuate your changes
   Remember that the F6 key (Mac Cmd-6) has several features (see the Info window below).
   In the Name and Surname column, invert the values.
3. Hit command button to send changes.

Archive and remove contacts that are no longer used

You can save phone contacts that you no longer use on your computer and delete them from your
First time:

1. Create a new Address Book file.
2. Utilities1 Menu-> Google Contacts-> Download Changes.
3. Save the file in your documents, "Folder_Philip_donotcancel_ever", so you remember that it is an important file.
4. Display the Archive view.
5. In the Archive date column, insert the current date (type the dot ".") for all contacts you no longer require
6. Utilities1 command-> Archive data Table-> Contacts.
7. Utilities1 command-> Google Contacts-> Send Changes. Your data will be deleted from the address book.
8. Utilities1->View Archived data-> Contacts will allow you to access your archived contacts.
   If you want to add them back to your directory, you must copy the line in the Contacts table and delete it from the Archives.

Safe-keep your file. Proceed as follows if you wish to archive unused contacts:

1. Open your address book file.
2. Utilities1 command-> Download changes or if there are problems Download and replace.
3. Proceed as indicated above in the Archiving and Sending Changes procedure.
4. Save the changes.

Resume data in Excel

- Download data from Google contacts.
- Select all (upper left corner button)
- Copy
- Paste into Excel.

Synchronization problems and suggestions

The Google address book offers many possibilities and can be used in very different ways. We have tried to make it work better for you, but there may be situations where the program might experience problems with the changes that have been made.

If this is the case, it will be necessary to use the command function. Download and delete existing contacts, to completely realign the two archives.

We are obviously interested in continuously improving the functioning of our software, so send us an e-mail describing the problem and show us how to replicate the problem on our computers. This will allow us to fix the problem.

Any suggestions on how to improve the product are always welcome.

For technical details related to the connection, check the Google API documentation.

- https://developers.google.com/google-apps/contacts/v3/
- https://developers.google.com/gdata/docs/2.0/elements#gdReference
Library and collections

How to use it / introduction

This is an application that allows you to keep a list of books, objects and contacts, and check on objects borrowed and returned.

Creating a Library and collections file

From the File menu -> New... in the Filter by: box enter the the text "library" and select the Banana Library template (also make sure you have selected English as search language).

Groups table

In this table you can assign to each user a group, for example to partition children between Kindergarten and Primary school users, etc. You can enter a group Id (Id column). In the Description column you enter a text describing the group.

<table>
<thead>
<tr>
<th>Id</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>TC</td>
</tr>
<tr>
<td>2</td>
<td>K</td>
</tr>
<tr>
<td>3</td>
<td>T-S</td>
</tr>
<tr>
<td>4</td>
<td>E-B</td>
</tr>
<tr>
<td>5</td>
<td>LV</td>
</tr>
</tbody>
</table>

For a detailed explanation of the columns, please consult the Address Book page.

Contacts table

In the Contacts table you can enter users data, divided into several customizable columns (you can keep visible only the ones you need and hide all others - you can also add new ones).

<table>
<thead>
<tr>
<th>Name</th>
<th>Communication</th>
<th>Address</th>
<th>Birth</th>
<th>Complete</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

For a detailed explanation of the columns, please consult the Address Book page.

Items table
In this table you can enter your items data.
There are different ways of entering the items data: copy and paste from Excel, automatic data retrieving from the Internet, etc.
See detailed explanations below.

Columns

There are various columns and it is also possible to add new ones.

- **Id**: the item number that has to be attributed.
  The F6 key assigns the number progressively.
  It is also possible to use a prefix. For example: A-001, after that, the program suggests A-002.
  When entering the ISBN in the Id column and pressing the F6 key (⌘+6 on Mac), the program automatically completes all the book's data in the other columns, incorporating them from the Google database, provided there is an internet connection available.
  Any already present information will be overwritten.
  For more information see: [Google documentation](https://www.googleapis.com/books/v1/volumes?q=9781906042509).
  - The data in the Google database are not always complete. For example, the title might be present, but the editor or other data might be missing.
  - In order to know which data are available on Google, please visit the following page: https://www.googleapis.com/books/v1/volumes?q=9781906042509, entering after q= the book's ISBN number.
    If you see "totalItems: 0" it means that the book is NOT in Google's database
    If you see a page in a JSON format (programmers format) with the book's data, it means that the book IS in Google's database.
- **Title**: Is the title of the work.
- **Author**: There can be several authors entered, separating them with semicolon ";".
- **Publisher**: There can be several editors entered, separating them with semicolon ";".
- **Return date**: The projected return date for this item.
This column is automatically completed according to the checked out item.

**Entering books data**

Books data can be entered in different ways:

- **Manual insertion** - You can manually enter the books data in the *Items* table (see previous paragraph)
- **Retrieve data from Excel** - If you already have a list of books from another program or Excel, you can simply copy/paste the data. In order to copy/paste the data you need to make sure the columns in Excel as arranged in the same order as in Banana. If the column order is the same in both programs you can copy the data in block, otherwise you need to proceed column by column. The copy/paste operation is possible from Excel or from txt files.
- **Retrieve book data automatically from the internet** - The ISBN column is very useful if you have an Internet connection: each book has an ISBN code (internationally recognized and generally written on the back of the cover); If you enter a book’s *ISBN code* on the appropriate column in Banana and press the **F6 key** (or **Cmd + 6** for Mac), the program automatically retrieves the books data from the Internet and inserts all data (title, author, publisher, etc. even a small summary).
- If the book has different authors or publishers, just separate the names with a semi-comma “;” - they will also be found individually in searches (for example if you need to find all the books of a certain author).

**Loans table**

In the *Loans* table you can enter the checked out items, the expiration date and the return date.

**Columns**

- **Date**
  The data of the loan.
- **ItemId**
  The item number. A search can be made based upon the title.
- **ContactId**
  The contact number. A search can be made based upon the name, family name, place.
- **Expiration date**
  The projected date for the item’s return.
  If you enter "+30", the program proposes the date that come 30 days later.
- **Return date**
  Enter the return date.
How to manage the loans

Loan of a book

- Add a new line and indicate the date of the loan (useful shortcut: hitting dot "." on your keyboard will automatically generate the current date!)
- In the Item Id column, as you start typing the title of the book or library user, the program will display all choices available in your database; just select the right option and press the F6 key: the program will automatically fill the Item Id and Description cells.
- In the Expiration column (date of return for the book) the program automatically enter a date 30 days after your current date, but you can manually change it: you can enter the number of actual days (for example +40) to generate the correct return date (40 days later).

Return of a book

- From the Utilities1 menu, choose Items return;
- This will open a window where you type the name of the library user. This will display all books on loan to this library user.
  - You can now check all returned books (usually a library user returns all the books he has on loan simultaneously).
  - Click the Apply button and the program will automatically insert the actual return date in the Date column.
  - In case of error, return to the Loans table and click the Undo command.
How to archive data

The Archive feature avoids the adding up of too many transactions of lent and returned books. Outdated data to be archived in hidden tabs without being deleted. This data can be recalled at any time for statistics or any other use.

Store data of returned books

- Choose Archive data from the Utilities menu and then Archive table data -> Loans. The program will delete all transactions of already returned books from the Loans table and store them in the Archive table.
- Only books on loan that are not yet returned will be shown in the Loans table.

Store contact information no longer used

As for your books, you can equally archive your old and unused contacts
○ Indicate a storage date for all the contacts you wish to archive.
○ Choose the Archive data from the Utilities1 menu and then Archive table data -> Contacts.

Diary - organization and internal notes

Diary table

In the Diary table you can enter daily notes and connect them to a specific contact. You can for example organize the shifts of people working at the library, post notes or important facts, lists of things to do, etc.
Each row of record has it's column for date, description, expiration date, the contact Id of the originator.

![Diary Table](image)

Printouts

Everything that you see on screen can be printed or saved in a pdf format.

In the BananaApps section (look for library), you can also find extensions for specific printouts:

○ printout of the complete book catalog in pdf, to be published on the internet
○ printout of the users details with the books they have loaned and the ones still to be returned

Print library labels

Label printing

You can print two different types of labels:

○ small labels (containing the book code) for use on the spine of the book, so that they are visible on the bookshelves
○ larger labels are used on the inside of the cover, maybe mentioning that the book has to be returned at a specified date

Labels can be printed either on the basis of the Banana file, where you have registered all the books
in the library, or from an empty file in case you wish to print a list with codes, that you will then assign to the books.

**Creating a file to print library labels**

From the **File** menu -> **New...** in the **Filter by:** box enter the text "library" and select the **Banana Library - printing book labels** template (also make sure you have selected English as search language)

**Printing labels for the spine of the book**

You can choose the format that best suites your needs by consulting the websites of label producers (for example A4 sheets, 25,4 mm x 10 mm - Herma 10001 or Herma 4333 models).

In order to print the labels, you can open a new blank file in Banana, containing no data (**File** menu -> **New**), but, as stated, you may wish to start from an existing file in your library.

There is a useful Excel function to generate a large amount of codes in a speedy manner, rather than entering them manually or than using F6 key. Here is how you do it:

Open a new Excel file; in cell **A1** enter the library code that suited your purpose (any combination of letters followed by numbers will do) - for example B1000.

Choose the bottom right angle of your cell with your mouse (the point will now be a cross), and, while holding down the right click, drag down along the column; Excel will automatically generate autoprogressive numbers.
Now copy (Ctrl + C keys) the codes that have been generated into Banana's Items table, in the Id column (Ctrl + V keys).

You can now create the label.

Chose the Labels -> Print command from the Apps menu. This window will be shown:
It is important to have the **Items** table selected as the source for **Data**; now you can define your label by pressing the **Change...** key in the **Labels format** section.

In the window now shown, enter the margins and other characteristics of your chosen label, Herma 10001 in this case.

Before hitting the **OK** key, open the **Composition** tab, where you can assign a name to your custom settings (so they can be used in the future). In this case it's Book codes (Spine).
Hitting the **OK** key will now return you to the **Print labels** window.

Once you have defined the size of your label, you still need to indicate it's contents.

Enter the **Label** tab to do so.

In the example, the label only needs to indicate the book's code, i.e. the **RowId** column.

You can therefore select the **RowId** line in the available list and press the **Add Field button**.

**RowId** will show in **View labels**.

Pressing the **OK** button will generate a preview of your label.
You may now print using your Herma sheets.

**Printing labels for the inside cover**

Choose your label format. In the example a 70x36mm (Herma 4630 or Avery 3490) format has been chosen. The steps to follow are identical to the previous example::

- First, choose the **Labels -> Print** command from the **Apps** menu
- Click **Change** in the **Labels format** section
- Enter the margins for your new label in **Labels format** window.
- Before hitting the **OK** key, open the **Composition** tab, where you can assign a name for your new custom settings (Inside Cover label, for example), than hit **OK**.
- Select **Label** in the **Print label** section to add the content of your label.

You may enter text, other than the available fields, as well.

Pressing the **OK** button will generate a preview of your label.
Note:

The models available in Banana already include the two mentioned label formats: label for the spine of the book and label for the inside of the cover.

Related features:

Management of yearly membership fees

If you run a library requiring an annual membership fee, or if fees are charged for the loan of individual books, it is useful to use the accounting functions of Banana Accounting. Please check our page Accounting templates.

Simple table

This is a table that can be set up according to the needs of the user. One can add columns and views and give them the most appropriate header, with the Columns setup and Tables setup commands of the Data menu.

Fixed assets register

For professional management of depreciable assets with the related amortisation, write-downs, revaluations and other changes. The program automatically calculates amortisation based on the parameter's setup. A data history is maintained, and they can then be imported into your accounting.

How to manage your Fixed assets register
The steps to manage your register are summarized below:

1. Create a new file of the Fixed Assets Register type.
   Search for the example file "Fixed Assets"
2. Insert the different acquisitions into the Items Table, setting up the different values and parameters for the calculation of the amortisation.
   You may create groups for items that have the same parameters.
3. At the end of the period, press the "Create amortisation lines" command. The program will create amortisation lines for individual assets, based on the specified parameters.
4. The amortisations can be imported into accounting with the Import into Accounting->Transactions command.

The contents of the Fixed assets register

The fixed asset register file is composed of the following tables:

- **Items** table - where you list the depreciable assets and the amortisation parameters
- **Transactions** table - where you enter the amortisation transactions, as well as purchases assessments
- **Amrt. Type** table - indicates the various amortisation types.
- **Trans. Type** table - indicates the various transaction types

As opposed to a regular Excel spreadsheet, that will normally only register the changes in accounting values, this application will allow you to keep track of:

- Asset at purchase value.
  The total outlay for the purchase of an asset.
- Historic value (purchase value +/- assessment of appreciation or amortisation).
  Which is needed for the calculation of amortisation on historical value.
- Accounting value (historic value +/- corrections due to amortisations).
  As managed in accounting.
- Fiscal value (Accounting value +/- corrections of the fiscal value).
  As recognized by the tax authorities.

In order to take note of changes in value, such as amortisations, write-downs and other changes, the programme uses an accounting logic. Variations of value for a specific item are entered in the Transactions table:

- There is a history with all changes in the value of the asset, from purchase to disposal.
- A function for automatic calculation of periodical amortisation of predefined basic values, is integrated. Transaction values can be adjusted manually (as, for instance, in a varying calculation for a first accounting year).
- Transactions can be added manually for appreciation, extraordinary amortisation, adjustment of fiscal value and so on.

Usage Notes

Amortisation in the year of purchase of the asset

There are an infinite number of methods for establishing how the amortisation value for the first year is to be calculated.

The program offers these possibilities:
- It normally calculates amortisation for the whole year.
- In the **Amortisation month first year** (Month 1.Year) column, you can indicate for how many months the amortisation is to be calculated.
  - If in the first year you desire to calculate only 50% of the normal amortisation, you should indicate 6 months.
- **Amortisation percentage 2 Column**
  Used for an extra amortisation. An extra amortisation row is being created.
- For other situations, let the program create the amortisation row and then adjust the automatically created amortisation transaction.

**Items Table**

Allows the insertion of depreciable assets, related groups and parameters for calculating amortisation. For the calculation of the amortisation, if the parameters Amrt. Type, Percentage, Account or Contra account are not entered for a single item, the software will use the group or subgroup parameters.

This table contains the following columns; The ones marked with an asterisk (*) are protected and calculated by the program:

- **Group**
  If a value is present it means that the row is a group. Items and groups values are added up in this row.
- **Id**
  The Item Id
- **Description**
  The item description.
- **In Group**
  The group the row belongs to. This must be a value present in the Group column.
- **Account**
  The account to which the item is being attributed in the accounting.
  This account can also be a group.
- **Contra Account**
  The account where the amortisation should be registered. The contra account can also be indicated for the group.
- **Date Begin**
  The item purchase date (or at which the item was entered in the accounting file)
- **Document Date**
  The date of the item purchase document, if available
- **Initial value**
  The purchase value.
- **Purchase Variation**
The total purchase value, positive or negative, indicated in the transactions.

- **Purchase Value**
  The initial value plus the purchase variation.

- **Historical Variation**
  The positive or negative value of the historical variation (revaluations or write-downs) indicated in the transactions.

- **Historical Value**
  The purchase value plus historical variation.

- **Book variation**
  The positive or negative accounting value (amortisations or inverse amortisation entries) indicated in the transactions.

- **Book value**
  Historical value plus book variations.

- **Fiscal Variation**
  The positive or negative value of the fiscal adjustments indicated in the transactions.

- **Fiscal Value**
  The Book Value plus the fiscal adjustments.

- **Residual Value**
  A possible minimal residual value to be indicated.
  If the residual value is equal or bigger than the book value, no more amortisation rows are created.

- **Estimate value**
  An item's probable estimated value

- **Amortisation Id Type**
  The amortisation type applied to this item
  The amortisation type can also be indicated for the group.

- **Amortisation Percentage**
  The amortisation percentage.
  The amortisation percentage can also be indicated for the group.

- **Amortisation amount**
  A possible amortisation amount if the amortisation is not specified as a percentage.

- **Amortisation Percentage 2**
  The additional amortisation percentage to be applied to this item.
  The "Create amortisation rows" command creates an extra amortisation row, the calculation method is the same.
  The extra amortisation percentage can also be indicated for a group.

- **Amortisation Months First Year**
  The number of months the item needs to be depreciated in the first year.

- **Serial Number**
  The item's serial number

- **Warranty Date**
  The warranty expiration date.

- **Insurance Value**
  The value this item or group is insured for.

- **Insurance name**
  The insurance company's name.

- **Insurance number**
  The insurance policy number.

- **Insurance expiration**
  The insurance policy's expiry date.

- **Insurance cancellation**
The date by which legal notice needs to be given to the insurance company if automatic renewal is not desired.

- **Archive Date** and **Archive notes**
  Columns you might use if you need to archive the item.

**Transactions table**

This is the table where you enter the items variations. It has several columns:

- **Date**
  The transaction date
- **Transaction Type Id**
  The transactions type, identical to the one in the Transaction table.
- **Transaction Type Description**
  The description from the Items table is displayed.
- **Item Id**
  The Item Id.
- **Items Description**
  The items description from the Items table is displayed.
- **Notes**
  An additional note concerning the transaction.
- **Purchase Variation**
  The item (+/-) variation compared to the purchase or sale.
- **Historical Variation**
  The Item (+/-) variation compared to a item revaluation or write-down.
- **Book Variation**
  The item (+/-) variation value compared to the book variation.
  This is particularly used for negative amortisations
- **Fiscal Variation**
  This is the fiscal variation amount.
- **Amortisation Type Id**
  The amortisation type code as shown in the Items table.
- **Amortisation Type Description**
  The amortisation code descriptions as per the Items table.
- **Amortisation Percentage**
  The amortisation percentage applied.
- **Account**
  The Assets account where the operation must be registered
- **Contra Account**
  Contra account (for example the amortisation account) where the operation must be registered.
- **Archive Date** and **Archive notes**
  Columns you might use if you need to archive the item.

**Amortisation type table**

- **Id**
  The amortisation code.
  These codes are fixed and must not be modified.
  If you change the Id number the program will not operate correctly anymore.
  - 00 No amortisation. No amortisation will be created.
  - 01 Full amortisation at once of the item. The item is amortised all at once.
  - 02 Specified amount. The amortisation is calculated, based on the entered amount.
  - 10 On the historical value. The amortisation is calculated as a percentage of the historical value.
  - 11 On the book value. The amortisation is calculated on the book value.

- **Description**
  The code explanation

**Transactions type table**

- **Id**
  The transaction type code
  These codes are fixed and must not be modified.
  If you change the Id number the program will not operate correctly anymore.
  - 01 Initial value. Used to enter an initial value, instead of entering the initial value in the Items table
  - 11 Purchase or production
  - 15 Sale or value reduction.
  - 21 Revaluation
  - 25 Devaluation
  - 31 Inverse amortisation
  - 35 Amortisation
  - 36 Supplementary amortisation
  - 41 Fiscal value increase
  - 45 Fiscal value reduction

- **Description**
  The code explanation

**Utilities1 menu**

**Create amortisation rows**

Indicate:

- The date for the calculation of the amortisation
- The period of the amortisation calculation, monthly, quarterly, half-yearly or annual.

The program creates the amortisation lines based on the parameters of the items indicated in the Items table.
If the parameters Amrt. Type, Percentage, Account or Contra account are not entered for a single item, the software will use the group parameters of which the item is a part to create the amortisation transactions.

Automatically calculated record values can be adjusted manually.

Value adjustment records, such as devaluations or revaluations, must be entered manually.

Show Journal

Will display all operations with the variation of values and the cumulative value.

Show items report

Will display the variations for each item and item groups for the selected period.

Import amortisation rows into accounting

You can choose to import the rows of the Fixed Assets register into the accounting with the Import to Accounting command -> Transactions.

Only the rows of the journal that fall within the accounting period are taken over.

You can then choose to import only a few dates.

Further application developments

Printing

It is planned to develop further printing modules within the BananaApps, that will go beyond existing available printing templates, allowing for more flexibility and tailor made solutions.

Do not hesitate to report your needs and requirements to our programmers, possibly by sending an example of the type of report you wish to use, such as an Excel table, with columns, totals, header data, and formatting.

Different types of amortization

It is equally planned to develop modules within BananaApps for this feature, to include different types of amortization, aiming to deliver a tailor made solution to you.

Do not hesitate to report your needs and requirements to our programmers.

Utilities1 Menu

The Utilities1 menu includes various commands that are specific for the Utilities applications. The general commands, available in all the Utilities applications, are explained hereunder. Other commands, specific for the Address Book and the Library application, are explained in the corresponding documentation.

Recheck all...

Checks everything and gives a warning in case there are errors.
Sort contacts by name
Sorts the rows of the Contacts table in ascending order by Name, Family Name, Second Name, Place.

Archive Data menu
The program keeps a list of the rows that have been archived, for each table.

The archived rows are being shown in the Archived rows table. Select the rows that need to be shown.

Archive data
Moves the rows of a table (Contacts, Items, Loans, Diary) to the Archived data table, where:

- The Archive data column is not empty.
- For the Loans table, there should be an expiration date and a return date (a "closed" loan)

A list of tables is being shown. The tables present on this list contain rows that can be archived. If there are no tables with rows that can be archived, the selection is empty.

Show archived data
Shows a list of the archived rows of a specific table.
Select value

Show archive data of table

- Contacts
- Items
- Loans
- Diary

OK  Cancel  Help
File Viewer

Banana Accounting 9 Software allows for reading and displaying in tabular form multiple file formats.

View CSV File

When opening, or dragging and dropping a file of the CSV or JCSV type in the Banana window, Banana will automatically create a simple Table type file, resuming the columns and data contained in the CSV table.

View ISO 20022 file

The Banana software allows the user to view and print the contents of ISO20022 - camt. 052, camt. 053 (included version 4), camt. 054 - and MT940 bank statements. The transactions of the electronic bank statement, with description, amount income or expenses, are being presented in separate columns and can be printed or pasted into Excel.

Open the ISO 20022 or MT940 file

In order to open and see the file:

- Download your bank statement in ISO 20022 format
  - If it is a compressed file, extract the XML file to be displayed with its own utility (p.es. 7zip)
- Install and open Banana Accounting
- Drag the file inside Banana Accounting: Banana immediately shows all entries with text and date, amount and the progressive balance (the file is being opened as “read only”)
- The data of the bank statement can then be printed or copied into Excel or other programs

In this image, one can see how an exemple file is being displayed
Additional indications

- The opening balance in the ISO 20022 file is entered into the Accounts table.
- The column width can be adapted with the mouse.
- To align the text of the description on several lines, use the command Format -> Calculate all row heights
- To categorize the movements and get statements, enter the appropriate categories in the Categories table and display the Categories column in the Transactions table with the Columns setup command.
  Or, create a new file with an existing template and categories and accounts already set up, and import the data of the bank statement as explained in the page Import ISO 20022 file.
- In the free Starter Edition mode, files with more than 70 transactions cannot be saved.

More information

For more information with regard to the ISO 20022 Standard, please consult the page Import ISO 20022 file.
Technical support

For all accounting questions and questions about the use of the program, please use one of the following options:

- Use the Search box on the upper part of the page, right hand side
- Consult the Questions and answers page
- Consult the Documentation pages
- Consult the Solve it with a click page
- Consult the Support page

Rare case troubleshooting pages:

If you are experiencing a problem starting or using the application consult the Rare cases pages.

How to retrieve the event log in Windows

If the application crashes (the application has stopped working or disappears) please send us an event log file to help the development team to troubleshoot the problems.

Follow the steps below to find and send us the event logs:

- Click Windows Start button > Type event in Search programs and files field.
- Select Event Viewer.
- Navigate to Windows Logs > Application, and then find the latest event with “Error” in the Level column and “Application Error” in the Source column.
- Copy the text on the General tab.
- Attach the text in the contact form or in a email.